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1 This Release

What’s New in Siebel Finance Guide, Version 7.8
Table 1 lists changes described in this version of the documentation to support Release 7.8 of the
software.

Table 1. New Product Features in Siebel Finance Guide, Version 7.8

Topic Description

Show Audit Trail button Added information on using the Show Audit Trail button on

. . . the toolbar.
See “Using the Show Audit Trail

Button” on page 26

VBC Cache and Instance Manager | Added information on the VBC Cache and Instance Manager,
which includes Caching VBC Overview, Components, Stages

See "VBC Cache and Instance of the Caching VBC Process, and Caching VBC Configuration.

Manager” on page 208

Free Form Converter Added information on the Free Form Converter, which
includes FINS EAI Free Format Hier Converter Methods and

See “Free Format Converter” on PropSetToPlainText and PropSetToRawText User Properties.

page 213

Collections chapter removed Deleted chapter. This module is no longer available in
Financial Services.
This functionality is still available in the Automotive
collections module.

Integration chapter removed The Integration chapter has been removed as this

functionality is not supported in Version 7.8 of the software.

Financial Services Workflow User Detailed information about workflow user interface utilities
Interface Utilities in Chapter 19, can be found in Siebel Business Process Designher
“Business Services for Siebel Administration Guide.

Financial Services,” was removed

Siebel Finance Guide Version 7.8 15



What’s New in This Rel

Siebel Finance Guide Version 7.8



2 )f Siebel Finance

Siebel Finance includes various modules that you can mix and match according to your business
needs. The next section, “Siebel Finance Functionality and Modules” on page 17, describes Siebel
Finance functionality.

Siebel Finance is built upon the Siebel Business Architecture, which includes Siebel Sales, Siebel
Service, and Siebel Call Center applications. Like many other Siebel Business Applications, Siebel
Finance uses the Siebel Data Model, the Siebel Object Architecture, and the Siebel Application Server
Architecture.

For customers with the Siebel Janna applications, the Siebel Finance Basic application and modules
provide a migration path. Siebel Finance Basic also uses the Siebel Data Model, the Siebel Object
Architecture, and the Siebel Application Server Architecture. For more information on Siebel Finance
Basic, see “Siebel Finance Basic Functionality and Modules” on page 22.

Siebel Finance Functionality and
Modules

Siebel Finance Functionality
Siebel Finance provides the following functionality:

B Multiple lines of business management, permitting use by a range of users in retail and
investment banking, which includes call center representatives, commercial bankers, investment
bankers, mutual fund managers, small business officers, private bankers, division and regional
managers, tellers, and others

B Financial account management, allowing the user to see and manage different types of financial
accounts such as checking, savings, mutual funds, and credit products

B Campaigh management, allowing product promotion to specific segments, accounts, and other
targeted opportunities

B Activity management, integrated with the Calendar, promoting streamlined call planning and call
reporting

B Enterprise-wide product management, promoting product information sharing across sales
teams and regional branches

B Knowledge management, supporting customer-service centers and providing solutions for
Financial Services-specific inquiries

B Multi-channel correspondence management, supporting a large number of inbound telephone
calls, faxes, email, and Internet correspondence for customer service, sales, banking agents, and
investment specialists
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Outbound campaign management, supporting outbound calling for telesales, telemarketing, and
meeting planning

Multi-channel relationship management, supporting all customer touch points and modules of
interaction, which includes Supermarket, Call Center, Field Sales, Marketing, Sales, Service,
Kiosk, Branch, and Relationship Managers

Siebel Finance Modules
Siebel Finance includes the following modules:

18

Small Business Banking. Formerly called the Business Relationship Management module, this
module is primarily targeted at Business Lending and Relationship Management. Within a small
business banking organization, the primary users of this module include vice presidents,
assistant vice presidents, line officers, and credit officers who have responsibility for business
accounts. These positions are often referred to as relationship managers, account officers, or
bankers. The Small Business Banking module provides detailed client profile information,
competitive information, and summary charts to allow relationship managers to better identify
and close opportunities with business customers.

Needs Analysis/Applications. Siebel Needs Analysis/Applications, which is designed for sales
personnel, their managers, and their associates, focuses on consumer sales opportunities. This
module identifies appropriate product recommendations for deposit, investment, and home
banking products for consumers and small businesses.

The Needs Analysis/Applications module also allows agents to capture information required to
open and establish new liabilities products or services for customers. This module supports
universal applications to facilitate a streamlined application process. For credit products
application, use the Credit origination module.

Call Reports. Siebel Call Reports are records of meetings and conversations with clients or other
organizations and individuals. Financial institutions often require employees to generate call
reports when they meet with customers.

Credit Origination. The Siebel Credit Origination module supports loan origination. This module
helps call center, field, and branch personnel do what if analysis to determine the needs of
customers, recommend the right loan products, prequalify the customer, take the application,
provide additional information about the product’s fees, rate, and conditions, and manage loan
documentation. This module further supports the consumer credit industry with the five most
frequently used calculators in the industry, which includes Loan Amount, Monthly Payment, Loan
Comparison, Refinance Break Even, and Loan Payoff.

Financial Accounts. The Siebel Financial Accounts module allows organizations to view account
details along with associated transactions. This module supports products such as checking,
savings, credit cards, certificates of deposit (CDs), and all types of loans. It also includes
investment accounts and holdings.

Securities. Siebel Finance also provides functionality for investment accounts that support
brokerage financial accounts and their related investment holdings. This module records and
provides information about various securities (stocks, bonds, mutual funds, options, or unit
investment trusts [UITs]) that make up these holdings. A financial institution using this module
can execute trades of securities (buy and sell orders) on behalf of its clients.
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Institutional Sales & Research. Siebel Institutional Sales & Research provides a client
management system for securities firms serving institutional clients. By facilitating
communication across product groups and geographic regions, Siebel Finance allows client team
members to work with the entire firm’s relationships and competencies, thus institutionalizing
the client relationship. Siebel Institutional Sales & Research includes the following functionality:

m Holdings & Interests Tracking. Siebel Institutional Sales & Research provides institutional
salespeople with a tool for tracking client holdings and contact interests. Siebel Finance
accepts feeds from third-party vendors of holdings data, and also allows individual
salespeople to import spreadsheets sent to them from clients. Salespeople can query
holdings and interests data to build their day’s call list, and then make the calls with the
assistance of Siebel CTI. Activity records are automatically generated, thus reducing data
entry for the salesperson while still maintaining accurate contact histories.

B Research Distribution Management. Siebel Institutional Sales & Research provides a
central repository for company research publications, and allows professionals to fax or email
research documents to clients. Siebel Finance automatically tracks research distribution,
allowing sales and research professionals to better understand their clients’ interests.
Security firms can also use Siebel Finance to better understand the channels through which
its research is being distributed, and to manage entitlements.

m Investor Profiling. Siebel Institutional Sales & Research provides institutional salespeople
with an understanding of organizations or companies as investors, with their holdings and
transaction history, charts and profiles of the investor, and the literature distributed to the
organization. As well, you can integrate Siebel Finance with external news sources to display
additional information about the investor.

B Securities. Siebel Institutional Sales & Research includes the Securities module. This
module provides for the set up and profiling of securities, which includes mutual funds. The
Securities module provides the salesperson with a picture of each security available for sale
to his or her clients, which includes literature about the security and information about
mutual funds, their objectives, risk profile and asset mix.

Commercial Banking Loan Approval. Siebel Commercial Banking Loan Approval provides the
necessary tools and functions for the commercial banking market. Commercial Lending allows
end users to automate the application approval process in commercial banking. It allows agents
to capture the information necessary for a credit committee to make decisions. Users can capture
both customer and facility-level information. The customer-level information includes the
Request Summary view, and displays general information about the primary borrower and the
relationship. The information at the facility level includes the facility detail views, which display
detailed information about the specific facilities for which approval is requested.

Corporate & Commercial Banking. Siebel Corporate & Commercial Banking is designed for
financial services professionals working with corporations and other business customers in
corporate banking. This module augments the customer relationship management features of
Siebel Finance.

Company profiling provides corporate bankers with an in-depth picture of companies, which
includes their investment and financial profile, competitors, third-party providers, and investors.
Also, it includes summary views to provide quick snapshots of the key information about the
company. Siebel Corporate & Commercial Banks includes the following functionality:
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Retail Brokerage. Siebel Retail Brokerage provides tools that allow an advisor or a broker to
provide the right advice to the right customer at the right time. This results in increased returns
on investment for the customer and increased profitability for the financial institution. Siebel
Retail Brokerage includes the following functionality:

B Household Holdings. Because retail brokerage sales are often to residents in the same
household, this module also provides the total household picture which includes all the
holdings for individuals within the household. It provides the advisor the ability to select and
aggregate holdings for a household with multiple accounts, view the time-weighted rate of
return or anticipated cash flows for an identified period, and compare the household's actual
portfolio by asset class or by industry sector against a selected model portfolio.

®m Holdings & Interests Tracking. Brokers and advisors can use this module as a tool for
tracking an individual's holdings and interests. Siebel Finance accepts feeds from third-party
vendors of holdings data, and also allows individual brokers and planners to import
spreadsheets sent to them from clients. Brokers and advisors can query holdings and
interests data to build their day's call list and then make the calls. Activity records are
automatically generated, thus reducing data entry for the salesperson while still maintaining
accurate contact histories.

B Securities. Siebel Retail Brokerage includes the Securities module. This module provides for
the setup and profiling of securities, which includes stocks, bonds, mutual funds, and other
investment products. The salesperson is provided with a picture of each security available for
sale to his or her clients, such as literature about the security and information about mutual
funds, their objectives, risk profile and asset mix.

B Research Distribution Management. Siebel Retail Brokerage provides a central repository
for company research publications, and allows brokers and planners to fax or email research
documents to clients. Siebel Finance automatically tracks research distribution, which allows
sales and research professionals to better understand their clients' interests. The securities
firm can also use Siebel Finance to better understand the channels through which its research
is being distributed and to manage entitlements.

Retirement/Pension Management. Siebel Retirement/Pension Management provides
comprehensive support for group pensions. It allows a user to manage private group pensions,
which includes defined contribution plans, such as 401(k) plans and occupational pensions, and
defined benefit plans. It is designed to meet the needs of sales and service professionals,
managers, and pension administrators. The module allows users to define group pension plans,
plan classes, plan eligibility rules, and plan funding vehicles. Siebel Retirement/Pension
Management also provides eligible and enrolled participants tracking, participant contribution
and investment allocation management, as well as a participant beneficiary management.

Siebel Retirement/Pension Management includes the Securities module that provides for the set
up and profiling of funding vehicles such as mutual funds for pension plans. The plan
administrators are provided with a picture of each mutual fund available for investment under
the terms of the plan, which includes literature about the fund, fund objectives, risk profile, and
asset mix.

Investment Banking. Siebel Investment Banking offers investment bankers and their
managers the tools to identify which customers need the most attention to push deals through
to closure. Siebel Investment Banking includes the following functionality:
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B Company Profiling. Company profiling provides investment bankers with an in-depth
picture of companies. This information includes their investment and financial profile,
competitors, and investors. Also, summary views provide quick snapshots of the key
information about the company.

m Investor Profiling. Siebel Investment Banking provides bankers with an understanding of
companies as investors with their holdings and transaction history, charts and profiles, and
the literature distributed to the company. Users can integrate Siebel Finance with external
news sources to display additional information about the investor.

B Research Distribution Management. Siebel Investment Banking provides a central
repository for company research publications, and allows bankers to fax or email research
documents to clients. Siebel Finance automatically tracks research distribution, which allows
sales and research professionals to better understand their clients' interests. The firm can
also use Siebel Finance to better understand the channels through which its research is being
distributed, and to manage entitlements.

B  Investment Management. Siebel Investment Management gives the account manager the
tools to determine how best to build and maintain customer relationships, and how best to
manage customer assets. Information is provided on customer financial accounts and holdings,
as well as recent activity within customer accounts. Siebel Investment Management includes the
following functionality:

m Company Profiling. Company profiling provides account managers with an in-depth picture
of companies. This information includes their investment and financial profile, competitors,
and investors. Also, summary views provide quick snapshots of the key information about
the company.

m Investor Profiling. Siebel Investment Management provides account managers with an
understanding of companies as investors with their holdings and transaction history, charts
and profiles of the investor company, and the literature distributed to the company. Users
can integrate Siebel Finance with external news sources to display additional information
about the investor.

®m Holdings & Interests Tracking. It also provides account managers with a tool for tracking
holdings for both corporate and individual clients and their interests. Siebel Finance accepts
feeds from third-party vendors of holdings data, and also allows individual account managers
to import spreadsheets sent to them from clients. Account managers can query holdings and
interests data to build their day's call list and then make the calls. Activity records are
automatically generated, thus reducing data entry for the salesperson, while still maintaining
accurate contact histories.

B Research Distribution Management. Siebel Investment Management provides a central
repository for company research publications and allows account managers to fax or email
research documents to clients. Siebel Finance automatically tracks research distribution,
which allows sales and research professionals to better understand their clients' interests.
The firm can also use Siebel Finance to better understand the channels through which its
research is being distributed and to manage entitlements.

Siebel Finance Guide Version 7.8 21



Overview of Siebel Finance & Siebel Finance Basic Functionality an

B Rollup. Siebel Rollup provides a comprehensive view of a client relationship in a single click,
thereby eliminating the process to collect this information.

Siebel Rollup offers four views of the relationship with a client—Activities, Opportunities,
Coverage Team, and Contacts. These views show the records for the selected client and for any
hierarchical children. For example, the Contacts Rollup view displays all contacts associated with
the selected company, all subsidiaries of the selected company, and the regional offices.

Executives, sales managers, or sales professionals are often looking for aggregate information
across a corporate enterprise, and the individuals who work there. For example, before the
Global Relationship Manager visits the CEO at his client company, he may want to view a report
of all the latest activities, and deals conducted with the client company or with any of the
subsidiaries, divisions and offices of the client company. This information arms the Global
Relationship Manager with a picture of the relationship between the client and his company, and
is an excellent preparation tool for his meeting.

NOTE: Optional modules from Siebel Business Applications can provide enhanced functionality to
support various business processes. For information about the optional modules, contact your Siebel
sales representative.

Siebel Finance Basic Functionality and
Modules

Siebel Finance Basic Functionality

Siebel Finance Basic (exclusively for customers upgrading from the Siebel Janna applications)
provides comparable functionality to Siebel Janna for Institutional Finance or Siebel Janna Contact
Enterprise, which includes the following functionality:

B Relationship management, provides a graphical, hierarchical representation of an entity’s
relationship with other entities for use by a range of users in financial services

B Specific querying, which allows product promotion to specific segments, accounts, and other
targeted opportunities

B Activity management, integrated with the Calendar, promotes streamlined call planning and call
reporting

B Enterprise-wide literature repository at your employees' fingertips, provides information sharing
across sales teams and locations

Siebel Finance Basic Modules
Two modules, Siebel Opportunity Manager and Siebel Household Management, are exclusively for
use with Siebel Finance Basic:

Bl Siebel Opportunity Manager. When used with Siebel Finance Basic, Siebel Opportunity
Manager helps financial sales professionals develop, manage, and drive their pending
opportunities or deals to closure. Siebel Opportunity Manager's opportunity and deal
management capabilities include lead generation, managing opportunities, and forecasting.
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B Siebel Household Management. When used with Siebel Finance Basic, Siebel Household
Management helps financial sales professionals manage consumer household information.
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This section includes the following topics:
|
|
|
|
|
|
|
|
|
|
|

This chapter lists the applications administration tasks that are specific to Siebel Finance. Use this
chapter in combination with Applications Administration Guide.

“Renaming Siebel Account Objects” on page 26

“Integrating Data with Host Applications” on page 26

“Using the Show Audit Trail Button” on page 26

“Configuring Lists of Values” on page 27

“Setting Up Type, Area, and Subarea Information” on page 27
“Establishing Applets as Read and Write or Read-Only” on page 27
“About Displaying Back End/Host System Fields” on page 27
“Configuring Summary Views” on page 28

“About Command Center” on page 29

“Command Center Configuration and Administration” on page 29

“Process of Configuring the Command Center Action Form” on page 30

Applications Administration Guide covers the setup tasks that are common to all Siebel Business
Applications, such as using license keys, defining employees, and defining your company’s structure.
It also provides the information you will need to implement, configure, and monitor the Siebel sales,
service, and marketing products and to perform data administration and document administration
tasks.

This guide assumes that you have already installed or completed the upgrade of Siebel Finance. If
you have not, go to the Installation/Upgrade section of the Siebel Bookshelf and click the links to the
guides that are relevant to your company’s implementation.

The Siebel database server installation creates a Siebel administrator account that can be used to
perform the tasks described in this guide. For more information about this process, see the
Installation Guide for your operating system.

CAUTION: Do not perform system administration functions on your local database using the Mobile
Web Client. Although there is nothing to prevent you from doing this, it can have serious results,
such as data conflicts, an overly large local database, or a large number of additional transactions
to route.
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Renaming Siebel Account Objects

In general, Siebel applications refer to companies as accounts. In the Financial Services industry, the
term account has typically been synonymous with financial accounts, so historically the word
company has been used in many places in Siebel Finance. By default, Siebel Finance installs using
the term accounts. Users can change this term and use another description, such as Companies,
Clients, or Customers. Users wishing to change this default need to rename all Siebel Account objects
prior to deployment. Make changes to the Ul layer (for example, applet titles and control labels),
rather than the Business Objects layer. For more information, see Upgrade Guide.

NOTE: All of the chapters in this guide are written assuming you have renamed Siebel Account
objects to Companies.

Integrating Data with Host Applications

Siebel Finance is not designed as a financial institution’s primary system of record for financial
account information. Typically, financial institutions operate mainframe systems, or sometimes
multiple systems, as their core operating systems. Financial account information from these systems
is made accessible in Siebel Finance, by loading it in batches using Enterprise Integration Manager,
or in real time using one of Siebel applications’ real-time integration technologies.

Using the Show Audit Trail Button

The Show Audit Trail toolbar button is not visible in the preconfigured Siebel Finance product. Using
Siebel Tools, you can activate the Show Audit Trail button to display the audit trail for the selected
record.

For more information on configuring the Audit Trail in Siebel Tools, see the Audit Trail chapter in
Applications Administration Guide.

To use the Show Audit Trail button
1 Navigate to the Administration - Audit Trail screen.

2 In the Audit Trail Buscomp list, create a new record and complete the necessary fields.
3 Click the Field tab, and create a new record for the field that you want to audit.
4

Repeat Step 3 until the Field list shows all the fields in the business component that you want to
audit.

5 Click the Show Audit Trail button on the toolbar to show the audit trail records.
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Configuring Lists of Values

In Siebel Finance, modify the List of Values (LOV) in accordance with the terminology used by your
financial institution. For example, the list of transaction types used in Siebel Finance should match
those used by your financial institution. For more information on configuring a LOV, see Applications
Administration Guide.

NOTE: This may impact certain forms and lists, which rely on the preconfigured values for correct
operation.

Setting Up Type, Area, and Subarea
Information

Many records in Siebel Finance are associated with a type of product, such as a bank account, mutual
fund, or security. Based on a record’s associated product type, a corresponding list of values may be
used along with the record, and in some instances, a subarea is assigned. As a result, you must set
up the account categories and account types so that they are associated with the proper products.

For more information about setting up financial product types, see Product Administration Guide. For
more information on setting up securities, see “Process of Administering Securities” on page 174.

Establishing Applets as Read and Write
or Read-Only

The preconfigured Siebel Finance functionality allows read and write data modification for many of
the Siebel Finance views. This may not be desirable in all cases; for example, your financial
institution may not want end users to modify account balances or create transaction records. Each
view should be carefully evaluated to determine the appropriate read and write configuration, and
the accessibility of each view to the various classes of employee users.

Where data is considered to be editable, it may be desirable to send these transactions to the host
system that is the system of record. If not, data may not be synchronized between the Siebel
database and the system of record.

About Displaying Back End/Host System
Fields

Make sure that fields returned by back end/host system are displayed within the Siebel application.
There may also be additional fields that are displayed only within the Siebel application, such as
calculated or otherwise denormalized fields, or data for which Siebel is the system of record. Also,
make sure the Siebel required fields match those captured by the financial institution. Where certain
required fields are not used, it may be necessary to provide a default value.
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Configuring Summary Views

In Siebel Finance, summary views have been restructured. In the past, multiple summary views
existed, typically one summary view for a particular type of user. For example, there were
preconfigured summary views specifically for salespeople and customer service agents. This has
been replaced by common summary views whose appearance can be configured by individual end
users.

Users can change the way a list appears in a summary view by using the controls in the top right
corner of each list. These controls, described in Table 2, allow users to manage what appears on the
summary view.

Table 2. Summary View Controls

Button Description

Hide Temporarily hides a list or form from view.

Collapse Collapses the list of records. If the list cannot be collapsed, the expand button
appears instead of the collapse button.

Expand Expands the list of records. If the list cannot be expanded, the collapse button
appears instead of the expand button.

Any changes made to a summary view layout are only visible to the current user and remain in effect
until that user changes them again or reverts to the default layout. If users hide a list, they must
click Edit Layout to restore it. For more information, see “Editing a Summary View Layout.”

Editing a Summary View Layout

Using the Edit Layout view, users can restore hidden lists, collapse or expand all lists, move lists or
forms up or down on the page, or revert to the default layout. The edit layout buttons, described in
Table 3, allow users to change the way a summary view appears and apply those changes to future
sessions.

Table 3. Edit Layout Buttons

Button Description

Collapse Collapses the list or form.

Expand Expands the list or form.

Move up Moves the list or form up on the home page.

Move down Moves the list or form down on the home page.
Show Displays the list or form on the home page.

Hide Hides the list or form from view on the home page.
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For more information on available summary views, see “Viewing a Contact Summary (End User)” on
page 85, “Viewing Company Summaries (End User)” on page 63, and “Viewing Household Summaries”
on page 70.

About Command Center

The command center allows you to launch a process, perform a task, or jump to a view. Command
center actions are preconfigured by your system administrator in accordance with your company’s
business process requirements. For example, if the financial services agents at your company often
need to jump to the financial accounts view for a contact, you could configure the command center
to perform this action, saving them time and keystrokes. See “Command Center Configuration and

Administration” on page 29 for information on how to configure the command center.

Out of the box, the command center is only available from the Summary views on the Contacts and
Companies screens.

Command Center Interface Types
There are two interface types for the command center:

B Action form
B Command line

Figure 1 shows the action form, a menu-driven interface guiding the end user through preconfigured
choices in order to launch an action. The command line requires the end user enter specific command
line syntax to launch the action.

I Contacts Houssholds

Contacts Home Contacts List Consumers List Perzonal Contacts List Chartz Manager's Explorer My Team'z Universe By Specialty

Edit Layout

Command Center

| Menu v | | Command Ling |

Driving Field: |E| Action: |E| Type: E‘ Sub Type:

Figure 1. Command Center Action Form

Command Center Configuration and
Administration

Command Center configuration and administration should only be done by expert users accustomed
to working with business services.
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Process of Configuring the Command
Center Action Form

To configure the appearance and function of the Command Center Action form you must:

1 Define the business object where the Command Center Action form appears and what business
component and fields are to be used. See “Defining the Command Center Business Object.”

2 Define actions available for the business object, indicating for each combination of possible
attribute values what action is taken (launch a business service or workflow, go to a view, and
so on). See “Defining the Command Center Actions.”

3 For actions defined as private, select the defined roles for which the actions will be available. See
“Selecting the Command Center Responsibilities.”

An example configuration is included at “Example of Configuring the Command Center Action Applet”
on page 34.

Defining the Command Center Business Object

The first step in configuring the Command Center Action form is to define the business object where
the Command Center form appears, and what business component and fields are to be used. Out of
the box, the Command Center forms appear on the Contact Summary and Company Summary views.

This task is part of “Process of Configuring the Command Center Action Form.”

To define the business object
1 Navigate to Site Map > Administration - Command Center screen > Defined Objects view.

2 Create a new object definition record and complete the fields as follows:

Field Parameters Description

Business Object Any Business Object for which  This identifies the screen where the
the forms have been defined. Command Center form is to appear.
For example, Contact or

Companies.
Source Business The business component The value of this field is constrained by the
Component against which the Driving Field value of Business Object field. In turn, itis a
will be compared. For constraint for the Driven Field.

example, FINCORP Account.

This should be a business
component available on the
view where the Command
Center applets are visible (for
example, Contact Summary
view).
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Source Business
Search
Specification

Parameters

A filter on the source business
component. For example, Acct.
Status = Open. Only Financial
accounts with a status of Open
will be available in the
Command Center.

cess of Configuring the Command Center Action

Form

Description

Use this field to enter an optional filter
criteria on the selected Business Component.

Driving Field

A field name from the Source
Business Component. The field
name can be ascertained using
Siebel Tools.

Following the examples in the
preceding field parameter

descriptions, this could be the
Financial Account name or ID.

The value of this field is constrained by
Source Business Component and Source
Business Search Specification (if entered).

The driving field is equivalent to Attribute 1.

Driving Field
Label

Free text field, 20 character
limit.

The text label exposed in the Ul for Driving

Field (Attribute 1). If blank, the label defaults
to the Driving Field on the Command Center
form.

Attribute 2,3,4
Label

Free text fields, 20 character
limit.

The text label for each of Attributes 2-4. If
left blank, the attribute will not appear on the
form.
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Field Parameters Description

Driving Field on Check box. If checked, it exposes the Driving Field label

Cmd Form on the Command Center form preceding the
Command field.

Expression Free text field. Use this field to constrain the available set of

actions based on what the user has selected
in the Driving Field. As each object definition
can have multiple action definitions, the

expression field is a way to limit the available
actions based on a business component field.

For example, if the user selects a checking
account, investment based actions may not
be appropriate.

For example: IIF([Account Number] LIKE
'1800*', Liability, Asset). That is, if the
account number starts with 1800, it maps to
action definitions in the Action Definition list
that have the Attribute 1 Map field set to
Liability. Otherwise, it is mapped to action
definitions that have the Attribute 1 Map field
set to Asset.

If there is no need to constrain the actions,
then any value will suffice (for example,
Contact - All).

Defining the Command Center Actions

After you define the business object, you define actions for each object. These actions indicate for
each object a combination of possible attribute values what action is taken (launch a business service
or workflow). The relationship is one-to-many.

This task is part of “Process of Configuring the Command Center Action Form” on page 30.

To define actions for the Command Center applet

1 Navigate to Administration - Command Center screen > Defined Objects view, and select the
Object Definition for which you wish to define actions.
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2 Scroll down to the Action Definition list, create actions and complete the fields as described in
the following table.

Field Parameters Description

Attribute 1 Check box. Indicates whether or not an entry in the

Required Driving Field (Attribute 1) is required for
the Command Center to return results.

Attribute 1 Map Free text. Works in concert with the Expression field
of the Object Definition to determine the
contents of the Command Center
dropdown menus.

Attribute 2-4 Free text. Value lists for Attributes 2-4.

Command

Free text. Each entry must be
unique, that is, you cannot use
the same command for different
actions.

The command line equivalent for the
action.

These commands are restricted to the
Business Object with which they are
associated.

See also “Creating Global Commands for
the Command Line Applet” on page 36.

Command Help
Text

Free text.

The Help text for the command help
feature when a question mark (?) is
entered using the command line.

This field is reserved for future use. You
can expose it in some manner, should you
choose, using a custom configuration.

Business Service

Free text.

EX: FINS Goto View Service

The name of the Business Service to be
run.

Business Service Free text. The parameters for the Business service.
Context
Business Service Free text. The method for the selected Business
Method service.
Public Flag Check box. If checked (true), then any roles selected
for the action do not apply.
If unchecked (false), then any roles
selected do apply and visibility to actions
will be limited by the selected roles.
Inactive Check box. This hides the defined action and

attribute combination.
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Selecting the Command Center Responsibilities

For each action, select the defined responsibilities for which the action will be available. The
relationship between actions and responsibilities is one-to-many.

This task is part of “Process of Configuring the Command Center Action Form” on page 30.

To select responsibilities for a Command Center action

1 Navigate to Administration - Command Center screen > Defined Objects view, and select the
Action for which you wish to define responsibilities.

2 Scroll down to the Responsibility list, create a new record, and select the desired responsibility.

The responsibilities information appears as read-only in the Responsibility list. Selected
responsibilities are only enforced if the Public Flag for the action is unchecked (false).

Example of Configuring the Command Center Action
Applet

This topic gives an example of configuring the Action applet. You may use this feature differently,
depending on your business model.

NOTE: This example uses a view available only in Siebel Healthcare. Although it is not visible to
Siebel Finance users, the example is still useful to all Siebel Financial Services users to illustrate how
to set up the Command Center.

The Command Center is available on the Siebel Healthcare Member Summary view and can be
configured to launch several key sales processes such as ordering a new ID card or changing a
primary care physician. For more information on using the Member Summary Command Center when
configured as in this example, see Siebel Healthcare Guide.

The Command Center is set up using the Administration - Command Center view.

To configure the action applet to run the business service FINS Goto View

1 Navigate to FINS Command Center Admin Object view and create a new object definition record.
Complete the fields as follows:

Field Value

Business Object Name FINS Members
Source Business Component FINS Members
Driving Field Last Name
Driving Field Label Name
Attribute 2 Label Area
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Attribute 3 label Action
Expression RedundantExpression
Driving Field On Cmd Form Checked

2 To set up a pop-up applet, in the Action Definition list create a new action record and complete
the fields as follows:

Field Value

Attribute 2 ID Card Requests

Attribute 3 Show History

Command IDCSH

Business Service SLM Save List Service

Business Service Context ‘Applet Mode', '6', '‘Applet Name’', 'FINS Service

Request Order ID Popup Applet’

NOTE: The applet in this example is only
available in Siebel Healthcare. Siebel Finance
customers would select a suitable view and applet
available in their respective applications.

Business Service Method LoadPopupApplet

Public Flag Checked

3 To set up a view navigation, in the Action Definition list create a new action record and complete
the fields as follows:

Field Value

Attribute 2 ID Card Requests

Attribute 3 Order New ID Card

Command IDCOR

Business Service FINS Goto View Service

Business Service Context 'ViewName', 'FINS Member Benefits View',

'‘Rowld’, '[Current Src Rec Id]’, 'AppletName’,
'FINS Member Form Applet - short'

NOTE: The view and applet in this example are
only available in Siebel Healthcare. Siebel Finance
customers would select a suitable view and applet
available in their respective applications.
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Field Value

Business Service Method GotoView

Public Flag Checked

Creating Global Commands for the Command Line
Applet

Some users may prefer to use only the Command form. In this case, the only configuration required
is to indicate the command line syntax and the associated business service and responsibility

information. Use these global commands through the Command line form on whatever business
object it appears.

To create global commands for the Command Line applet
1 Navigate to the Administration - Command Center screen > Global Commands view.

2 In the Global Commands list, create a command record, and complete the fields as described in
“To define actions for the Command Center applet” on page 32.

3  For each Command, record select responsibilities as described in “To select responsibilities for a
Command Center action” on page 34.
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This section includes the following topics:

About Managing Opportunities

An opportunity is a potential revenue-producing event related to one or more companies or
individuals. An opportunity often has a close date, a win probability, and a sales team. It is typically
related to contacts, products, decision issues, activities, and competitors.

“About Managing Opportunities” on page 37

“About Deal Management Capability” on page 37
“Scenario for Creating a New Opportunity” on page 38
“Process of Managing Opportunities” on page 40

“Adding Opportunities as an Administrator” on page 40
“Managing Opportunities and Team Members” on page 41
“Adding Opportunities in Siebel Finance” on page 42
“Creating Opportunities from Applications” on page 43

“Managing Deals in Siebel Finance” on page 44

In Siebel Finance, opportunities help an organization to nurture and manage the entire life cycle of
a revenue-generating opportunity, from creation to closing. Relationship managers and sales
representatives, who are responsible for managing and generating revenue, use opportunity
information on a regular basis. Top management also uses the opportunity analysis tools in Siebel
Finance to analyze pipeline performance and help manage overall business performance through
well-planned strategic-selling activities.

About Deal Management Capability

In addition, Siebel Finance includes deal management capabilities through extensions to the basic
opportunity management functionality. Using deal management, end users can manage and track
deal information throughout the deal life cycle. Specifically, users can track the following types of

information:
B Deal type
B Industry

M Product line

B Related activities
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Related attachments
External deal contacts
Closure information

Related products

Status information

Users can control access to deals and deal details by adding and deleting people to the deal team.
Users can further narrow deal visibility and any associated activities and attachments by enabling
the Secure flag. The combination of these restrictive visibility features provides basic security
functionality.

End users use the Opportunities screens to add an opportunity, create an opportunity from an
application, and review opportunity details. From a deal management perspective, end users can
create new deals, manage deal team members, secure deals, change the primary deal team member,
create deal activity plans, create new deal activities and associate team members, and add
attachments to deals.

This chapter describes opportunity functionality that is unique to Siebel Finance. For more
information on basic opportunity functionality, see Applications Administration Guide.

Scenario for Creating a New Opportunity

This scenario features sample opportunities tasks performed by a sales representative, an
investment banker, and their managers in the securities and banking industries. Your company may
follow a different workflow according to its business requirements.

Sales Representative Records a Loan Opportunity

The sales representative has a new lead. The company is already entered in Siebel Finance, and the
individual the representative is calling on is already a contact for that company.

The customer calls to let the sales representative know that she is interested in negotiating a loan.
She would like the sales representative to present a proposal. If that goes well, she will want to
discuss the terms of the deal.

First, the sales representative creates a new opportunity record. Then, he schedules the meeting,
records the associated activities on his to-do list, and enters the terms of the proposal.

As the sales process continues, the sales representative continues to gather information about the
company, its contacts, and the opportunity. At any time, he can review a summary of the profile,
sales team, contacts, and activities associated with this opportunity.

Every morning, the sales representative’s manager reviews the opportunities created the previous
day. The manager evaluates the new opportunities and determines if she should add more members
to each opportunity’s sales team to make sure it is covered sufficiently. In a few critical cases, she
decides to change the primary team member from the sales representative to herself.
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In this scenario, end users are sales representatives who manage opportunities in the field. They use
the Opportunities screen to:

B Create new opportunities for new and existing accounts
B Update existing opportunities

B View information about an opportunity

|

Perform actions related to an opportunity. These action include reviewing details about products,
projects, and competitors, creating activity plans, performing organization assessments and
analyses, entering campaign leads and call reports, accessing decision issues, or generating
proposals, quotes, and presentations

Investment Banker Creates I1PO Deal

An investment banker, who is responsible for helping companies raise funds in the form of equity or
debt, is starting work on an IPO deal for one of his companies. He creates the deal in the Opportunity
screen. As the deal creator, he is automatically added as the primary deal team member. He sets the
deal attributes, and secures the deal by checking the Secure flag. As the primary deal team member,
he has the ability to add and delete other deal team members as needed; he adds his manager and
a research associate to the deal team to make sure they have visibility to the deal and all its details.
Finally, the banker assigns a task, the pitch book creation, to the research associate.

Instead of starting from scratch, the research associate copies and modifies an IPO pitch book
document that she previously created for another deal. After the pitch document is completed, the
associate’s involvement in the deal is finished, so the investment banker takes her off the deal team
to restrict her visibility.

During the life cycle of the deal, the investment banker’s manager occasionally reviews the deal with
respect to the current pipeline, revenue numbers, and forecasts.

After the deal is won, the investment banker includes closing information, such as the reason the
deal was won, and a closure summary. He also unchecks the Secure flag so that other employees in
the company outside the deal team now have visibility to this completed deal.

In this scenario, the end users are an investment banker, his manager, and a research associate in
the banking industry. They enter information to:

Create a new deal

Secure the deal

Add or delete deal team members
Create deal activity plans

Create new deal activities and assign deal team members

Add attachments to a deal
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Process of Managing Opportunities

This section details sample tasks often performed by administrators and end-users when managing
opportunities. Your company may follow a different process according to its business requirements.

Administrator Procedures
The following list shows tasks administrators typically perform to manage opportunities:
B “Adding Opportunities as an Administrator” on page 40

B “Managing Opportunities and Team Members” on page 41

End-User Procedures

The following list shows tasks end users typically perform when managing opportunities:
B “Adding Opportunities in Siebel Finance” on page 42

B “Creating Opportunities from Applications” on page 43

B “Managing Deals in Siebel Finance” on page 44
|

“To change the primary deal team member” on page 44

Adding Opportunities as an
Administrator

Administrators can add, modify, and delete opportunities from the Opportunity Administration view,
as well as the Opportunities List view.

To add an opportunity from the Opportunities Administration screen
1 Navigate to the Opportunities screen > Opportunities Administration view.
2 In the Opportunities form, add a new record, and complete the necessary fields.

NOTE: Deleting an opportunity completely removes the opportunity, as well as every activity related
to the opportunity, from the system. If you are unsure whether the opportunity is still active (and
therefore should not be deleted), you can remove yourself from the opportunity team instead of
deleting the record.
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Managing Opportunities and Team
Members

You may want to modify the members of the sales team for an opportunity, or change the primary
team member designation. When the existing primary team member is a direct report, a manager
can change the designate using the Opportunity Sales Team view or the My Team’s Opportunities
view. If you are logged in as an administrator, you can change the primary team designate for any
opportunity in the Opportunity Administration view.

The primary designate of the opportunity can use any of the opportunity views to secure an
opportunity in order to restrict visibility to just the members of the sales team. When the Secure flag
is checked, the opportunity is hidden from other users. A secured opportunity can only be viewed by
members of the sales team from the All Opportunities or the My Opportunities view.

NOTE: The primary sales team member for an opportunity can add and delete sales team members,
and edit the Secure flag setting. Only managers or administrators can change the primary designate
of an opportunity. Use the MVG Set Primary Restricted user property to overwrite this behavior. For
more information, refer to Using Siebel Tools.

To add or delete members of the sales team for an opportunity
1 Navigate to Opportunities screen > Opportunities Administration view.

2 In the Opportunities list, drill down on the desired opportunity.

3 In the Sales Team field, click the select button and you can:

To... Select...

Add an employee to the sales team. The employee and click Add in the Team
Members dialog box.

Delete an employee from the sales team. Select the employee in the Selected Team
Members list and click Remove.

To change the primary sales team member for an opportunity
1 Navigate to Opportunities screen > Opportunities Administration view.

2 In the Opportunities list, drill down on the desired opportunity.

3 In the Sales Team field, click the select button, and click the check box in the Primary field to
select a new Primary designate.

To secure an opportunity

1 Navigate to Opportunities screen > Opportunities Administration view.

2 In the Opportunities list, select an opportunity that you want to secure (lock).

Siebel Finance Guide Version 7.8 41



Managing Opportunities B Adding Opportunities in Sieb

3 In the Opportunity form, click the Secure check box.

Only the primary member of the sales team or the Siebel administrator can set the Secure check
box. When an opportunity is marked Secure, only members of the sales team can view it in the
All Opportunities view. Sales team members can also see a secure opportunity in their My
Opportunities views.

Adding Opportunities in Siebel Finance

When end users identify a unique opportunity, they add a new opportunity record.

To add an opportunity
1 Navigate to the Opportunities screen > Opportunities List view.

2 Add a record, and complete the necessary fields.

Some fields are described in the following table.

Field Comments

Closure Summary Summary comments about the closing of an opportunity. Financial
institutions use this information when closing deals in order to track
the circumstances and success or failure of closing.

Commitments A read-only monetary value representing sum of commitments made
in a commercial loan opportunity. This value is entered on the
Opportunity Detail, Commercial Loans view. For more information,
see “Adding Opportunity Details” on page 43.

Deposits A read-only monetary value representing the sum of deposits made
in a commercial loan opportunity. This value is entered through the
Opportunity Detail, Commercial Loans view. For more information,
see “Adding Opportunity Details” on page 43.

Lead Quality Estimate of the quality of the deal.

Loans A read-only monetary value representing the total amount of loans
made in a commercial loan opportunity. This value is entered through
the Opportunity Detail, Commercial Loans view. For more
information, see “Adding Opportunity Details” on page 43.

Probability % The estimate of the likelihood that the opportunity will result in
business, expressed as a percentage:

B 0% means it is doubtful that business will result

B 100% means it is certain that business will result

Product Line Select the product line associated with the opportunity.
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Field Comments

Revenue Enter the amount of money you expect this opportunity to generate.
When combined with the probability you assign to the opportunity,
the Expected Value field is calculated.

Sales Cycle Select the current cycle of the opportunity. The total number of
opportunities in a specific cycle stage, and the length of time that a
particular opportunity has been in that cycle, are important data for
evaluating that opportunity.

Secure Click on this check box to restrict the visibility of an opportunity in
the All Opportunities view to the members of the sales team. Only
the primary member of the sales team or the Siebel administrator
can set the Secure field. Leave this field unchecked, to make the
opportunity visible to every end user in the All Opportunities view.

Start Date Start date for the opportunity.

Adding Opportunity Details

End users can add details specific to commercial lending, equity, fixed income, advisory, and lending
syndicate opportunities in the Opportunities Details view tab.

To add specific opportunity details
1 Navigate to the Opportunities screen > Opportunities List view.

2 In the Opportunities list, drill down on the desired opportunity, and click the Opportunity Detail
view tab.

3 Select one of the following links:
m  Advisory
m  Commercial Loan
m  Equity
m  Fixed Income
® Lending Syndicate

4 In the appropriate lists, add a record and complete the necessary fields.

Creating Opportunities from
Applications

End users can also create opportunities when they create a financial application.
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To create an opportunity from an application
1 Navigate to the Applications screen > Application List view.

2 In the Applications list, add a record, and complete the necessary fields.

The new application is saved and an opportunity is created.

Managing Deals in Siebel Finance

Perform the deal management end user tasks detailed in this section from any of the Opportunities
views. In Siebel Finance, user’s responsibilities can limit the availability of certain views and
functionality. As a result, the views that appear may vary from those documented here.

The primary deal team member, and occasionally the primary’s manager, act as the deal
administrator. End users add a new deal by creating a new opportunity in the Opportunities screen.
For more information, see “To add an opportunity” on page 42.

NOTE: Deals can also be added from the Opportunities Administration view.

The deal primary members and their managers can restrict other deal team and non-deal team
members’ visibility to a deal by securing it. Securing a deal also secures the deal activities associated
with the deal. Give end users visibility to the deals and activities by adding them to both the deal
team and the activities team.

For information on adding and deleting deal team members, see “To add or delete members of the
sales team for an opportunity” on page 41.

To secure a deal

1 Navigate to the Opportunities screen > Opportunities Administration view.
2 In the Opportunities list, drill down on the desired deal.
3 In the opportunity form, select the Secure field to indicate that the deal is secure.

NOTE: Administrators can secure deals from the Opportunities Administration view.

To change the primary deal team member
1 Navigate to the Opportunities screen > Opportunities Administration view.

2 In the Opportunities list, drill down on the desired opportunity.
3 In the Sales Team field, click the select button.
4 In the Sales Team list, select the Primary field of the contact.

NOTE: Only the primary’s manager in the My Team’s Opportunities view or the Opportunities
Administration view can change the primary deal team member. Use the BC user property - MVG Set
Primary Restricted: visibility_mvlink_name to overwrite this. See Siebel Developer’s Reference for
additional details.

44 Siebel Finance Guide Version 7.8




Opportunities W Managing Deals in Siebel Finance

To create a new activity plan for a deal
1 Navigate to the Opportunities screen > Opportunities List view.

2 In the Opportunities list, drill down on the desired opportunity, and click the Assessments view.
tab.

3 In the Assessments list, add a record, and complete the necessary fields.

In the Template Name field, select an activity plan template.

To create a new activity and assign a deal team member
Navigate to the Opportunities screen > Opportunities List view.

In the Opportunities list, drill down on the desired opportunity, and click the Activities view tab.

In the Activities list, add a record, and complete the necessary fields.

A W N P

In the Employees field, select the employee to assign to the activity.

To create a new attachment for a deal
1 Navigate to the Opportunities screen > Opportunities List view.

In the Opportunities list, drill down on the desired opportunity, and click the Attachments view
tab.

3 In the Attachments list, add a record by clicking either New File or New URL.
4 In the resulting dialog box, do one of the following:

B Select the file to add as an attachment.

m  Type a URL to the file to add as an attachment.

The remaining fields are automatically updated using the selected file’s properties.
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This section includes the following topics:

“About Managing Companies and Accounts” on page 48

“About Company Hierarchies” on page 48

“Scenario for Managing Company Information” on page 49

“Process of Managing Companies” on page 50

“Setting Up Values for Companies” on page 51

“Deleting Company Information” on page 52

“Managing Competitor Information” on page 52

“Verifying Coverage Team Members” on page 53

“Managing the Custom-Defined Relationship Types LOV” on page 54
“Generating Company Hierarchies for Data Aggregation” on page 55
“Adding Companies and Investors (End User)” on page 58
“Updating Company Profiles (End User)” on page 58

“Viewing Company Hierarchies in Roll-Up Views (End User)” on page 59
“Creating Company Assessments (End User)” on page 61

“Adding Company Applications (End User)” on page 61

“Adding Company Service Requests (End User)” on page 62
“Managing Company Coverage Teams (End User)” on page 62
“Viewing Company Summaries (End User)” on page 63

“Viewing Company Relationship Hierarchies (End User)” on page 63

“Displaying Lists of Investor Transactions or Holdings (End User)” on page 65
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About Managing Companies and
Accounts

Within Siebel Finance, the term companies refers to entities that are typically referred to as accounts
in other Siebel applications. A company represents the relationship between your organization and
companies or organizational entities (or structures) with which you do business. Use the Companies
screen and its associated views to view company information and interactions.

CAUTION: This chapter assumes you have renamed Siebel Account objects to Companies. By
default, Siebel Finance installs using the term Accounts. For more information on renaming Siebel
Account objects, see Upgrade Guide.

In Siebel Finance, the term investors refers to financial organizations such as mutual fund or money
management institutions; investors are not contacts, rather they are companies that are identified
as investors. In Siebel Financial Services, the investors functionality has migrated to the Companies
screen. This chapter covers both regular company and investor procedures.

Use the procedures in this chapter to perform the administrator tasks of adding industries and
territories, controlling company information, generating company hierarchies, managing competitor
information, verifying coverage team members, and managing custom-defined relationship types.

End users use the Companies views to add new companies and investors, create company
assessments, associate service requests with a company, update the coverage team, define
relationships to other companies, contacts, and households, and view company summary
information. In addition, end users can retrieve information about investors, including investors’
preferences, holdings, and transactions.

You can save time and reduce keystrokes by using a workflow to automate steps that are repeatedly
performed by end users. For more information, see Siebel Business Process Designer Administration
Guide.

About Company Hierarchies

A company hierarchy is a group of companies that are organized by parent-child relationships. Siebel
Industry Applications support displaying these company relationships in a hierarchical tree.

The hierarchical tree is a visual representation of company hierarchy data that allows end users to
view the relationships between companies. By viewing a company roll-up, users can see aggregated
company information, including contacts, coverage teams, activities, and opportunities.

When end users have access to a company, they can review the hierarchical structure for that
company, its child divisions, and the contacts that work there. Company hierarchies are displayed in
five subviews of the Companies screen—Relationship Hierarchy view, Activity Roll-up, Contact Roll-
up, Opportunity Roll-up, and Coverage Team Roll-up.

Depending on your configuration, a company that does not have a parent-child relationship with
another company may not appear in the roll-up views.

For more information on company hierarchies, see “Generating Company Hierarchies for Data
Aggregation” on page 55 and “Viewing Company Hierarchies in Roll-Up Views (End User)” on page 59.
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Scenario for Managing Company
Information

This scenario features sample tasks performed by a sales representative, investment banker, and
research analyst in the securities or banking industries. Your company may follow a different
workflow according to its business requirements.

In this scenario, end users are the sales representatives who manage company information. They
enter information to:

B Add new companies to the database and create company assessments

Associate applications and service requests with a company

B Manage company coverage teams
B View company summary information
B View relationships in a graphical manner

Sales Representative Tracks Company Information

A sales representative uses the Companies screen to capture and manage profile information about
her business customer, such as contacts, organizational structure, management, and financial
information. In addition to viewing market statistics and D&B reports. Using Siebel Finance, she can
capture and track information about a company’s:

B Relationship with her organization, such as the coverage team, contract terms, sales and service
information

B Preferred delivery channels, at both summary and detailed levels
She can also view details of competitors and create and access marketing and sales presentations.

The sales representative can create a new company record or view and modify information about
existing companies. For example, if the sales representative is preparing for a sales call, she can use
the Companies screen to answer the following questions:

B  What business is this company in?

Who are the executives | should be calling on?

B What is this company’s financial profile?
B What financial accounts and products does the company already own?
B What types of service issues has the company had?
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Investment Banker and Research Analyst Analyze Research Literature
to Send to Client

An investment banker for a sell-side institutional firm is reviewing one of her accounts to decide what
research literature she should send to her client. The client’s profile suggests a conservative stance
and includes significant cash on hand. The investment banker decides to send some literature about
various secured fixed-income instruments. The banker creates a service request for the literature
distribution and assigns it to a research analyst at her firm.

The research analyst receives a service request to send literature to a client. The analyst determines
the literature to send to the client. He then creates a new email, attaches the required literature,
and sends it to the client.

In this scenario, users are bankers and research analysts. They enter information in Siebel Finance
to:

Add new investors
Display an investor organizational chart
Add investor holdings

Add coverage team members and track coverage roles

Display a list of transactions or holdings by investor

Process of Managing Companies

This section details sample tasks often performed by administrators and end-users when managing
companies. Your company may follow a different process according to its business requirements.

Administrator Procedures

The following list shows tasks administrators typically perform to manage companies:
“Setting Up Values for Companies” on page 51

“Deleting Company Information” on page 52

“Managing Competitor Information” on page 52

“Verifying Coverage Team Members” on page 53

“Managing the Custom-Defined Relationship Types LOV” on page 54

“Generating Company Hierarchies for Data Aggregation” on page 55

End-User Procedures
The following list shows tasks end users typically perform when managing companies:

B  “Adding Companies and Investors (End User)” on page 58
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“Updating Company Profiles (End User)” on page 58

“Viewing Company Hierarchies in Roll-Up Views (End User)” on page 59
“Creating Company Assessments (End User)” on page 61

“Adding Company Applications (End User)” on page 61

“Adding Company Service Requests (End User)” on page 62

“Managing Company Coverage Teams (End User)” on page 62

“Viewing Company Summaries (End User)” on page 63

“Viewing Company Relationship Hierarchies (End User)” on page 63

Setting Up Values for Companies

Administrators can create new industries and territories so that the appropriate selections are
available to end users when they add companies.

“Displaying Lists of Investor Transactions or Holdings (End User)” on page 65

When a company is added to Siebel Finance, the end user adding the company is responsible for
indicating the industry to which the company belongs. Administrators are responsible for creating
the industries that appear to end users.

To add an industry
1 Navigate to the Administration - Data screen > Industries view.

2 In the Industries list, add a record, and complete the necessary fields.

Some fields are described in the following table.

Field Description

Language Code Primary language of the classification used.

SIC Code Standard Industry Classification code as defined by the U.S.
Department of Commerce.

Type The classification used to describe the industry.

Companies are often associated with a territory. Administrators can create the territories that appear
in the Territory field when end users add a company to Siebel Finance.

To add a territory
1 Navigate to the Administration - Assignment screen > Territories view.

2 In the Territory List list, add a record, and complete the necessary fields.
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Deleting Company Information

Deleting a company completely removes the company, as well as all activities related to the
company, from the system. Only delete a company record if you are certain that the company is no
longer active. If end users are unsure whether or not a company is still active (and therefore should
not be deleted), they have the option of removing themselves from the company team instead of
deleting the record.

As the Siebel administrator, you can make a company unavailable to all other users. First, you can
assign yourself as the primary team member. Second, you remove all other employees from the
company’s team.

To make a company unavailable to all other users
1 Navigate to the Companies screen > Companies Administration view.

2 In the Company list, drill down on the Name link.
3 In the Company Team dialog box, locate the administrator, and click in the Primary field.
4 In the Company Team dialog box, delete all other coverage team members and click OK.

Only those users with access to the All Companies and All Companies Across Organizations views
will be able to see this company.

Managing Competitor Information

Effective sales and marketing requires that your employees have up-to-date and consistent
information about the competition and their products. This section describes how to administer
information about competitors and competitive products within the Companies screen.

To indicate that a company is a competitor
1 Navigate to the Companies screen > Companies Administration view.

2 In the Company list, add or select a company.
3  In the Company form, click the show more button.
4 Select the Competitor check box to add the company to the Competitor’s list.

The company appears in the Competitor’s list. The Competitor’s list is available in the
Competitors screen and related screens, such as Opportunities.

NOTE: Non-administrators can specify that a company is a competitor by selecting Competitor from
the Type drop-down list. However, selecting Competitor from the Type drop-down list does not add
the company to the Competitor’s list as seen on the Competitor’s screen, or in the Pick Competitors
dialog box, which is accessible on related screens, such as Opportunities.

When a company has been indicated as a competitor, you may want to add document files of
comparative and competitive literature. For more information, see the chapter on literature
administration in Applications Administration Guide.
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Removing Records from the Competitors List

You cannot delete records that have been added to the Competitors list, since deleting them would
also remove them from related screens, like Opportunities. For example, a company may have been
a competitor for an opportunity last month. Even if the company is no longer a competitor, the
competitor record should remain as part of the history of the opportunity.

If you no longer want a record to appear in the Competitor’s list, deselect the Competitor check box.
This removes the record from the Competitors screen without affecting other screens.

Verifying Coverage Team Members

If you are logged on as a Siebel administrator, you can search for companies that do not have any
coverage team members.

Managers can add or delete the members of a company’s coverage team if they are the existing
primary team member, or the primary team member is one of their direct reports. If you are logged
in as an administrator, you can change the primary team designate for any company in the Company
Administration view. (Navigate to the Companies screen > Companies Administration view.)

NOTE: In Siebel Financial Services, the terms sales team and account team are equivalent to
coverage team.

The procedures that follow involve making selections in the Account Team field. If the Account Team
field does not appear in your installation, you may need to reveal it using the Columns Displayed
dialog box.

NOTE: Usually, Assignment Manager resolves problems with coverage teams and owner assignment

automatically. For more information on Assignment Manager, see Siebel Assignment Manager
Administration Guide.

To search for a company without any coverage team members
1 Navigate to the Companies screen > Companies Administration view.

2 In the Companies list, define a new query where the Name field is:
count(
)=0

3 Execute the query.

The query returns a list of all companies that do not have any coverage team members.

To add or delete members of the coverage team for a company
1 Navigate to the Companies screen > Companies Administration view.

In the Companies list, select a company, and click the More Info view tab.

3 In the Account Team field, select an employee in the Coverage Team dialog box, and click Add or
Remove.
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To change the primary coverage team member for a company
1 Navigate to the Companies screen > Companies Administration view.

2 In the Companies list, select a company, and click the More Info view tab.

3 In the Account Team field, select the Primary field for the new primary coverage team member.

Managing the Custom-Defined
Relationship Types LOV

If you are logged in as the Siebel administrator, you can create and maintain a list of predefined
custom-defined relationship types. A default list of values is provided with the application. These
relationship types appear in the drop-down LOV for the Type field found on the Relationship Hierarchy
views, in the Party Relationship applet.

To add a custom-defined relationship type
1 Navigate to the Administration - Data screen > List of Values view.

2 In the List of Values list, create a New Query where Type equals PARTY_RELATIONSHIP_TYPE.

At least six records will be returned, showing the existing list of values for custom-defined
relationship type.
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3 In the List of Values list, add a record, and complete the necessary fields.

Some fields are described in the following table.

Field Comments

Active Determines whether the value is displayed to the end user in the
Relationship drop-down list.

Display Value Value as displayed in the Relationship drop-down list.

Language Independent Code used internally by the Siebel application.

Code

Language Name Language used for the list of values Display Value field.

Order Numerical order in which a value is displayed within the Relationship
drop-down list.

Parent LIC Language-independent code of a parent list of values. It is used in
hierarchical list of values.

Translate When checked, indicates that the list of values is part of a multilingual
list of values (MLOV).

Type The type of list of values. For this procedure, select

PARTY_RELATIONSHIP_TYPE.

NOTE: You cannot delete LOV table entries. Use the Active check box to deactivate an LOV entry and
thereby remove it from the Relationship drop-down list.

Generating Company Hierarchies for
Data Aggregation

Data aggregation is available by using the Roll-up views, providing the administrator defined one or
more hierarchies. The application administrator typically defines a default hierarchy by associating
accounts with one another using the parent field on a company form, or the subaccount view for child
accounts. Administrators can define Company hierarchies to display aggregated data—the activities,
opportunities, contacts, and coverage teams—across organizational structures. For example, the top
node of the hierarchy contains activities for the organization, the subsidiaries below the organization,
the departments at the subsidiaries, and contacts working at any level of the tree. As the end users
move up and down the tree, they see more or less data rolled up to the selected level.

By default, only companies that are part of a relationship hierarchy can display roll-up data. You can
modify the application to display roll-up data for companies which are not part of a hierarchy.

To configure display of roll-up data for companies not in a hierarchy
B Using Siebel Tools, set the DynHierachry user property of the Dynamic Hierarchy Direct
Relationship business component to LoadAllAccounts

For more information on setting user properties, see Configuring Siebel Business Applications.
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Siebel Global Accounts is the module that provides this aggregation functionality. For more on global
accounts, see Applications Administration Guide.

The application administrator can define two types of hierarchies for data aggregation:
B Default hierarchy for all end users, see Default Company Hierarchies on page 56

B Specific hierarchies that are used only by certain end users, see Dynamic Company Hierarchies on
page 57

Default Company Hierarchies

The application administrator sets up a default company hierarchy one time, during the initial
application setup. The default hierarchy is available to all end users who are not tied to a specific
hierarchy, and who have been granted view access to the companies represented in the hierarchy.
It is the administrator’s responsibility to give end users access to Company views. For more
information, see Applications Administration Guide.

When new companies are added, they are automatically added to the default hierarchy tree. The
contacts, coverage teams, activities, and opportunities that are associated with the company are
automatically displayed in the roll-up views.

In the preconfigured application, using the Generate Hierarchy button adds only parent account and
child companies to the hierarchy. Any company that does not have a child or parent is not displayed
in the roll-up views. Use Siebel Tools to change the DynHierarchy LoadAllAccounts user property to
alter this behavior.

You can set the DynHierarchy LoadAllAccounts user property on the Dynamic Hierarchy Direct
Relationship business component to N or Y. When it is set to N, only parent and children appear in
the a generated hierarchy. When DynHierarchy LoadAllAccounts user property is set to Y, all
companies are added to the generated hierarchy. For more information on setting user properties,
see Siebel Developer’s Reference.

To generate a default company hierarchy
1 Navigate to the Companies screen > Global Companies Administration view.

2 In the Company Hierarchies list, click Generate Hierarchy.

The parent-child account relationships that have been defined in your application are registered
for participation in the roll-up views. This process may take some time, depending on the
quantity of account records that are in your existing environment.

When the company hierarchy has been generated, a new record appears in the Company
Hierarchies list. The Hierarchy Name field of the record contains the user ID of the administrator
who generated the hierarchy and the time it was generated. If it is the only hierarchy record, the
Default field is automatically checked. The companies that have been added for participation in
the roll-up views appear in the Company Relationships list.

NOTE: If no accounts are visible in the Company Relationships list, click the query button, step
off the query, and click Go to refresh the view.
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(Optional) Rename the company hierarchy and, if necessary, check the Default field.
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NOTE: If end users are using the application when you generate a hierarchy, they must log off

and log on again to see the default hierarchy in the roll-up views.

Dynamic Company Hierarchies

In some cases, users work with particular companies within a large corporation, but not with others.
In these instances, some end users do not need to or should not see aggregated data across the
entire corporation. An administrator can define a custom hierarchical structure across which data can
be aggregated. This defined structure, called a dynamic hierarchy, can be as simple or complex as
needed and offers users the ability to aggregate data across the companies they are interested in
seeing.

To create a dynamic company hierarchy of selected companies

1
2
3

Navigate to the Companies screen > Global Companies Administration view.

In the Company Hierarchy list, and create a new record.

Scroll down to the Company Relationships list, create a new record, and select company.
All the accounts in the Company Relationship list belong to the new account hierarchy.
To define parent and child relationships:

a  Select an company in the Company Relationship list that has no parent.

b In the Parent field, select a parent.

NOTE: Only companies entered in the Company Relationships list (Step 3) are available for
selection in the parent field.

Repeat Step 4 for all companies that have no parents.

To associate the dynamic hierarchy with an organization

1
2
3

Navigate to the Administration - Group screen > Organizations view.
Select the organization in the Organizations list.

In the organization form, select the desired hierarcy in the Account Hierarchy field.

End users can only see the hierarchy with which their current position’s primary organization is tied.
It is the administrator’s responsibility to associate end users with positions, positions with
organizations, and organizations with hierarchies. For more information, see Applications
Administration Guide.
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Adding Companies and Investors (End
User)

When end users identify a possible lead, the lead can be added as a company. Users can then begin
to add and track information about the company.

To add a company or investor
1 Navigate to the Companies screen > Companies List view.

2 In the Companies form, click the show more button, add a record, and complete the necessary
fields.

3 To specify a privacy level, in the Privacy Option field select one of the following:
B Opt-In. Sharing of non-public personal information is allowed without restrictions.

B Opt-Out - Affiliates. Sharing of non-public personal information with affiliates is not
allowed.

B Opt-Out - Third Party. Sharing of non-public personal information with third parties is not
allowed.

B Opt-Out - All Parties. Sharing of non-public personal information with any affiliate or third
party is not allowed.

United States law requires that financial institutions disclose their privacy policies regarding the
sharing of non-public personal information with third parties, and fair credit reporting, that
impacts the sharing of non-public personal information with affiliates. End users can specify a
privacy level by making a selection from the Privacy Option field.

The Privacy Option field is for registering the privacy level requested by the company; it does not
impact record visibility in any way.

4 To identify the company as an investor, check the Investor box in the Company form.

Updating Company Profiles (End User)

A company’s profile information should always be kept up to date. The information in a company’s
profile is used throughout Siebel Finance to make decisions about and manage company records. For
example, in the Commercial Loans screen, a company’s profile information automatically appears in
the Borrower Detail view.

To update a company profile
1 Navigate to the Companies screen > Companies List view.

2 In the Companies list, drill down on the desired company.
3 Click the Client Profile view tab.
4

In the Client Profile form, select the link to one of the following profile areas to update:
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Business

Financial
Investors
Management

Market Statistics

Transactions

5 In the Profile form, update the information as needed.

Viewing Company Hierarchies in Roll-Up
Views (End User)

End users can review the company and its parent organization, subsidiaries, contacts, opportunities
and relationships to other entities using the graphical relationship hierarchy tree control. This control
is available in the roll-up views. By drilling down on hypertext links on the hierarchy tree, end users
can navigate to related views.

NOTE: If the company has not been added to a hierarchy tied to the user's position's organization
(either default hierarchy or dynamic hierarchy), the hierarchy tree is not visible to the end user. The
following message appears: “The selected record is not included as part of your defined hierarchy.
If you feel this is in error, please contact your system administrator.” The administrator is responsible
for associating positions with organizations and an organization with a hierarchy.

The Activities-Roll-up view shows all of the activities associated with the selected company and its
children. End users can apply filters to the list to find specific activity records and save the filtered
list.

NOTE: If a company is not associated with any other organizations through the relationship
hierarchy, then the roll-up views will not contain any data. A company must have a parent
organization, or have children organizations, in order to display roll-up data.

To view aggregated activities for a company
1 Navigate to the Companies screen> Companies List view.

2 Drill down on the desired company, and click the Activities-Roll-up view tab.

The associated hierarchy appears on the right side of the screen. All activities associated with
the company and all of its children appear in the Activities-Roll-up list.

In the Activities-Roll-up List, you can:
m  Drill down on an activity type to navigate to the Activities screen > Attachments view.
m  Drill down on a company name to navigate to the Companies screen > Contacts view.

NOTE: If you create an activity in the Activities screen and do not set the Company field, the
activity will not appear in the Activities-Roll-up list.
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To view the aggregated coverage team for a company
1 Navigate to the Companies screen > Companies List view.

2 Drill down on a company, and click the Coverage Team-Roll-up view tab.

The associated hierarchy appears on the right side of the screen. All coverage team members
associated with the company and all of its subsidiaries appear in the Coverage Team-Roll-up list.

In the Coverage Team-Roll-up list, you can:
m  Drill down on a last name to navigate to the Employees screen.

m  Drill down on an email address to open a blank email message addressed to the team
member who has that address.

To view aggregated opportunities for a company
1 Navigate to the Companies screen > Companies List view.

2 Drill down on an company, and click the Opportunities-Roll-up view tab.

The associated hierarchy appears on the right side of the screen. All opportunities associated with
the company and all of its children appear in the Opportunities-Roll-up list.

In the Opportunities-Roll-up list, you can:
m  Drill down on an opportunity name to navigate to the Opportunities screen.

m  Drill down on a company name to navigate to the Companies screen > Contacts view.

To view an aggregated list of contacts for a company
1 Navigate to the Companies screen > Companies List view.

2 Drill down on a company, and click the Contact-Roll-up view tab.

The associated hierarchy appears on the right side of the screen. All contacts associated with the
company and all of its children appear in the Contacts-Roll-up list.

In the Contacts-Roll-up list, you can:
m  Drill down on a last name to navigate to the Contacts screen.
m  Drill down on a company to navigate to the Companies screen > Contacts view.

m  Drill down on an email address to open a blank email message addressed to the contact who
has that address.
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Creating Company Assessments (End
User)

An assessment is a set of attributes used to assess the business potential or credit worthiness of a
company. Company assessments can be used to compare companies to each other or against a
model, or to learn about companies and sales situations. End users complete the company
assessment by selecting the appropriate values for the different attributes.

To perform a company assessment

1
2
3
a4

5

Navigate to the Companies screen > Companies List view.

In the Companies list, drill down on the company for which the assessment is being performed.
Click the Assessments view tab, and create a new record.

In the Template Name field, select the appropriate template.

Attribute records are automatically generated in the Assessment Attributes list.

In the Assessment Attributes list, make a selection in the Value field for each attribute.

NOTE: Administrators must create the assessment templates. See Applications Administration Guide
for more information on how to create assessment templates.

Adding Company Applications (End
User)

Applications are used for companies that want to apply for offered services or products. For example,
a small business wants to apply for a business checking account. The end user handling the inquiry
finds the company in the All Companies view, navigates to the Applications view, and creates an
application record for this business checking account application.

To associate an application with a company

1
2
3

Navigate to the Companies screen > Companies List view.
In the Companies list, drill down on the company to associate with an application.

Click the Applications view tab, create a new record, and complete the necessary fields.

NOTE: Drill down on the Application Name link to enter more detailed application information.
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Adding Company Service Requests (End
User)

A service request is a request from a company for information or assistance with a problem related
to purchased products or services. When a customer calls about an existing service request, end
users can find the service request and give status information to the caller in several ways. They can:

Review the service request information
Create an activity to record the customer’s call
Update the service request with additional information from the customer

Resolve the service request

Assign the service request
B Transfer the caller to another service representative

If a call requires that an end user create a new service request, she can create one. Siebel Finance
automatically assigns a unique service request (SR) number to track the new service request
throughout the system.

To add a service request associated with a company
1 Navigate to the Companies screen > Companies List view.

2 From the Show drop-down list, select All Companies.
3 In the Companies list, drill down on the desired company.
4 Click the Service Requests view tab, create a new record, and complete the necessary fields.

The application automatically assigns a service request number (SR#).

Managing Company Coverage Teams
(End User)

A coverage team is the group of employees that are assigned to manage the relationship with a given
company. The coverage team for a company is defined as all users who have access to the company
in the My Companies view.

NOTE: Similar coverage team functionality is also available for contacts. You can use the Contact
Coverage Team view (Navigate to the Contacts screen > Coverage Team view) to manage the contact
coverage team.

End users can use the company coverage team functionality available in Siebel Finance to:
B Record and display employees covering a company within a single company record

B Specify and review the nature of the employee’'s relationship with each covered company, defined
as the Coverage Role and Attributes list
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To add a member to a coverage team
1 Navigate to the Companies screen > Companies List view.

2 In the Companies list, drill down on the desired company.
3 Click the Coverage Team view tab, create a new record, and select an employee.
4 If known, select the employee’s coverage role using the drop-down list in the Coverage Role field.

NOTE: The Siebel administrator maintains the Coverage Role LOV in the List of Values screen
under the Type field value type FINS_COVERAGE_ROLE_TYPE. Navigate to the Administration -
Data screen > List of Values view, to access the List of Values screen.

5 If desired, scroll down to the Categories and Securities view tabs and select values defining the
coverage relationship between the employee and the company; you can select one or more
attributes.

The application adds the employee to the coverage team with a defined relationship. The
company will appear in the employee’s My Companies view.

End users can create coverage team activities. For more information, see “Viewing Company Coverage
Team Activities” on page 104.

Viewing Company Summaries (End
User)

The Company Summary view provides a comprehensive view of a company in an editable format.
This view displays basic company information, financial accounts, call reports, logged alerts, and
contacts associated with a company.

To view company summary information
1 Navigate to the Companies screen > Companies List view.

2 In the Companies list, drill down on the desired company.
3 Click the Summary view tab.

For more information on editing summary view information, see “Configuring Summary Views” on
page 28.

Viewing Company Relationship
Hierarchies (End User)

End users use the Relationship Hierarchy view to identify and capture key relationships for a
company. This view features a graphical tree that provides a visual representation of a company’s
relationships. The tree shows the natural hierarchy of a company’s parent-child relationships to
entities such as companies, subsidiaries, divisions, contacts, and coverage relationships with
employees, as well as custom-defined relationships.
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Custom-defined relationships are ad-hoc associations between the company and any contact,
organization, household, or employee. End users can record custom-defined relationships between
any two entities in the adjacent Party Relationships list.

NOTE: The Relationship Hierarchy view is also available on the Contacts, Employee (read only) and
Households screens. For more information, see “Viewing Contact Relationship Hierarchies (End User)”
on page 86 and “Using the Household Relationship Hierarchy” on page 70.

To establish a natural parent-subsidiary relationship between two companies
1 Navigate to the Companies screen > Companies List view.

In the Companies list, drill down on the company to be established as the subsidiary.
Click the More Info view tab.

In the Parent field, select the parent company.

a » W N

Repeat Step 2 through Step 4 to set up companies, subsidiaries, branches, and departments as
needed for your deployment.

o

Click the Relationship Hierarchy view tab.

The new parent-subsidiary relationship is shown in the Relationship Hierarchy explorer in the
lower-left corner of the screen.

To create a custom-defined relationship
1 Navigate to the Companies screen > Companies List view.

In the Companies list, drill down on the company for which you want to create a custom-defined
relationship.

3 Click the Relationship Hierarchy view tab.
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4 In the Party Relationship list, add a record, and complete the necessary fields.

Some fields are described in the following table.

Field Comments

Relationship Categorizes the relationship between the company and another entity.
Field has an LOV for custom-defined Relationship values. Predefined
values include Reports To, Spouse, Child, Lawyer, Board Member, Primary
Contact (Backup), Admin Assistant, Competitor, Referral, Service
Provider, Investor, Wealth Management Rep, Related Subsidiary, Bank
Attorney, Trustee Attorney, and Debtor Attorney.

This LOV can be modified by the Siebel administrator. For more
information, see “Managing the Custom-Defined Relationship Types LOV” on

page 54.
Start Date If the custom-defined relationship falls:
End Date I Between the Start and End Dates, it appears in the tree.

I Outside the range, it does not appear to the user. The user can enter
a start or end date, or both.

Type Use this field to determine the type of entity with which you wish to
establish a relationship. Defaults to Contact. Other values include
Household, Organization, and Employee.

Value The value in this field is based on the Type field. For example, if Type
equals Contact, then clicking the select button in the Value field displays
the Select Contact dialog box.

The newly defined relationship appears in the Relationship Hierarchy explorer.

Displaying Lists of Investor
Transactions or Holdings (End User)

End users can view lists of transactions associated with an investor.

To display a list of transactions by investor
1 Navigate to the Companies screen > Companies List view.

2 In the Companies list, drill down on the investor for which you want to display transactions.
3 Click the Investor Profile view tab.
4

Scroll down to the All Transactions as Investor list to review the transaction history.
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To display a list of holdings by investor
1 Navigate to the Companies screen > Companies List view.

2 In the Companies list, drill down on the investor for which you want to display holdings.
3 Click the External Holdings view tab.

End users can also enter holdings information in the External Holdings view.
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This section includes the following topics:

“About Managing Households” on page 67
“Scenario for Managing Households” on page 68
“Process of Managing Households” on page 68

“Adding Households” on page 69

“Associating Contacts with Households” on page 69
“Viewing Household Summaries” on page 70

|

|

|

|

B “Setting the Household Privacy Option” on page 69

|

|

B “Using the Household Relationship Hierarchy” on page 70
|

“Viewing and Evaluating Household Portfolios” on page 71

About Managing Households

A household is a group of contacts generally sharing a common link or association. Households
provide valuable segmentation information on the household as a whole, as well as a summary of
information about the household member contacts. Users can use the Households screen for
identifying and capturing demographic information about a household. They can also use the
Households screen to review customer’s financial accounts, products, and contact information
associated with that household. This information allows them to assess customers’ data.

CAUTION: This chapter assumes you have renamed Siebel Account objects to Companies. By
default, Siebel Finance installs using the term Accounts. For more information on renaming Siebel
Account objects, see the Upgrade Guide for your operating system.

Grouping all of a customer’s accounts by household allows a service provider to identify a client’s
real value to the organization and seek opportunities to cross-sell and up-sell additional products and
services to them, such as homeowners insurance and loans for children’s education. In addition, the
ability to view all of a customer's financial accounts and related portfolio information by household
allows an organization to view the household’s overall financial position.

By following the procedures described in this chapter, users can enter, manage, and review
information about household members (contacts), accounts, policies, underwriting reports, claims,
opportunities, activities, service requests, and relationship hierarchies.

NOTE: Many of the views are read-only, as they provide a summary of information about household
contacts. The only editable views are Contacts and Relationship Hierarchy.
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The Households screen and associated views that appear in Siebel Finance share much of the
functionality found in Siebel Business Applications. This chapter focuses on the household
functionality that is unique to Siebel Finance. For more information on basic household functionality,
see Applications Administration Guide.

Scenario for Managing Households

The following business scenario contains sample tasks performed by a sales representative; it covers
insurance, healthcare, securities, and banking businesses.Your company may follow a different
workflow according to its business requirements.

Household information supports sales and service decisions for segmentation and cross-selling. It
also provides background information for the finance and insurance industries about a household and
all of its contacts.

A sales representative uses the Household screen for identifying and capturing demographic and
relationship information about the household, and for reviewing accounts and products associated
with that household. From the Households screen, the sales representative creates a new household
for a new bank customer. He then adds contacts to the household.

Some weeks later, the sales representative wants to review household information. He navigates to
the My Households view and then selects the Summary view tab to review lists of contacts and
service requests associated with that household. Next, using the Relationship Hierarchy view, the
sales representative reviews the various parties related to the household.

NOTE: In the wealth management industry, a relationship manager, retail broker, or wealth manager
has access to view the household's aggregated holdings within their financial accounts, the
performance on these accounts, cash flows expected for the household for a specified period, and
the household's current versus model portfolio allocations by sector and by asset class. For more
information, see “Viewing and Evaluating Household Portfolios” on page 71.

In this scenario, end users are the sales representatives or relationship managers who manage
household information in the field. They enter and review information to:

B Add a household

Add a contact to a household

B View household summary information
B View household relationships
B View household financial account, performance, cash flow, and portfolio allocation details

Process of Managing Households

This section details sample tasks often performed by end-users when managing households. Your
company may follow a different process according to its business requirements.

B “Adding Households” on page 69
B “Setting the Household Privacy Option” on page 69
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“Associating Contacts with Households” on page 69
“Viewing Household Summaries” on page 70
“Using the Household Relationship Hierarchy” on page 70

“Viewing and Evaluating Household Portfolios” on page 71

Adding Households

End users can collect and manage information about a customer’s household. Households are added
from the Households screen. For detailed information on how to add a household see Applications
Administration Guide.

Setting the Household Privacy Option

United States law requires that financial institutions disclose their privacy policies regarding the
sharing of non-public personal information with third parties, and fair credit reporting, that impacts
the sharing of non-public personal information with affiliates. End users can specify a privacy level
by making a selection from the Privacy Option field.

The Privacy Option field is for registering the privacy level requested by the household; it does not
impact record visibility in any way.

To set the privacy option for a household
1 Navigate to the Households screen > List view.

2 To specify a privacy level, scroll down to the Privacy Option field and select one of the following:
m  Opt-In. Sharing of non-public personal information is allowed without restrictions.

B Opt-Out - Affiliates. Sharing of non-public personal information with affiliates is not
allowed.

m  Opt-Out - Third Party. Sharing of non-public personal information with third parties is not
allowed.

m  Opt-Out - All Parties. Sharing of non-public personal information with any affiliate or third
party is not allowed.

Associating Contacts with Households

Contacts are persons associated with a household. End users can specify one person in the household
as the head of household and then identify the others as spouse, child, or dependent parent.

To add a contact to a household
1 Navigate to the Households screen > List view.

Siebel Finance Guide Version 7.8 69



Managing Households ® Viewing Household Summaries

2 In the Households list, drill down on the household to which the contacts will be added.
3 Click the Contacts view tab.
4 In the Contacts list, click Add, and do one of the following:
m  Select an existing contact and click OK.
m  Perform a query to choose an existing contact.
B Select New to add a new contact.
The contact is associated with the household.

NOTE: In the Households screen, a contact’s address is his or her residential or personal
address. In the Contact’s screen, a contact’s address is his or her work address. Household
addresses can only be selected from among residential addresses.

Viewing Household Summaries

The Household Summary view provides a comprehensive view of the household’s relationship with
an end user’s organization in an editable format. This view displays basic information about the
household, contacts, financial accounts, and past or pending service requests.

To view household summary information
1 Navigate to the Households screen > List view.

2 In the Households list, drill down on the household, and click the Summary view tab.

Using the Household Relationship
Hierarchy

End users use the Household Relationship Hierarchy view to identify and capture key relationships
for a household. This view features a graphical tree that provides a visual representation of a
household’s relationships, which includes its natural relationships to the household contacts as well
as custom-defined, ad-hoc relationships.

Users can create custom-defined relationships between a household and any contact or organization.
End users can record custom-defined relationships between any two entities in the adjacent Party
Relationships list.

NOTE: The Relationship Hierarchy view is also available on the Contacts and Companies screens. For
more information, see “Viewing Contact Relationship Hierarchies (End User)” on page 86 and “Viewing
Company Relationship Hierarchies (End User)” on page 63.

To create a custom-defined relationship
1 Navigate to the Households screen > List view.
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2 In the Households list, drill down on the household for which you wish to define relationships.
3 Click the Relationship Hierarchy view tab, and in the Party Relationship list, add a record.
4 Complete the necessary fields.

Some fields are described in the following table.

Field Comments

Relationship The value in this field categorizes the relationship between the household
and the other entity. The field has an LOV for custom-defined Relationship
values. Predefined values include Reports To, Spouse, Child, Lawyer,
Board Member, Primary Contact (Backup), Admin Assistant, Competitor,
Referral, Service Provider, Investor, Wealth Management Rep, Related
Subsidiary, Bank Attorney, Trustee Attorney, and Debtor Attorney. This
LOV can be modified by the Siebel administrator. For more information,
see “Configuring Lists of Values” on page 27.

Type The value in this field determines the type of entity with which you wish
to establish a relationship. Defaults to Contact. Other values include
Household, Organization, and Employee.

Value The value in this field is based on the Type field. For example, if Type
equals Contact, then clicking the select button in Value field displays the
Select Contact dialog box.

The newly defined relationship appears in the Relationship Hierarchy explorer.

Viewing and Evaluating Household
Portfolios

End users can use the Financial Accounts view tab to view a household’s portfolio information from
a number of different perspectives:

B Financial Accounts list. Displays financial accounts associated with contacts in the selected
household. For more information, see “To select a financial account associated with a household”
on page 72.

B Aggregated Holdings List. Displays holdings within the selected accounts by asset class, such
as securities, mutual funds, or bonds. For more information, see “To view aggregated holdings for
a financial account” on page 72.

B Class Allocation List. Displays a comparison of the selected account holdings against a portfolio
model. For more information, see “To compare account holdings against a portfolio model” on
page 72.

B Sector Allocation List. Displays the selected account holdings by sector, allowing the user to
view the degree of portfolio diversification. For more information, see “To view the selected
account holdings by sector” on page 72.
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B Cash Flow List. Displays future cash flows for the selected financial accounts. allowing users to
estimate the amount of cash that may be available for future investments. For more information,
see “To view expected future cash flows for selected accounts” on page 73.

B Performance List. Displays how the selected accounts have performed over time. For more
information, see “To view selected accounts’ past performance” on page 73.

NOTE: These views are virtual business components and need to be configured before they can be
used. For more information, see “Setting Up Household Financial Accounts Virtual Business
Components” on page 113.

To select a financial account associated with a household
1 Navigate to the Households screen > List view.

2 In the Households list, drill down on the desired household, and click the Financial Accounts view
tab.

3 In the Financial Accounts list, select the Aggregation Select field for the accounts you want to
select.

NOTE: You can also click Select All to select all accounts, or click Select None to clear all
accounts.

To view aggregated holdings for a financial account

1 Select the financial accounts by checking the Aggregation Select field of the desired accounts.
(See “To select a financial account associated with a household” on page 72.)

Scroll down and click the Aggregated Holdings subview tab.
Scroll up to the Financial Accounts list, and click Generate Holdings.

The Aggregated Holdings list appears, displaying all holdings in the selected account by asset
class, such as securities, mutual funds, or bonds. Selecting a specific asset class in the
Aggregated Holdings displays the individual positions in the Holdings subview.

To compare account holdings against a portfolio model

1 Select the financial accounts by checking the Aggregation Select field of the desired accounts.
(See “To select a financial account associated with a household” on page 72.)

Scroll down and click the Class Allocation subview tab.

Scroll up to the Financial Accounts list, select a portfolio model from the drop-down list, and click
Go.

The Class Allocation list and model and actual holdings charts appear.

To view the selected account holdings by sector

1 Select the financial accounts by checking the Aggregation Select field of the desired accounts.
(See “To select a financial account associated with a household” on page 72.)
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Scroll down and click the Sector Allocation subview tab.
Scroll up to the Financial Accounts list, select a sector from the drop-down list and, click Go.

The Sector Allocation list appears, displaying the account holdings by sector, allowing the user
to view the degree of portfolio diversification versus the selected model portfolio.

To view expected future cash flows for selected accounts

1

2

Select the financial accounts by checking the Aggregation Select field of the desired accounts.
(See “To select a financial account associated with a household” on page 72.)

Scroll down and click the Cash Flow subview tab.
Scroll up to the Financial Accounts list, and click Generate Cash Flow.
In the period filter, select the period for which you want to view cash flows, and click Go.

The Cash Flow subview displays an estimate of the amount of cash that may be available for
future investments.

NOTE: In order to work, the preceding procedure requires preconfiguration. For more
information, see “Setting Up Household Financial Accounts Virtual Business Components” on
page 113.

To view selected accounts’ past performance

1

For the desired financial accounts, check the Aggregation Select field. (See “To select a financial
account associated with a household” on page 72.)

Scroll down and click the Performance subview tab.
Scroll up to the Financial Accounts list, and click Generate Performance.

In the period filter, select the period for which you wish to view an account’s performance, and
click Go.

The Cash Flow list appears, displaying how the account performed over time.

NOTE: In order to work, the preceding procedure requires preconfiguration. For more
information, see “Setting Up Household Financial Accounts Virtual Business Components” on
page 113.
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This section includes the following topics:

“About Managing Contacts” on page 75

“Scenario for Adding a New Contact” on page 76

“Process of Managing Contacts” on page 77

“Updating or Reviewing a Contact’s Holdings” on page 78
“Managing Contact Information (End User)” on page 79

“Creating Customer Assessments (End User)” on page 84
“Setting the Customer Value Icon (End User)” on page 85
“Viewing a Contact Summary (End User)” on page 85

“Viewing Contact Relationship Hierarchies (End User)” on page 86

“Managing Mortgages (End User)” on page 87

“Creating Financial Plans (End User)” on page 90

About Managing Contacts

Contacts are entities or individuals with whom the company does business with or with whom it
expects to do business with in the future. Contacts includes employees of other companies,
independent consultants, vendors, or personal acquaintances. Contacts can belong to only one
company, but they can be part of many opportunities, including opportunities that do not involve
their companies. Within Siebel Finance, contacts are presented in a single view of the customer and
your relationship with the customer.

CAUTION: This chapter assumes you have renamed Siebel Account objects to Companies. By
default, Siebel Finance installs using the term Accounts. For more information on renaming Siebel
Account objects, see the Upgrade Guide for your operating system.

End users can:

B Enter and track information about contacts, which includes products bought, details of signed
agreements or contracts, and products previously recommended to the customer.

B  Document marketing campaigns and details of each customer’s response.

Maintain a complete history of service requests and product applications that the customer has
made in the past.

B Analyze a customer’s financial health as well as a customer’s needs.
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The Contacts screen provides an alternative view of data that is available in other screens. Many
tasks that can be performed in the Contacts views can also be performed in other screens. For
example, users can create activities for a contact either in the Contact Activities view, or they can
go to the My Activities view to enter a new activity, and then associate it with the contact.

For more information on basic contact functionality and administration, see Applications
Administration Guide.

You can save time and reduce keystrokes by using a workflow to automate steps that are repeatedly
performed by end users. For more information, see Siebel Business Process Designer Administration
Guide.

Scenario for Adding a New Contact

These scenarios feature sample tasks performed by a sales representative and a private banker in
the securities or banking industries. Your company may follow a different workflow according to its
business requirements.

Sales Representative Adds a New Contact

At a conference, a new account representative meets a potential customer. The potential customer
gives the new account representative his business card and informs her that he had recently moved
to the area and is still looking for a financial institution to serve his small business and personal
banking needs.

The new account representative returns to her office and enters her new acquaintance into Siebel
Finance as a new contact. She can also enter his company information and associate the company
with the contact. In the Relationship Hierarchy view, she can enter the relationships for this contact,
including all companies he is associated with, the contact's business partners, lawyer, his family
members, and other influential relationships. As the creator of this new contact record, she is
automatically added to the coverage team as the primary representative for the customer. If
necessary, she can also add the small business manager and other product experts to the coverage
team so they can see this new contact in their My Contacts view.

As the customer is looking for personal and business services, the account representative can create
separate opportunity records in Siebel Finance associated with the contact. In the opportunity
records, she records the products and services the customer is interested in as well as other follow-
up activities to serve the customer's financial needs.

In the scenario, end users are the new account representatives who manage company information
in the field. They enter information to:

B Add a new contact and associate him/her with companies

Use the Relationship view to enter all the contact's influential relationships

B Add other account representatives to the coverage team
B Create new opportunities associated with the contact
B Create follow-up activities and assign them to the right representatives to close the potential

opportunities
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Private Banker Prepares for Sales Call

A private banker is preparing for a sales call. He reviews his client’s information by answering the
following questions:

What company does this person work for?
What is the value of this customer’s relationship?
What is this person’s financial profile?

What financial accounts and products does the person already own? What might the person need
in addition?

What types of service issues has the person had?

Access the Contacts screen to answer all of these questions.

In the scenario, end users are private bankers in the banking industry. They enter information to:

Add a new contact
Create a customer value assessment
View contact summary information

View the results of a customer value assessment

Process of Managing Contacts

This section details sample tasks often performed by administrators and end-users when managing
contacts. Your company may follow a different process according to its business requirements.

Administrator Procedures

The following list shows tasks administrators typically perform to manage contacts:

“Updating or Reviewing a Contact’s Holdings” on page 78

“Updating or Reviewing a Contact’s Investment Profile” on page 78

End-User Procedures

The following list shows tasks end users typically perform when managing contacts:

“Managing Contact Information (End User)” on page 79
“Creating Customer Assessments (End User)” on page 84
“Setting the Customer Value Icon (End User)” on page 85
“Viewing a Contact Summary (End User)” on page 85

“Viewing Contact Relationship Hierarchies (End User)” on page 86
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B “Managing Mortgages (End User)” on page 87

B “Creating Financial Plans (End User)” on page 90

Updating or Reviewing a Contact’s
Holdings

Administrators can perform various procedures to review, add, and modify contact information
through the Contacts Administration views in the Finance Administration screen.

The Investment Profile view allows administrators to create contacts’ profiles, such as overall
objectives, financial goals, annual income, liquid net worth, experience, risk assessment, knowledge
levels, and income tax bracket.

To update or review a contact’s holdings
1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, select a contact and drill down on the contact’s name.
3 Update the contact’s information as needed.
4 Click the Holdings view tab, and select a financial account.

The Financial Accounts and Holdings lists appear; the Financial Accounts list includes all of the
Contact’s financial accounts at your organization.

5 Scroll down to the Holdings list, and update the information as needed.

Updating or Reviewing a Contact’s
Investment Profile

The Investment Profile view allows administrators to create contacts’ profiles, such as overall
objectives, financial goals, annual income, liquid net worth, experience, risk assessment, knowledge
levels, and income tax bracket.

To update or review a contact’s Investment Profile
1 Navigate to the Administration - Finance screen > Contacts view.

In the Contacts form, query to retrieve the desired contact.
Update the contact’s information as needed.

Click the Investment Profile view tab.

a A W N

Update the contact’s investment profile as needed.
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Managing Contact Information (End
User)

Contacts are entities or individuals with whom the company currently does business with or with
whom it expects to do business with in the future. End users manage contact information by:

B Adding new contacts. See “Adding Contacts” on page 79.

B Creating contact categories and notes. See “Creating Categories for Contact Information” on
page 80 and “Creating Notes About Contacts” on page 81.

B Adding a contact to a literature distribution list. See “Adding Contacts to a Literature Distribution”
on page 81.

Setting a contact’s access level. See “Contact Access Level” on page 82.
Setting a contact’s securities interest. See “Entering Securities Interest for Contacts” on page 82.
Viewing a contact’s transaction history. See “Viewing a Contact’s Transaction History.”

Managing contact referral information. See “Managing Contact Referral Information” on page 82.

Viewing contact profitability. See “Reviewing Contact Profitability” on page 84.

Adding Contacts

When end users meet someone in the course of business, they add a contact record for that
individual to track pertinent personal information and possible potential future business.

NOTE: The Personal Contacts List is different from the Contacts Lists because it is designed for
contacts not associated with a company. Therefore, in the Personal Contacts List, adding a company
to a record does not also add it to the My Contacts view, All Contacts view, and so on. End users
must add business contacts in one of the Contacts List views proper. They must create, review, and
manage activities for their personal contacts only in the Activities view of the Personal Contacts List
view, not in the other Contacts views.

To add a contact
1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts form, click the show more button, add a record, and complete the necessary
fields.

3 To specify a privacy level, drill down on the contact name link, scroll down to the Privacy Option
field, and select one of the following:

m  Opt-In. Sharing of non-public personal information is allowed without restrictions.

B Opt-Out - Affiliates. Sharing of non-public personal information with affiliates is not
allowed.

B  Opt-Out - Third Party. Sharing of non-public personal information with third parties is not
allowed.
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m  Opt-Out - All Parties. Sharing of non-public personal information with any affiliate or third
party is not allowed.

United States law requires that financial institutions disclose their privacy policies regarding the
sharing of non-public personal information with third parties, and fair credit reporting, that
impacts the sharing of non-public personal information with affiliates. End users can specify a
privacy level by making a selection from the Privacy Option field.

The Privacy Option field is for registering the privacy level requested by the contact; it does not
impact record visibility in any way.

To associate a contact with a company
Navigate to the Contacts screen > Contacts List view.

In the Contacts list, drill down on the desired contact.

Click the More Info view tab.

A W N P

In the Account Name field, select a record from the list of available companies.

The application automatically associates the company with the contact and populates the address
with the default company address information.

5 To change the address, click the select button in the Address Line field, and select an address.
6 To specify an address as the contact’s primary address, click the Primary field.

NOTE: The primary address in the Contact Addresses dialog box appears in the address fields
on the More Info form.

7 In the Time Zone field, select the contact’s time zone.

Creating Categories for Contact Information

If the default Contacts list and More Info form do not contain fields to track the type of information

that end users need to track, they can add additional categories. A manager may have set up a list
of values from which they can select.

To add a category to a contact
Navigate to the Contacts screen > Contacts List view.

In the Contacts form, query for the desired contact.
Drill down on the Last Name link, click the Categories view tab, and create a new record.
In the Categories list, select a category from the list of values or create a new category.

Complete the necessary fields.

o a0 A W N PR

Create additional categories by repeating Step 4 through Step 5.
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Creating Notes About Contacts

As end users work with contacts, they learn things they may want to remember. Often these tidbits
of information are best stored as notes. Users can create notes that everyone with access to the
contact record can see, or they can create notes that only they can see.

To create a note regarding a contact
1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, drill down on the desired contact.

NOTE: If the contact does not exist, add it. For more information, see “Adding Contacts” on
page 79.

3 Click the Notes view tab.
4 From the link bar, select one of the following:
m  Public Notes. Notes that others can see.
m  Private Notes. Notes that only their creators can see.
5 In the Notes list, add a record and complete the necessary fields.
NOTE: You can perform a spell check in Private Notes, but not in Public Notes.

Some fields are described in the following table.

Field Comments

Created Automatically populates with a date and timestamp.

Type Default value is Note. Select alternate value to categorize the type of
note.

Description Text field for the content of the note.

Adding Contacts to a Literature Distribution

The Literature Distribution view displays all the literature that has been distributed to a contact.
Typically, a literature distribution record is created each time literature is emailed to a contact. For
more information about the activity of distributing literature using an email message, see “Providing
Literature Fulfillment by Email” in Chapter 9, “Managing Activities.”

To distribute literature to a contact
1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, drill down on the desired contact.
3 Click the Literature Distribution view tab, create a new record, and complete the necessary fields.
4

In the Distribution Channel field, select a distribution channel.
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5 Scroll down to the Literature list, add a record, and complete the necessary fields.

6 Repeat Step 5 for all the pieces of literature to be distributed.

Contact Access Level

Siebel Finance uses access levels to grant customers access to different levels of service, research,
events, and literature. Setting a contact’s access to a specific level allows that contact access and
visibility to literature items that have the same or lesser access level. For more information about
setting a contact’s access level, see “Setting Access Levels” on page 195.

Entering Securities Interest for Contacts

End users can record a contact’s securities interest. For more information about entering a contact’s
securities interest, see “Entering Interests and Holdings Information” on page 179.

Viewing a Contact’s Transaction History

The Contacts Transaction History view allows end users to display a contact’s transaction history by
financial account for all the accounts held by the contact at your organization.

To view a contact’s transaction history
1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, drill down on the desired contact.
3 Click the Transaction History view tab.

The Transactions view appears, displaying all the financial accounts associated with the contact,
and the investment transactions that took place in each account.

Managing Contact Referral Information

The Referrals view tab allows end users to enter referral information associated with contacts.
Referrals are potential opportunities.

In the Referrals tab view, end users can record both referrals they give to their contacts, as well as
referrals received from a contact.

To create a new contact for a referral
1 On the Contacts screen, create contacts. For more information, see “To add a contact” on page 79.
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Associate those contacts with the new company. For more information, see “To associate a contact
with a company” on page 80.

On Referrals view tab, select the Contact from the Pick Contact dialog box associated with this
field.

To enter a referral received from a contact

A W N PR

Navigate to the Contacts screen > Contacts List view.

In the Contacts list, drill down on the desired contact.
Click the Referrals view tab.

From the drop-down list, select Referral From This Contact.

NOTE: View all referrals from the contact by selecting Referrals From This Contact in the drop-
down list.

In the form, add a record, and complete the necessary fields.

Some fields are described in the following table.

Field Comments

Company Select an existing company or create a new one. The company selected
represents the potential opportunity for your organization.

Last Name Select a contact to associate with the referral company, as selected in the
Company field; if you entered a Company, the list of Contacts is restricted
to those associated with the selected company.

Referred By Select the employee who made the referral.

To create a referral to a contact

A W N P

Navigate to the Contacts screen > Contacts List view.
In the Contacts list, drill down on the desired contact.
Click the Referrals view tab.

Scroll down to the Referrals to This Contact list, and from the drop-down list, select Referrals To
This Contact.

In the list, add a record, and complete the necessary fields.

Some fields are described in the following table.

Field Comments

Disposition The status of the referral.

Company Select an existing company or create a new one. The company
selected represents the potential opportunity for your service
provider.
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Field Comments

Last Name Select a contact to associate with the referral company, as selected
in the Company field; if you entered a Company, the list of Contacts
is restricted to those associated with the selected company.

Referred By Select the employee from your organization who made the referral.

Reviewing Contact Profitability

End users can use the Profitability view to review customer profitability calculations. These
calculations help financial institutions adjust their sales, pricing, service, and marketing activities
appropriately. This information also helps institutions cross-sell to their customers.

NOTE: In Siebel Finance, end users can access the Profitability view from the Contacts, Households,
and Companies screens.

To review a contact’s profitability
1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, drill down on the desired contact.

3 Click the Profitability view tab.

Creating Customer Assessments (End
User)

The Contacts Assessments view can help end users qualify contacts. Contact assessments are
created in the Contacts Assessments view.

NOTE: A similar assessment functionality is available for companies. For more information, see
“Creating Company Assessments (End User)” on page 61.

A customer assessment evaluates a contact based on defined criteria. Each assessment template has
a group of assessment attributes that make up the different measurement points of the assessment.
A Siebel administrator can create new templates and add or modify assessment attributes. For more
information on assessment templates and how to define and manage them, see Applications
Administration Guide.

To create a customer assessment
1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, drill down on the contact for whom the assessment will be added.

3 Click the Assessments view tab, and create an new record.
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4 In the Template Name field, select the desired template.

Assessment attributes, as defined for the template, are automatically created in the Assessment
Attributes list.

5 Scroll down to the Assessment Attributes list, and where possible, select a value for each
attribute by clicking the select button in the Value field.

Setting the Customer Value Icon (End
User)

In addition to the customer value assessment tool described in “Creating Customer Assessments (End
User)” on page 84, there is an alternative customer value measurement device in Siebel Finance.

The customer value icon is a series of five stars visible on the contact form. The number of stars
activated indicates the perceived value of the contact.

To adjust the customer value stars
B From the Contacts > More Info view, adjust the value in the Tier field.

Viewing a Contact Summary (End User)

The Contact Summary view provides a comprehensive view of a contact’s relationship with an end
user’s organization in an editable format. This view displays the customer’s contact information,
financial accounts, applications, alerts, campaigns targeted at the customer, and service requests
and opportunities associated with the customer.

The Customer Value stars on the Contact form indicates the customer’s value to the organization.
For more information, see “Setting the Customer Value Icon (End User)” on page 85.

To view contact summary information
1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, drill down on a contact.
3 Click the Summary view tab.

For more information on editing summary view information, see “Configuring Summary Views” on
page 28.
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Viewing Contact Relationship
Hierarchies (End User)

A contact’s relationships are those of influence. End users may have a contact who relies heavily on
the opinions of others when making purchasing or other decisions. If so, they may want to keep track
of the relationships between a contact having purchasing authority and those who might influence
his purchasing decisions.

End users use the Contacts Relationship Hierarchy view to identify and capture key relationships for
a contact. This view features a graphical tree that provides a visual representation of a contact’s
relationships. The tree displays both the natural hierarchy of a contact’s parent-child relationships
to entities such as companies and households, as well as custom-defined relationships.

Custom-defined relationships are ad-hoc associations between the contact and any other contact,
organization, or household. End users can record custom-defined relationships between any two
entities in the adjacent Party Relationships list.

NOTE: The Relationship Hierarchy view is also available on the Companies and Households screens.
For more information, see “Viewing Company Relationship Hierarchies (End User)” on page 63 and
“Using the Household Relationship Hierarchy” on page 70.

To view a contact’s relationship hierarchy
1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, drill down on the contact for whom you want to view a relationship hierarchy.
3 Click the Relationship Hierarchy view tab.

The Contacts Relationship Hierarchy view appears.

To define a relationship between contacts
1 Navigate to the Contacts screen > Contacts List view.

In the Contacts list, drill down on the contact for whom you want to describe relationships; if the
contact does not exist, add it.

For more information on adding contacts, see “Adding Contacts” on page 79.

3 Click the Relationship Hierarchy view tab.
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4 In the Party Relationship list, add a record, and complete the necessary fields.

Some fields are described in the following table.

Field Comments

Relationship Categorizes the relationship between the contacts. The field has an LOV for
Custom Defined Relationship values. Predefined values include Reports To,
Spouse, Child, Lawyer, Board Member, Primary Contact (Backup), Admin
Assistant, Competitor, Referral, Service Provider, Investor, Wealth
Management Rep, Related Subsidiary, Bank Attorney, Trustee Attorney, and
Debtor Attorney.

The Siebel administrator can modify this LOV. For more information, see
“Configuring Lists of Values” on page 27.

Type Defaults to Contact. Other values include Household, Organization, and
Employee.
Value Identifies the other member of the relationship. The values are constrained by

the Type field selection. For example, if Type equals Contact, then clicking the
select button displays the Select Contact dialog box.

The newly defined relationship is expressed in the Relationship Hierarchy explorer.

Managing Mortgages (End User)
Using the Contacts screen, end users can perform the following mortgage-related tasks:

B Perform a mortgage needs analysis. For more information, see “Performing Mortgage Needs
Analyses” on page 87.

B Make a mortgage recommendation. For more information, see “Making Mortgage Product
Recommendations” on page 88.

B Perform a mortgage prequalification. For more information, see “Performing Mortgage
Prequalifications” on page 89.

B Use the mortgage calculator. For more information, see “Using the Mortgage Calculator” on
page 89.

Performing Mortgage Needs Analyses

End users can use the Needs Analysis Mortgage view to perform a mortgage needs analysis for a
contact.

To perform a general needs analysis for a contact
1 Navigate to the Contacts screen > Contacts List view.
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In the Contacts list, drill down on the contact.
Click the Needs Analysis view tab, and click the Mortgage link.
In the Needs Analysis form, add a record and complete the necessary fields.
If the values to enter are unknown:
a  Click Script.
The script session appears.
b Complete the questions as prompted.
You can generate a recommendation after the Needs Analysis form is completed.

NOTE: For more information about needs analysis and generating recommendations, see
Chapter 12, “Managing Financial Needs Analyses.”

Making Mortgage Product Recommendations

End users can use the Product Recommendation view to recommend mortgage products based on
the loan term that a customer specifies. This view also displays the mortgage monthly payments,
detail fees, interest rate, and points for each recommended mortgage product.

CAUTION: All Siebel Finance calculators described provide results intended for comparison purposes
only; the accuracy of the results is not guaranteed. Rounding or the mathematical formula used may
account for any differences from the expected results. Modifying the formula used to perform
calculations requires administrative responsibilities.

To
1

2
3
4

88

recommend mortgage products for which a customer qualifies
Navigate to the Contacts screen > Contacts List view.

In the Contacts list, drill down on the desired contact.

Click the Product Recommendation view tab, and select Calculator Detail from the drop-down list.
In the Calculator Detail form, add a record, and complete the necessary fields.

The monthly payment is automatically calculated for the request loan terms.

Click Recommend.

All the mortgage products that have the same loan term as that set in the Calculator form, appear
in the Recommendations list.

In the Recommendations list, select a mortgage product.

The Rate/Points list displays the loan rate and points associated with the product, while the Fees
list displays the fees associated with the product.
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Performing Mortgage Prequalifications

End users can use the Mortgage Pre-Qualification view to prequalify mortgage prospects before
starting the application process.

To perform a mortgage prequalification
1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, drill down on the desired contact.
3 Click the Mortgage Pre-Qualification view tab, add a record, and complete the necessary fields.

The Pre-Qualification Output, such as purchase price, loan amount, and closing cost, is
automatically calculated based on the values in the Prequalification Attributes fields.

4 To see the calculation results, step off or save the record.

Using the Mortgage Calculator

Loan officers, loan originators, and other financial representatives can use the Siebel Finance
Mortgage Calculator to calculate and compare the following amounts for customers:

B Early Payoff, which calculates the new monthly payment amounts that are required to pay off a
loan in a specified amount of time prior to the original mature date

B Loan Amount, which calculates the amount of money a customer can borrow, given a loan’s
monthly payment, interest rate, loan term, and down payment

B Loan Comparison, which compares different types of mortgage loans (ARM versus Fixed Rate)
from which the customer can choose one

B Monthly Payment, which calculates a customer’s monthly payment, given the loan amount,
interest rate, loan term, property tax, and insurance payment

B Refinance Breakeven, which calculates monthly savings and costs associated with refinancing an
existing loan

CAUTION: All Siebel Finance calculators described in this guide provide results intended for
comparison purposes only; the accuracy of the results is not guaranteed. Rounding or the
mathematical formula used may account for any differences from the expected results. Contact your
Siebel administrator to modify the formula for your use.

To use the mortgage calculator
1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, drill down on the desired contact.

3 Click the Calculator view tab, and from the link list in the Calculator form, select a calculation
function:

m  Early Payoff
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Loan Amount
Loan Comparison

Monthly Payment

Refinance Breakeven
4 In the Input section in the form, complete the necessary fields.

5 To see the calculation results, step off or save the record.

Creating Financial Plans (End User)

End users can use the Financial Planning view to ask customers questions about their specific
financial goals and recommend a required monthly savings amount.

To create a financial plan
1 Navigate to the Contacts screen > Contacts List view.

In the Contacts list, drill down on the desired contact.
Click the Financial Planning view tab.

In the Financial Planning list, add a record and complete the necessary fields.
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To follow a script of questions:
a  Scroll down to the Details form and click Script.
b In the SmartScript list, drill down on the Name link.

NOTE: If the script does not exist, add it. For more information about scripts, see Siebel
SmartScript Administration Guide.

c Complete the questions as prompted.

The Savings (Future Value), Additional Funds Required, and Monthly Saving Required are
automatically calculated based on the values entered in the Financial Planning list.
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This section includes the following topics:

About Managing Call Reports

Call reports are records of meetings and other conversations with clients, organizations, and
individuals. Call reports are often required of employees because they:

“About Managing Call Reports” on page 91

“Scenario for Managing Call Reports” on page 92

“Process of Managing Call Reports” on page 93

“Viewing Call Report Charts” on page 94

“Activating the New Call Report Workflow” on page 95
“Managing Call Report Templates” on page 95

“Adding Call Reports (End User)” on page 96

“Creating Call Report Distribution Lists (End User)” on page 97
“Associating Action Items, Notes, and Attachments with Call Reports (End User)” on page 97
“Setting the Call Report Privacy Flag (End User)” on page 98
“Emailing and Printing Call Reports (End User)” on page 98

Are a means for new relationship managers to learn about the client and its history with the
organization.

Allow senior managers and product specialists associated with a certain client to keep up with
the developments in the client relationship, even if they do not meet with the client on a regular
basis.

Provide a record of important and informal agreements. In the event that a failed financing
transaction results in legal proceedings, these reports are an important component of the legal
process.

Administrators use these procedures to view a chart of call reports and manage call report templates.
End users use the Call Reports screen to add a new call report, create a call report distribution list,
designate a report as private, and email or print call reports.

Siebel Finance can provide notification of new call reports to designated individuals. For more
information, see Siebel Business Process Designer Administration Guide.
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Scenario for Managing Call Reports

This scenario features sample tasks performed by an investment banker or commercial lending
officer and their manager. The scenario outlined in this section is based on the business requirements
of the banking industry. Your company may follow a different workflow according to its business
requirements.

The investment banker spends approximately 35 percent to 50 percent of his time calling his
companies and prospects. Most company meetings revolve around discussing the company’s
financial plans, understanding the company’s business strategies, and presenting his bank’s

investment banking or lending experience and capabilities.

The investment banker uses Siebel Finance integrated calendar and activity management
functionality to plan his day and maintain his to-do list. Today, he reviews his calendar and sees that
he has a meeting scheduled with a client to discuss a $10 million private investment that the
company is considering. The investment banker will be making the call with a commercial lending
officer, his counterpart from the bank’s Commercial Lending group. He uses Siebel Finance to review
his bank’s relationship with the client. He uses the Company Summary view to review the client’s
financial and business profile. The investment banker attends the meeting with an understanding of
the client and its needs.

After returning to the office following a successful meeting with the client, the investment banker
loads Siebel Finance to complete his call report. His bank encourages its bankers to maintain call
reports so other professionals working with the client can understand recent events in the
relationship. The investment banker navigates back to his calendar and marks the meeting as Done.
He navigates to the Call Reports screen and enters a new call report to document the conversation.
In the Report Detail view, he types a brief log of the meeting and adds the names of contacts and
employees who participated.

Upon completing his report, the investment banker turns to the action items that resulted from the
meeting. First, he needs to send an email to a fellow employee in the firm’s Private Investments
group to alert her about the deal. He uses the Email Report button on the Call Report form to
accomplish this task.

Next, he remembers that he promised to include the client on the invitation list for the upcoming
Charity Ball, so he adds an action item on the Call Reports Action Items view tab. He does this by
clicking Add Action Items on the Call Report form. After he enters his action item, along with several
others, he assigns them to members of his team for follow-up. Finally, he attaches several of the
financial spreadsheets that his analyst prepared for the meeting so that the call report record is
complete.

When the commercial lending officer arrives at the office the next day, he sees that there is a new
call report from his joint meeting with the investment banker. Upon reviewing the report in his My
Call Reports view, he adds several comments based on his knowledge of the company. He does this
by clicking Add Notes on the Call Report form and adding his comments in the Notes list. Due to
regulatory requirements, he also prints a copy of the report for the credit file by clicking the toolbar
Reports icon.
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The commercial lending officer’s manager is also a member of the client team. When she arrives in
the office the next day and loads Siebel Finance, she reviews the new call reports on the Call Reports
screen, by reading about the meeting details and notes. While the manager is on the Call Reports

screen, she views the Call Report Charts view tab to see an analysis of her team’s call volume and
call types by employee and by customer, in order to determine which clients are receiving the most
service.

In this scenario, managers or Siebel administrators can use Siebel Finance to view graphical
representations of their call reports, and perform volume analysis of their own calls, their team'’s
calls, or all call reports.

The end users are the investment bankers and commercial lending officers who create call reports
to record their meetings and activities. They enter information to:

Create new call reports

Create call report distribution lists
Create call report action items
Attach related documents

Specify a call report as private

Review and add additional notes or comments

Email or print call reports

Process of Managing Call Reports

This section details sample tasks often performed by administrators and end-users when managing
call reports. Your company may follow a different process according to its business requirements.

Administrator Procedures

The following list shows tasks administrators typically perform to manage call reports:
B “Viewing Call Report Charts” on page 94

B “Activating the New Call Report Workflow” on page 95

B “Managing Call Report Templates” on page 95

End-User Procedures

The following list shows tasks end users typically perform when managing call reports:
B “Adding Call Reports (End User)” on page 96

B “Creating Call Report Distribution Lists (End User)” on page 97

B “Associating Action Items, Notes, and Attachments with Call Reports (End User)” on page 97
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B “Setting the Call Report Privacy Flag (End User)” on page 98
B “Emailing and Printing Call Reports (End User)” on page 98

Viewing Call Report Charts

As a manager or Siebel administrator, you can use the Call Report Charts view for call volume
analysis of your own calls, your team'’s calls, or all call reports in Siebel Finance. Use this view to

analyze call volume and call types by employee and by customer, in order to determine which clients
are receiving the most service.

To view a chart for your call reports
1 Navigate to the Call Reports screen > Call Report List view.

2 From the visibility filter, select one of the following:

®m My Call Reports

®m My Team'’s Call Reports

= All Call Reports

The view selected returns an appropriate set of call report records to be analyzed.
3 Click the Charts link on the link bar.

The chart reflects only those call report records in the current query; that is, those records listed
in the Call Reports list preceding the chart.

4 From the lower Show drop-down list, select one of the following chart types:

Chart Comments

Call Type Analysis A breakdown of all selected call reports by Call Type.

Call Volume Analysis Charts the number of calls per month, quarter, or year.

Call Volume by Employee Charts the number of calls per month, quarter, or year, per
employee.

Company Calling Analysis Charts the number of calls per company.

Employee Calling Analysis  Charts the number of calls per company, by employee.

NOTE: Place your cursor over any chart segment to reveal additional information about that
segment. Click a segment to drill down and refocus on just the call reports in that segment.
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Activating the New Call Report Workflow

When activated, the New Call Report Workflow allows end users to create call report records
automatically from the Contacts, Companies, Activities, and Opportunities screens. After the
administrator activates the New Call Report Workflow, the New Call Report icon appears in the upper-
left corner of those screens for end users.

To activate the New Call Report Workflow
1 Navigate to the Administration - Business Process screen > Workflow Deployment view.

2 In the Repository Workflow Processes list, query for the New Call Report Workflow record.
3 Click the Activate button at the top of the list to activate this workflow process.

When activated, the definition is written to the run-time tables and appears in the Active
Workflow Processes view.

To use the New Call Report feature after it is activated, end users can do one of the following:
B Click the icon
B Choose File = Auto > Call Report from the application-level menu

B Use the short cut key Alt+P

NOTE: The New Call Report Workflow uses the Data Transfer Utility business service to transfer fields
from one view to another. For information on modifying the New Call Report Workflow, so that it is
available from more screens, or populating more fields when moving from one screen to the next,

see “Using Data Transfer Utilities (DTU)” on page 271. The current Data Map Objects used for the New

Call Report in the Data Transfer Utility business service include: New Call Report - Account, New Call
Report - Activity, New Call Report - Contact, and New Call Report - Opportunity.

Managing Call Report Templates

You can email call reports. Emailed call reports, like other communications in Siebel applications, use
templates to automatically format information in a message sent as an email. When you email a call
report, Siebel Finance uses the Call Report Email template to populate the email message.

For more information on configuring communication templates, see Siebel Communications Server
Administration Guide.

To view or change the call report email template

1 Navigate to the Administration - Communications screen > All Templates view.
2 In the Templates list, query for the template named Call Report Email.

3 Review or change the call report in the Call Report Email form.
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Siebel Finance provides additional syntax for customizing message templates, offering a way to
embed multi-value fields within the body of the message templates. As an example of this syntax,
examine the template text for the Call Report Email template.

Adding Call Reports (End User)

End users add call reports to create a record of meetings and other conversations with clients,
organizations, and individuals.

To add a call report
1 Navigate to the Call Reports screen > Call Report List view.

2 In the Call Report form, add a record and complete the necessary fields.

Some fields are described in the following table.

Field Comments

Associated The activity that is the subject of the call report; each call report can have
Activity only one associated activity. Selection of the associated activity is
governed by the following constraints if those fields are populated:

B Same Company ID
B Same Primary Opportunity ID

B Same Primary Contact ID

Contacts Enter the participating contacts who were at the meeting. Designate a
primary contact if desired, otherwise the first contact selected is defaulted
as the primary. Entries appear in the Report Detail view and on the printed
Call Report.

Description A summary description of the call report; enter a more detailed report in
the Report Detail view.

Distribution List additional employees from your organization who should receive the
Call Report, but should not appear on the list of participants. The call
report creator and all Employee Participants are automatically placed on
the distribution list.

Employees List employees from your organization who participated in the call. Entries
appear in the Report Detail view and on the printed Call Report. The call
report creator is automatically listed as a participant.

Opportunity Associate an opportunity with the call report. You can view all call reports
associated with any given opportunity from the Opportunities screen.

Type The LOV type for this field is FINCORP_CALLRPT_CONTACT_TYPE.

NOTE: In the Call Reports list, the New flag is a calculated field and appears checked for five
days after the creation of a call report. Your systems administrator can change this setting.
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3 In the Call Reports list, drill down on the Description link to navigate to the Report Detail view.
4 In the Employees and Contact lists, enter detailed information about the call.

Information you enter here appears in emailed or printed call reports.

Creating Call Report Distribution Lists
(End User)

A distribution list is the list of contacts who need to know what is happening with a particular client.
Usually, it is the coverage team for the client, plus any additional employee participants. The
application automatically places the call report creator and each employee participant on the
distribution list. For other employees, such as the coverage team, to receive a call report, end users
must manually add them to the distribution list.

When end users use the call report Email Report feature, the distribution list controls who receives
the report. The call report Print Report function and the Send Email function, both available through
the application-level File menu (F9), are not affected by the distribution list.

To create a distribution list
1 Navigate to the Call Reports screen > Call Report List view.

2 In the Call Reports list, drill down on the call report for which you want to create a distribution
list.

3 In the Distribution field, select one or more employees to add to the distribution list.

The selected name or names are added to the distribution list.

Associating Action Items, Notes, and
Attachments with Call Reports (End
User)

After an end user has added a call report, they can associate it with action items, notes, and
attachments.

NOTE: Call report attachments, like the attachments for other activities, are stored in the
S_ACTIVITY_ATT table.

To associate action items, notes, and attachments
1 Navigate to the Call Reports screen > Call Report List view.

2 In the Call Reports list, drill down on the desired call report.

3 To add notes or action items to the call report, in the Call Report form click the appropriate view
tab:
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®m Notes. Adds notes or comments.
m Action Items. Adds an action item.

4 To attach external documents to a call report, click the Attachments view tab, and choose a file
or select a URL.

Setting the Call Report Privacy Flag (End
User)

Certain call reports may contain sensitive or confidential information about a given company or

opportunity. Users can designate certain calls as private by clicking the Private check box in the call
report form or list. After a call report is marked as private, only those employees on the employees
list can access it.

To set a privacy flag
1 Navigate to the Call Reports screen > Call Report List view.

2 In the Call Reports list, select the desired call report, and click the Private field.

The call report is now categorized as private. Only the employees on the employees list can
access it.

Emailing and Printing Call Reports (End
User)

You can email or print call reports for distribution and record keeping. First, submit a call report and
then email or print the report.

To submit a call report
1 Navigate to the Call Reports screen > Call Report List view.

2 In the Call Reports list, select the call report to submit.

3 In the Call Report form, select Submitted from the drop-down list.

To email or print a call report
1 Navigate to the Call Reports screen > Call Report List view.

2 In the Call Reports list, drill down on the call report to email or print.
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3 In the Call Report form, do one of the following:

To...

Email the report.

Click...
Email Report.

The report is automatically emailed to
everyone on the distribution list.

Print the report.

The toolbar Reports icon.

In the Reports dialog box, select
Summary or Detail and click Run.
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This section includes the following topics:

About Managing Activities

Activities are the duties, tasks, and actions performed to maintain relationships with customers.
These customers are companies or individuals with which your company conducts business.

“About Managing Activities” on page 101

“Scenarios for Managing Activities” on page 101

“Process of Managing Activities” on page 102

“Making Appointments with Customers” on page 102
“Managing the My To Do List” on page 103

“Assigning Activities to Coworkers” on page 103

“Viewing Company Coverage Team Activities” on page 104
“Creating Call Lists” on page 104

“Providing Literature Fulfillment by Email” on page 104

End users use these procedures to make appointments with customers, manage their My To Do List,
assign an activity to a coworker, create a call list, and provide literature fulfillment by email.

This chapter describes the activity procedures and functionality that are specific to Siebel Finance.
For more information about the Activities screen and about administrative tasks associated with the
Activities screen, see Applications Administration Guide.

NOTE: Only team members of the secured opportunity can view the activities that belong to secured
opportunities.

Scenarios for Managing Activities

These scenarios feature sample tasks performed by end users. Your organization may follow different
workflows according to its business requirements.

In these scenarios, end users are the account representatives and agents who manage day-to-day
interactions with customers. They enter information to:

B Make an appointment with a customer
B Manage their My To Do Lists

I Assign activities to coworkers
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B Create call lists

B Provide literature fulfillment by email

Institutional Finance Account Rep Creates a Call List

While reviewing her accounts, an account representative realizes that she should catch up with one
of her contacts at a client investor company. The representative decides to send her contact some
literature regarding new investment opportunities. To do so, the account representative goes to the
My Call List view, creates a new call list, drafts an email to one of the contacts listed in the call list,
and attaches the respective literature item.

Retail Finance Agent Creates an Activity for Customer Follow Up

An agent at a retail financial service institution receives a call from a customer inquiring about
investment products with respect to his 401(k) plan. The call center agent creates a new activity to
follow up with the customer and assigns it to an investment specialist.

Process of Managing Activities

This section details sample tasks often performed by end-users when managing contacts. Your
company may follow a different process according to its business requirements.

“Making Appointments with Customers” on page 102
“Managing the My To Do List” on page 103

“Assigning Activities to Coworkers” on page 103

“Viewing Company Coverage Team Activities” on page 104

“Creating Call Lists” on page 104

“Providing Literature Fulfillment by Email” on page 104

Making Appointments with Customers

Typically, end users use the Appointment feature to schedule meetings with their customers. From
the Activities view, end users can create appointment activities, which can be automatically added
to their calendars.

To make an appointment with a customer
1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, drill down on the desired contact.
3 Click the Activities view tab.
4

In the Activities list, add a record, and complete the necessary fields.
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5 In the Type field, select Appointment.

NOTE: You can view all activities associated with your contacts by navigating to the Activities screen
and selecting All Activities for My Contacts from the Show drop-down list.

Managing the My To Do List

In Siebel Finance, an end user’s My To Do List view shows all To Do items assigned to the end user.
End users can create these To Do items using any one of the views from the Activities screen.
Typically, end users can use their To Do Lists to help manage their daily activities.

To manage the My To Do List
1 Navigate to the Activities screen > Activity List view.

2 From the Show drop-down list, select My To Do List.
3 In the Activities list, drill down on the Type link.
4 In the To Do form, complete the necessary fields:

m  Status field. Select an appropriate value from the drop-down list, or check the Done box to
indicate the activity is complete.

m  Comments field. Explain the change to the activity information.

5 To add an attachment, click the Attachments view tab, add a record, and complete the necessary
fields.

Assigning Activities to Coworkers

End users with the appropriate responsibilities can assign activities to coworkers. This provides a
communication mechanism among coworkers to coordinate tasks. End users can create new
activities and then assign them to others, or they can assign existing activities to one another.

To assign an activity to a coworker
1 Navigate to the Activities screen > Activity List view.

2 In the Activities list, select an activity to assign.

3 In the form, for the Employees field, select one or more employees.
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Viewing Company Coverage Team
Activities

A coverage team is the group of employees that are assigned to manage the relationship with a given
company. The coverage team for a company is defined as all users who have access to the company

in the My Companies view. For more information on adding coverage team members see “Managing
Company Coverage Teams (End User)” on page 62.

To view coverage team activities involving a company
1 Navigate to the Activities screen > Activity List view.

2 In the Show drop-down list, select All Activities for My Companies.

The All My Companies’ Activities list appears, displaying all activities for the companies for which
you are on the coverage team. This list displays all activities for these companies, including your
activities and other users’ activities.

NOTE: You can view the user associated with each activity in the Users field. However, this field does
not display by default. Use the Columns Displayed dialog box to reveal the Users field.

Creating Call Lists

A call list is a tool to help end users manage customer calls related to a specific security. End users
can create call lists in the Activities and Holdings and Interests screens.

To create a call list
1 Navigate to the Activities screen > Activities List view.

In the Show drop-down list, select My Call List.
Create a new record, and complete the necessary fields.

In the Last Name field, select contacts to add to the call list.

a A W N

In the Security Symbol field, select the securities to associate with the call list.

Providing Literature Fulfillment by Email

End users can distribute literature directly to activity participants or contacts. For example, emailing
meeting minutes to everyone who attended a specific meeting.

By following this procedure, the application creates a new Activity record with Type of Literature
Distribution, and associates the same list of participants or contacts with this new activity.

104 Siebel Finance Guide Version 7.8




s I Providing Literature Fulfillment by Email

To provide a literature fulfillment by email
1

2
3

Navigate to the Activities screen > Activity List view.

In the Activities list, select the Activity record for which you want to send follow-up literature.
From the application-level menu, choose File > Send Email.

TIP: Press F9 instead of choosing the option from the File menu.

In the Pick Recipient dialog box, select one of the following values:

m  Activity Contacts. Sends an email to the external contacts associated with the activity.
m  Activity Employees. Sends an email to the employees who participated in the activity.

® None. Chooses a specific recipient.

A new email message appears.

In the From field, select a profile.

NOTE: If a default profile has been set up for the user, the From field is automatically populated
with the user’s information.

Click the Add Literature button, preceding the Check Spelling button.
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1 Financial Accounts

This section includes the following topics:
“About Managing Financial Accounts” on page 107
“Scenarios for Managing Financial Accounts” on page 108
“Process of Managing Financial Accounts” on page 109

“Financial Account Administration” on page 110

“Setting Up Household Financial Accounts Virtual Business Components” on page 113
“Reviewing Financial Accounts (End User)” on page 115

|

|

|

|

B “Working with Financial Accounts” on page 111

|

|

B “Creating Service Requests Using the GO Button (End User)” on page 116
|

“Placing Trades (End User)” on page 117

About Managing Financial Accounts

Siebel Finance provides financial institutions with a graphical interface that allows qualified
employees to access financial account information. The Financial Accounts screen provides users
with a way to view loan and deposit accounts, which includes the related contacts, balance history,
investment holdings, and investment transaction details.

The Financial Accounts screen allows companies to service the needs of retail or institutional
customers, in either a high-transaction environment, such as a consumer call center, or a higher
touch environment, such as corporate banking. Call center agents can use the Financial Accounts
screen to handle common service requests, such as inquiries about current account balances, past
transactions, or investment holdings. Corporate bankers can use the Financial Accounts screen to
answer detailed questions about complex corporate accounts and advise their clients. By monitoring
their clients’ financial accounts through this format, relationship managers are better equipped to
recognize changes in their clients’ portfolios and to identify new cross-selling opportunities.

Administrators use these procedures to create a financial account, add a new authorized user to a
financial account, and associate holdings information with a contact’s financial account.

End users use the Financial Accounts screen to:

B Create and maintain financial accounts for multiple product types, which includes loans, direct
deposits (checking and savings), market interest deposits (or money market accounts, MMA),
time deposits (or Certificates of Deposit), and more. Financial Accounts tracks the unique set of
information to describe and manage each of these account types.

B Associate additional products and services affiliated with an account. (For example, a checking
account may have lock box service, account reconciliation service, and online bank reporting.)
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B Create and maintain hierarchical account relationships, which includes relationships with
accounts held by other clients.

B Automatically generate service requests based on the type of account and associate those
requests with the primary contact and financial account.

Scenarios for Managing Financial
Accounts

These scenarios feature sample tasks performed by a financial institution’s relationship managers
and call center agents. Your organization may follow a different workflow according to its business
requirements.

In these scenarios, the Siebel administrator is responsible for administering Siebel Finance and
requires administrative responsibilities to:

B Add a financial account or a new authorized user to a financial account
B Associate holdings information with a contact’s financial account

The end users are the call center agents and relationship managers who answer customer calls. They
enter information and create service requests:

B Review financial account information

Create service requests using the Go button or place a trade

B Create a call list based on account holdings/balances
B Generate account reports
B Place a trade

Call Center Agent Provides Account Information to Customer

An agent receives a call from a customer with both brokerage and banking accounts at the financial
institution. The customer first wants to know the current balance on her checking account. After
identifying and authenticating the customer, the call center agent views each of the customer’s
accounts and locates the customer’s checking account. The call center agent reads the current
balance to the customer, who then wants to know whether a recent deposit has been posted to her
account. The call center agent confirms that the deposit was posted yesterday. Finally, the caller
wants to know the exact time and purchase price of two recent transactions in her brokerage
account. Using Financial Accounts, the call center agent locates the trades and provides the time and
value of the transactions to the customer.
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Relationship Manager Resolves Customer Service Charge Inquiry

A corporate relationship manager receives a call from a contact at one of the companies she handles.
The contact wants more details about a service charge that appeared on her company’s last financial
statement. After authenticating the contact, the relationship manager determines the type of
authority that the contact has over the account. The relationship manager sees that this contact can
sign a check, send a wire transfer, or request a loan advance. The relationship manager also sees
that the company the caller works for has significant deposit balances with the firm. After locating
the service charge the customer is calling about, the relationship manager is able to reverse the
charge based on the overall value the caller’'s company contributes to the financial institution.

Wealth Management/Brokerage Relationship Manager Creates Call
List

A wealth manager reviews the morning research and news and relates it to client account balances
and holdings information. After reviewing his clients’ portfolio and account balances, the wealth
manager creates a list of clients to call that may be interested in a particular security discussed in
that morning’s research. After contacting the client, the wealth manager sends the client a copy of
a news and research article. After receiving the customer’s consent, he conducts a trade. While on
the phone, the wealth manager schedules a portfolio review meeting, and in preparation for the
meeting, produces account summary/portfolio reports.

Process of Managing Financial Accounts

This section details sample tasks often performed by administrators and end-users when managing
financial account. Your company may follow a different process according to its business
requirements.

Administrator Procedures

The following list shows tasks administrators typically perform to manage financial accounts:
B “Financial Account Administration” on page 110

B “Working with Financial Accounts” on page 111

B “Setting Up Household Financial Accounts Virtual Business Components” on page 113

End-User Procedures

The following list shows tasks end users typically perform when managing financial accounts:
B “Reviewing Financial Accounts (End User)” on page 115

B “Creating Service Requests Using the GO Button (End User)” on page 116

B “Placing Trades (End User)” on page 117
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Financial Account Administration

This section provides those with the required administrative responsibilities, such as Siebel
administrators, with background information about financial accounts. This information is helpful for
understanding the administrative tasks described in subsequent sections.

A financial account is an instance of a financial product. For example, a checking account is an
instance of a checking product. Therefore, you must first establish a library of products in Siebel
Finance. These products should correspond to the financial account types that are being retrieved
from the back-end system. For more information about setting up products, see Chapter 16,
“Managing Products and Pricing.”

Siebel Finance provides users with information about the financial accounts in their portfolios. There
are two broad categories of financial accounts: assets and liabilities. For each of these categories,
there are also multiple account types. Siebel Finance dynamically modifies certain applets to provide
information that is specific to certain financial account products. This modification increases the
relevance of the data provided for each individual account.

For example, for Certificates of Deposit (CDs), Siebel Finance presents the user with the maturity
date and the withdrawal penalty; for loan accounts, risk-rating and payoff amounts are also
displayed. It is the Type attribute that determines the set of detailed information displayed for
financial accounts associated with the product. Types include:

Analysis Accounts
Certificates of Deposit
Credit Cards

Demand Deposit Accounts
Facility

Investments

Loans

None

Retirement

Savings and Money Market Accounts
Trust Accounts

Financial institutions can also expand the account types supported by Siebel Finance through the use
of Siebel Tools. For more information about Siebel Tools, see Using Siebel Tools.

Examples of financial account products include business checking accounts, 180-day certificates of
deposit, market interest accounts, and revolving lines of credit. An account held by a client is
considered an instance of one of these products. For example, a $1,000,000 loan can be an instance
of the revolving line of credit product.

NOTE: Many of the products offered by a financial institution will not be related to either Assets or
Liabilities.
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The ATM Card Administration view provides information about cards associated with an account. The
Siebel Finance data model allows establishing many-to-many relationships between Financial
Accounts and ATM Card records. Although the out-of-the-box ATM Card Administration view allows
users to add ATM Cards to Financial Account records, typically such transactions are accomplished
through the initiation of a Service Request to a back-end system.

Account Categories and Types

For the Financial Accounts screen to function properly, Siebel administrators must establish the
Account Category and Account Type attributes of each product.

For more information about defining products, see Product Administration Guide.

Working with Financial Accounts

In Siebel Finance, administrators can add financial accounts from the Financial Accounts screen. In
many companies, Siebel Finance is not an organization’s primary system of record for financial
accounts. Typically a system administrator loads financial account information from another system
into Siebel Finance. For more information on uploading financial account information into Siebel
Finance, see Siebel Enterprise Integration Manager Administration Guide.

To add a financial account

1 Navigate to the Financial Accounts screen > Financial Account List view.
2 In the Financial Accounts list, add a record and complete the necessary fields.

Some fields are described in the following table.

Field Comments

Status If specified as Open, then allows the financial account to appear in
Siebel eBanking.

Account # User-assigned number.

Product Indicates the product associated with the account. This selection
populates the Type field.

3  (Optional) In the Financial Account form, enter at least one contact for the account.
4 In the Team field, add users at the financial institution responsible for maintaining the account.

NOTE: Business system administrators must determine which views and types of views their users
need.

After a financial account is created, you add authorized users for the account. For each authorized
user, you define the authorization actions they can take for different categories of account use. For
example, one authorized user might be allowed to sign checks and make withdrawals and another is
only able to request wire transfers.
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To add a new authorized user to a financial account
1 Navigate to the Financial Accounts screen > Financial Account List view.

2 In the Financial Account List, drill down on the account to which to add an authorized user.
3 Click the Authorized Users view tab.
4 In the Authorized Users list, add a record, and in the Last Name field, select the contact.

Scroll down to the Authorization list, add a record and complete the necessary fields, some of
which are described in the following table.

Field Comments

Category The category of account use for which the authorization is granted, such
as wire transfer, check signing, or withdrawal.

Action The specific activity that is authorized for the category of authorization,
such as confirm, sign, or request.

Limit The dollar value limit for the specificied authorization.

NOTE: You cannot add contacts to the system in the Authorized Users view tab. Create contacts
in the Contacts screen or the Contacts Administration screen. For more information, see “Adding
Contacts” on page 79.

After a contact has been added to a financial account, you can specify that contact’s authorization
level as described in this procedure.

After adding authorized users to a financial account, administrators can associate holdings
information. Holdings information is usually only relevant to certain types of accounts, such as
Investment Accounts.

To associate holdings information with a financial account
1 Navigate to the Financial Accounts screen > Financial Account List view.

2 Click the Investment Holdings view tab.
3 In the Investment Holdings list, add a record, and complete the necessary fields.
4

In the Security Name field, select a security name you want to associate with the financial
account.
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Setting Up Household Financial Accounts
Virtual Business Components

Siebel Finance includes virtual business components. Use these virtual business components to
display financial account related data sourced from a back office or a third party system for specific
financial accounts views within the Households screen. These views include FINS IBD Holdings Model
Value - Asset Class, FINS IBD Holdings Model Value - Asset Sector, FINS IBD Household Cash Flow,
FINS IBD Household Performance, and FINS IBD Holding External. For more information on using
these views, see “Viewing and Evaluating Household Portfolios” on page 71.

In Siebel Finance, the term virtual business components refers to external data obtained from a
location other than a database table in a Siebel database, and presented in a standard Siebel user
interface. Typically, information is pulled real-time from an external database, such as a Hogan or
ALLTEL system.

These virtual business components are driven by the Siebel XML Gateway business service, which
communicates between Siebel Finance and an external data source using XML. You can configure the
XML Gateway business service using the EAlI HTTP Transport.

For more information on virtual business components, see Using Siebel Tools. For more information
on XML Gateway business service, see Integration Platform Technologies: Siebel Enterprise
Application Integration.

Configuring Virtual Business Components User
Properties

For each of the virtual business components driven by XML Gateway business service, you need to
configure these user properties in Siebel Tools:

B Service Name. The name of the business service.

B Service Parameters. Any parameters required by the business service (Optional). The Siebel
application passes this user property, as an input argument, to the business service only when
the application is attempting to load or initialize the business service.

To configure virtual business components user properties
In Siebel Tools, lock the appropriate project.

In the Object Explorer, click the Business Component folder to expand the hierarchical tree.
Select each of the following business components and define its user properties:

B FINS IBD Holdings Model Value - Asset Class

® FINS IBD Holdings Model Value - Asset Sector

B FINS IBD Household Cash Flow

B FINS IBD Household Performance

Siebel Finance Guide Version 7.8 113



Managing Financial Accounts i Setting Up Household Fi
Components

= FINS IBD Holding External VBC

4 In the Object Explorer, click the Business Component User Prop folder.
The Business Component User Properties list appears.
Choose Edit New Record to create a new blank user property record.
In the Service Name field, enter XML Gateway.
In the Service Parameters field, enter the following:

Transport=EAl HTTP Transport; HTTPRequestMethod=POST; XMLCharEncoding=UTF-16;

HTTPRequestURLTemplate=http://machine name/ virtual directory name/active server page
file

NOTE: Business component user properties are case sensitive.

For more information on XML Gateway business service, see Integration Platform Technologies:
Siebel Enterprise Application Integration.

Setting Up a Test ASP and Testing the Local Database

You can use an Active Server Page (ASP) to retrieve data from a test database and return an XML
file in Siebel format to the Siebel XML Gateway business service.

To set up an ASP and local test database

1 Install Microsoft Internet Information Server (11S) 4.0 on a local Windows machine (for example
Windows NT or Windows 2000).

2 Create a virtual directory with the name you specify. Make sure the property for the virtual
directory has write permission.

3 Create the following files in the folder to which the virtual directory points:
cashflow.asp

Perfomance.asp

ModelValueByClass.asp

ModelValueBySector.asp

holdings.asp

NOTE: For information on viewing these sample ASPs, see Appendix B, “Sample ASPs for
Household Financial Accounts Virtual Business Components.”

4 In the same virtual folder, create a test database for all the fields in a Microsoft Access database
titled mdb.mdb.
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Virtual Business Components Testing

Assuming everything is configured correctly, Table 4 describes how to verify that your virtual
business components are working.

Table 4. Testing the Virtual Business Components

Virtual Business

Component Description
FINS IBD Holdings Model View the model types for these virtual business components in the
Value - Asset Class drop-down list in the Financial Accounts, Class Allocation, and

Sector Allocation subviews in the Households screen. For more
information, see “To compare account holdings against a portfolio
model” on page 72 and “To view the selected account holdings by
sector” on page 72.

FINS IBD Holdings Model
Value - Asset Sector

After clicking Go, the application recalculates the model value at
each subview and displays the percentage for each model weight.
You can compare this with data in mdb.mdb database.

FINS IBD Household Cash View the Financial Accounts, Cash Flow, and Performance

Flow subviews in the Households screen.

FINS IBD Household For more information, see “To view expected future cash flows for
Performance selected accounts” on page 73 and “To view selected accounts’ past

performance” on page 73.

FINS IBD Holding External This virtual business component replaces FINS Holding. In
Buscomp FINS IBD Aggregated Holdings, specify which buscomp
your aggregation is based at. The business component User
Property Name is Aggregate Business Component.

Reviewing Financial Accounts (End
User)

Aside from being able to execute securities trades in the Trades view, end users typically have read-
only access to the Financial Accounts screen; therefore, most end-user tasks involve using the
Financial Accounts screen to gather information as opposed to entering data.

To review a financial account
1 Navigate to the Financial Accounts screen > Financial Account List view.

2 In the Financial Accounts list, drill down on the desired account.

3 Click a view tab to review specific financial information.
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As users review financial accounts, they can create activities for use as a call list. You can base the
selection of financial account records on a number of different criteria, such as account holdings and
balances. Users can view detailed information on a specific account, which includes minimum
balance, statement date, and current changes in the Account Analysis view tab.

To view an account analysis
1 Navigate to the Financial Accounts screen > Financial Account List view.

2 In the Financial Accounts list, drill down on the desired account.

3 Click the Account Analysis view tab.

To create a call list based on account criteria
1 Navigate to the Financial Accounts screen > Financial Account List view.

2 In the Financial Accounts list, drill down on the desired account.
3 Click the Activities view tab.
4 In the Activities list, add a record, and complete the necessary fields.

Some fields are described in the following table.

Field Comments

New Indicates a new activity.
Type Default value is Other. Select alternate value to categorize the type of
activity.

Creating Service Requests Using the GO
Button (End User)

Call center agents and relationship managers often review the Financial Accounts screen to answer
customers’ questions about their accounts. During these conversations, customers frequently
request changes to their accounts. Enter a change, such as a fee reversal or statement copy, by
clicking the GO button from the Financial Accounts screen.

The GO button allows end users to choose from a predefined list of service requests for a given
account type. After selecting the GO button, a user is automatically navigated to the view in the
Service Requests Screen to handle that type of request. The contact and account are automatically
associated with the new service request.

To create a service request using the GO button
1 Navigate to the Financial Accounts screen > Financial Account List view.

2 In the Financial Accounts list, drill down on the desired account, and click the More Info view tab.
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In the New Service Request drop-down list, select the type of service request to create, and click
GO.

In the resulting Service Request view, complete the necessary fields.

Placing Trades (End User)

End users can place securities trades using the Trades view in the Financial Accounts screen.

To place a trade

1
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Navigate to the Financial Accounts screen > Financial Account List view.
In the Financial Accounts list, drill down on the desired account.

Click the Trades view tab.

In the Trades list, add a record, and complete the necessary fields.

In the Action field, select a type of trade.

NOTE: Based on the action that is selected, another trade information form appears at the
bottom of the screen. For example, if the transaction is a stock trade, a Stock Trade form appears
and some fields are automatically filled in as you complete the fields in the Trades list.

Complete the fields in the Trades list and the related form beneath it.
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This section includes the following topics:

B “About Managing Service Requests” on page 119

B “Scenarios for Managing Service Requests” on page 120

B “Process of Managing Service Requests” on page 121

B  “Changing a Company Address or Name” on page 121

B  “Changing a Customer Address or Name” on page 121

B “Creating Service Requests (End User)” on page 122

B “Requesting Account Service in Service Requests (End User)” on page 122

B  “Changing Company Address or Name Information (End User)” on page 124

B “Changing Customer Address or Personal Information (End User)” on page 125
|

“Recording Customer Appeals or Grievances (End User)” on page 126

About Managing Service Requests

A service request in Siebel Finance acts as a container for a customer request or an account service.

Entering a service request in Siebel Finance can create an extract file. You can use the extract file to
transmit data to legacy systems.

CAUTION: This chapter assumes you have renamed Siebel Account objects to Companies. By
default, Siebel Finance installs using the term Accounts. For more information on renaming Siebel
Account objects, see Upgrade Guide.

Administrators use these procedures to change a company address, contact address, or contact
name. End users use the Service Requests screen to view and update existing requests and create
new requests. Based on the requirements of the individual making a request, users can create
service requests for companies or customers. After identifying the caller and understanding the
nature of the request, the agent takes action to complete the request. Service Requests provide
status and substatus information about the request, which closes the loop of the customer service
process.

You can save time and reduce keystrokes by using a workflow to automate steps that are repeatedly
performed by end users. For example, you can use a workflow to handle all exception processing at
a financial institution. If an exception is generated by a call center or a relationship manager, you
can route this exception automatically to the administrator for handling. For more information, see
Siebel Business Process Designer Administration Guide.
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Scenarios for Managing Service
Requests

These scenarios feature sample tasks performed by a financial institution’s call center agents,
relationship managers, and application administrators. Your organization may follow a different
workflow according to its business requirements.

Call Center Agent Creates a Service Request

A customer calls a financial institution’s call center and is routed to a call center agent. As the call
center agent is talking with the customer, she finds out that the customer wants to get a copy of a
specific account statement for one of his accounts. The call center agent talks with the customer and
gets his first name and last name. The agent also authenticates the customer with information such
as his social security number or his mother’s maiden name. After authenticating the caller, the call
center agent creates the appropriate service request.

Relationship Manager Creates a Service Request

Siebel Finance allows financial institutions’ relationship managers to have an overall view of every
aspect of their relationship with the customer. This scenario illustrates how a relationship manager
can assist a customer to address any type of customer concern.

A customer calls his relationship manager regarding some issues with his account. The relationship
manager gets his first and last name. The customer has indicated that he has a number of issues
that need to be resolved with the account. The customer requests that the relationship manager
review the status of each request and enter a new request. After authenticating the customer, the
relationship manager reviews the existing service requests with the customer and updates the
necessary information in the service requests.

Application Administrator Changes a Company Name

A client notifies her bank that her company name is changing. The organization allows only Siebel
administrators to make name changes in Siebel Finance. The organization’s policy states that the
representative taking the request should submit a service request for a name change. In addition,
the appropriate person may need to get permissions or signatures from the client’s company to send
to the Siebel administrator in order to confirm this change. The submitted service request could be
automatically sent to the Siebel administrator using a business service set up by the institution. The
administrator then determines whether the name change is approved and updates either Siebel
Finance or another computer system that feeds data to Siebel Finance.
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Process of Managing Service Requests

This section details sample tasks often performed by administrators and end-users when managing
service requests. Your company may follow a different process according to its business
requirements.

CAUTION: All Siebel Finance calculators described in this guide provide results intended for
comparison purposes only; the accuracy of the results is not guaranteed. Differences from the
expected results may be due to rounding or the mathematical formula used. Modifying the formula
can only be done by someone with the appropriate responsibilities, such as the Siebel administrator.

Administrator Procedures
The following list shows tasks administrators typically perform to manage service requests:
B “Changing a Company Address or Name” on page 121

B “Changing a Customer Address or Name” on page 121

End-User Procedures
The following list shows tasks end users typically perform when managing service requests:
B “Creating Service Requests (End User)” on page 122

“Requesting Account Service in Service Requests (End User)” on page 122

B “Changing Company Address or Name Information (End User)” on page 124
B “Changing Customer Address or Personal Information (End User)” on page 125
B “Recording Customer Appeals or Grievances (End User)” on page 126

Changing a Company Address or Name

The following procedure describes how to change a company address or name.

To change a company address or name
1 Navigate to the Companies screen > Companies List view.

2 In the Companies list, select a company.

3 In the Company form, update the company information as needed.

Changing a Customer Address or Name

The following procedure describes how to change a customer address or name.
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To change a customer address or name
1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, select a contact.

3 In the Contacts form, update the contact’s information as needed.

Creating Service Requests (End User)

There are several ways to create a new service request. Typically, service requests are created from
the Service screen, Contacts screen, Companies screen, or Financial Accounts screen.

One of the easiest ways to create a service request is within the Financial Accounts screen using the
GO button. Using the GO button, end users can choose from a predefined list of service requests for
a given account type. After selecting the GO button, a user is automatically navigated to the view in
the Service screen to handle that type of request. The contact and account are automatically
associated with the new service request. For more information on creating a service request using
the GO button, see Chapter 10, “Managing Financial Accounts.”

The Service screen allows end users to initiate a service request to change customer address and
name information so that this information can be updated in their organization’s database.

To create a service request from the Contacts screen
1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, drill down on the contact for which you want to create a service request.
3 Click the Service Requests view tab.
4 In the Service Requests list, add a record and complete the necessary fields.

For more information about service requests, see Applications Administration Guide.

Requesting Account Service in Service
Requests (End User)

The Account Services view tab in the Service screen allows end users to create service requests that
are related to an organization’s service. Available account services are described in Table 5.

Table 5. Account Services View ltems

Add Payment Schedule Creates a customer’s payment schedule.
Auto Payment / Saver Associates an auto payment request with a service request.
Bank Check Requests a replace credit card or an additional card.
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Account Service Description

Bill Pay Sign Up

Requesting Account Service in Service Requests (End User)

Account Services View ltems

Creates or changes a customer’s bill pay service with a service
request.

Card Services

Requests issuance of a bank check to a specified payee and his/her
address.

Check Copy Request

Requests a copy of a check.

Check Order

Orders additional checks.

Close Account

Closes the specified account.

Extension

Records a one-time short extension under an existing contract.

Typically, extensions are granted for up to six-months and no new
paperwork is required.

Extra Payment

Changes a customer’s monthly payment schedule or amount. You
can use the Service Request Extra Payment view to record the new
monthly payment and provide the customer with updated loan
information, such as the new term and interest saved.

Funds Transfer

Requests a funds transfer.

Interest/Fee Reversal

Reverses an interest payment or fee.

Line Increases

Increases a customer’s credit line or cash limit.

Lost/Stolen Information

Records information regarding lost or stolen items, such as credit
cards.

Lump Sum

Records a lump sum transaction and provides a customer with new
monthly terms.

This feature allows customers to:

B Reduce the amount of their monthly payment, while
maintaining the same terms, or

B Continue paying the same monthly payment while reducing
their terms

Modify Payment Schedule

Modifies a customer’s payment schedule.

New Assumption

Records a new assumption if a lease gets traded to a new party, and
this party assumes the future payments of the lease.

Payment Inquiry

Records information for customers who claim to have made a credit
card payment, but the payment has not shown up on their
statement.

Payment Promise

Records customer payment promises during a collection call or
campaign.

Payoff

Records a payoff of the lease.

Siebel Finance Guide Version 7.8 123



Managing Service Requests i Changing Company Addr

User)

Table 5. Account Services View ltems

Account Service Description

Payoff Status

Records a payoff transaction and provides customers with their
payoff amounts.

POS Support

Handles merchant requests related to credit card point of sales
(POS) equipment such as terminal repairs, paper orders, and order
signage.

Quick Pay Records check transactions as if the customer had sent the check
in as a payment. Customers can provide check information, such as
the ABA number, check number, and amount, to expedite a monthly
payment.

Re-lease Records the re-lease of the vehicle to the customer.

Redeem Points

Records information for customers who want to redeem points.

Refinance

Records the refinance request.

Statement Copy

Orders a statement copy for customers.

Stop Payment

Stops a payment.

Title Move

Records moving the title from one party to another.

Transaction Dispute

Creates a record of a customer dispute. End users can associate
disputes with notes and attachments.

Wire Transfer

Provides wire transfer information if applicable.

To request an account service using a service request

1 Navigate to the Service screen > Service Request List view.
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Create a new record and drill down on the SR #.
In the Service Request Detail form complete the necessary fields.
Click the Account Services view tab.

From the view link bar, select an account service.

For a description of the service types, see Table 5 on page 122.

NOTE: In the Account Services list, the following views have additional drop-down lists: Check
Copy Request, Extra Payment, Fee Reversal, Payoff Status, Quick Pay, Statement Copy, and Stop
Payment. From the values in these drop-down lists, end users can choose to display the list or
the more detailed form in which they can enter an account service request.

Changing Company Address or Name
Information (End User)

If users are:
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B Allowed to change company-wide address and name information, they can update the
appropriate information in the Service screen. After the information is captured in Siebel Finance,
users can use this information to update existing host systems. For more information about
updating company information, see Chapter 5, “Managing Companies.”

B Not allowed to change company-wide address and name information, they can use the Company
Address Maintenance view and the Company Name Information Change view to send service
requests to administrators responsible for updating the information.

To submit a service request to change a company’s name or address

1 Navigate to the Service screen > Service Request List view.
2 In the Service Requests list, add a record, and drill down on the SR #.
3 In the Service Request form, complete the necessary fields.
4 Then:
To... Click...
Update the company name. The Company Name Information Change view
tab.
Update the company address. The Company Address Maintenance view tab.

Changing Customer Address or Personal
Information (End User)

If end users are:

B Allowed to change company-wide address and name information, they can update the
appropriate information in the Service screen. After the information is captured in Siebel Finance,
users can use this information to update their company’s host systems.

B Not allowed to change company-wide address and name information, they can use the Customer
Address Maintenance and Personal Information Change views to send service requests to
administrators responsible for updating the information.

To submit a service request to change a customer’s address or personal information
1 Navigate to the Service screen > Service Request List view.

2 In the Service Requests list, add a record and drill down on the SR #.

3 In the Service Request form, complete the necessary fields.
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4 Then:
To... Click...
Update the customer’s address. The Customer Address Maintenance view tab.

Update the customer’s personal information. The Personal Information Change view tab.

Recording Customer Appeals or
Grievances (End User)

End users can record customer complaints.

To record a new customer complaint
1 Navigate to the Service screen > Service Request List view.

In the Service Requests list, add a record and drill down on the SR #.
In the Service Request form, complete the necessary fields.

Click the Appeals & Grievances view tab.
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In the Complaint Detail form, complete the necessary fields.
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This section describes the procedures necessary to administer and perform a needs analysis session

using Siebel Finance and includes the following topics:
B “About Managing Financial Needs Analysis” on page 127

B “Scenarios for Managing Financial Needs Analysis” on page 128

B “Administrator Financial Needs Analysis Procedures” on page 129

B “End-User Financial Needs Analysis Procedures” on page 129

B “Needs Analysis Script Creation” on page 129

B “Setting Up Product Scores” on page 129

B “Creating Investment Objectives and the Portfolio Mix” on page 130

B “Performing General Needs Analysis for Companies or Contacts” on page 132
B “Performing Investment Needs Analysis for Contacts” on page 133

|

“Generating Recommendations from a Needs Analysis Session” on page 133

About Managing Financial Needs
Analysis

Needs analysis is the process sales agents use to gather information about their customers and
recommend the best products to them. In a needs analysis, an agent asks questions and selects
answers with preassigned scores. The scores for each product are aggregated, and by clicking on the
Recommend button, an agent can recommend and cross-sell a package of products or a single
product to customers. In addition, a relationship manager can use the investment needs analysis to
recommend model fund and asset distributions for an investment portfolio.

Following the procedures in this chapter, administrators will be able to:

B Develop needs analysis scripts, which are specifically worded sets of questions. Call center
agents use these scripts in a needs-based selling process to gather information from customers
interested in learning about or purchasing a specific product. The scripts can also include pick
list values for the customer answers.

B Set up product scoring, which assigns number values to needs analysis script answers. Based on
the script answers, a needs analysis recommendation lists the products for the agent to
recommend to the customer; recommended products having higher scores more closely meet
the customer’s needs than those with lower scores.

Create investment objectives.

Create an optimal portfolio mix for asset and fund types for each investment objective.
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Following the procedures in this chapter, end users will be able to:
B Perform a needs analysis.
B Recommend products that best match customer needs.

B Recommend model fund and asset distributions for an investment portfolio.

Scenarios for Managing Financial Needs
Analysis

These scenarios feature sample tasks performed by a financial institution’s applications
administrator, a call center agent, and a relationship manager. Your organization may follow different
workflows according to its business requirements.

The Needs Analysis views within Siebel Finance allow financial institutions to capture customer
requirements in a needs-based selling process for multiple products including checking, convenience,
investment, credit, mortgage, savings, and retirement products. The views specifically support both
the individual customer as well as the business customer.

Application Administrator Creates a New Needs Analysis Script

An applications administrator is given the business requirements to create a new needs analysis
script. The administrator supports the requirements by defining the product scores for each needs
analysis question. The product scores are used to calculate and define the product recommendations.
The administrator also sets up the optimal portfolio mix and investment objectives for the
Investment Needs Analysis view.

Agent Uses Needs Analysis Script to Determine Product Requirements
A call center sales agent receives a call from a prospective new customer who is interested in opening
a checking account. The agent uses the Siebel Finance Needs Analysis script to walk the customer
through a series of questions to gather her product requirements, and to record the answers used
to calculate the best financial products for her. The agent provides the customer with key information
about the recommended checking accounts with the highest scores. The call center agent tells the
customer that she can apply for more than one product if she chooses; however, the customer
decides to go with the first product on the list, and the sales agent begins the application process
using the Auto Application feature.

Relationship Manager Uses Investments Needs Analysis Script

A relationship manager receives a call from a customer who has an investment account with the
financial institution. The customer is interested in finding out about a general investment strategy.
The relationship manager uses the Investments Needs Analysis script to walk the customer through
a series of portfolio interest, risk tolerance, investment horizon, and profile information questions to
recommend a model portfolio of assets and fund types.
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Administrator Financial Needs Analysis
Procedures

The following administrator procedures are included in this chapter:
B “Needs Analysis Script Creation” on page 129
B “Setting Up Product Scores” on page 129

B “Creating Investment Objectives and the Portfolio Mix” on page 130

End-User Financial Needs Analysis
Procedures

The following list of end-user procedures are included in this chapter:

B “Performing General Needs Analysis for Companies or Contacts” on page 132
B “Performing General Needs Analysis for Companies or Contacts” on page 132
B “Performing Investment Needs Analysis for Contacts” on page 133
|

“Generating Recommendations from a Needs Analysis Session” on page 133

Needs Analysis Script Creation

Those with the required administrative responsibilities, such as Siebel administrators, can set up and
modify needs analysis questions and the related scripts.

Before creating a script, define each question that the script will use. If you add questions to a script,
you need to add score values to the Product Scores for the questions. You also need to add the
questions to the appropriate Business Component. For example, if you are modifying a checking
account needs analysis script for a contact, then you would need to add questions to the FIN NA RET
Checking Business Component. When the user clicks the Recommend button in the script wizard to
calculate the score, changes to the script are taken into account.

For additional information about creating SmartScripts, see Siebel SmartScript Administration Guide.

Setting Up Product Scores

Administrators use the Product Scores Administration subview in the Administration - Product screen
to define the product scores associated with each of an organization’s products. You can include each
product in one or more needs analysis view.

To associate questions and scores with products
1 Navigate to the Administration - Product screen > Products view.
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In the Products list, drill down on the product for which you want to define questions and scores.

NOTE: If the product does not exist, add it. For more information about adding products, see
Product Administration Guide.

Click the Product Scores view link.

The Product Scores list displays the questions and corresponding answers that are currently
associated with a selected product.

In the Product Scores list, add a record and complete the necessary fields.

Some fields are described in the following table.

Field Description

Answer The answer given by the customer. For each possible answer the customer can
give, you can assign a score.

Question The asked question.

Score The score associated with the answer. You assign this value according to the
importance you attach to the customer’s response.

Script Name The script used for this question. You are not limited to a single script for a
product; you can use any number of the scripts listed.

NOTE: During a needs analysis session, if the sum of the product scores appears incorrect after you
click the Recommend button to select a product, check for duplicate product score questions.

To correct a script problem with a product score

1
2
3

Navigate to the Administration - Product screen > Products view.
In the Products list, drill down on the product with the script to correct.
Click the Product Scores view link.

The Product Score displays the questions and corresponding answers that are currently
associated with the selected product.

Edit the Score list.

For example, if the same question-and-answer pair appears more than one time, delete the extra
question and answer.

Creating Investment Objectives and the
Portfolio Mix

Administrators can add or modify investment objectives as well as create asset and fund portfolio
distributions in the Securities views in the Finance Administration screen.
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Several Portfolio Objectives are provided in the standard Siebel Finance application. If you need to
make changes to the assets or funds used to score the investment objectives in the Investments
subview of the Needs Analysis view in the Contacts screen, you can change the score calculations in
the FINS Investment NA Action business component by making changes to the applicable fields, such
as these:

B The Computed INV NA Score Calc field is used to calculate the average score of the first 13
questions.

B The fields Scorel to Score5 are used to convert the average score to a number divisible by 4.
B  The field Computed INV NA Score is used to calculate the final score.

You can even apply a different algorithm to compute the scores if, for example, you want to add more
questions or convert the average score to a number divisible by 3 or 5 instead of 4.

To create an investment objective
1 Navigate to the Administration - Finance screen > Investment Objectives view.

2 In the Portfolio Investment Objectives list, add a record, and complete the necessary fields.

After you create a new investment objective, you can set up the portfolio mix for the investment
objective.

To perform portfolio mix administration
1 Navigate to the Administration - Finance screen > Investment Objectives view.

2 In the Portfolio Investment Objectives list, select a portfolio investment objective to administer.

To... Add...

Add a new asset. A record in the Asset Recommendation list and complete the
necessary fields.

Add a new fund. A record in the Fund Recommendation list and complete the
necessary fields.
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Performing General Needs Analysis for
Companies or Contacts

Table 6 shows the needs analysis sessions that can be performed by product type.

Table 6. Needs Analysis by Product

Product Available For

Checking B Companies
B Contacts
Convenience B Companies
B Contacts
Credit B Companies
B Contacts
Investments B Contacts
Mortgage B Contacts
Retirement B Companies
B Contacts
Savings B Companies
B Contacts

After entering specific details in the selected Needs Analysis view, end users can prompt Siebel
Finance to recommend the best product or service for the company or contact.

To perform a general needs analysis for a company or contact
1 Navigate to the one of the following views depending on the type of needs analysis to perform:

m Companies screen > Companies List view.

m Contacts screen > Contacts List view.

In the list, drill down on a company or contact for which you want to perform a needs analysis.
Click the Needs Analysis view tab.

On the Needs Analysis link bar, select the desired type of needs analysis.

In the Needs Analysis form, add a record and complete the necessary fields.

To use a script to help determine values to enter, click Script.

In the SmartScript list, drill down on the Name link.
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Complete the questions as prompted, and click Finish.

132 Siebel Finance Guide Version 7.8



ial Needs Analyses ' Performing Investment Needs Analysis for
Contacts

9 (Optional) Click the Recommend button to generate a recommendation.

See “Generating Recommendations from a Needs Analysis Session” on page 133 for more
information on recommendations.

Performing Investment Needs Analysis
for Contacts

An investment needs analysis is similar to a general needs analysis. The results, however, are
different. After completing an investment needs analysis, a recommended mix of assets and funds
appears, based on the customer’s needs.

The Investment Needs Analysis view provides an approach to understanding the customer’s needs
and recommending an investment strategy. A script is used to guide the customer through a series
of questions. The average score from the set of answers, in conjunction with the time that the
customer may need his or her money invested, drives the model and determines the asset and fund
allocation.

To perform an investment needs analysis for a contact
1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, drill down on the contact for which you want to perform a needs analysis.

NOTE: If the contact does not exist, add it. For more information about adding contacts, see
“Adding Contacts” on page 79.

Click the Needs Analysis view tab.

Select the Investments link at the top of the Needs Analysis form.

In the Needs Analysis form, add a record and complete the necessary fields.
To use a script to help determine values to enter, click Script.

In the SmartScript list, drill down on the Name link for the script you want.

Complete the questions as prompted, and click Finish.
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(Optional) Click the Recommend button to generate a recommendation.

Generating Recommendations from a
Needs Analysis Session

After performing a needs analysis, end users can generate a list of recommended products or a
proposed mix of investments.

For more information on performing a needs analysis, see “Performing General Needs Analysis for
Companies or Contacts” on page 132 and “Performing Investment Needs Analysis for Contacts” on
page 133.
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After customers have determined the product or products they are interested in, the end user can
select the Apply field for those specific products. If it has been set up, the end user can then use the
Auto Application feature to automatically create a new application for the customer. The Application
is prepopulated with the company and product-related information already captured in this screen.
For more information about creating an application, see Chapter 13, “Managing Siebel Finance
Applications.”

You can select products recommended in all Needs Analysis views in the Contacts screen, except the
Investments view.

To generate a recommendation from a needs analysis session

1
2

Navigate to the Contacts screen > Contacts List view.
In the Contacts list, drill down on the contact for which you want to generate a recommendation.

NOTE: If the contact does not exist, add it. For more information about adding contacts, see
“Adding Contacts” on page 79.

Click the Needs Analysis view tab.
In the Needs Analysis form, select the link for the needs analysis type, and click Recommend.
Scroll down to see the generated recommendations.

For an Investment Needs Analysis, the application generates a recommended asset and fund
distribution. The Asset Distribution and Fund Distribution display information in either lists or
charts.

For other types of needs analysis, the recommendation list displays a score (a relative ranking),
a product name, and a description.

In the Recommendation list, drill down on the Product Name field to view further information
about the product.

To select a recommended product using the Apply field

If necessary, return to the generated Recommendation list based on the needs analysis.

Click to place a check mark in the Apply field to the left of each product for which the customer
wants to apply.

There is no limit to the number of products that can be selected.

NOTE: If the customer wants to apply for more than one product (for example, a checking
account and a mortgage loan), you can go to a different Needs Analysis view for each product
type desired, perform the needs analysis, and apply for additional products. When you select
Auto Application, you are taken to the Application screen, where you can fill out applications for
all the selected products.

Leave the record containing the checked Apply field.
Select Auto Application by doing one of the following:

B Click the Auto Application icon in the upper left corner.
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®m  From the application-level menu, choose File > Auto > Application.
5 In the first Application view, click the select button in the Product Name field.

The recommended products appear in the Applications view.

6 In the Products dialog box, select the Primary field for the product whose name should appear
in the Product Name field.

For more information about filling out applications, see Chapter 13, “Managing Siebel Finance
Applications.”
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S

This section describes navigating through the Siebel Finance application and defining a sequence of
views required to capture application data elements, creating sales methodologies to match business
processes, creating activity plans, and setting up correspondence and application form templates.

This section covers the following topics:
“About Managing Siebel Finance Applications” on page 137
“Scenario for Managing Siebel Finance Applications” on page 138
“Process of Managing Siebel Finance Applications” on page 139
“Setting Up Application View Navigation” on page 139
“About Auto Application” on page 141

“Upgrade Notes to Continue Using Customized Version of Auto Application Workflow” on page 142
“Viewing and Creating Applications (End User)” on page 143
“Managing Application Information (End User)” on page 146

|

|

|

|

|

B “Verifying the Run-Time Event Data for Auto Application” on page 141
|

|

|

B “Creating Small Business Loan Applications (End User)” on page 150
|

“Processing Applications (End User)” on page 152

About Managing Siebel Finance
Applications

In Siebel Finance the application process is conducted by navigating through a series of screens to
capture information for a product application. Sales representatives can create applications for
different types of banking products, such as depository, checking, savings, auto loans, mortgages,
and home equity loans. Sales representatives, customer service representatives, small business
managers, and underwriters are the primary users.

End users are sales representatives, customer service representatives, small business managers,
and underwriters within your organization. Sales representatives use the procedures in this chapter
to create new applications, enter application information for different types of products, generate
prefilled application forms, and submit applications to the back office. Customer service
representatives or small business managers use the Applications screen to check the status of an
application, update application information, and follow up on trailing documentation.

NOTE: Small business manager activities are similar to the sales representative activities, except
that the small business manager completes the applications for small business companies instead of
individual customers.
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If the application is a loan, underwriters use the procedures in this chapter to check and review the
application data, update third-party data in applications, such as credit bureau information, and
make decisions on applications.

Scenario for Managing Siebel Finance
Applications

This scenario features sample tasks performed by a financial institution’s applications administrator
and branch agents. Your company may follow different workflows according to its business
requirements.

Application Administrator Creates a New Financial Product and
Application

An application administrator receives a list of business requirements from the Product department
for a new checking product. The requirement list includes:

B The fields necessary to capture the application

B The new sales methods and their stages

B The activities to complete after the application is submitted
|

The form template for the application and the correspondence templates for this product to
complete this application

With these requirements, the application administrator determines which views have the required
fields for this product. He then defines the sequence of views in the Application Workflow view of the
Administration - Product screen.

After setting the view sequence, the administrator creates new application stages for the product.
Because it is a new product, the application stages differ from those of other products. The
administrator then sets up an activities plan to associate with the product. The activities plan allows
agents to accomplish and coordinate complex tasks by automatically creating and assigning the
appropriate follow-up activities to support the review and processing of the application. It also
provides a way to monitor the progress of these activities after the application is submitted.

The administrator then sets up the application form template in a Microsoft Word document and
associates the template with fields in the application screen. Finally, the administrator works on the
correspondence views to set up new correspondence templates for the product.

Branch Agent Prepares a Customer Application for the New Product

A branch agent assists a customer who wants to open the new checking account product. The agent
creates a new checking application by using the Next button to navigate through the application
screens and views. He also generates the activities plan for this application in order to create
activities to follow up on trailing documents, set up the review process, and call back the customer.
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Process of Managing Siebel Finance
Applications

This section details sample tasks often performed by administrators and end-users when managing
applications. Your company may follow a different process according to its business requirements.

Administrator Procedures

The following list shows tasks administrators typically perform to manage applications:
B “Setting Up Application View Navigation” on page 139

B “About Auto Application” on page 141

B “Verifying the Run-Time Event Data for Auto Application” on page 141

|

“Upgrade Notes to Continue Using Customized Version of Auto Application Workflow” on page 142

End-User Procedures

End users can create applications in a variety of ways, using various screens and views. Typically,
they create applications using the Auto Application feature, or they navigate to the Applications
screen to create a new application record and then fill in the required information.

The following list shows tasks end users typically perform when managing applications:
B  “Viewing and Creating Applications (End User)” on page 143

B “Managing Application Information (End User)” on page 146

B “Creating Small Business Loan Applications (End User)” on page 150

|

“Processing Applications (End User)” on page 152

Setting Up Application View Navigation

Setting up an application view navigation allows end users to use the Next button to navigate through
the screens required to complete an application in Siebel Finance. This view navigation can include
views from screens other than just the Applications screen, although navigation is restricted to the
current screen. The Next button is supported by the FINS Application View Navigation Service
business service. For more information on this business service, see “FINS Application View
Navigation” on page 299.

The application view order varies from product to product; therefore, you will need to set up the view
order for every product for which your agents will fill out applications. As an administrator, you set
up the view order using the Application Workflow view in the Administration - Product screen.
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The view order determines the next view the agent sees when filling out one or more applications
for a customer in a single session. For instance, the view order of a basic checking application may
use the following views in the following order: Applicant, Income Sources, Check Order, and Funding.
If the end user manually starts in the Income Sources view, then clicks the Next button, the next
view to appear is the Applicant view. The Application view sequence for the checking application
process then follows the sequence for basic checking that was set in the Application Workflow
Administration view.

NOTE: If the product does not exist, add it. For more information about adding products, see Product
Administration Guide.

To set up an application view navigation
1 Navigate to the Administration - Product screen > Products view.

2 In the Products list, drill down on the product for which you want to set up an application
workflow.

In the More Info form, from the Show drop-down list, select Application Workflow.
In the Application Workflow list, add a record.

In the Add View Order dialog box, select a view to add to the workflow.

o 00 A~ W

To change the view order of a view, change the Sequence Number in the Application Workflow
list.

7 Continue adding views an end user needs to complete an application.

Sales Method Creation and Modification

Sales methods consist of various stages from start to finish. Depending on the specific sales method,
the stages can differ. The sales method should map to the product type. Each product type may have
a different set of stages for review and approval. For example, depository products will not have an
underwriting stage that credit products might. For information on creating a sales method and
setting up sales stages, see Applications Administration Guide.

Activity Plans Set Up

For information about creating an activity plan, see Applications Administration Guide.

Correspondence Set Up

For information on setting up correspondence, see the chapter on Correspondence in Siebel
Correspondence, Proposals, and Presentations Guide.
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Application Form Template Creation

For information on creating application form templates, see the section on creating proposal
templates in Applications Administration Guide.

About Auto Application

Auto Application allows end users to create application records automatically from the Contact,

Companies, and Products screens. End users access the Auto Application icon on the toolbar in those
three screens.

Auto Application uses the Data Transfer Utility (DTU) business service to transfer fields from one view
to another view. For more information on DTU, see “Using Data Transfer Utilities (DTU)” on page 271.

NOTE: Previous versions of Siebel Financial Services used a workflow to automatically place three
run-time events associated with Contact, Internal Products, and Account. The Auto Application
Workflow has been retired and removed from the seed data. Instead of using workflow, the
invocation is defined by seed data run-time events and action sets. See “Verifying the Run-Time Event
Data for Auto Application” on page 141 to learn how to set this up.

Verifying the Run-Time Event Data for
Auto Application

For new Siebel Finance 7.7 and higher installations, Auto Application is configured to automatically
invoke the DTU business service through seed data run-time events and action sets. There are no
additional steps you need to take to activate the function.

However, if you have upgraded from a previous version before 7.7 and you want to use the DTU
invocation method, you should:

1 Verify the seed data run-time events and action sets.

2 Remove the Auto Application workflow.

To confirm you have the Siebel Finance 7.7 and higher seed data
1 Navigate to the Administration - Runtime Events > Action Sets.

2 Query for Action Sets named:

FINS DTU Auto

3 Select each record returned, and verify in the Actions list that only one action named DTU is
listed.

If any additional actions are listed, deactivate them by deselecting the Active checkbox.

4 Select the Events view link.
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5 In the Events list, query for Subevents named:
EventMethodAutoApplication

6 Check that the Action Set Name for each record returned is as shown in the following figure;
make any adjustments as necessary.

Opportunities [Tl Administration - Runtime Events

Action Sets Event Aliases Events
Wenu v 1-30f3 | K@
Sequence Object Type Object Name Event Subevent . Action Set Name Na

> BusComp Account E Autospplication FINS DTU Auto Application - Account Action Set

-1 BusComp Contact Invw E AutoApplication FINS DTU Auto Application - Contact Action Set

-1 BusComp Internal Product  Inv E utoApplication  FINS DTU Aute Application - Internal Product Action Set

7/ Refresh the run-time event by selecting Reload Runtime Events from the Events menu.

To deactivate the auto application workflow
1 Navigate to the Administration - Business Process screen > Workflow Deployment view.

2 In the Active Workflow Processes list, query for a workflow named:
Auto Application Workflow

3 If your query returns an active workflow, deactivate it using the Active Workflow Processes menu
item Deactivate Process.

Upgrade Notes to Continue Using
Customized Version of Auto Application
Workflow

If you wish to continue to use your customized version of Auto Application workflow, you need to
modify the actions in the actions sets to route the actions to the workflow.

To route actions to the Auto Application workflow
1 Navigate to the Administration - Runtime Events screen > Events List view.

2 In the Events list, query for Subevents named:
EventMethodAutoApplication

3 Delete the three run-time event records as shown in Step 6 in “To confirm you have the Siebel
Finance 7.7 and higher seed data” on page 141.

4 Upgrade the workflow and activate it.

See Siebel Business Process Designer Administration Guide for details.
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5 Check the run-time events by following Step 4 through Step 6 in “To confirm you have the Siebel
Finance 7.7 and higher seed data” on page 141.

The action set names are not necessarily the same as described. They might be called something
like Workflow XXX. Drill down into each action set.

6 For each action set, there should be one action item that invokes the Auto Application workflow
you just activated. Define the action as shown in the following table.

Field Value

Action Type BusService

Business Service Name Workflow Process Manager
Business Service Method RunProcess

Context "Processld", "42-4PVA1"

The actual workflow process ID may be
different.

7 If there are other items in the action list, deactivate them.

8 Refresh the run-time events by selecting Reload Runtime Events from the Events menu.

Viewing and Creating Applications (End
User)

The Siebel Finance Applications screen provides access to consumer and small-business applications.
The Applications list displays information about applications, such as applicant address, phone
number, and application stages. End users can use the Applications screen to locate, view, and
update applications.

To access the Applications view from the Contacts screen
1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, drill down on the desired contact.
3 Click the Applications view tab.
4

To view more detailed information about an application, in the Applications list, drill down on the
application Name link.

To access the Applications view from the Companies screen
1 Navigate to the Companies screen > Companies List view.

2 In the Companies list, drill down on the desired company.
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3 Click the Applications view tab.
The Applications list displays applications associated with the selected company.

4 To view more detailed information about an application, in the Applications list, drill down on the
application Name link.

To create an application
1 Navigate to the Applications screen > Application List view.

2 In the More Info form, add a record, and complete the necessary fields.

Some fields are described in the following table.

Field Comments

Product Name Indicates the product or products for this application.

Stage Indicates the application status. This value changes according to the
Method selection.

NOTE: Only those with the required administrative responsibilities, such as Siebel
administrators, can set the Sales Stage and Sales Method values in the Siebel Assistant
Administration screen, Sales Method view. For more information, see Applications Administration
Guide.

Navigating Applications Using the Next Button

Siebel Finance allows end users to create an application with multiple products. When filling out an
application with multiple products, end users can move from one view to the next view by clicking
the Next button instead of selecting a view tab. Based on the views that have been set up for each
specific application (for example, a savings account application or a mortgage loan application),
Siebel Finance automatically navigates users to the views they need to fill in.

With the Next button functionality, users do not have to fill out the same view more than one time,
even if the same view appears in several product applications. For more information on creating
multiple applications from performing needs analyses, see Chapter 12, “Managing Financial Needs
Analyses.”

NOTE: Only Siebel administrators can set up a Next Button Application Workflow. For more
information, see “Setting Up Application View Navigation” on page 139.

To complete an application using the Next button
1 Navigate to the Applications screen > Application List view.

2 In the Applications list or form, create a new record, and complete the appropriate fields.

NOTE: A product must be selected in the Product field in the Application form to use the Next
button to navigate to another view.
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3 Click the Next button in the Applications form.

The next application view appears with the uncompleted fields required for the customer’s
application.

4 Continue filling in application views and clicking the Next button in the Applications form.

Creating Applications Using the Auto Application
Feature

The Auto Application feature is available in the following screens in Siebel Finance:

B Contacts
B Companies
B Products

End users can use the Auto Application feature to automatically create an application using
information from the selected record. For example, in the Companies screen, end users can select
the Auto Application option from the application-level menu (File > Auto > Application) to
automatically create and populate the application using the information from the selected company.

To create an application using the Auto Application feature
1 Navigate to the Companies screen > Companies List view.

2 Select the company for which you want to create an application.

NOTE: If the company does not exist, add it. For more information on adding companies, see
“Adding Companies and Investors (End User)” on page 58.

3 Select Auto Application by doing one of the following:
m  Click the Auto Application icon in the upper left corner
m  From the application-level menu, choose File > Auto > Application
The first required Application view appears.

4 In the Product Name field in the Application form, click the select button, and then select a
product for which you want to apply.

5 Complete the remaining Application fields using the Next button.

NOTE: You can also use the Auto Application feature from the Contacts and Products views.

Assigning Applications to Coworkers

After an application has been saved, an end user can assign an application to a coworker. The
assignment can be done from the Applications screen by:
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B Implementing an assignment button and using Siebel Assignment Manager. For more information
on Assignment Manager, see Siebel Assignment Manager Administration Guide.

B Using the Approval business service. See “Automating Approval Processing” on page 286.

NOTE: The application does not have to be complete to assign it.

Managing Application Information (End
User)

In Siebel Finance, end users can capture the following types of applicant information:

Details about the products in the application
Details about the applicant
Reference information

Collateral information

Mortgage information
m Documents submitted by applicants

NOTE: Typically, end users would click the Next button to move between views and capture this
detail information. For more information, see “Navigating Applications Using the Next Button” on
page 144 and “Setting Up Application View Navigation” on page 139.

Adding Product Detail Information

End users use Product Detail subviews to capture information about the products in the application.
Siebel Finance supports multiple products under one application.

To add product detail information
1 Navigate to the Applications screen > Applications List view.

2 Drill down on an application, and click the Account Setup view tab.
3 On the Account Setup list, select one of the following view links:
Account Funding

Account Services

Check Order

Credit Card

Debit card & CD

Loan Servicing

Loan Terms
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®m Mortgage Detail

4 In the Product Detail list, select a product.

5 In the subviews, complete the necessary fields.

Adding Applicant and Guarantor Information

End users use the Applicant view to record the name and address information specific to the primary,
secondary, and guarantor applicants.

The Applicant view has additional subviews to add other information about:
B Co-applicant

B Applicant and Co-applicant security

B Employment

NOTE: The Applicant Info and Applicant Security Info views show information on the primary
applicant only. The Co-applicant Info and Co-applicant Security Info views show information on the
rest of the applicants.

To add applicant information
1 Navigate to the Applications screen > Applications List view.

2 Drill down on an application, and click the Applicant view tab.
3 In the Applicant Details list, add a record for all applicants.
4 In the Applicant Type field, select the appropriate applicant type:
B  Primary
m Secondary
m  Guarantor
m  Joint
m  Authorized Signer

5 Complete the necessary fields for each applicant.

To create an updated statement
Navigate to the Applications screen > Applications List view.

Drill down on an application, and click the Applicant view tab.

Siebel Finance Guide Version 7.8 147



Managing Siebel Finance Applications ' Managing Application In

3 In the Applicant list, click Create Statements.

If the applicant has an existing financial statement, then the Siebel application copies the latest
financial statement into the Consumer Detail view.

Financial statements are automatically created for the applicant and co-applicant. These
statements are used in the Consumer Detail view, as described in “Adding Consumer Detail
Information” on page 148.

NOTE: The Create Statements button only performs this function if the applicant has an existing
financial statement.

Adding Consumer Detail Information

From the Consumer Detail view in the Applications screen, end users can create or view one of many
financial statements for a customer. In Siebel Finance, the Financial Statement is used to manage
consumer detail information. A financial statement is a snapshot of the customer condition at a
certain point in time.

For example, a customer applies for a product today; the end user creates a financial statement with
all customer detail, such as income sources, assets, and liabilities. If the customer applies for
another product in three months, the end user can pull the same financial statement, and Siebel
Finance will prefill all customer details. The end user can then ask the customer if that information
has changed since the last time. If the information has changed, the end user can make a copy of
the old Financial Statement and modify it. Using the copied financial statement, the end user does
not need to type the consumer information again.

To add consumer detail information
1 Navigate to the Applications screen > Applications List view.

2 Drill down on an application, and click the Consumer Detail view tab.
3 From the Consumer Detail link list, select the following subviews:
E Credit Information. Records credit information for all applicants.

B Income & Expenses. Records income and expense information about the primary and
secondary applicants.

m Assets & Liabilities. Records the current asset holding and liabilities of all applicants.
E Real Estate. Records applicant real estate holdings.

E Residence Information. Records residency information for all applicants.

In the Financial Statements list, select an existing statement or add a new one.

5 In each subview list or form, add records and add additional details as necessary.
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Adding Reference Information

Some product applications require reference information from the applicant. Users can use the
Reference view to capture this information.

To add reference information
1 Navigate to the Applications screen > Applications List view.

2 Drill down on an application, and click the Reference view tab.

3 In the Reference list, complete the necessary fields.

Adding Collateral Information

End users can use the Real Estate Collateral, Vehicle Collateral, and Other Collateral views to track
collateral information. For consumer loans, collateral typically consists of real estate, automobiles,
bonds, and cash.

To add collateral information
1 Navigate to the Applications screen > Applications List view.

2 Drill down on an application, and click one of the following view tabs:
m Real Estate Collateral
m  Vehicle Collateral
m  Other Collateral

3 In the collateral list, add a record and complete the necessary fields.

NOTE: To select collateral to add to the application, the collateral must first be defined as an
asset in the Financial Position view. For more information about adding assets, see “Adding
Consumer Detail Information” on page 148.

Reviewing Product Disclosure Information

As part of the application process, an agent is required to read general and product disclosure to
customers, and record whether or not customers have read and understood them. Using the
Compliance view, end users can record this information.

To capture a product-specific disclosure, please see “Automating the Display of Disclosure Documents”
on page 290.

To capture general disclosure information
1 Navigate to the Applications screen > Applications List view.
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2 Drill down on an application, and click the Compliance view tab.

3 In the disclosure form, complete the necessary fields.

Reviewing Closing Requirements

The agent should review closing requirements before submitting the application. The closing
requirement lists all requirements that the customer needs to provide, or agents need to do, before
the further processing and closing the product application.

Please see “Requirements Manager” on page 248 to set up the Closing Requirements view.

Managing Documents

After the agent captures all information on the application, he can then generate a custom
application form with application data already prefilled by Siebel Finance. He can also attach any
additional documents related to the application, and send any required correspondence to the
customer.

End users may use the following subviews under the Application Document view to manage
documentation related to applications:

B Attachment. Attach additional documents related to an application.

B Correspondence. Capture correspondence information, which includes template, recipients,
and enclosures. For more information on setting up and generating correspondence, see Siebel
Correspondence, Proposals, and Presentations Guide.

B Documents. Produce custom application form with data prefilled from the Siebel database. For
more information on setting up and generating proposals, see Siebel Correspondence, Proposals,
and Presentations Guide.

Creating Small Business Loan
Applications (End User)

To create a small business loan application, end users need to record the following customer
information:

B Business Details. Records the business name, address, and contact information as well as asset
information, liabilities, income statements, and cash flow. For more information, see “Adding
Business Details” on page 151.

B Applicant Information. Captures personal information about the primary, secondary, and
principle loan applicants. For more information, see “Adding Applicant and Guarantor Information”
on page 147.
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Guarantor and Applicant Employment Details. Captures loan guarantor information and
applicant employment, income, assets, and liabilities information. For more information, see
“Adding Consumer Detail Information” on page 148.

Unique Product Features and Terms. Records unique loan features or terms. For more
information, see “Recording Unique Features and Terms” on page 152.

Business Services. Manages business service information for an application. For more
information, see “Managing Business Services Information” on page 152.

NOTE: Typically, users would click the Next button to move between views and enter this customer
information. To create an application view navigation, a Siebel administrator would need to create a
view workflow that follows the views described in this section. For more information, see “Navigating
Applications Using the Next Button” on page 144 and “Setting Up Application View Navigation” on
page 139.

Adding Business Details

End users use the Business Details view to track detailed information about a business applying for
a small business loan. Siebel Finance automatically populates some of the information in this view
from Companies Profile view tab. In addition to the business profile information, users use this view
to capture financial information such as income statement, balance sheet and cash flow statement.

To add small business details

1

2
3
4

Navigate to the Applications screen > Applications List.
In the Applications list, drill down on an application.
Click the Business Detail view tab.

From the Business Detail link list, select the following subviews, and complete the necessary
fields:

m Business Profile. Records the business name, phone numbers, and addresses.

m Assets. Captures company asset information, including cash, accounts receivable, inventory,
fixed assets, and depreciation values.

m Liabilities. Records company liabilities such as accounts payable, long term debt,
noncurrent debt, capital stock, and retained earnings and treasury.

®m Income Statement. Captures income information such net sales, cost of goods sold, other
income, expenses, interest, depreciation, taxes, dividends, and adjustments.

m Cash Flow. Records cash flow statements based on customer balance sheet and income
statement information.
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Recording Unique Features and Terms

End users use the Loan Terms subview to record special features and terms about the small business
loan.

To record loan features and terms
1 Navigate to the Applications screen > Applications List view.

Drill down on an application, and click the Account Setup view tab.
From the link list, select Loan Terms.

In the Loan Terms list, select a product.

a b W N

In the Loan Terms form, complete the necessary fields.

Managing Business Services Information

End users can use the Business Services views in the Applications screen to add, modify, copy, or
delete business service application information.

To add business services
1 Navigate to the Applications screen > Applications List view.

2 Drill down on an application, click the Business Services view tab.
3 In the Business Services list, from the link list, select one of the following subviews:
m  Business Payroll
B Business Tax Service
®m Merchant Card Accepted
m  Merchant Card Location
m Merchant Card Services
In the list for the associated subview, select a business service product.

5 Complete the necessary fields.

Processing Applications (End User)

After the application information is captured in “Managing Application Information (End User)” on
page 146 and “Creating Small Business Loan Applications (End User)” on page 150 and submitted, the
processing agent or underwriter may perform any of the tasks described in the following sections to
process an application:

B “Viewing Assigned Applications” on page 153
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“Assessing Applications” on page 153

“Ordering and Viewing Reports” on page 154

“Viewing Decisions on Applications” on page 154

“Capturing Regulation C Compliance Information” on page 154

“Adding Closing Activities” on page 155

“Creating and Modifying Trailing Documents” on page 155
“Creating Notes About Applications” on page 155

NOTE: Typically, end users would click the Next button to move between views, and process the
application. To create an application view navigation, a Siebel administrator would need to create a
view navigation for processing an application. For more information on setting up an application view
workflow, see “Setting Up Application View Navigation” on page 139.

Viewing Assighed Applications

After users have been assigned an application for processing, they can view their applications in the
My Applications list.

Use the Application screen for application assignment by:

B Implementing an assignment button and using Siebel Assignment Manager. For more information
on Assignment Manager, see Siebel Assignment Manager Administration Guide.

B Using the Approval business service. See “Automating Approval Processing” on page 286.

To view assigned applications
1 Navigate to the Applications screen.

2 From the visibility filter, select My Applications.

The Applications list appears displaying the applications that are assigned to the current user.

Assessing Applications

Application assessment is done by using:

B Assessment view. The processing agent or underwriter can use the Application Assessment
view to make application assessments, as to whether or not the application should be approved.
For more information on assessment templates, see Applications Administration Guide.

B Integration to decisioning system using Siebel integration method. You can configure
integration to a legacy system or a decisioning system. For more information, see Overview:
Siebel Enterprise Application Integration.
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Ordering and Viewing Reports

During the processing of an application, the processing agent or underwriter might need to order
reports such as appraisal or credit report. The agent can use the Report view to order such reports.

To enter report information
1 Navigate to the Applications screen > Applications List view.

2 Drill down on an application, and click the Reports view tab.
3 In the Report list, create a new record and complete the necessary fields.
4 Scroll down to the Report Detail list, and enter detail information for the selected report.

NOTE: For information on how to integrate Siebel Finance with third-party systems, such as a credit
bureau system to automatically prepopulate the fields, see Overview: Siebel Enterprise Application
Integration.

Viewing Decisions on Applications

The processing agent or underwriter uses the Decisioning views to see decisioning information from
the back-end or decisioning system. End users see the financial and product information by
accessing:

B Decisioned Financial view to view insurance, fees, and cost borrowing information.
B Decisioned Product view to view to see the approved product terms and conditions.

NOTE: These views are virtual business components and need to be configured before they can be
used. For more information, see “Setting Up Household Financial Accounts Virtual Business
Components” on page 113.

Capturing Regulation C Compliance Information

If the loan is declined, the processing agent or underwriter needs to enter the reason of the decline
for regulation C reporting. The agent uses the Regulation C view to capture the information.

To enter regulation C information
1 Navigate to the Applications screen > Applications List view.

Drill down on an application, and click the Compliance view tab.
In the Compliance list, select the Regulation C Information view link.

In the Product list, select the product that is being declined.

a A W N

In the Regulation C Information form, complete the necessary fields.
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Adding Closing Activities
End users use the Closing Activities view to record all closing activities associated with the currently

selected application.

For more information on activities and activity plans, see Chapter 9, “Managing Activities.”

To add closing activities associated with an application
1 Navigate to the Applications screen > Applications List view.

2 Drill down on an application, and click the Closing Activities view tab.

3 In the Activities list, add a record and complete the necessary fields.

Creating and Modifying Trailing Documents

Some applications, such as those for mortgages, require documentation from the applicants. End
users can use the Trailing Documents view to track documents to be provided by the applicants. After
they set the target date for a trailing document, Siebel Finance, with the help of business processes,
creates activities to remind them to call the applicant to provide the necessary document, expediting
the approval process.

NOTE: For more information on setting up a workflow, see Siebel Business Process Designer
Administration Guide.

To add trailing documents
1 Navigate to the Applications screen > Applications List view.

2 Drill down on an application, and click the Closing Activity view tab.
3 Select the Trailing Documents view link.
4

In the list, add a record for each trailing document to track.

To view outstanding trailing documents
B Navigate to Applications > My Outstanding Documents view.

Creating Notes About Applications

As the processing agent or underwriter works with an application, they might want to enter notes

about the application. End users can create notes that everyone with access to the application record
can see, or they can create notes that only they can see.
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To
1

2
3
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create a note regarding an application
Navigate to the Applications screen > Application List view.

Drill down on the desired application, and click the Notes view tab.
From the Notes link view bar, select one of the following:

B Public Notes. Notes that others can see.

m Private Notes. Notes that only their creators can see.

In the Notes list, add a record and complete the necessary fields.

TIP: Click Check Spelling to check the spelling in your note.
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This section includes the following topics:

About Managing Commercial Loans

This chapter presents the procedures necessary to create, maintain, and process a commercial loan
request in Siebel Finance. The commercial loan request process involves navigating through a series
of screens used to capture client and facility information. Loan officers, credit committee team
officers, and administrators are the primary users.

“About Managing Commercial Loans” on page 157

“Scenarios for Managing Loan Requests” on page 158

“Process of Managing Commercial Loans” on page 160
“Activating Loan Request Workflows” on page 161
“Assessment Templates for Loan Approvals” on page 161
“Activities Plan for Loan Requests” on page 162

“Document Template for Loan Requests” on page 162

“Setting Up Approval Levels” on page 162

“Setting Up Portfolio Types for Commercial Loans” on page 163
“Associating Facilities with Financial Accounts” on page 164
“Creating Commercial Loan Requests (End User)” on page 165
“Setting Up Facilities (End User)” on page 167

“Syndicating Facilities (End User)” on page 167

“Setting Pricing and Fees for Facilities (End User)” on page 168
“Adding Guarantors to Loan Facilities (End User)” on page 168
“Adding Covenants to Facilities (End User)” on page 169
“Adding Collateral to Loan Facilities (End User)” on page 170
“Creating Policy Exceptions (End User)” on page 170
“Reviewing Underwriting Standards for Loan Requests (End User)” on page 171
“Reviewing Group Exposure (End User)” on page 171

“Entering Credit Decisions for Commercial Loans (End User)” on page 172

“Assigning Loan Requests (End User)” on page 172
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Use these procedures to perform the administrator tasks of defining assessment templates, activities
plans, documents templates, commercial loan approval stages, the contacts required to approve a
commercial loan, portfolio types for a commercial loan, and underwriting standards.

End users are commercial loan and credit committee officers. Commercial loan officers will use the
procedures in this chapter to:

Create new commercial loan requests
Create additional borrowers for a loan
Create a facility

Associate facilities with borrowers
Create bank syndication for a facility
Set the pricing and fees for a facility
Capture the guarantors for a facility
Create covenants for a facility

Copy covenants to a facility

Set up collateral for a facility

Create and review policy exceptions for borrowers and facilities

Review group lending exposure

Review underwriting standards

Submit a loan request to a credit committee

Credit committee officers will use the procedures in this chapter to:
B Check and review the data in a loan request

B Make decisions on a loan request

B Assign a loan request to the next person on the credit committee

Scenarios for Managing Loan Requests

These scenarios feature sample tasks performed by a financial institution’s applications administrator
and commercial bankers. Your company may follow different workflows according to its business
requirements.

In these scenarios, the applications administrator is responsible for setting up approval stages and
underwriting standards. He requires administrative responsibilities to:

B Set up an assessment template and activities plan
B Create a document template

B Set up an approval level
|

Define portfolio types and underwriting standards
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End users are loan officers and credit administrators. They enter information to:
B Create a loan request

Create a facility for borrowers

B Attach a company and financial needs analysis to the loan request
B Choose a loan approval level
B Assign the loan request to a credit committee

Administrator Sets Up Approval Stages and Underwriting Standards

An administrator receives a request to set up two new loan approval stages and add a new
underwriting standard for a chemical portfolio. The request specifies that a loan smaller than one
million dollars requires two approval stages, whereas a loan larger than one million dollars requires
three approval stages. The administrator sets up the following two approval levels:

B Level A for a loan less than one million
B Level B for loans greater than one million

He also sets up the individuals who are responsible for approving each stage of the loan. Finally, the
administrator sets up the new underwriting standard.

Loan Officer Creates New Loan Request

A loan officer receives a call from a chemical company that wants to borrow 1.25 million dollars for
working capital. She creates a new loan request and then sets up a working capital facility. The officer
determines the price and fees, collateral, covenants, and policy exceptions for this facility. She then
attaches the company analysis and financial statement to the loan request.

When the loan officer chooses the chemical portfolio, the underwriting standard that is set by the
administrator automatically appears. The loan officer chooses approval level B for the loan and
selects the credit committee name for each stage.

Credit Committee Officer Reviews Loan Request

A credit committee officer reviewing her loan requests sees that there is a loan request in the queue
waiting for her approval. She reviews the loan request details and the attachments that contain
company and financial analysis. She decides to approve the credit. After adding her decision and
comments to the loan request, the credit committee officer sends the request to the next credit
committee officer for the officer’s approval.

Credit Administrator Sets Up Capital Facility

A credit administrator looks at his queue and sees that one request has been approved. The
administrator prints the credit summary with the decision and adds it to the company’s credit file.
The administrator then sets up the working capital facility that has been approved.
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Process of Managing Commercial Loans

This section details sample tasks often performed by administrators and end-users when managing
commercial loans. Your company may follow a different process according to its business
requirements.

Administrator Procedures

The following list shows tasks administrators typically perform to manage commercial loans:
“Activating Loan Request Workflows” on page 161

“Assessment Templates for Loan Approvals” on page 161

“Activities Plan for Loan Requests” on page 162

“Document Template for Loan Requests” on page 162

“Setting Up Approval Levels” on page 162

“Setting Up Portfolio Types for Commercial Loans” on page 163

“Associating Facilities with Financial Accounts” on page 164

End-User Procedures

The following list shows tasks end users typically perform when managing commercial loans:
“Creating Commercial Loan Requests (End User)” on page 165

“Setting Up Facilities (End User)” on page 167

“Syndicating Facilities (End User)” on page 167

“Setting Pricing and Fees for Facilities (End User)” on page 168

“Adding Guarantors to Loan Facilities (End User)” on page 168

“Adding Covenants to Facilities (End User)” on page 169

“Adding Collateral to Loan Facilities (End User)” on page 170

“Creating Policy Exceptions (End User)” on page 170

“Reviewing Underwriting Standards for Loan Requests (End User)” on page 171
“Reviewing Group Exposure (End User)” on page 171

“Entering Credit Decisions for Commercial Loans (End User)” on page 172

“Assigning Loan Requests (End User)” on page 172
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Activating Loan Request Workflows

For the commercial loan processes to work correctly, you must activate two workflows.

B FINS Commercial Loan - Populate Company Group Name. This workflow makes sure that the
Parent Account value is kept up to date as the Account value is modified.

B FINS Commercial Loan - Refresh Company Group Name. This workflow is called to refresh the
user interface as the Parent Account value is changed.

To activate the commercial loan request workflows
1 Navigate to the Administration - Business Process screen >Workflow Deployment view.

In the Repository Workflow Processes list, use a query to find all processes where the Name
begins with FINS Commercial Loan.

NOTE: You can query on FINS Commercial Loan.
3 To activate each of the two workflows processes listed:
a  Select the workflow process record.
b Click Activate.
4 To verify that the workflow is active:
a In the Active Workflow Processes list query for Name = FINS Commercial Loan.

b Confirm the value in the Deployment Status field = Active.

To reload runtime events
Navigate to the Administration - Runtime Events screen > Events view.

From the menu, select Reload Runtime Events.

Assessment Templates for Loan
Approvals

The assessment template must be set up so that end users can assess loan requests to determine
whether they need to go through the approval process. Some loan requests, with adequate
assessment scores, may not be required to go through the approval stages. After an administrator
sets up the assessment templates, end users can select the appropriate one and enter the answer
for each attribute. Based on the answers, the final score is calculated.

For more information on setting up an assessment template, see Applications Administration Guide.
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Activities Plan for Loan Requests

You must set up the activities plan so that end users can accomplish and coordinate complex tasks.
The activities plan creates a set of activities for the loan request. The end user can select a particular
activities plan template, and let the Siebel application execute or prompt the user for those activities.

For more information about creating an activity plan, see Applications Administration Guide.

Document Template for Loan Requests

You must set up the document template so that end users can print a prefilled document. After the
administrator sets up the document templates, end users can select the appropriate template, which
is automatically populated with information from the Siebel Finance database.

For more information on creating document form templates, see the section on creating proposal
templates in Applications Administration Guide.

Setting Up Approval Levels

Siebel Finance supports an automated commercial loan approval process. The administrator is
responsible for setting up a financial institution’s approval levels and the corresponding approval
stages. For example, an administrator may set two approval levels: one for commercial loans under
one million dollars, the other for commercial loans over one million dollars. The approval level
assigned to a loan request depends on the details of the loan.

To set up the approval level for a commercial loan
1 Navigate to the Administration - Finance screen > Commercial Loan view.

2 Click the Approval Administration view tab.

3 To create a new approval level, add a record in the Approval Level list, and complete the
necessary fields.

Some fields are described in the following table.

Field Comments

Approval Level Name for the approval level.

Description Describes which loans should be used with the approval level.
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4 To add an approval stage, add a record in the Approval Administration list, and complete the
necessary fields.

Some fields are described in the following table.

Field Comments

Executive Indicates the contacts to add to the approval stage.

Stage # Shows the stage number.

NOTE: Modify an existing approval level by selecting a record in the Approval Level list, and
updating the associated records in the Approval Administration list.

Setting Up Portfolio Types for
Commercial Loans

Using the Portfolio Administration view, administrators can set up the commercial loan portfolios that
are used to group similar types of commercial loans. For example, an administrator may set up
Automobile, Manufacturing, and Chemical portfolio types.

In this view the administrator can also set the limit and utilization of each portfolio type. For
example, an administrator may set the limit for an automobile portfolio at 100 million dollars. As a
result, the organization’s combined loan total for the automobile industry should not exceed 100
million. The utilization captures how much the bank already lends to the automobile industry.

After the appropriate portfolios are set up, end users can then review the portfolios in the Request
Summary view to see the financial institution’s exposure in each industry.

To set up a commercial loan portfolio
1 Navigate to the Administration - Finance screen > Commercial Loan view.

2 Click the Portfolio Administration view tab.

3 To create a new portfolio type, add a record in the Loan Portfolio Type list, and complete the
necessary fields.

NOTE: Modify an existing portfolio by selecting a record in the Portfolio Administration list, and
updating the record as needed.

Some fields are described in the following table.

Field Comments

Limit Financial organization’s limit for combined commercial loans in this
portfolio.
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Field Comments

Portfolio Type Name for the portfolio.
Utilization Captures the current exposure of the financial organization within the
portfolio.

After setting up the appropriate portfolios for commercial lending, administrators can add
underwriting standards to the portfolios. These standards are used by the credit committee when
determining whether to finance the loan. An example of a portfolio underwriting standard is a
leverage of less than 30% for a software portfolio.

The values in this view are displayed in the Portfolio Administration view tab.

To set up a commercial loan underwriting standard

1 Navigate to the Administration - Finance screen > Commercial Loan view.
2 Click the Portfolio Administration view tab.

3 In the Loan Portfolio Type list, select a portfolio for which you want to set up an underwriting
standard.

4 In the Portfolio Administration list, add a record and complete the necessary fields.

Some fields are described in the following table.

Field Description

Definition Definition of the standard; for example, loan to value or collateral value.
Standard Standard set by the bank.
Type Type of underwriting standard used for the loan request; for example,

Coverage, Leverage, or Team.

Associating Facilities with Financial
Accounts

After a facility is approved, administrators can use Siebel Finance to create a facility in the Financial
Account screen. After the financial account for the approved facility is created, the administrator
must also associate the new financial account with the approved facility. This makes certain that the
next time a user chooses the approved facility, the loan information is automatically populated from
the financial account screen. The administrator can also set the status of the facility in this view. If
the facility is closed, the administrator must change the status to Closed so that the facility is not
available for end users to select.

To associate a facility with a financial account

1 Navigate to the Administration - Finance screen > Commercial Loan view.
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2 Click the Facility Financial Account Administration view tab.

3 In the Financial Account/Facility Association list, select the status for the facility in the Status
field.

NOTE: If the financial account does not exist, add it. For more information about adding a
financial account, see Chapter 10, “Managing Financial Accounts.”

4 In the Account Number field, select the financial account number to associate with the facility.

Creating Commercial Loan Requests
(End User)

End users can create a loan request using one of the following views:

B Companies screen, Loan Request view
B Commercial Loan screen, Requests view

The Siebel Finance Commercial Loan screen provides access to commercial loan requests. The
Requests list displays information about the request, such as company name, request stage, and
lending information. End users can use the Commercial Loan screen to locate and update the
requests that they create.

To create a commercial loan request
1 Navigate to the Commercial Loan screen.

2 In the Request list or form, add a record and complete the necessary fields.

Some fields are described in the following table.

Field Description

Name Descriptive name to identify the request.

Request Indicates the loan request type, such as Business Loan Application or Credit
Method Card Application.

Request The values displayed in the Request Stage field drop-down list depend on the
Stage request type chosen in the Request Method field.

Team Organization’s contacts that have access to the commercial loan request.

After creating a loan request, end users can begin adding the details that are used to make loan
decisions. The Borrower Detail view is used to show the profile details of each borrower, such as
business, location, and year established. The Borrower Detail information is automatically populated
using the information in a company’s profile. As a result, end users should first navigate to the
Companies view and update the borrower’s profile.

For more information about updating a company profile, see Chapter 5, “Managing Companies.”
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To add borrower details to a loan request
1 Navigate to the Commercial Loan screen.

In the Requests list, drill down on a commercial loan request.
The Borrower Detail view appears.

In the Request Borrower list, select a borrower to which to add details.

a M W N

Scroll down to the Public Rating list, add a record, and complete the necessary fields.

Some of the fields are described in the following table.

Field Description

Source Source of the ratings information such as Moodys.
Rating The rating level, such as AAA.
Debt Type Indicates whether long term or short term debt.

The Request Summary view is used to capture key credit decisions and approval stages for loan
requests. This view is also used to capture decisions from credit committees.

To associate an approval level with a loan request
1 Navigate to the Commercial Loan screen.

2 In the Request list, drill down on a commercial loan request.

3 In the Request form, select the approval level to associate with the loan request in the Approval
Level field.

NOTE: For information on setting up an approval level, see “To set up the approval level for a
commercial loan” on page 162.

4 Click the Request Summary view tab.

The Decision list at the bottom of the screen is populated with the stages associated with the
approval level, as set up by the administrator.

5 In the Decision list, select officers for each stage, if necessary.

6 To start the loan approval process, select the record for the first approval stage in the Decision
list, and click Assign.

The Team field in the Request form displays the selected officer’s name. This makes the record
visible to that officer.

NOTE: For more information about assigning a loan, see “To assign a loan request to the next
credit committee officer” on page 172.

The Request Summary view is also used to manage credit issues associated with a loan request.
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To create or modify a credit issue for a commercial loan request
1 Navigate to the Commercial Loan screen.

2 In the Request list, drill down on a commercial loan request.
3 Click the Request Summary view tab.
4

In the Key Credit Issues list, add a record and complete the necessary fields.

Setting Up Facilities (End User)

The Facility Set Up view allows end users to associate the borrowers of a commercial loan request
with a corresponding facility. When end users create new records in the loan facility list, an
Association dialog box displays all facilities under the company group name. The user can select an
existing facility for a facility that is renewed or create a new one for a new facility.

To share one facility between two companies
1 Highlight the first company and create a new facility.

2 Highlight the second company and associate the same facility with this second company.

To create a new facility and associate a borrower
1 Navigate to the Commercial Loan screen.

2 In the Request list, drill down on a commercial loan request.
3 Click the Facility Set Up view tab.

4 In the Borrower list, select a borrower.

5

To create a new facility for the borrower, scroll down to the Loan Facility list, add a record, and
complete the necessary fields.

NOTE: When an existing facility is selected, some fields in the Facility Set Up views are automatically
populated using information in the Financial Account screen. Additionally, when you select an
existing facility, all other information related to this facility, such as prices, fees, and covenants, is
copied over to the new request.

Syndicating Facilities (End User)

In some instances, the facility requested by a customer may exceed the maximum amount that an

organization can handle. In these cases, end users can syndicate the loan to spread the loan facility
among other organizations.

To syndicate a facility
1 Navigate to the Commercial Loan screen.
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In the Request list, drill down on a commercial loan request.
Click the Facility Syndication view tab.
In the Borrower list, select a borrower.

In the Loan Facility list, select a facility for the borrower.
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In the Bank Syndication list, add a record and complete the necessary fields.

Setting Pricing and Fees for Facilities
(End User)

End users can use the Pricing and Fees view to set up the pricing and fees for facilities. For example,
an organization may charge a setup fee for each facility created. The end user can use the Fees list
to add a fee.

The prices and fees that appear in the Pricing and Fees view are populated automatically, with data
from the products that the administrator has set up. For more information on creating new products,
see Chapter 16, “Managing Products and Pricing,” or see Product Administration Guide.

To set the pricing and fees for a facility
1 Navigate to the Commercial Loan screen.

In the Request list, drill down on a commercial loan request.
Click the Pricing and Fees view tab.

In the Borrower list, select a borrower.
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In the Loan Facility list, select a facility for the borrower.

The Rates list and the Fees list are automatically updated.

(o))

To add a new rate, add a record in the Rates list, and complete the necessary fields.

To add a record in the Fees list, and complete the necessary fields.

Adding Guarantors to Loan Facilities
(End User)

Some borrowers may use a guarantor to secure a commercial loan. Using the Guarantors view, end
users can add guarantors to a loan facility.

To add a guarantor to a loan facility
1 Navigate to the Commercial Loan screen.

2 In the Request list, drill down on a commercial loan request.
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Click the Guarantors view tab.
In the Borrower list, select a borrower.

In the Loan Facility list, select a facility for the borrower.

3
4
5
6

In the Guarantors list, add a record and complete the necessary fields.

Adding Covenants to Facilities (End
User)

Using the Covenants view, end users can associate facilities with covenants. For example, an

organization may require a borrower to submit a financial statement every quarter. This type of
requirement can be created and managed in the Covenants view.

To add a covenant to a facility
Navigate to the Commercial Loan screen.

In the Request list, drill down on a commercial loan request.
Click the Covenants view tab.
In the Borrower list, select a borrower.

In the Loan Facility list, select a facility for the borrower.
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In the Covenants list or Covenant Detail form, add a record and complete the necessary fields.

Some fields are described in the following table.

Field Description

Covenants Type Select Coverage or Leverage.

Current The current value of the covenant.

Proposed The proposed value for the client to comply with the covenant.
Definition Brief description of the covenant.

Measurement Measurement used to define the covenant, such as month or year.
Operand Operand used to define the covenant conditions. For example, <, >,

To copy existing covenants from one facility to another
1 Select the facility that has the covenants to be copied.

In the Covenants list, click Apply To Facility.

3 In the Pick Loan Facility dialog box, select the facility to which the covenants are to be added,
and click OK.
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Adding Collateral to Loan Facilities (End
User)

Some borrowers may use collateral to secure a commercial loan. Using the Collateral view, end users
can add collateral to a loan facility.

To add collateral to a loan facility
Navigate to the Commercial Loan screen.

In the Request list, drill down on a commercial loan request.
Click the Collateral view tab.
In the Borrower list, select a borrower.

In the Loan Facility list, select a facility for the borrower.
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In the Collateral list, add a record and complete the necessary fields.

Creating Policy Exceptions (End User)

After setting up the loan details and adding all the necessary information to make a decision, end
users can review loans and determine whether the loan request conforms to all of the organization’s
standard policies. If it does not conform, create a policy exception explain differences.

You can create policy exceptions at one of the following three levels:
B Loan request level
B Borrower level

B Facility level

To create a policy exception at the loan request level
Navigate to the Commercial Loan screen.

In the Request list, drill down on a commercial loan request.

Click the Request Detail view tab.

1
2
3
4 Scroll down to the Request Policy Exceptions list and add a record.
5 In the Type field, select a type of exception to add.

6

In the Comments field, type a detailed explanation for the policy exception.

To create a policy exception at the borrower level
1 Navigate to the Commercial Loan screen.

2 In the Request list, drill down on a commercial loan request.
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Click the Policy Exception view tab.
In the Borrower list, select a borrower.

In the Borrower Policy Exception list, add a record and complete the necessary fields.

3
a4
5
6

To create a policy exception at the facility level
Navigate to the Commercial Loan screen.

In the Comments field, type a detailed explanation for the policy exception.

In the Request list, drill down on a commercial loan request.
Click the Policy Exception view tab.

In the Borrower list, select a borrower.

In the Loan Facility list, select a facility for the borrower.

In the Loan Facility Policy Exception list, add a record and complete the necessary fields.
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In the Comments field, type a detailed explanation for the policy exception.

Reviewing Underwriting Standards for
Loan Requests (End User)

Before submitting a loan request, loan officers must determine whether the request conforms to the
organization’s underwriting standard.

To review an underwriting standard
1 Navigate to the Commercial Loan screen.

In the Request list, drill down on a commercial loan request.

In the Request form, select a portfolio to which the borrowers belong in the Portfolio field.
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Click the Request Detail view tab.
The Underwriting Standard list is populated with the standard for the selected portfolio.
5 Update the fields as needed.

NOTE: For information on entering the underwriting standard for a portfolio, see “To set up a
commercial loan underwriting standard” on page 164.

Reviewing Group Exposure (End User)

End users can use the Exposure Summary view to display the combined loan total given to an
organization and all its subsidiaries.
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To review the group exposure
1 Navigate to the Commercial Loan screen.

2 In the Request list, drill down on a commercial loan request.
3 Click the Exposure Summary view tab.

The Group Exposure list is populated with information from the Financial Account screen. If this
list does not display any records, make sure that a financial account is associated with the
company group name.

Entering Credit Decisions for
Commercial Loans (End User)

After reviewing a loan, credit committee officers can use the Request Summary view to enter their
decisions about the loan.

To enter a credit decision for a commercial loan
Navigate to the Commercial Loan screen.

In the Request list, drill down on a commercial loan request.
Click the Request Summary view tab.
Scroll down to the Decision list and select a record for the decision.

In the Decision field, select Approved, Counter Offer, or Decline.
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In the Comments field, type a detailed description of the decision.

Assigning Loan Requests (End User)

After a credit committee officer enters a decision about a loan request, the end user can assign the
request to the next credit committee officer.

To assign a loan request to the next credit committee officer
1 Navigate to the Commercial Loan screen.

From the Show drop-down list, select My Requests.
In the Request list, drill down on a commercial loan request.

Click the Request Summary view tab.
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In the Decision list, select the next credit committee officer, and click Assign.
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This section is about administering securities records in Siebel Finance and managing contacts’
interests and holdings. It includes the following topics:

B “About Managing Holdings and Interests” on page 173

“Scenario for Promoting a Market Opportunity to Targeted List of Clients” on page 174
“Process of Administering Securities” on page 174

“Setting Up Securities Lists of Values” on page 175

“Creating and Modifying Stock, Bond, and Mutual Fund Records” on page 177

“Process of Tracking Clients’ Interests and Creating Interest-Based Call Lists” on page 179
“Entering Interests and Holdings Information” on page 179

“Creating and Using Targeted Call Lists” on page 181

“Configuring Call List Generation” on page 183

About Managing Holdings and Interests

In Siebel Finance, there is a collection of screens and views that helps financial representatives track
multi-dimensional information on client's investment interests, including:

B Products, such as stocks, bonds, mutual funds, options, and investment trust units
B Industries

B Sectors

B Analyst ratings

Use these procedures to perform the administrator tasks of modifying product information as well as
adding industries, security product classes, security categories, security exchanges, and new
securities.

End users use Siebel Finance to capture specific details about each investment, such as basic product
information, issuer fundamentals, market data, literature, research, and news.

Securities information assists users in searching for a type of investment that would satisfy a
customer’s specific requirements and providing details on specific investments. Institutional
salespeople can search to determine the contacts and investors who have either expressed an
interest in a specific security or are currently holding that security in their portfolios. Also, sales
agents and financial representatives can generate a call list, which is a list of targeted contacts that
is associated with one or more securities.
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Targeted List of Clients

You can save time and reduce keystrokes by using a workflow to automate steps that are repeatedly
performed by end users. For more information, see Siebel Business Process Designer Administration
Guide.

Scenario for Promoting a Market
Opportunity to Targeted List of Clients

This scenario features sample tasks performed by a financial institution’s applications administrator
and an investment representative. Your company may follow different workflows according to its
business requirements.

An administrator is requested to add a new municipal bond issue to Siebel Finance. The administrator
checks if all the required information to define the security exists in the application, and creates list
of values entries as necessary. Then, the administrator adds the municipal bond by entering product
information, which includes such details as the product name, symbol, industry, region, and sector.

In the morning sales meeting, they discuss the new bond product. After covering the details of the
new product on the morning call, the sales team cross references the new bond’s profile against the
list of their clients’ interested in purchasing the new bond. The firm anticipates the current bond
market rally to continue and the firm takes a substantial position in NYC municipals. The fixed income
desk is requested to promote the product heavily for the week.

At the conclusion of the call, the bond desk creates a targeted, prioritized call list to promote the
product. They search for investors and contacts who have expressed interest in bonds. Further, they
target investors and individuals who are holding or have expressed interest in Munis. The financial
instrument held has a B rating. The salesperson first targets investors and individuals interested in
B rating or better, and also customers with accounts registered in NY or managing NY mutual funds.
Munis represent the highest values to these customers.

Process of Administering Securities

This process represents a portion of the tasks carried out in the “Scenario for Promoting a Market
Opportunity to Targeted List of Clients” on page 174. This process includes:

1 Setting Up Securities Lists of Values on page 175
2 Creating and Modifying Stock, Bond, and Mutual Fund Records on page 177

Typically, securities information is imported into Siebel Finance using Enterprise Integration Manager
(EIM). Your organization can import the data displayed in the Securities views from one or more
other systems (such as a trading system).

You can also manually add or edit records of securities using administrative functions described in
this section.

For more information about EIM, see Siebel Enterprise Integration Manager Administration Guide.
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Setting Up Securities Lists of Values

Before entering new securities into Siebel Finance, you should make sure that all the fields used to
define a security are populated with the appropriate terms and classifications used by their
organization. The following securities fields need to be set up with the appropriate values:

Industry
B Product Line
B  Product Class
B Category
Exchange

The task is part of Process of Administering Securities.

Defining Industry Values

When you enter a new security, the Industry field is used to indicate the industry or sector to which
the security belongs. Populate the industry field with a list of values that are relevant to your
organization. For example, if you are adding a new biotechnology stock as a security to Siebel
Finance, you may need to add Biotechnology if the industry does not already exist. For details on
how to modify the industry field values, see “To add an industry” on page 51.

NOTE: The Industries table is used throughout Siebel Finance. Be sure to add industries that
represent your companies and clients.

The task is part of Setting Up Securities Lists of Values on page 175.

Defining Product Lines

When you enter a new security, the Product Line field is used to indicate the asset class of the
security. For example, if your company is an investment firm you might want to add equity, fixed
income, derivatives, and mutual fund product lines, if they do not already exist.

NOTE: In Siebel Finance, the Product Line field and the Product Class field are used to indicate a
security asset class in different modules of the application. The fields are used exclusively in different
modules of the application. As a result, both fields should be populated with the same list of values
to indicate the asset classes.

For more information about creating a product line, see Chapter 16, “Managing Products and Pricing.”

The task is part of Setting Up Securities Lists of Values on page 175.
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Defining Product Classes

The Product Class field is used in addition to the Product Line field to indicate the asset classes of
securities when they are added to Siebel Finance. Using Siebel Finance, you can add and modify the
asset classes that appear in the Product Class field.

The task is part of Setting Up Securities Lists of Values on page 175.

To add a product class for a security

1
2

Navigate to the Administration - Data screen > List of Values view.
Run a new query for Type = FINS_ASSET_CLASS.

The current FINS_ASSET_CLASS records are returned with the existing list of values for the
Product Class type.

In the List of Values list, add a record, and complete the necessary fields.

Some fields are described in the following table.

Field Description

Active Check box to determine whether or not the value is displayed to
the end user in the Product Class dialog box.

Display Value Value as displayed in the Product Class drop-down list.
Language-Independent Code used internally by the Siebel application.

Code

Language Name Language used for the list of values Display Value field.

Order Numerical order in which a value is displayed within the Product

Class drop-down list.

Parent LIC Language-independent code of a parent list of values. It is used
in hierarchical lists of values.

Translate When checked, indicates that the list of values is part of a
multilingual list of values (MLOV).

Type The type of list of values. Select FINS_ASSET_CLASS.

NOTE: Deleting LOV table entries is not recommended; instead, use the Active check box to
deactivate an LOV entry and thereby remove it from the Product Class drop-down list.

176 Siebel Finance Guide Version 7.8



nterests ' Creating and Modifying Stock, Bond, and Mutual Fund
Records

Adding Categories

When you enter a new security, the Category field is used to indicate another level of classification
in addition to the Product Class field. For example, a security with a Product Class value of Stock may
be further classified as a Category of Preferred Stock. A security with a Product Class value of Bond
may have a Category of Mortgage or Corporate Bond. Using Siebel Finance, you can add the
categories that appear in the Category field.

The task is part of Setting Up Securities Lists of Values on page 175.

To add a security category

1 Navigate to the Administration - Data screen > List of Values view.
2 Run a new query for Type = FINS_INVST_CATEGORY.

The current FINS_INVST_CATEGORY records are returned with the existing list of values for the
Category type.

3 In the List of Values list, add a record, and complete the necessary fields.

Adding Security Exchanges

In some instances, you may need to add new exchange information to Siebel Finance. The Exchange
field is used to indicate the securities exchange systems. For example, a brokerage organization may

populate the Exchange field with values, such as NASDAQ, FTSE, and Nikkei. You should add all the
exchanges that are relevant to your organization.

The task is part of Setting Up Securities Lists of Values on page 175.

To add a security exchange

1 Navigate to the Administration - Data screen > List of Values view.
2 Run a new query for Type = SECURITY_EXCHANGE.

The current SECURITY_EXCHANGE records are returned with the existing list of values for the
Product Class type.

3 In the List of Values list, add a record, and complete the necessary fields.

Creating and Modifying Stock, Bond, and
Mutual Fund Records

Once the securities lists of values are populated correctly, you can then add and modify individual
securities records. You can also associate a literature item with a security.
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Typically, securities information is imported into Siebel Finance using Enterprise Integration Manager
(EIM). An organization can import the data displayed in the Securities views from one or more other
systems (such as a trading system). Administrators can also add or modify securities for their
organizations in the All Securities view in the Finance Administration screen.

For more information about EIM, see Siebel Enterprise Integration Manager Administration Guide.

This task is part of Process of Administering Securities on page 174.

To add a new securities record
1 Navigate to the Administration - Finance screen > Securities view.

2 In the Securities list, add a record, and complete the necessary fields.

To edit mutual fund information
1 Navigate to the Administration - Finance screen > Mutual Funds view.

2 In the Mutual Fund form, locate the appropriate fund.
3 Click the Mutual Fund Holdings view tab.
4 In the Fund Holdings list, do one of the following:

® Add a record and complete the necessary fields for each security that makes up the mutual
fund

m  Modify or delete existing securities

(&)

From the Asset Allocation drop-down list, select Asset Allocation List.

(@)

In the Asset Allocation list, do one of the following:
B Add an asset class and associate the percentage of holdings in each mutual fund
m  Modify or delete existing asset classes

NOTE: The Asset Allocation Chart provides a graphical representation of the asset allocation for the
mutual fund.

To associate a literature document with a security
1 Navigate to the Administration - Finance screen > Securities view.

2 In the Securities list, select a security.
3  Click the Literature view tab.
4

In the Literature list, add a record, and complete the necessary fields.
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Process of Tracking Clients’ Interests
and Creating Interest-Based Call Lists

This process represents a portion of the tasks carried out in the “Scenario for Promoting a Market
Opportunity to Targeted List of Clients” on page 174. This process includes:

1 “Entering Interests and Holdings Information” on page 179
2 “Creating and Using Targeted Call Lists” on page 181

From the Holdings and Interests views, end users can track a particular security. From the List
Management Call List view, end users can review and manage their generated call lists.

Enterprise Integration Manager (EIM) imports the market data displayed in the Securities views. An
organization can import the data displayed in the Securities views from one or more other systems
(such as a trading system). Also, those with the required administrative responsibilities, such as
Siebel administrators, can manually add or edit records of securities using administrative functions
described in “Process of Administering Securities” on page 174.

For more information about EIM, see Siebel Enterprise Integration Manager Administration Guide.

Entering Interests and Holdings
Information

Tracking your clients’ interests and holdings is an important first step towards building targeted call
lists.

This task is a step in “Process of Tracking Clients’ Interests and Creating Interest-Based Call Lists” on
page 179.

To record an interest
1 Navigate to the Contacts screen > Contacts List view.

2 Drill down on the contact for which you wish to add interests information.

3 Click the Interests view tab.
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4 Create a new record and complete the necessary fields.

Some fields are described in the following table.

Field Description

Description Enter text to describe the contact’s interest, or the system will
automatically enter a string containing a compiled list of the
interest attributes.

Ticker Select any of the securities previously entered into your Siebel
application.

Volume Desired trading volume of the security.

Quantity Number of shares the contact is interested in transacting.

Interest Type Registers if the interest is in selling or buying.

Analyst A particular research analyst.

Industry Group The high-level industry interest, for example Technology. Also

known as a sector.

Industry Specific industry interest, for example Software.

Internal Rating The research rank of the product, for example Strong Buy.

NOTE: You can record a contact’s interests using either the Contacts or the Holdings and Interests
screen.

To record an interest based on a holding
1 Navigate to the Holdings and Interests screen > Interests view.

2 In the Interests list, create a new record and complete the necessary fields, some of which are
described in Step 4 of “To record an interest.”

3 In the Interests form, check the Holding box to signify this is an interest based on a holding.

NOTE: You cannot perform a search on a holding unless the holding has been saved as an interest
with the Holding box checked.

Entering Holdings Information

You can add individual holdings information for Investors from the Holdings and Interests Holdings
view. In addition, use the Financial Accounts Investment Holdings view to add holdings to financial
accounts.

NOTE: These holdings are not searched in the Holdings and Interests Search view. Only interests
based on holdings are searched. See “To record an interest based on a holding.”
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To add a holding record

1 Navigate to the Holdings and Interests screen > Holdings view.
2 In the Holdings list, add a new record and complete the fields.

3 In the Holdings form, enter additional information about the holding.

Creating and Using Targeted Call Lists

Generate and execute call lists based upon your client’s interests and holdings-based interests
through a:

B Batch search to add multiple contacts
B Single selection to add an individual client

NOTE: If your organization chooses to use the call list functionality, you should coordinate with your
IT department to run a regular batch process to remove dated lists.

This task is a step in “Process of Tracking Clients’ Interests and Creating Interest-Based Call Lists” on
page 179.

To search for contacts with particular interests
1 Navigate to the Holdings and Interests > Search view.

2 In the Criteria form, enter investment and classification criteria.

Some of the fields are described in the following table.

Field Description

Ticker(s) Select any of the securities previously entered into your Siebel
application.

Search for multiple tickers by listing them separated by a
comma. For example: CSCO, SEBL, IBM.

Search Select whether to search Interests only, Holdings only, or both
Interests and Holdings.

Interests only returns contacts with an active interest in the
named security. If the Inactive checkbox is checked on the
interest record, then it is ignored in the search.

Holdings only returns contacts with an active holdings-based
interest in the named security. For information on how these
types of records are created, see “To record an interest based on
a holding” on page 180.

Holdings and Interests returns contacts with either an interest
or holdings-based interest in the named security.
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Field Description

Market Cap The market cap ranking of the issuing company, for example
Small Cap.
Product The security type in which the client is interested, for example

Equities, Fixed Income, or Options.

3 Click Add Above Criteria to add the criteria to the search.

NOTE: If multiple criteria are entered within a single criteria search record, the search includes
an AND clause such that all field values must be met to return a contact. For example, within a
single search record you enter an interest in ticker IBM and interest type Buy, then only contacts
who have both an interest in IBM with an interest type of Buy will be returned in the search
results.

4 Repeat Step 2 and Step 3 to add additional desired criteria.

NOTE: The search aggregates multiple criteria search records into an OR clause, so if, for
example, two criteria forms are added, one specifying an interest in ticker SEBL and another
specifying an interest in ticker IBM, contacts with an interest in either or both tickers are
returned.

5 Click Go to execute the search.
Contacts that meet the search criteria appear in the Contacts list.

6 There are now three active buttons in the Contacts list, each providing a different way to proceed
to an existing or new call list:

m Add to Active Call List. Adds contacts to the user’s most recently created call list from the
current date, while remaining on the Holdings and Interests Search view. If no call list exists
for the current date, a new call list is created.

m Create New Call List. Adds contacts to a new call list identified by the user’s ID and the
current date and time, while remaining on the Holdings and Interests Search view.

m Go to Call Lists. Navigates to the List Management Call List view where the user can see all
of their own generated call lists.

To modify the contacts in a targeted call list
Navigate to the List Management screen > Call List view.

Select a call list to modify.

In the Call List list, review the contacts, modifying as necessary.

To... Then...
Remove a contact. Select it in the list and click Remove.
Add a contact. Click Add and select a contact in the Pick Contact dialog box.

Contacts added in this way will have no criteria associated with them.
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To use a targeted call list

1 Navigate to the List Management screen > Call List view.

2 Select a call list to use and work through the call list, marking the contacts according to the action

performed:
m  Ignore
m Called
®m  Emailed

3 Clarify the list of calls remaining by clicking Refresh List.

If the Show drop-down list is set to Outstanding Items, an updated list containing only the
contacts not yet marked as either Ignore, Called, or Emailed is displayed.

4 To return to the full call list, click the drop-down list and select All List Members.

Configuring Call List Generation

The call list generation functionality, which included the three Call List Buttons on the Holdings and
Interests Search view, are supported by user properties definitions for predesigned behavior. You
may wish to modify these user properties to fit your own business processes.

The following options are all configured through the business component FINS Contact Interest
Search Result. Table 7 lists the user properties.

Table 7. Call List Generation User Properties
User Property Value Comment
Reset Called Flag Y Called flag is reset to N when a duplicate contact is added to
the call list.
N Called flag is not updated when a duplicate contact is added

to the call list.

Reset Emailed Flag Y Emailed flag is reset to N when a duplicate contact is added
to the call list.

N Emailed flag is not updated when a duplicate contact is
added to the call list.

Reset Ignore Flag Y Ignore flag is reset to N when a duplicate contact is added
to the call list.

N Ignore flag is not updated when a duplicate contact is added
to the call list.

Merge Criteria Y Criteria Matched field is merged when a duplicate contact is
added to the call list.

N Criteria Matched field is not updated when a duplicate
contact is added to the call list.
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Table 7. Call List Generation User Properties
User Property Value Comment
Merge or Ignore Merge If a contact is already in the call list, other attributes of this
Duplicate Contact contact record are merged.
Ignore If a contact is already in the call list, no action is taken with
this record.
Popup When Add Call Y A dialog box pops up when the user adds contacts to an
List active call list.
N No dialog box pops up when the user adds contacts to an
active call list.
Popup When Create Y A dialog box pops up when the user creates a new call list.
Call List
N No dialog box pops up when the user creates a new call list.
Reflect Holding Holding The value of this property shows as prefix text on the
(default) Criteria Matched field to indicate that the matched criteria is
associated with a holding.
Reflect Holding and Holding/ The value of this property will show as prefix text on the
Interest Interest Criteria Matched field to indicate that the matched criteria is
(default) associated with both holdings and interests.
Reflect Interest Interest The value of this property shows as prefix text on the
(default) Criteria Matched field to indicate that the matched criteria is

associated with an interest.
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This section is about administering and working with products and pricing. It includes the following
topics:

B “About Managing Products and Pricing” on page 185

B “Scenario for Managing Products and Pricing” on page 185
B “Process of Managing Products and Pricing” on page 186
B “Creating New Products” on page 187

B “Defining Fees and Rates” on page 188

B “Using Product Information (End User)” on page 190

About Managing Products and Pricing

In Siebel Finance, products are the physical goods and services that a financial institution offers to
its customers. Only those with the required administrative responsibilities, such as Siebel
administrators, can set up and create new products.

The Products screen provides a collection of views to supply service representatives, sales agents,
and managers with product information in an organized format. Managing product information and
pricing structures requires setting up and maintaining products, product lines, product features, and
price lists.

Use these procedures to perform the administrator tasks of setting up product and pricing
information in Siebel Finance. End users use the Products screen to view product information.

The Products screen and associated views that appear in Siebel Finance share much of the
functionality found in Siebel Business Applications. This chapter focuses mainly on the products
functionality that is unique to Siebel Finance. For more information on creating and administering
products, see Product Administration Guide and Applications Administration Guide.

Scenario for Managing Products and
Pricing
These scenarios feature sample tasks performed by a Siebel administrator and a customer service

representative. Your company may follow a different workflow according to its business
requirements.

In this scenario, end users are the customer service representatives who answer customer calls.
They use the Products screen to:

B View lists of products
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B Obtain information about each product, which includes the product line, products code, rates,
fees, key features and benefits, and description

B Compare products by feature
B View literature about a product
B View and create news items associated with a product

The Siebel administrator is responsible for administering Siebel Finance and requires administrative
responsibilities to:

B Create a new product line
B Define a new product

B Set product fees, rates, and conditions

Administrator Defines New Products
An administrator sets up a new product line in Siebel Finance by:

1 Creating the new product line and then defining products.
2 Creating regions and associating those regions with each product.

3 Defining application workflows, product scores, fees, rates and conditions, and financial
attributes.

Customer Service Representative Views Product Information

A customer service representative receives a call from a customer inquiring about the company’s
products. He navigates to the Product Details view to review product information such as key
features, a product image, and other product details.

As a customer service representative talks with the customer, he learns that she is interested in a
Gold Visa credit card. The representative describes the product’s features and benefits, such as an
increased credit limit and free insurance on goods purchased with the card. The customer also
expresses interest in features the service representative knows are available in another product.
Immediately, he provides the customer a feature-by-feature comparison of the two products and
quotes prices from the price list. He can check for the latest news updates on the product, such as
an anticipated rate change, and convey this information to the customer. After the call ends, the
service representative follows up with the customer by sending her more detailed information, such
as the Consumer Disclosure Statement, through the mail.

Process of Managing Products and
Pricing
This section details sample tasks often performed by administrators and end-users when managing

products and pricing. Your company may follow a different process according to its business
requirements.
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Administrator Procedures
The following list shows tasks administrators typically perform to manage products and pricing:
B “Creating New Products” on page 187

B “Defining Fees and Rates” on page 188

End-User Procedures

B “Using Product Information (End User)” on page 190

Creating New Products

Before creating a new product in Siebel Finance, end users must first create a product line. Then
they can designate the products to be included in the product line, and set up the scoring system a
financial institution’s agents will use to determine customers’ needs.

Administrators have the job of creating new products. The Product Administration view is used to
define the finance-related products that are recommended by the sales agents and used in customer
needs analyses. For more details on defining products and product lines, see Product Administration
Guide.

To create a new product line
1 Navigate to the Administration - Product screen > Product Lines view.

2 In the Product Line list, add a record, and complete the necessary fields.

Some fields are described in the following table.

Field Description

Contracting Indicates whether the product line is offered on a contracting basis.
Licensing Indicates whether the product line requires a license.

Product Line Name of the product line.

Products List of products associated with the product line.

To create a product
1 Navigate to the Administration - Product screen > Products view.
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2 In the Products list, add a record, and complete the necessary fields.

Some fields are described in the following table.

Field Description

Avg Profit Average profit generated by product.

Sub Type Product groupings by Pension, Asset, Liability, Life & Annuity,
Personal Lines Insurance, Service, Transaction, Group Insurance,
Individual Health Insurance, Derivative, Currency, Commodity, and
Commercial Insurance.

Equivalent Product Products to be used in comparisons.
Profit Rank Ranking of product by profit generation.
Region Geographic region using this product.
Status Current availability of the product.

NOTE: Some of these fields may not be visible. You may need to reveal them using the Columns
Displayed command from the Menu drop-down list.

Defining Fees and Rates

The Fees and Conditions view in the Product Administration screen allows administrators to set fees
and rates and define conditions for products.

To set fees and conditions for a product
1 Navigate to the Administration - Product screen > Products view.

Drill down on the product for which you want to set fees.
Select the Fees and Conditions view link.

In the Fees and Conditions list, add a record, and complete the necessary fields.

o b W N

Scroll down to the Conditions list, add a record, and complete the necessary fields.

Some fields are described in the following table.

Field Description

Condition Condition for the product.

Maximum Credit Line Maximum amount allowed for the credit line.

Minimum Deposit Amount Minimum amount required in the account for the condition
to apply.
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To set a rate for a product
1

2
3
4

5

Navigate to the Administration - Product screen > Products view.

Drill down on the product for which you want to set a rate.

Select the Rates and Conditions view link.

In the Rates and Conditions list, add a record, and complete the necessary fields.

Some fields are described in the following table.

Annual % Rate Annual Percentage Rate for credit products.

Annual % Yield Annual Percentage Yield for deposit products.

Conditions Description of the conditions under which the rates are calculated.
Index Name Name of the index used.

Index Rate Percentage rate of index.

Maximum Amount Maximum amount for the product to qualify for the rate.
Maximum Rate Maximum interest rate for a product.

Maximum Term Maximum term for tiered rates.

Minimum Amount Minimum amount for the product to qualify for the rate.

Minimum Rate Minimum interest rate for a product.

Minimum Term Minimum term for tiered rates.

Points Fee equal to 1% of the principal.

Rate Rate percentage, calculated by adding Index Rate to Margin/Spread.
Rate Type Type of rate.

Spread Increase over index rate to determine rate.

Scroll down to the Conditions list, add a record, and complete the necessary fields.

Some fields are described in the following table.

Field Description

Condition The condition for the product.
Maximum Credit Line The maximum amount allowed for the credit line.
Minimum Deposit Amount The minimum amount required in the account for the

condition to apply.
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Using Product Information (End User)

End users access the Products screen either to inform a customer of the details of a given product
or to educate themselves on new products or changes to existing offerings.

To view product information
1 Navigate to the Products screen.

2 From the Show drop-down list, select All Products.
3 In the Products list, drill down on the Product link to display more information about the product.
The Product form appears, along with the Features and Benefits list and the Product Image.

Another task that is commonly performed in the Products screen specifically for Siebel Finance, is to
create an application using the Auto Application feature. For more information on using Auto
Application, see “Creating Applications Using the Auto Application Feature” on page 145.
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This section is about managing access exceptions for literature. It includes the following topics:
“About Managing Access Exceptions” on page 191

“Scenario for Analyzing Access Exceptions” on page 192

“Administering Access Exceptions” on page 192

“Setting Access Levels for Literature and Lists” on page 192

“Activating Access Workflows for Distribution Exceptions” on page 193

“Using Access Exceptions” on page 194

“Adding Access Exceptions” on page 194

“Setting Access Levels” on page 195

“Viewing Access Exceptions Charts” on page 195

“Viewing Access Exceptions Associated with Literature” on page 195

“Viewing Access Exceptions Associated with a List” on page 196

About Managing Access Exceptions

This chapter describes the procedures necessary to set up and create access exceptions for literature
in Siebel Finance. An access exception is an instance in which a contact, investor, or list that has
purchased a basic level of service or research is provided with a premium level. Organizations
generally provide different levels of service to their customers and therefore expect to generate
different amounts of business based on the level of service purchased. For example, Premium
customers receive higher levels of service for higher fees, and Basic customers receive lower levels
of service for lower fees.

Premium levels of service could include access to premium pieces of research literature and
invitations to premium events. On occasion, Basic customers are given Premium services to entice
them to sign up for the Premium level. In these instances, executives do not want to stop relationship
managers from sending premium pieces of literature to the basic customers or from inviting them to
premium events. However, the managers want to record every instance as an access exception so
that they can review all the premium services received by the basic level customers, and follow up
with them to persuade those customers to sign up for the premium level of service.

Use these procedures to perform the administrator tasks of setting up:

B An access level for an existing piece of literature or a list, using the Administration - Business
Process screen to monitor and generate access exceptions.

B A workflow policy for literature or distribution lists.
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End users use these procedures to add an access exception, set access levels for contacts, investors,
or distribution lists, and view access exception charts.

For more information about creating and managing literature, see Applications Administration Guide.

Scenario for Analyzing Access
Exceptions

This scenario is an example of a workflow performed by a financial institution’s investment bankers
or sales representatives. Your company may follow a different workflow according to its business
requirements.

A relationship manager at an institutional brokerage firm receives a phone call from a customer who
is a non-premium contact. The contact requests the latest piece of research, which happens to be
premium research that has been published by the relationship manager’s brokerage firm. The
relationship manager uses Siebel Finance to email this piece of literature to the customer.

When the literature is sent, a workflow created by the Siebel administrator automatically creates an
Access Exception, allowing the relationship manager to track every time that premium literature has
been sent to this particular contact.

Account managers can analyze access exception information at regular intervals to determine which
customers are causing the most access exceptions, and try to persuade these customers to sign up
for a higher level of service. Because access exceptions are tracked by employee as well as by
customer, account managers can also monitor which employees are generating the most access
exceptions and make sure that premium research distribution is properly executed.

Administering Access Exceptions
The following administrator procedures are described in this section:

B “Setting Access Levels for Literature and Lists” on page 192

B “Activating Access Workflows for Distribution Exceptions” on page 193

Setting Access Levels for Literature and
Lists

Administrators can use the appropriate administrative screen to set an access level for a piece of
literature or a list.

NOTE: Only those with the required administrative responsibilities, such as Siebel administrators,
can set the access level for a piece of literature or a list.

To set an access level for an existing piece of literature
1 Navigate to the Administration - Document screen > Literature view.
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2 In the Literature list, select the piece of literature for which you want to set the access level.

NOTE: If the piece of literature that you want does not exist, you can create it. For more
information on creating a piece of literature, see Applications Administration Guide.

3 In the Access Level field, select a value.

To set the access level for a list
1 Navigate to the List Management screen > Lists view.

2 In the Lists list, select the list for which you want to set an access level.

3 In the Access field, select the access level for the list.

Activating Access Workflows for
Distribution Exceptions

To generate access exceptions, you need to activate two workflows, as shown in Table 8.

Table 8. Distribution Exception Workflows

Workflow Description

Literature Access Workflow Use the Literature Access Workflow when distributing literature.
If the access level of the literature is higher than that of the
contact, the application generates an access exception record.

List Access Workflow Use the List Access Workflow to generate access exceptions
while adding contacts to a list. If the access level of the list is
higher than the level of the contact, the application generates an
access exception record.

For more information on working with workflows, see Siebel Business Process Designer
Administration Guide.

NOTE: Activating workflows requires administrative responsibilities.

To activate the Access workflows
1 Navigate to the Administration - Business Process screen > Workflow Deployment view.

2 In the Repository Workflow Processes list, query for the two Access workflow records.
TIP: Query for Name = * Access Workflow.
3 Click the Activate button at the top of the list to activate this workflow process.

When activated, the definition is written to the run-time tables and appears in the Active
Workflow Processes view.
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To reload runtime events

1 Navigate to the Administration - Runtime Events screen > Events view.

2 From the menu, select Reload Runtime Events.

Using Access Exceptions

The following end-user procedures are described in this section:
B “Adding Access Exceptions” on page 194
“Setting Access Levels” on page 195

“Viewing Access Exceptions Charts” on page 195

“Viewing Access Exceptions Associated with Literature” on page 195
“Viewing Access Exceptions Associated with a List” on page 196

The Access Exceptions screen and views allow end users to view or add information about access
exceptions. End users can also view access exceptions associated with a piece of literature in the
Literature screen or a list in the List Management screens.

Adding Access Exceptions

End users can add access exceptions for literature using the Access Exceptions screen.

To add an access exception
1 Navigate to the Access Exceptions screen > Access Exceptions list view.

2 In the Access Exceptions list, add a record, and complete the fields that correspond to the type
of access exception you want to record.

Some fields are described in the following table.

Field Comments

Access Exception Type Types include List and Literature.

Contact Name The contact name for which the exception was made.
Employee Name The employee who created the exception.

Investor The investor for which the exception was made.

List Name The list for which the exception was made.

Literature Name The literature item for which the exception was made.

NOTE: If your Siebel administrator has set up a workflow, data automatically appears in the
appropriate fields.

194 Siebel Finance Guide Version 7.8



Managing Access Exceptions M Setting Access Levels

Setting Access Levels

Siebel Finance uses access levels to grant customers access to different levels of research and
literature. Setting a contact’s access to a specific level allows that contact access and visibility to
items and services that have the same or a lesser access level.

To set a contact’s access level
1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, click the drop-down list in the Access Level field and set the desired level.

NOTE: If the contact does not exist, add it. For more information about adding contacts, see
“Adding Contacts” on page 79.

You can see access levels for companies and investors by navigating to the Companies screen >
Companies List view, and setting the Access Level field as in Step 2.

To set an access level for a list
1 Navigate to the List Management > Lists view.

2 In the Lists list, select an access level in the Access Level field.

Viewing Access Exceptions Charts

End users can view access exceptions by employee or investor. They can also view a chart showing
access exceptions by type (list or literature).

To view access exceptions by type
1 Navigate to the Access Exceptions screen.

2 Click the appropriate view tab:
m Access Exceptions By Employee
m Access Exception by Investor
B Access Exception by Type

The Access Exceptions view appears with a chart showing access exceptions broken down by
employee, investor, and type.

Viewing Access Exceptions Associated
with Literature

The following procedure shows how to view all the access exceptions for a piece of literature. You
can view access exceptions associated with literature by contact, employee, investor, or date.
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To view an access exception associated with a piece of literature

1

a M W N

Navigate to the Literature screen.

From the Show drop-down list, select All Literature.

Select the literature for which you want to view access exceptions.
Select the Literature view.

Click the Access Exceptions view tab.

The Access Exceptions list shows all access exceptions associated with the piece of literature.

Viewing Access Exceptions Associated
with a List

To view an access exception associated with a list

1
2
3

Navigate to the List Management screen > Lists view.
In the Lists list, drill down on the list for which you want to view an access exception.
Click the Access Exceptions view tab.

The Access Exceptions list appears, showing all access exceptions associated with the list.
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This section includes the following topics:

About Managing Group Pensions

Siebel Finance provides support for group pensions and is designed to meet the needs of sales and
service professionals, managers, and pension administrators. End users can use the Group Pensions
screen to manage private group pensions, which includes defined contribution plans, such as 401(k)
plans and occupational group pensions, and defined benefit plans.

“About Managing Group Pensions” on page 197

“Scenario for Creating a Company 401(k) Plan” on page 197
“Group Pension Sample Tasks” on page 198

“Process of Managing Group Pension Plans” on page 198
“Defining Group Pension Products” on page 199

“Defining Group Pension Plans” on page 200

“Administering Group Pension Plans (End User)” on page 202

Use these procedures to define group pension plans, plan classes, plan eligibility rules, and plan
funding vehicles. Once a group pension plan is defined, users can track eligible and enrolled
participants, participant contribution and investment allocations, and participant beneficiary
information.

You can save time and reduce keystrokes by using a workflow to automate steps that are repeatedly
performed by end users. For more information, see Siebel Business Process Designer Administration
Guide.

Scenario for Creating a Company 401 (k)
Plan

The following business scenario features sample tasks performed by a pension administrator. Your
company may follow a different workflow according to its business requirements.

Product Administration view to define a new group pension product and investment options for plan
participants. She then creates a new 401(k) retirement plan and enters all the basic plan
information. In this instance, she defines one class, enters the plan eligibility rules, and specifies the
key contacts for the plan.
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A week later, the administrator updates information for the 401(k) retirement plan participants. First,
she imports a list of eligible participants. Then, she enrolls 10 new participants, specifying each
employee’s contribution amount, the employer match, and the selected fund allocations.

In this scenario, the end user is a pension administrator who uses the Group Pensions screen to:
B Define a group pension product and specify pension plan investment options

B Define a group pension plan, including participant classes, eligibility rules, and key group pension
plan contacts

Add eligible plan members

Enroll group pension plan participants and record participant beneficiary information

Group Pension Sample Tasks

Figure 2 illustrates sample tasks that end users typically perform when managing group pensions.

Define Group Pension Product Define Group Pension Plan Ongoing Plan Administration
[One-Time Setup) (Dne-Time Setup for an Account)
Define group pension product Select group product Add eligible plan members

! ] |

Specify funding vehicles

(optional) Define plan clazses Enrall plan participarts
’ Specify Specify
Dl ki A participant participant
l contribution allocation

'L_¥—J

Record benificiaty information

Specify key plan contacts

]

Record payment method and
hilling information

Figure 2. Group Pension Sample Tasks

Process of Managing Group Pension
Plans

This section details sample tasks often performed by administrators and end-users when managing
group pension plans. Your company may follow a different process according to its business
requirements.
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Administrator Procedures

The following list shows tasks administrators typically perform to manage group pension plans:
B “Defining Group Pension Products” on page 199

B “Defining Group Pension Plans” on page 200

End-User Procedures

The following list shows a task end users typically perform when managing group pension plans:

“Administering Group Pension Plans (End User)” on page 202

Defining Group Pension Products

Before end users create an actual group pension plan, the product administrator must first define a
group pension product and specify investment options for plan participants.

To define a group pension product
1 Navigate to the Administration - Product screen > Products view.

2 Click the New and Release button and do the following:
= In the Name field, enter a name for this group pension product.
® In the Finance Product Type field, select Retirement from the drop down list.
® In Products form, select Pension from the Sub Type drop down list.
3 Drill down on the name, and on the link bar, click the Group Pensions Product Administration.

4 In the Funding Vehicles list, create a new record and complete the fields.

To define funding vehicles for a group pension product
Navigate to the Group Pensions screen > Group Pensions Administration List view.

In the Product list, select a group pension product.

1

2

3 In the Funding Vehicles list, add a record, and complete the necessary fields.
4 In the Name field, select the funds and investments available on this plan.

5

In the Effective Date field, specify the date this plan will become available within the system.

Once users have defined a group pension product and funding vehicles, the next step is to create a
group pension plan for an account (see “Defining Group Pension Plans”).
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Defining Group Pension Plans

To define a group pension plan, end users must perform the following steps:

Define a group pension plan. For more information, see “To define a group pension plan” on
page 200.

Specify plan rules. End users use the Rules view tab to define the types of rules that govern
the selected group pension plan. For more information, see “To specify plan rules” on page 201.

Define participant classes. End users define different groups of plan participants in the Classes
view tab. For more information, see “To define participant classes for plan participants” on
page 201.

Record key plan contacts. End users use the Contacts view tab to define key contacts
associated with the selected plan. These contacts are not plan participants, but consist of key
individuals associated with the selected plan such as a plan administrator, trustee, or investment
committee member. For more information, see “To record key group pension plan contacts” on
page 201.

Enter billing information. End users use the Bill To view tab to specify high-level payment
information, such as payment frequency and a billing address. For more information, see “To
enter billing information” on page 202.

To define a group pension plan

1

Navigate to the Group Pensions screen > Group Pensions List view.
In the lower form, add a record and complete the necessary fields.

Some fields are described in the following table.

Field Comments

Plan Sponsor A company or account that has a group pension plan associated with it
or a company or account that provides a group pension for a group of
people. For more information on adding additional companies, see
“Adding Companies and Investors (End User)” on page 58.

Name The group pension product defined in the Group Pension Product
Administration view.

For more information on defining group pension products, see “To define
a group pension product” on page 199.
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Field Comments

Type The type of group pension plan. Options include:

B Defined Benefit. Group pension plan that defines the amount of the
benefit a plan participant will receive upon retirement.

B  Defined Contribution. Group pension plan that describes the plan
sponsor's annual contribution to the plan on behalf of each plan
participant.

Sub Type Further defines the type of group pension plan being created. Available
values are based on the Type field selection.

If the Type is:

B Defined Benefit, available options include Final Salary and Average
Salary.

B Defined Contribution, available options include 401(k), 403(b),
Group Occupational Pension, Group Personal Pension, and Group
Stakeholder Pension (UK-specific).

To specify plan rules

1

2
3
A4

Navigate to the Group Pensions screen.
In the Group Pensions list, select a group pension plan, and drill down on the plan # link.
Click the Rules view tab.

In the Rules form, complete the necessary fields.

To define participant classes for plan participants

a b W N P

Navigate to the Group Pensions screen.

In the Group Pensions list, select a group pension plan, and drill down on the plan # link.
Click the Classes view tab.

In the Classes list, add a record and complete the necessary fields.

If this is an employer-sponsored plan, enter the appropriate percentage in the Employer Match%o
field.

To record key group pension plan contacts

aa b W N P

Navigate to the Group Pensions screen.

In the Group Pensions list, select a group pension plan, and drill down on the plan # link.
Click the Contacts view tab.

In the Contact list, add a record and complete the necessary fields.

In the Contact Role field, select one of the following:
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®m  Administrator
®m Investment Committee

m  Trustee

To enter billing information

1

2
3
4

Navigate to the Group Pensions screen.
In the Group Pensions list, select a group pension plan and drill down on the plan # link.
Click the Bill To view tab.

In the Pay Plans list, create the appropriate number of pay plans by adding a record for each plan
and completing the necessary fields.

Scroll down to the lower applet and enter the required information to complete the payment
information.

Administering Group Pension Plans (End
User)

End users administer group pension plans by performing the following tasks:

View available plan funds and investments. End users view which funds and investments are
available within a specific group pension plan in the Funding Vehicles view tab. For more
information, see “To view the funds and investments available within a group pension plan” on
page 203.

Add eligible plan members. End users can track individuals who are eligible to participate in
a group pension plan in the Eligible Members view tab. For more information, see “To add eligible
plan members” on page 203.

Create service requests to track plan administration. End users can use the Service
Requests view tab to track general plan administration activities, which includes account value
inquiries, changes in participant contributions, and updates to participant contact information.
Users can also use this view to track changes to the features and benefits of a specific plan. For
more information, see “To create a service request associated with a group pension plan” on
page 203.

Enroll group pension plan participants. End users enroll new group pension plan participants
in the Participants view tab. For more information, see “To enroll new participants in a group
pension plan” on page 203.

Record beneficiary information. End users record beneficiary information for plan participants
in the Beneficiary view tab. For more information, see “To record participant beneficiary
information” on page 203.

Create activities and notes associated with a group pension plan. For more information,
see “To create an activity associated with a group pension plan” on page 204 and “To create a note
associated with a group pension plan” on page 204.
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For more information on defining funding vehicles, see “To define funding vehicles for a group pension
product” on page 199.

To view the funds and investments available within a group pension plan

1
2
3

Navigate to the Group Pensions screen > Group Pension List view.
In the Group Pensions list, select a group pension plan, and drill down on the plan # link.

Click the Funding Vehicles view tab.

To add eligible plan members

A W N P

Navigate to the Group Pensions screen > Group Pension List view.
In the Group Pensions list, select a group pension plan, and drill down on the plan # link.
Click the Eligible Members view tab.

In the Participants list, add a record and complete the necessary fields.

To create a service request associated with a group pension plan

a A 0w N PR

Navigate to the Group Pensions screen > Group Pension List view.

In the Group Pensions list, select a group pension plan, and drill down on the plan # link.
Click the Service Requests view tab.

In the Service Requests list, add a record and complete the necessary fields.

To add further information about the service request, drill down on the SR # link.

To enroll new participants in a group pension plan

A W N P

Navigate to the Group Pensions screen > Group Pension List view.

In the Group Pensions list, select a group pension plan, and drill down on the plan # link.
Click the Participants view tab.

In the Participants list, add a record and complete the necessary fields.

NOTE: In order for Siebel Finance to automatically populate the Employer Match % field in the
Participants view tab, you must enter a value in the Class field.

In the Allocations form, add a record for each fund or investment option. Select the appropriate
funds and investments options from the Pick Funding Vehicle list.

To record participant beneficiary information

Navigate to the Group Pensions screen > Group Pension List view.
In the Group Pensions list, select a group pension plan, and drill down on the plan # link.

Click the Beneficiary view tab.

Siebel Finance Guide Version 7.8 203



Managing Group Pensions & Administering Gr

4 In the Participants list, select a participant.
5 In the Beneficiary list, add a record and complete the necessary fields.
NOTE: Make sure all the values entered in the % field equal 100%.

For more information on adding participants, see “To enroll new participants in a group pension plan”
on page 203.

To create an activity associated with a group pension plan
1 Navigate to the Group Pensions screen > Group Pension List view.

2 In the Group Pensions list, select a group pension plan, and drill down on the plan # link.
3 Click the Activities view tab.
4

In the Activities list, add a record and complete the necessary fields.

To create a note associated with a group pension plan
1 Navigate to the Group Pensions screen > Group Pension List view.

2 In the Group Pensions list, select a group pension plan, and drill down on the plan # link.
3 Click the Notes view tab.
4

In the Notes list, add a record and complete the necessary fields.
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This section includes the following topics:

“About a Business Service” on page 206

“About Siebel Financial Services Business Services” on page 206’
“VBC Cache and Instance Manager” on page 208

“Free Format Converter” on page 213

“Data Validation Manager” on page 214

“Business Rule Processor” on page 215

“Process of Defining Business Rule Processes” on page 216
“Creating and Managing Business Rule Processes” on page 218
“Defining Properties for a Business Rule Process” on page 220
“Defining Procedures for a Business Rule Process” on page 224
“Fine-Tuning the Assignment Statement” on page 232
“Handling Business Rules Processor Errors” on page 234

“Using BRP Helper Business Services” on page 236

“Invoking the Business Rule Processor” on page 246

“Logging Business Rules Processor Debug Messages” on page 248
“Requirements Manager” on page 248

“Customer Authentication Manager” on page 257

“Using the Calculation Manager” on page 262

“Using the Customer Expectations Manager” on page 268
“Using Data Transfer Utilities (DTU)” on page 271

“Automating Approval Processing” on page 286

“Automating the Display of Disclosure Documents” on page 290
“SmartScript Integration with Workflow” on page 293
“Dynamic Ul Business Service” on page 296

“FINS Application View Navigation” on page 299
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About a Business Service

A business service is an object that simplifies the use of a specific set of functionality. Business
services are not tied to specific objects, but rather operate or act upon objects to achieve a particular
goal. You can use business services to execute predefined or custom actions in a workflow process.

For more information on:
B Business services, see Overview: Siebel Enterprise Application Integration

B Workflows, see Siebel Business Process Designer Administration Guide

Abou_t Siebel Financial Services Business
Services

Siebel Financial Services introduces a number of business services that fulfill a specific need in an
end-to-end business process. The overall goal with these business services is to reduce the custom
scripting that customers do during implementation. These business services benefit Siebel Financial
Services customers in the following ways:

B Increased efficiency and consistency with automation

B Rapid deployment of functionality—less programming, and immediately deployable; SRF changes
are not required

B Better performance than scripting
B Ease of maintenance—ability for a business analyst to maintain rules

For example, the Data Validation business service allows customers to define data validation rules in
an administration view that users trigger in run time. This significantly reduces the amount of custom
scripting that would otherwise be required.

Other business services, such as the Disclosure and Approval business services, bring similar
benefits to customers' disclosure and approval business processes.
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Business Services

Table 9 lists the business services available in Siebel Financial Services.

Table 9.
Business Service

Disclosure Manager

Siebel Financial Services Business Services

Business Applications

Regulatory compliance,
sales process
compliance.

Functionality

Present literature specific to products; logs
presentation for compliance.

Approval Manager

Policy exception
approvals, underwriting.

Determines necessary approval sources
and routes to inbox.

VBC Cache and Instance
Manager

Cache data from external
applications in Siebel for
display.

Cache VBC data throughout user's session
and use Siebel Workflow to query external
data sources.

Free Format Converter

Comma-delimited and
other free-format
message creation.

EAIl Business Service to convert Siebel data
to non-XML formats.

Workflow - SmartScript
Integration

Embed Q&A style
processes as part of a
workflow process.

Launch SmartScript sessions within a
workflow process. Pass information from
SmartScript back into the workflow process
for downstream processing.

Using Data Transfer
Utilities (DTU)

Auto-creation, prefilling.

Copies data from one Siebel BO/BC/Field to
another BO/BC/Field.

Data Validation Manager

Conditional logic, data
integrity control.

Performs data validation across business
component fields.

Requirements Manager

Application closings,
service case resolution.

Determines requirements and next steps
for transaction completion.

Customer Authentication
Manager

Transaction level
security, regulatory
compliance.

Situation specific customer authentication
data collection and logging.

Using the Calculation
Manager

Lead scoring, payment
calculations,
prioritization.

Performs arithmetic functions and if/then/
else calculations in background or through
Ul.

Using the Customer
Expectations Manager

Customer services
expectations, fulfillment
expectations.

Calculates expected and promise dates,
and sets priorities, based on item type and
customer value.

Business Rule Processor

Definition and execution
of complex, frequently
changing business logic.

Siebel Finance Guide Version 7.8

Higher performance and more scalable than
scripting. Can change business logic
without a new SRF. Flexible - supports
procedure, loops, if-then-else, switch-case
constructs.
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Table 9. Siebel Financial Services Business Services
Business Service Business Applications Functionality
Dynamic Ul Business Create read-only view Create and render views containing a single
Service that can be changed read-only applet in the Siebel Financial
without the need to Services application.

recompile and redeploy a
Siebel Repository File
(SRF).

FINS Application View View navigation. Guides users through a series of views
Navigation based on administration data.

CAUTION: As with other specialized code, users should use only the specialized business services
that are documented in Siebel documentation. The use of undocumented services is not supported
and can lead to undesired and unpredictable results.

VBC Cache and Instance Manager

Integrating external systems with Siebel data in real time is a common business requirement. A
standard approach is to use Virtual Business Components (VBC) with a substantial amount of
scripting. This approach, however, often has associated performance and scalability concerns. The
Caching VBC was originally developed to address integration with external billing systems, and the
design requires a minimal amount of scripting. These features, however, can be extended and applied
to a broad set of integration challenges beyond billing.

Caching VBC Overview

The Caching VBC enhances the existing horizontal CSSBCVRec VBC class and works in conjunction
with the SIA Billing Extern Service business service. Although the name of this business service
implies that it is billing specific, it is a generic service without any industry specific functionality.

Features of the Caching VBC include:

B Caching of response data, allowing navigation between records in a parent BC without generating
duplicate requests in the child VBC

Ability to have a VBC be the parent of another VBC child within a single business object
Forced refresh of already cached data

Ability to generate integration object instances without using the EAI Siebel Adapter business
service

B Integration with workflow process that can take advantage of any existing integration flow that
uses Application Service Interfaces (ASIs), Web Services, or connector technology

Possible limitations to consider:

B Read-only behavior
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Only available as part of the Siebel Industry Applications (SIA) product
Queries are not supported

Only an active field of an active business component will have its value prefilled properly by the
request integration object

B The business service only references the top-level from the top-level integration component
when creating the request message to populate predefault fields.

Components

Figure 3 shows the components to implement the Caching VBC.

Any VBC based on
class
CSSFABCVYRec

514 Billing Extemn N Any Workflow
Service Process

Extamal Systam

Figure 3. Caching VBC Components

Stages of the Caching VBC Process

The caching VBC process uses the following process flow.

1 The Caching VBC invokes the named service when queried.
2 User properties on the VBC identify:
®m  Whether or not to enable caching
m The service name to invoke (SIA Billing Extern Service)
m The integration object name to be passed to the service as an input parameter
m  The workflow process name to be passed to the service as an input parameter

3  When the VBC is executed, the VBC calls the business service and passes it the integration object
name and workflow process name.

4 The business service instantiates the named integration object and populates it with values in
the currently active business object without using the EAI Siebel Adapter.

5 The business service passes the integration object instance to the SiebelMessage workflow
process property and invokes the workflow process.

6 The workflow process handles any integration tasks, including communicating with the external
system.

It receives data from the external system and populates a hierarchical process property that
matches the field structure of the VBC.

7/ The workflow process completes.
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8 The business service reads the hierarchical output process property from the workflow process
property named VBC Output and compares it with the fields in the VBC.

Where matching field names are encountered, the value in the output process property is copied
to the VBC. Field names that do not match are ignored and do not generate an error.

Caching VBC Configuration

Base the VBC on the CSSFABCVRec class. Table 10 lists the user properties VBC uses for its
configuration.

Table 10. User Properties for VBC Configuration

User Property Name Valid Names Description

Enable Caching Yes or No Yes enables the caching of
records retrieved by the VBC.
No disables caching.

Outgoing Integration Object An integration object name Name of the integration object

Name to be passed to the business
service.

ProcessName A workflow process Name of the workflow process
to be passed to the business
service.

Service Name A business service Name of the business service
to be invoked when the VBC is
executed.

You must also configure the fields for your business component. No other scripting is necessary to
invoke the service or the workflow.

The VBC uses a special field called Vid. This field is an internally generated unique identifier. It is not
necessary to create this field in your VBC. However, if you do create this field in your VBC, do not
modify this value. Considered this field as a system field.

You can create link specifications between parent business components and this VBC, and between
this VBC and any child VBC. Any field can be used as a link specification.
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Purging the VBC Cache

Purge the VBC cache by configuring a button to invoke method RefreshVBCCache. Table 11 lists the
consequences if Enable Caching is set to Yes or No.

Table 11. Consequences of Setting Enable Caching

Enable Caching is set to Y. The VBC purges cached values and forces a
query of the external system.

Enable Caching is set to N. The RefreshVBCCache method has no effect.

Business Service Configuration

Base the business services specified in the Service Name parameter of the VBC on the
CSSFAExternalService class, and have a method named query defined. You do not need to specify
any input arguments to this method or configure any user properties. In this way, you can reuse this
business service.

Integration Object Configuration

Use the integration object specified as the Outgoing Integration Object Name user property of the
VBC to communicate record data between the business service and the workflow process. This
integration object is non standard because it does not need to have an integration component for all
the parent business components in the business object hierarchy. For example, if your business
object hierarchy consists of Contact and the VBC as a child of Contact, you do not need to include a
Contact integration component as the parent integration component in your integration object.

The reason for this is that this integration object is never used by the EAI Siebel Adapter. Therefore,
you do not need to include the complete business component hierarchy in the integration object.

The integration object uses the PREDEFAULT user property (Table 12) on integration component fields
to identify those fields that should be prefilled with data from the active business components:

Table 12. PREDEFAULT User Property

Integration Component Field

User Property Valid Values Description

PREDEFAULT [Business Component Identifies the source business
Name.Field Name] component field that the
For example, Business Services uses to
[Contact.Primary Personal prefill the integration
Postal Code] component field.
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After the workflow process completes, values in the integration component fields that have matching
names in the VBC are copied back to the VBC. If the integration object has fields that do not match

the VBC, then those fields are ignored and no error is produced.

Workflow Configuration

The workflow process specified as the ProcessName user property of the VBC is used to identify which
workflow process the business service should invoke after instantiating the named integration object.
Table 13 lists the two process properties that must be configured for this process to communicate

with the business service.

Table 13. Workflow Process Properties
Process Property Name Type

SiebelMessage Integration Object

Description

The input of the workflow
process. This is passed in by
the business service.

Contains the integration
object instance of the
integration object identified
with the Outgoing Integration
Object Name user property
on the VBC. This integration
object instance contains data
for integration component
fields that have the
PREDEFAULT user property
set as described in the
Integration Object
Configuration section of this
document.

VBC Output Hierarchy

The output from the workflow
process.

This is returned to the
business service. Contains
the integration object
instance of the result of
querying the external system
that is to be returned to the
business service for inserting
into the VBC.
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The SiebelMessage process property contains the query parameter for the external system. The
workflow process transforms this data to a format understood by the external system, then uses a
transport to send the request and receive the response from the business service. Finally, it must
transform the response data back to a format that matches the VBC fields. This transformed
response data needs to be stored in the VBC Output process property so that the calling business
service can map it back to the VBC.

Free Format Converter

This section describes how to leverage the FINS EAl Free Format Hier Converter business service to
convert a Siebel property set into a UTF-8 based text file structure for downloading.

Out of the box, the FINS EAI Free Format Hier Converter business service is used in the FINS
eBanking Account Download Outbound workflow to enable the creation of flat file, tag-based data
stream for download. The business service follows the same model as the EAlI XML converter, but
provides flexibility for manipulating the output data stream and header information.

If the desired output format is XML-based, use EAlI XML Converter, XML Hierarchy Converter, or other
XML related converter Business Service that Siebel Systems provides. If the file format is not XML-
based, use FINS EAI Free Format Hier Converter.

FINS EAI Free Format Hier Converter Methods

The FINS EAI Free Format Hier Converter business service provides two methods for creating text
data streams:

B PropSetToPlainText
B PropSetToRawText

The difference between these two methods is that the PropSetToRawText method has the
DiffBeginEndTag, EscCharSupport, and NewLineAfterNode user properties predefaulted. And in the
PropSetToPlainText method, the following parameters are preset:

B DiffBeginEndTag = N
B EscCharSupport = N
B NewLineAfterNode =Y

PropSetToPlainText and PropSetToRawText User Properties
Table 14 lists the user properties for the PropSetToPlainText and PropSetToRawText methods.

Table 14. User Properties

Parameter Name Description Predefault Value
BeginTagLeft A text value for the left boundary of the begin tag. <
BeginTagRight A text value for the right boundary of the begin tag. >
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Table 14. User Properties

Parameter Name

Description

Predefault Value

DiffBeginEndTag Y orN N
If there are different tags for the begin and end tag,
then for XML, they are the same. Use “,” as the
separator to set it differently.
For example, if this is set to Y, and the XML tag of
any component is A,B, then the begin tag is A and
end tag is B.
EndTagLeft A text value for the left boundary of the end tag. <
EndTagRight A text value for the right boundary of the end tag. >
EscCharSupport Y or N
Yes supports escape characters such as \n and \r.
NewLineAfterNode Y or N N
Yes prints a new-line character after each element.
PrintAggregateEndTag Y or N Y
Yes prints end tag for aggregate nodes.
PrintElementEndTag Y or N Y
Yes prints end tag for element nodes (element that
has no child).
PrintEndTagBeforeChild | Y or N N
Yes prints the end tag before print out the first
child.
PrintTagBound Y or N Y

Yes prints the tag boundaries.

XMLHierarchy

The IntObj instance that is parsed into the BusSvc.

Data Validation Manager

Many companies are governed by various regulatory agencies, as well as internal processes and
procedures, to verify the quality and accuracy of their transactions. Data validation can involve many
types of transactions, which includes orders, applications, claims, and various other service requests.

Data validation is a key component of almost every business process in Financial Services. The Data
Validation Manager business service can validate business component data based on a set of rules.
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In the case of a rule violation, a custom error message appears or a user-defined error code is
returned. The validation rules are defined using the Siebel Query Language and can be conveniently
constructed using the Personalization Business Rules Designer. The business service centralizes the
creation and management of data validation rules without requiring Siebel Tools configuration, and
does not require the deployment of a new SRF.

The Data Validation Manager business service significantly reduces the need for custom scripts,
decreasing implementation costs and increasing application performance.

The Data Validation Manager features include:

B Search automatically for the proper rule set to execute based on active business objects and
views.

Write validation rules based on fields from multiple business components.

B Apply a validation rule to a set of child business component records to see if a violation occurs
from one or more records.

B Invoke specific actions to be performed as a result of a validation.

Write validation rules that operate on dynamic data supplied at run time without that data being
from business component field.

B Automatic logging of data validation events.

Some example business rules that can be enforced by the Data Validation Manager business service
are:

B In an insurance company, claim adjusters are required to enter a closed date whenever they
close a claim. If the adjuster tries to close a claim without a closed date, he is prompted with an
appropriate error message and the claim record is not committed to the database.

B In aretail bank, different data validation rules are required for each of dozens of different service
request types. When a customer service representative creates a new service request, the Data
Validation manager identifies the appropriate validation rule set for the specific type of service
request and executes the data validation rules of that rule set.

B At a health insurance company, customer service representatives use activity plans and activities
to track service requests. All activities must be closed before the service request can be closed.
When the CSR closes the SR, the DVM loops through all associated activities making sure the
status of each activity is closed. If any are still open, the SR cannot be closed.

For more information about Data Validation Manager, see Siebel Order Management Guide.

Business Rule Processor

The Business Rule Processor (BRP) business service is a general-purpose, highly-scalable business
logic execution engine. The business logic is defined from within the Siebel client administration user
interface, reducing the need to hard-code the logic into the Siebel Repository file. This supports
scenarios in which there are constant changes to the business rules. The BRP can define and execute
highly complex business logic.
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You can invoke the BRP by a run-time event, workflow, or Siebel script. This is described in Invoking
the Business Rule Processor on page 246.

The Business Rule Processor features include:
B Business logic administration through the application user interface.

B Appropriate for complex business logic; supports procedure, loops, if-then-else and switch-case
constructs.

B Appropriate for business logic that changes frequently. You can modify business logic without
deploying a new SRF.

B Query, read, and write access to business components.
B Error handling.
B Support logging at multiple levels for easy testing and debugging.

Can potentially replace large amounts of custom scripts.

The BRP executes business rule processes. A business rule process is constructed much like a
computer program or a Siebel workflow. A process consists of procedures. Procedures are made of
steps. Steps, in turn, contain statements. A statement is a conceptual line of code.

BRP configuration and administration should only be done by expert users accustomed to working
with business services.

TIP: Before you begin to create a business rule process, you need to carefully consider and plan out
the required steps for the process.

Process of Defining Business Rule
Processes

Defining business rules processes involves the following procedures:

1 Defining Properties for a Business Rule Process on page 220
2 Defining Procedures for a Business Rule Process on page 224

3 Using BRP Helper Business Services on page 236
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Creating and Managing Business Rule
Processes

About Business Rule Processes

A BRP process is uniquely identified by its name. A process name must begin with a letter. It can
contain alphanumeric, space, underscore, and hyphen. The name cannot contain other special
characters like @ or !.

NOTE: BRP names are case sensitive and limited to 75 characters.

TIP: Itisimportant to establish a naming convention before you engage in the development of BRP
processes.

About Defining Business Rule Processes
You define business rule processes from the Business Rule Processor screen. You can either revise
an existing process or create a new one.

A business rule process is made up of procedures and properties.

A BRP process can have one of three statuses:

B In progress. You can modify only a process in the In-progress status

B Active. An Active status indicates that the process definition is released for execution

B Inactive. An Inactive process indicates that the process is in no longer in use and has been retired

NOTE: The status of process indicates its edit disposition rather than its current run-time execution
status.

Additionally, all BRP process definitions are cached in the object manager across all login sessions to
improve scalability. Hence, if any modifications are made to the process definitions, then they are
not available to the run-time sessions until the cache is refreshed.

It is recommended that you put in place procedures to promote BRP processes from development to
production, and establish controls on how to refresh the cache.

You can import and export business rule processes. This makes migrating process definitions across
development and production environments easier. The process is saved as an XML file for importing
and exporting purposes.

This step is part of Process of Defining Business Rule Processes on page 216.

To create a business rule process
1 Navigate to the Business Rule Processor screen.

2 Create a new record.
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revise an existing business rule process
Navigate to the Business Rule Processor screen.

In the Processes list, select a business rule process of status Active or Inactive and click Revise.
Clicking Revise changes the status of the process to In Progress.

Make the appropriate changes to the process.

activate a business rule process
Navigate to the Business Rule Processor screen.

In the Processes list, select the business rule process you wish to activate.

Click the Activate button.

Clicking Activate changes the Status from In Progress to Active and makes the record read-only.
Click the Refresh Cache button.

This clears the OM cache and creates a new copy of the process definitions.

Any process that is executing when the cache is cleared is allowed to complete. However, the
new process definition is available to all processes that start right after the button is clicked.

NOTE: Take care while using this feature. Refresh Cache clears the cache for all BRP process
definitions. Hence, any processes that are In-progress or Inactive are lost from the cache.

export a business rule process
Navigate to the Business Rule Processor screen.

In the Processes list, select the process you wish to export and click the More Info view tab.
In the Processes form, click the Export Process button.

Follow the on-screen prompts to save the rule set as an XML file.

import a business rule process
Navigate to the Business Rule Processor screen.

Click the More Info view tab.

In the Processes form, click the Import Process button.

In the Workflow Process Import dialog box, locate the file you wish to import and click Import.
The imported process appears with a status of In Progress.

To activate the imported process, select it in the Processes list and click Activate.

Clicking Activate changes the rule set Status to Active and makes the record read-only.

NOTE: If the process already exists, the process status must be In progress to allow the import.
View imported processes by performing a query/go operation to refresh the Processes list.
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Defining Properties for a Business Rule
Process

Properties are:

B Variables that are used either to facilitate flow of data in and out of a process or to store
information temporarily for the life of the process.

B Either global process properties or local procedure properties. Global properties are available for
all procedures that are associated with the business rule process.

The property name:

B Must begin with a letter.

B Can contain alphanumeric, spaces, underscore, and hyphen.

B Cannot contain other special characters such as an ampersand (@ ) or exclamation mark (!).
B Are case sensitive and limited to 75 characters.

NOTE: If a procedure defines a local property with the same name as a global property, the local
property takes precedence over the global property within the scope of that procedure.

This step is part of Process of Defining Business Rule Processes on page 216.

About Business Rule Process Property Types

You can categorize properties into two classes:

B Simple property types. Scalar properties such as an integer, string, or date.

B Complex property types. Non-scalar properties such as property sets, vectors, and Siebel
Business Component references.

At run time, you can pass values for global properties to the BRP business service as an input
argument. This run-time value overwrites the initial value definition, if any, on the property.

TIP: Use an appropriate prefix, such as global_, local_, or |_ to designate local and global
properties.

Complex properties except ProperySet and Vector cannot be passed as inputs to a BRP process.
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Table 15 describes the complex types in further detail.

Table 15. Complex Property Types

Type Description

BusComp

This data type stores a reference to a Siebel Business Component (BC) and
is used in conjunction with the FINS CAP Buscomp Handler business service.

See Using BRP Helper Business Services on page 236.

BusComp is used within BRP process as a stand-alone BC, without the
context of Business Object (BO). Hence, you have to explicitly query the
BusComp with the correct key values to establish a context.

Property Set

Property sets are collections of properties used for storing data. They may
have child property sets assigned to them to form a hierarchical data
structure.

See Siebel Object Interfaces Reference.

The Property Set itself can contain child property sets. This is particularly
convenient to store array-like data. For example, to store multiple contacts
and their properties such as Name, Phone Number, and Date of Birth. Each
contact is stored as a child property set of Contacts. At the leaf, the property
map stores data as a nhame-value pair.

A property set cannot be instantiated with an assignment. Property sets are

always instantiated using a business service, such as FINS CAP Buscomp
Data Loader Service. See Using BRP Helper Business Services on page 236.
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Table 15. Complex Property Types

Type Description

Vector Vectors are special-formatted Property Sets, where each non-leaf node
stores a unique key as its value.

NOTE: The vector root node type for a BRP process is always
SEBLFACapVector.

A vector cannot be instantiated with an assignment. Vectors are always
instantiated using an business service, such as FINS CAP Buscomp Data
Loader Service. See Using BRP Helper Business Services on page 236.

The following diagram shows a ProductRate vector that has 2 levels - Region
& Product name. At the leaf level the vector stores the rate and the balance
as key value pairs.

222 Siebel Finance Guide Version 7.8



| Services I Defining Properties for a Business Rule
Process

Table 15. Complex Property Types

Type Description

Vector Reference Vector Reference is a reference to a property set, vector or a child property
set. Once defined, you can use Vector Reference as a vector or propertyset.

When the referenced object is reset, the dependent reference is
automatically set to NULL.

This property set is particularly useful when accessing data on the child
property sets. There are two ways to make a child Property Set reference:

B childPropertySetRef = parentPropertySet[strkeyValue]
B childPropertySetRef = parentPropertySet(nindex)

About Using Parentheses
Round parentheses () are used to retrieve a child Property Set by index.

NOTE: The index starts at O.
Square parentheses [ ] are used to get a child Property Set by value.
NOTE: Accessing by value is only valid for Vectors.

Only literals or property names can be used within [ ] or (). Expressions
cannot be used within.

TIP: To use expressions within [ ] or (), assign these to a simple property
type and use the simple property within [ ] or ().

You can use square and round parentheses in combination.
Example:
grandchildPropertySetRef = parentPropertySet(2)["California"]

In the preceding notion, parentPropertySet itself can be a reference. In other
words, a reference and a property set are used interchangeably for data
access.

Retrieve leaf properties by using square parentheses [ ].

Example:

ProductRate = productRate[productld][domain]["Annual Fee"]

To define a property for a business rule process

1 Navigate to the Business Rule Processor screen and select a process for which you want to create
global variables.
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2 Click the Properties view tab and create a new property completing the fields as necessary.

Some fields are described in the following table.

Field Comments

Sequence Identifies the numeric sequence of this property. The application
initializes properties in numerical order based on this number.

Data Type The data type for the property. The value can be one of the following.
Simple types:
B String
B Integer
B Number
m  Date

B Boolean
Complex types:

B Property Set

B Vector

B Vector Reference

B BusComp

Value Initial value of the property.

Initial values can be set only for Simple property types.

Output Select this check box to make property an output argument and is used
to pass information out of the business service. which has no output
arguments of its own.

This flag does not apply to Complex property types except ProperySet
and Vector.

Defining Procedures for a Business Rule
Process

Procedures are collections of steps. When a procedure is executed, each step in the procedure is
executed in sequence.

One of the procedures is designated at the process level as the entry procedure. This procedure is
executed when the process is executed. Within the entry procedure, other procedures are invoked
by additional procedure statements.
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Each procedure is uniquely identified by its name. The name must begin with a letter. It can contain
alphanumeric, spaces, underscores, and hyphens. It cannot contain other special characters such as
an ampersand (@), exclamation mark (1), or percent sign (%). Procedure names are case sensitive.

A procedure can have its own local properties. These properties can only be accessed within the
procedure where they are defined. If a local property has the same name as a global property, the
local property takes precedence over the global property.

This step is part of Process of Defining Business Rule Processes on page 216.

To define a procedure for a business rule process procedure
1 Navigate to the Business Rule Processor screen and select a process.

2  Click the Procedures view tab, and create a new procedure.
3 In the Properties list, create new records to define local variables for the procedure.

The fields for a local variable are equivalent to those of a global variable. The fields are described
in To define a property for a business rule process on page 223.

NOTE: Properties defined for a procedure are local variables accessible only to the parent
procedure. You can define global variables in the Business Rule Processor Properties view. See
Using BRP Helper Business Services on page 236.

To define a step for a business rule process procedure
1 Navigate to the Business Rule Processor screen, select a process and a procedure.
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2 Navigate to the Steps list and create a new record to define each step for the procedure.

Some of the fields are described in the following table.

Field Comments

Sequence The numerical order in which the steps are executed.
Step Type There are three types of steps:
B Statement Step. Contains one or more child statements that are

executed if and when the statement step is executed.

Business Service Step. Invokes a Siebel business service. Business
Service Step provides a way to extend the capabilities of BRP beyond
its out-of-box features.

For instance, you could code custom functionality in an eScript and
then wrapped as a Siebel Business Service. You could invoke this
Business Service within the Business Service step and exchange
arguments between the script and the BRP process.

Switch Step. Contains switch criterion and a switch block for each
criteria. The switch block is like a statement step and contains one or
more child statements.

TIP: Use the switch step if a variable is a bounded variable. From a
performance and maintenance standpoint, a switch step is better than
multiple conditional statement steps.

Inactive A check box to activate or inactivate a given step.

Comment A free text field used to document the step.

TIP: Make sure that each step has appropriate comments for ongoing
maintenance of BRP process definitions.

3 Drill down on the Step Type and proceed to one of the following steps, depending on the step

type.
m Statement Step

B Business Service Step on page 231

m  Switch Step on page 232

Statement Step
For a statement step:
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a  Complete the fields in the Statement Steps form, some of which are described in the following

table.

Field Comments

Condition A Siebel Query Language expression evaluated to be TRUE or FALSE.
If the expression is evaluated to be TRUE, then the statement step is
executed. If the field is not specified, then the statement step
executes every time it is encountered.
Example: [SomelntegerVariable] < 0

Loop If checked, the statement step iterates over and over as long as the

Condition is evaluated to TRUE.

If neither Condition nor Loop is asserted, then the statement step is
executed one time, unconditionally.

The looping is counted and compared with the maximum allowed Loop
Count in order to avoid infinite looping. By default, this number is set
to 1000, however, you can overwrite this value by defining the system
preference FINS CAP Max lteration. If the iteration number exceeds
the maximum, an error is thrown. Refer to Handling Business Rules
Processor Errors on page 234 for more information on handling errors.

TIP: Construct a For...next loop, by defining a local variable and then
either incrementing or decrementing that variable in a statement. On
the condition, check if the local variable has reached its limit.

b Add one or more records to the Statements list, defining the statements of the statement step.
Some of the field are described in the following table.

Statement Type Value Expression Example
Assignment. Name of a local, A Siebel Query

Evaluates the global, and system Language

expression and properties expression.

assigns the resulting previously defined
value to the property for the business

listed in the Value rule process.

field.

Procedure. Invokes Name of a defined Null and read-
another procedure procedure which is  only.

defined inside the part of the business

BRP process. rule process.
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PropertySet Value.
Retrieves a property

Business Services for Siebel Financial Services
Rule Process

Value

Name of a local,
global, and system

value from a property properties

set or child property

set, as defined by
Expression. This
property value is
placed into the
variable defined by
Value.

previously defined
for the business
rule process.

Expression

A property set
value retrieve
expression. The
expression must
begin with a
variable of type
property set,
vector set
reference, or
vector.

Each index can be
either a variable
of type integer or
number, or
numeric literal.
No Siebel
calculation
expressions can
be involved.

EX:
PropSet[Anintege
r][“SomeName”]

PropSet(2)[“Som
eName”]

No Siebel
calculation
expressions can
be involved.

Example

Consider a Property Set
called productRate that
contains banking
product information
organized by Region and
Product Name.

Retrieve the Annual Fee
property from the
Property Set and assign
this to a local property
named |_Rate, by

setting:
Value = |_Rate
Expression =

productRate["West"]
["Checking"]["Annual
Fee"]

PropertySet Set
Value. Assigns a
value to a property
set property value.

A property set
value retrieve
expression.

If the stated
property name
value does not
exist, a new name/
value pair is
created.

Name of a local or
global property.

If the property is
not a string, it is
internally
converted to a
string first by
BRP.

Set the Annual Fee
property on the Property
Set productRate, by
setting:

Value =
productRate["West"]
["Checking"]["Annual
Fee"]

Expression = |_Rate
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Statement Type

PropertySet
Reference. Creates
a reference to a
vector or property
set. If the referenced
objectis a vector, the
reference acts as a
vector. Otherwise,
the reference acts as
a property set.

Creates an alias to a
subset of a property
set.

Value

A local or global
property of type
Vector Reference.

Expression

The expression
must begin with a
variable of type
property set,
vector set
reference, or
vector.

Each index can be
either a scalar
property or a
string or numeric
literal. No Siebel
calculation
expressions can
be involved.

cial Services I Defining Procedures for a Business

Rule Process

Example

Create a new Property
Set Reference to all the
products in the "East"
region from the
productRate Property
Set, and assign this to a
local variable
|_east_prod, by setting:

Value = |_east_prod

Expression =
productRate["East"]

PropertySet Sum.
Retrieves an
aggregation value
from a vector or
property set.

A local, global
property.

The property
should be of data
type number or
integer.

A property set
value retrieve
expression.

This expression
differs from other
property set
retrieval
expressions in
that one of the
indexes must be a
wild card,
indicating
summing of all
indices of that
node. This is done
by using an
empty set of
parenthesis.

If the child
property set, or
the property does
not exist, the
return value is set
to null.

Calculate the sum of
balances under the
Savings product across
all regions from the
productRate Property
Set, and assign this to a
local variable
|_savings_bal, by
setting:

Value = |_savings_bal

Expression =
producetrate[]
["Savings"]["Balance"]
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Statement Type

PropertySet
Childcount.
Retrieves the number
of child property
sets.

Value

A local, global
property.

Property should be
of data type integer
or number.

Expression

A property set
reference retrieve
expression.

If the property set
does not have a
child property set,
the returnvalueis
0. If the property
set does not
exist, the return
value is -1. The
latter is a useful
approach to
determine if a
property set, or a
reference is null.

Example

Calculate the number of
products available in the
west region from the
productRate Property
Set, and assign this to a
local variable
|_west_count, by

setting:
Value = |_west_count
Expression =

producetRate["West"]

Table Lookup. Look-
up a value based on
ranges. The look up
table is stored as a
specialized property
set. The property set
consists of child
property sets, and
the child property
sets contain three
properties
corresponding to
Lower Bound, Upper
Bound, and Value.

At run time, for any
input value, BRP
looks up the child
property set and
locates the leaf
whose lower Bound is
smaller than the
input value, but
whose Upper Bound
is bigger than the
input value, and
returns the Value
property.

A local, global
scalar property.

The expression
follows property
set retrieval
syntax, but in the
following
specialized
format:

PropertySet
[Upper Bound
Field Name]
[Lower Bound
Field
Name][Return
Value Field Name]
[InputProperty]

The Upper Bound
Field Name,
Lower Bound
Field Name, and
Return Value Field
Name must be a
string literal or a
BRP string
property. The
InputPropety
must be the name
of a BRP numeric
property used to
do the lookup.

Consider a TaxRateTable
vector, where High, Low,
and Rate fields define
the Upper Bound, Lower
Bound, and Return
Value.

Lookup the effective tax
rate for a person given
the Total Income and
assign this to a local
variable |I_tax_rate, by
setting:

Value: |_tax_rate
Expression:
TaxRateTable["High"]

["Low"]["Rate"]
[dMyTotallncome]
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Business Service Step
For a business service step:

a In the Business Service Step form, complete the fields as described in the following table.

Field Comments

Business Service The name of the business service to invoke. In particular for BRP,
there are two helper business services that you are likely to use for
data access: FINS CAP Buscomp Data Loader Service and FINS CAP
Buscomp Handler.

For more information on these two business services, see Using BRP
Helper Business Services on page 236.

Method The business service method to use.

BusComp A reference to a Buscomp Property Type.

This field is used only in conjunction with the two BRP helper business
services, FINS CAP Buscomp Data Loader and FINS CAP Buscomp
Handler. See Using BRP Helper Business Services on page 236.

b In the Arguments list, define required input and output arguments for the business service
invoked. Some of the fields required are described in the following table.

Field Comments
Direction Type of argument: Input, Output, or Input/Output.
Name The argument name.

Use the pick list to select the name for registered business services.
Picking the argument name automatically sets the direction.

Type The mechanics of passing values to the Business Service. Select from
one of three values:

B Literal. For Input and Input/Output arguments, the literal string
in the value field is passed as an input to the Business Service
method. For output arguments, this selection is invalid.

B Property. For Input and Input/Output arguments, the value of the
local or global property is passed as an input to the Business
Service method. For output arguments, the return value is
populated into the local or global property.

B Expression. For Input and Input/Output arguments, the
expression in the Value field is evaluated and is passed as an input
to the Business Service method. For output arguments, this
selection is invalid.
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Field Comments

Value Contains different values depending on the argument type:
B Literal. Contains the string value.
B  Expression. Contains the Siebel query expression.

B  Property. Disabled.

Property Local or global property.

This field is disabled for Literal or Expression type arguments.

Switch Step
For a switch step:

a

b

In the Switch Steps form, enter the switch criteria, a Siebel Query Language Expression that
evaluates to be a string.

In the Switch Blocks list, create records and complete the fields as described in the following
table.

Field Comments

Value A string value used to compare with the switch step criterion value.

If they are the same, the switch block is executed, which, in turn,
executes the child statements belonging to the switch block.

Default If checked, the switch block acts as the default switch block. It is
executed if no match is found for the switch step criteria.

At any point, you can disengage only one Switch Block as the default
block.

In the Statements list, enter one or more statements. See Statement Step on page 226 for
details on creating statements.

Fine-Tuning the Assignment Statement

You can use two fields available at the statement level to fine-tune the performance of Assignment
Statements:

B Cache Flag

B Light Parser Flag

For most cases, it is recommended to leave these fields at their default values. It is only necessary
to consider changing these values if performance is deemed poor.
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About the Light Parser Flag

Within your Siebel application, calculation expressions are evaluated using Siebel Query Language
Parser. This parser could be performance and resource intensive if the expressions are simple
numeric. However, to improve performance, BRP includes a high-performance light parser, which is
used solely to evaluate numeric expressions. In most cases, the light parser works many times faster
than the Siebel Query Language for simple numeric.

The following examples are numeric expressions that can be handled by the light parser:
® 12 + 8 + [A]* [B]

B 5+ (12 + [A]* ([B] + [CD)

The following examples are considered complex and cannot be handled by the light parser:
® 1If ([A] > [B], O, 1)

® [A] IS NULL

® LN (10)

When the Light Parser flag is checked, BRP attempts to use the light parser to parse and evaluate
the expression. If this fails, BRP resorts to Siebel Query Language engine to parse the expression.
By default, Light Parser Flag is checked.

TIP: If the Light Parser flag is checked, but the expression is not a simple expression, the BRP logs
an entry in the log file at run time if the Siebel log level is informational or higher. Use these log
entries to help you fine-tune assignment statements. See Logging Business Rules Processor Debug
Messages on page 248 for more information.
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About the Cache Flag
Table 16 shows the options if the Cache flag is checked or unchecked. It is recommended that you
leave this flag at its default value, that is, checked.

NOTE: The Cache flag is only meaningful when the expression is not handled by a light parser.

Table 16. Cache Flag Options

The Cache flag is checked. Only one single parse tree is established for the
expression within the object manager,
irrespective of the number of open sessions.

Therefore, when all sessions share the same
parse tree, the memory footprint is reduced,
however an overhead for context switch is
assumed.

The flag is not checked. Each session has its own parse tree for the
expression.

There will be no context switch, but the memory
footprint is increased.

Handling Business Rules Processor
Errors

BRP offers a mechanism to handle errors that includes two key features:

B Throwing Errors Within a Business Rules Process on page 235

B Recovering From Errors Within a Business Rules Process on page 235
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Throwing Errors Within a Business Rules Process

The BRP process definition includes three global system properties to throw errors and provide some
meaningful information when a run-time error occurs. These properties are presented in Table 17.

Table 17. Global System Properties for Errors

Property Name Type Description

System_ErrorCode String Alphanumeric error code.

This property contains an empty string when
there is no error.

System_ErrorMessage String Descriptive error message.

System_ErrorSource String Current context of the error.

After each statement, step, or procedure is executed, the BRP processor checks if System_ErrorCode
is an empty string. There are two ways to set System_ErrorCode:

B Manually (Expected Error Conditions). An explicit assignment statement sets a non-empty
string to System_ErrorCode.

B Automatically (Unexpected System Error Conditions). The BRP Processor detects a system
error such as failure to invoke a business service, or failure to evaluate a Siebel query language
expression, and sets System_ErrorCode to a Siebel error code.

When System_ErrorCode is non empty, an error occurs and the BRP processor uses the following
syntax to automatically set the error source to the full context of the current execution unit:

Statement Seq (Block Seq) Step Seq Procedure Name
where, Seq represents the sequence number of the Statement, Block, or Step.
NOTE: Block is optional and occurs only inside a switch step.

The three output global properties System_ErrorCode, System_ErrorMessage, and
System_ErrorSource are returned back to the calling process.

Recovering From Errors Within a Business Rules
Process

For every BRP process, a procedure can be nominated as the error procedure at the process level. If
defined, when an error condition occurs, this procedure is automatically invoked to handle the error.

On completion of the error procedure, System_ErrorCode property is rechecked. If it is empty, the
execution continues from the point where the error was originally thrown. If the error code is still
populated, the process does not necessarily end, but rather follows an error bubbling process.
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For example, if an error encounters in Statement 10 Step 5 Procedure Main, the error procedure is
first executed with System_ErrorSource to be 'Statment 10 Step 5 Procedure Main'. If the error is
not handled, the error bubbles one level higher, to Step 5 Procedure Main. The error procedure is

then re-executed with System_ErrorSouce to be 'Step 5 Procedure Main'. If error is handled there,
the next step following Step 5 is executed. Otherwise, the error bubbles to Procedure Main.

The whole bubbling process continues until it reaches the process level, with System_ErrorSource to
be Process myProcessName. If the error is not handled at the process level, the process ends with
an error.

It is important that the error procedure be thoroughly tested. If an execution error occurs within the
error procedure, the error procedure will not be recursively invoked; the error procedure will end
with an error.

TIP: Use a Switch block within the error procedure to check for known error codes.

Using BRP Helper Business Services

In Siebel Financial Services, there are two helper business services that are used as business service
steps within the BRP. They are both used to facilitate data access with a business rule process. The
two business services are:

B FINS CAP Buscomp Data Loader Business Service. The FINS Buscomp Data Loader is used to
load data for prop sets.

B FINS CAP Buscomp Handler Business Service. This business service takes the results of
calculations done within the BRP and then either creates new buscomp records, updates existing
buscomp records, or queries on calculation results.

FINS CAP Buscomp Data Loader Business Service

Use this business service to load data from a Siebel business component into a Siebel property set.
Additionally, once this data is loaded into a property set, it can be cached and shared across all login
sessions.

This business service exposes three methods:
B LoadData
B ClearCache

B NewVector
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About LoadData Method

Use the LoadData method to load Buscomp data into a property set. The property set follows the
vector format. Table 18 describes the input and output parameters for this method.

NOTE: Default the Search Spec, Sort Spec, Hierarchical Key, Key Field, Value Field, and Aggregate
field arguments by defining these as user properties on the source business component. Pre-fix the
BC user property with FINS Data Loader to identify these fields.

For example, define the default search spec as the Buscomp user property: FINS Data Loader Search
Spec.

Table 18. LoadData Method Parameters

Parameter
Name Direction Description

BusComp Input The name of a Siebel BC.

IsCachedData Input If true, the resulting vector is cached within the OM. Further
requests to load data from the same business component are
handled through the cache.

Cached data is retrieved based on the business component
name. If a second retrieval request uses different search
spec, fields, format, and so on, release the original cached
data first.

Search Spec Input The search spec applied to the business component when
loading data.

Since the FINS CAP Data Loader Service works outside the
context of a business object, the search spec should include
the appropriate user key fields.

Hierarchical Key Input Hierarchical keys define the hierarchy within the vector. These
[n] keys identify the unique key at each level.

Specify multiple hierarchical keys by defining [nN] =1,2,3 .. n

Refer to the ProductRate vector illustrated under Defining
Properties for a Business Rule Process on page 220. In the
ProductRate vector, Region and Product fields represent the
hierarchical keys.
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Table 18. LoadData Method Parameters

Parameter
Name

Sort Spec

Direction

Input

Description

The sort specification applied to the business component
when loading data.

It is important to match the Sort Spec and the hierarchical
keys when creating the vector. When a business component is
accessed through the FINS CAP Buscomp Data Loader
Service, sorting controls the shape of the parent/child tree
structure. Records are processed sequentially and are aware
of only the last parent node key. When children nodes are
added to a parent node, they continue to be added until a new
value is retrieved for the hierarchical key. When a new key
value is discovered, a new parent node is immediate created,
and children are assembled under that parent. This process
continues until all records are collected.

If a key equal to a previously processed node is retrieved after
a different node key has been processed, a new node is
produced rather than adding to the original.

Field [n]

Input

The name of Buscomp fields whose values are retrieved as the
leaf propertyset properties. The property name is the field
name, and the property value is the field value.

[n]=1,2,..

This represents one approach to how Buscomp fields can be
retrieved. See Example of LoadData Method Using Field [n] on
page 239.

Key Field & Value
Field

Input

Used to retrieve data as Key/value pair and store as a
property in the leaf propertyset. The field value of the Key
Field is the name of the property and the value of Value Field
is stored as the value of the property.

This is an alternative approach to Field [n] to retrieve data.
See Example of LoadData Method Using Key Field and Value
Field on page 240.

Duplicate Key/Value pairs are not allowed. If duplicates are
found when the vector is created, the new entry replaces the
old entry.
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Table 18. LoadData Method Parameters

Parameter

Name Direction Description

Aggregate Input Fields that will be aggregated if duplicates occur. Multiple

Field[n] aggregate fields can be specified by defining [n] =1,2,3 .. n
This parameter is useful with the Key Field/Value Field data
retrieval approach. For example, a contact can have multiple
income records with different types. If the Aggregate Field is
defined, the data loader service automatically sums the
income and stores this as a single income key/value pair.

Vector Output The resultant vector output.

Example of LoadData Method Using Field [n]

Golden Gate Bank defines its product rates in the Buscomp Financial Product. The fields in the
Buscomp and some sample data are:

Region Product Balance Rate
West Checking 10000 0.2
West Saving 29000 2.1
West N Market 87560 2.5
East Checking 40000 0.24

Use the following arguments to retrieve the data and store it in a format as defined by the
ProductRate Vector sample diagram shown in Vector type in Table 15.

Input Argument Name  Value

Buscomp Financial Product
IsCachedData Y

Hierarchical Key 1 Region
Hierarchical Key 2 Product

Sort Spec Region, Product
Field 1 Balance

Field 2 Rate

The data is stored into a vector named productRateVector. Then, the rate of the Checking product in
the East region can be retrieved as:

productRateVector["East][""Checking"][''Rate™]

using a PropertySet Value statement.
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Example of LoadData Method Using Key Field and Value Field

Golden Gate Bank decides to implement its product rates using a different schema. Instead of one
record for one product as shown in Example of LoadData Method Using Field [n] on page 239, they
would like to store the data using name-value pairs for each product. The advantage of this approach
is that they can add new attributes without schema changes. The data is stored in Financial Product
Attribute buscomp in the following manner:

Region Product Attribute Name  Attribute Value
West Checking Balance 10000

West Checking Rate 0.2

West Saving Balance 29000

East Saving Rate 2.1

Use the following arguments to retrieve the data and store it in a format as defined by the
ProductRate Vector sample diagram shown in Vector type in Table 15.

Input Argument Name Value

Buscomp Financial Product Attribute
IsCachedData Y

Hierarchical Key 1 Region

Hierarchical Key 2 Product

Sort Spec Region, Product

Key Field Attribute Name

Value Field Attribute Value

About ClearCache Method

Use this method to create an empty Vector or PropertySet. There is one output argument, Vector. In
BRP, PropertySets and Vectors are uninitialized before they are populated by a business service
method, for example, the data loader LoadData method. You can use the NewVector method to
generate an empty PropertySet/Vector.

FINS CAP Buscomp Handler Business Service

FINS CAP Buscomp Handler Business Service provides the ability perform data operations such as
query, update, and insert within the context of a business rules process.

NOTE: The business component is established without the context of business object. Pay special
care to identify the user keys for each record when inserting and setting values. Additionally, the
normal Siebel error handling resulting from the business object context is not enforced.

FINS CAP Buscomp Handler Business Service provides the following five methods:
B  Query
B NextRecord
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B SetFieldVvalue

B InsertRecord

ancial Services ! Using BRP Helper Business Services

All of these methods need a BusComp variable to be defined under the business service step
definition. See Business Service Step on page 231 for details on defining a business service step.

About Query Method

Use this method to retrieve data from a Siebel business component into a BRP BusComp property.
Table 19 describes the input and output parameters for this method.

Table 19. Query Method Parameters

Parameter Name

ActivateFieldName(1,2,3...n)

Direction

Input

Description

The name of the fields that should be included in the
query. List each field individually in a sequence.

Any field that you need to use with the GetFieldValue
and SetFieldValue methods, must be activated prior
to using these.

There are no limits to the number of fields that can
be activated, however, care must be taken since this
affects performance of the query.

BusCompName

Input

The Name of the business component from which the
data is to be retrieved.

SearchSpec

Input

The search spec applied to the business component
when retrieving data. This is a regular Siebel Query
Language expression.

Since the business service operates without a context
of business object, the search spec should include the
appropriate user keys when the query is used for an
update.

SearchSpecFieldName(1,2,3
...n)

Input

SearchSpecFieldValue(1,2,3
...n)

Input

Search Spec Field Name/Value pair is an alternative
way to set search spec on a field.

For example, SearchSpecFieldNamel=Application
Flag, SearchSpecFieldValuel=Y, then this is the
equivalent of setting SearchSpec to be:

[Application Flag] = Y
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Table 19. Query Method Parameters
Parameter Name Direction Description

SortSpec Input The sort specification applied to the business
component when querying data.

Status Output The status of the query operation. Status can have
one of two values:

B Succeeded. Indicates that the query returned at-
least one business component record.

B Failed. Indicates that either the query returned
no business component records or the query
failed due to a system error.

Following any data operation, use the Status field to
check for error conditions and take appropriate
actions. See Handling Business Rules Processor
Errors on page 234 for information on error handling.

Figure 5 shows the use of Query method to retrieve data from the FINS Health Provider business
component.
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HSacuenca: |3 =) Mehod: Quary =] rocar wactve [

Arguments [N I RS

Direcoon ©  Name Typo Valug Proporty Comments mactive
Dutput Stz Frozerty |_oaery_stanss Feetam stetus of the query
s AchivaleS ehamei Literai Hame Fame of the pravger
g Ativate® wehianel Liaral Pansi Panel stata for the provesr
L) BusComgtinmg Ltaral IS Heats Provier Busress companart i ueny
> gt SaprohSaen Expressen 0] &= = [g_provider_d] + = Query By the proviser i

Figure 5. Using Query Method to Retrieve Data
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About GetFieldValue Method

Use this method to get a value of a Business Component field into a local or global property. Table 20
describes the input and output parameters for this method.

Table 20. GetFieldValue Method Parameters
Parameter Name Direction Description

BusCompName Input The Name of the business component from which the
data is to be retrieved.

FieldName(1,2,3...n) Input Name of the fields to be retrieved.

This field needs to be activated prior to retrieval. See
Table 19 on page 241.

Fieldvalue(1,2,3...n) Output The output property into where the field value will be
written. This is always of type property.

FieldName and FieldValue need to be defined in pairs.
That is, for each FieldName defined, a FieldValue
should be defined as well.

Status Output The status of the GetFieldValue operation. The status
can have one of two values:

B Succeeded. Indicates that the query returned at-
least one business component record.

B Failed. Indicates that either the query returned
no business component records or the query
failed due to a system error.

Following any data operation, use the Status field to
check for error conditions and take appropriate
actions. See Handling Business Rules Processor
Errors on page 234 for information on error handling.
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About SetFieldValue Method

Use this method to set a value of a business component field. Table 21 describes the input and output
parameters for this method.

Table 21. SetFieldValue Method Parameters
Parameter Name Direction Description

BusCompName Input The name of a business component where the field to
be updated is located.

FieldName(1,2,3...n) Input The name of the fields to be updated.

This field needs to be activated prior to fetching. See
About Query Method on page 241.

Fieldvalue(1,2,3...n) Input The new value for the field.

FieldName and FieldValue need to be defined in pairs.
That is, for each FieldName defined, a FieldValue
must be defined as well.

Status Output The status of the SetFieldValue operation.
Status can have one of 2 values:

B Succeeded. Indicates that the operation
succeeded.

B Failed. Indicates that the operation failed.

Use the status field to check for error conditions and
throw appropriate errors. See Handling Business
Rules Processor Errors on page 234 for information on
error handling.

About InsertRecord Method

Use this method to insert a record into a Business Component. Table 22 describes the input and
output parameters for this method.

Table 22. InsertRecord Method Parameters

Parameter Name Direction Description

BusCompName Input The name of a business component to which a record
is to be inserted.

FieldName(1,2,3...n) Input The name of the fields to be included in the insert.
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Table 22. InsertRecord Method Parameters

Parameter Name Direction Description
Fieldvalue(1,2,3...n) Input The value for the field.

FieldName and FieldValue need to be defined in pairs.
That is, for each FieldName defined, a FieldValue
must be defined as well.

Status Output The status of the InsertRecord operation.
Status can have one of 2 values:

B Succeeded. Indicates that the operation
succeeded.

B Failed. Indicates that the operation failed.

Following any data operation, use the Status field to
check for error conditions and take appropriate
actions. See Handling Business Rules Processor
Errors on page 234 for information on error handling.

About NextRecord Method

Use the NextRecord method to advance to the next record in a list of business component records.
Table 23 describes the input and output parameters for this method.

Table 23. NextRecord Method Parameters

Parameter Name Direction Description
BusCompName Input The name of a business component.
Status Output The status of the NextRecord operation.

Status can have one of 2 values:

B Succeeded. Indicates that the operation
succeeded.

B Failed. Indicates that either the end record has
reached or the operation failed with a system
error.

Following any data operation, use the Status field to
check for error conditions and take appropriate
actions. See Handling Business Rules Processor
Errors on page 234 for information on error handling.
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Invoking the Business Rule Processor

A business rule process can be invoked from a workflow or Siebel script. While the processor cannot
be directly invoked from a run-time event, it can be invoked from a workflow that is triggered by a
runtime event. For all three of these invocation methods, you can prepopulate global variables
through the input arguments of the BRP. Input argument names must match the global variables you
define.

For an illustration of how to invoke the BRP from a run-time event or a workflow, see the process for
Data Validation Manager in Siebel Order Management Guide.

For information on invoking the BRP from with eScript, see Using eScript to Invoke the Business Rule
Processor on page 247.

NOTE: Within each session, BRP Processor creates a copy of the BRP executable objects. The
executable objects belong only to a single login session and are not shared. These executable objects
are cached within a login session. Release processes either explicitly or implicitly when the open
session is closed.

The FINS CAP Processor Service Business Services exposes three methods. Table 24 describes these
methods.

Table 24. FINS CAP Processor Service Business Services Methods

Method - Description Input Arguments Output Arguments
LoadProcess - The named System_ProcessName - The None.
calculation process definition is name of a calculation process.

loaded, and an executable instance
of the process is instantiated in the
current Web session.

RunProcess - This method executes | System_ProcessName - The System_ErrorCode

the named process. If the process name of a calculation process.

definition has not been loaded, the System_ErrorMessage
processor loads the definition first. System_ErrorSource
Whenever a BRP process is Return Codes. See
executed, the processor checks if the Handling Business Rules
current process definition cached in Processor Errors on

the OM instance. If not, the page 234.

processor instantiates the process
definition into the OM instance.

ReleaseProcess - This method System_ProcessName - The None.
releases the named process name of a calculation process.
executable in the current Web
session. This does not affect other
open Web sessions.
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Using eScript to Invoke the Business Rule Processor

The following is an illustration of how to invoke the BRP using eScript.

Example of Loading the BRP Business Service
This example provides a sample eScript that loads a BRP process definition.

var psln = TheApplication() .NewPropertySet();
var psOut = TheApplication() -NewPropertySet();
var bs = TheApplication() -GetService(""FINS CAP Processor Service"™);

psin.SetProperty (''System ProcessName', '‘MyBRPProcessName');

bs. InvokeMethod(*"LoadProcess™, psln, psOut)

Example of Running the BRP Business Service

This example provides a sample eScript that executes a BRP process definition. The script also shows
how to pass an input argument (g_Assetld) to a BRP process.

function WebApplet_PrelnvokeMethod (MethodName)

if (MethodName == "InvokeMyBRP'")
{ -
var psinputs
var psoutputs
var oBusObj
var oBusComp
var sAssetld

TheApplication() .NewPropertySet();
TheApplication() .NewPropertySet();
TheApplication().ActiveBusObject();
0BusObj .GetBusComp(*"FINS Group Policy™);
oBusComp .GetFieldValue(*'1d™);

psinputs.SetProperty (“'g_Assetld", sAssetld);
psinputs.SetProperty (‘'System_ProcessName', "MyBRPProcessName'™);

var obs = TheApplication() .GetService(""FINS CAP Processor Service');
obs. InvokeMethod ('RunProcess",psinputs, psoutputs);

return (CancelOperation);

}

return (ContinueOperation);

}
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Logging Business Rules Processor
Debug Messages

BRP provides different levels of execution logging in the form of trace files to facilitate debugging a
process. Currently, there are two levels of BRP logging. These levels are detailed in Table 25:

Table 25. BRP Levels of Execution Logging
Level Severity BRP Implementation

4 Detail Log the execution and initialization path of the BRP process
without details.

5 Debug Log execution details.

Under this level of logging, the values of local and global
properties are logged as a part of the assignment statements.

TIP: To check the value of a variable, use a dummy
assignment step.

The BRP log level is set with the environment parameter SIEBEL_FACAP_LOG_EVENTS.

BRP logging is written to the Siebel object manager log file. In order to enable BRP logging, the Siebel
log level must also be informational or higher. For a mobile client, set the workstation system
environment parameter SIEBEL_LOG_EVENTS = 3.

The SIEBEL_LOG_EVENTS can be set from Server Administration. Refer to Siebel System
Administration Guide for more information.

In BRP logs, each local property is appended with its procedure name. For example, if a local property
was defined as local_dMylncome in Procedure Main, within the log file, this property would be
identified as Main@local_dMylncome.

CAUTION: BRP log files can grow quickly. In general, the logs should be enabled only for
administrators to do debugging.

Requirements Manager

The section is about the Requirements Manager business service and includes the following topics:
About Requirements Manager

Administering Requirements Manager on page 250

Creating Record Templates on page 250

Creating Requirement Templates on page 251

Using Requirements Manager on page 254

Creating Record Group Templates on page 254
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B Example of Using Requirements Manager for Record Group Templates on page 256

About Requirements Manager

The Requirements Manager is a business service that automatically generates activities, customer
submissions, and workflows required at predetermined steps in the business process.

For example, a loan applicant may be required to submit proof of employment, account statements,
and other documents. The Requirements Manager allows a business analyst to specify conditions
under which certain documents would be required in order to move the application process forward.
The business service is invoked at a predetermined point during the application process to generate
the appropriate follow-up activities for customer submissions.

The Requirements Manager can be applied to a wide variety of usage scenarios including service
processes such as the auto-creation of a fund transfer service request. Some examples of
Requirements Manager scenarios are:

B Life Insurance. A life insurance policy might require a trailing document (a physical exam), an
activity (such as an interview with an underwriter), and several forms to complete. If the product
type = life insurance for instance, this set of requirements might be selected. However, an
exclusion rule might be present to eliminate the need for the underwriter interview if the policy
was for less than $100,000.

B Mortgage Application. A mortgage application might require several documents, several
disclosures, two annual tax returns (documents), an appraisal (activities), and a credit check
(workflows) to complete. This set of requirements might be run for every mortgage, but there
might be an exclusion rule such that if the loan-to-value is less than 50%, the tax returns are
not required.

The Closing Requirement view is preconfigured in the Applications and Life & Annuities screens. You
can use this to view the output of the Requirement Manager business service, for requirement
templates defined on the FINS Application, and FINS Life Policy business objects respectively.

Key Features of Requirements Manager
The Requirements Manager business service provides the following key features:

B Define multiple requirement templates that supports version control

B Provide support for conditional expression in each requirement template

B Define record templates that can insert records into any Siebel business object and component
|

Invoke predefined workflows automatically to support the processes

About Invoking Requirements Manager

Requirement Manager is invoked the same as any other business service; through a workflow, run-
time event, or script. At the time of execution, the service evaluates the various templates from
which to execute, and executes each requirement where the exclusion rule evaluates to false.
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Administering Requirements Manager

Administering the Requirements Manager business service involves the following steps:
1 Creating Record Templates
2 Creating Requirement Templates on page 251

Optionally, you can create record group templates in order to aggregate other record group template
and record templates. See Creating Record Group Templates on page 254.

Creating Record Templates

The Record template is used to define templates that will work in a specific business object/
component. It also defines the fields that will automatically populate the template in that business
object/component. Upon execution, the business service generates a record in the business object/
business component and populates the fields according to the specified template.

To create a record template
1 Navigate to the Administration - Record Template screen > Record Template view.

2 In the Record Template list, create a new record, and complete the fields.

Some of the fields are described in the following table.

Field Description

Template Name Name for the record template.
Display Name The display name of the template as seen in the UI.
Business Object The business object for the template to be enabled.

For example, to auto populate a record in the Applications or Life &
Annuities screen, you must select FINS Application or FINS Life
Policy business objects, respectively.

Business Component Business Component on the selected business object.

The Record Template Administration view is preconfigured so you
can specify the prefill of two applets in the Closing Requirements
view: activities and documents.

For example, to prefill the record in one of these two applets, you
must select Action or INS Policy Document, or FINS Application
Mortgage Trailing Documents business component.
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3 In the Fields list, create a new record and complete the fields.

Some of the fields are described in the following table.

Field Description

Sequence # Sequence number for the fields.
Field Name The field name in the specified business component.
Pre-Default Value The prefilled value for the field.

NOTE: You can put conditional statements on this field.

Business Component Read-only field of the business component name.

4 In the Related Record Template list, create a new record and complete the fields.

The Related Record Template applet is used to specify child and grand child of record templates.
Upon execution, the business service inserts a record as specified in the parent record template,
as well as all records specified in child and grandchild templates.

Creating Requirement Templates

The Requirement Template is used to aggregate several record templates. The record template
specified in Creating Record Templates on page 250 only inserts one record in the business object/
business component. Insert multiple records in different business objects/components, by
aggregating multiple record templates in a single requirement template. Additionally, in a
requirement template, you can specify a workflow to invoke.

To create a requirement template
1 Navigate to the Administration - Requirement Template screen > Workflows view.

2 In the Requirement Template list, create a new record and complete the fields.

Some of the fields are described in the following table.

Field Description

Template Name Name for the requirement template.
Display Name The display name of the template as seen in the Ul.
Business Object The business object for the template to be enabled.

For example, to pick the template name in Applications or Life &
Annuities screen, you must select FINS Application or FINS Life
Policy business objects, respectively.
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Field Description

Business Component Business Component on the selected business object.

For example, to be able to pick the template name in the
Applications or Life & Annuities screen, you must select
Opportunity or FINS Life Policy business components, respectively.

Condition A valid Siebel query language expression. If this conditional
expression evaluates to True then the rules under the rule-set
would be evaluated.

TIP: Use the expression builder to test the validity of conditional
expressions.

Version The version number of the template.

NOTE: When you select the Revise button, the Siebel application
automatically versions the template.

Status Status of the template with values: active, pending active, inactive,
outdated, and in progress.

Start Date Start date for the template.

You can specify a date in the future, and when activated, the status
of the template changes to Pending Active. The application
automatically changes the status to Active on the specified date
and time, and executes the appropriate version of the template.

End Date End date for the template.

The application sets the status of the template to Outdated once
the specified end date arrives.

3 In the Workflow list, create a new record and complete the fields.

Some fields are described in the following table.

Field Description

Sequence # Sequence number for the workflow.

Workflow Name Name of the workflow that is enabled for the business object/
business component specified in the requirement template.

NOTE: The workflow called here should be deployed and active.
Please see Siebel Business Process Designer Administration Guide
for further information.

Exclusion Rules A valid Siebel query language expression. If this conditional
expression evaluates to True, then the workflow is excluded.
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Field Description

Execute Immediately A flag to automatically execute the workflow when the requirement
template is executed. This field should be empty to execute the
workflow manually.

See Using Requirements Manager on page 254 for information on
executing the workflow manually.

Workflow Context A text field passed as process properties to the workflow.

The format of this field should be in the form of comma delimited,
Name-Value pairs. For example:

“State”, “CA”, “Source BusComp”, “FINS Life Policy”

Where State and Source BusComp are property names, and CA and
FINS Life Policy are property values, respectively.

Business Component Read-only field similar to the business component specified in the
requirement template applet. ldentifies the business component on
which the exclusion rules will be evaluated.

Click the Record Template view tab.
5 In the Record Template list, create new record, and complete the fields in the list.

Some fields are described in the following table.

Field Description

Template Name Select the template you want to associate with the requirement
template.
Exclusion Rule A valid Siebel query language expression. If this conditional

expression evaluates to True, then the record template is excluded.

Expectation Set A flag to automatically invoke the Customer Expectations Manager.

NOTE: The Customer Expectations Manager should be set before
hand for this to work. Please see Using the Customer Expectations
Manager on page 268 for more information.

Auto-Assign A flag to automatically invoke the Siebel Assignment Manager.

NOTE: Assignment Manager should be set before hand for this to
work. Please see Siebel Assignment Manager Administration Guide
for more information.

6 In the Requirement Template list, click Activate.
7 (Optional) To revise the requirement template, click Revise.

8 (Optional) To deactivate a requirement template, click Deactivate.
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Using Requirements Manager

Use the Closing Requirement view, enabled in the Applications and Life & Annuities screens, to view
the output of the Requirement Manager business service, for requirement templates defined on the
FINS Application, and FINS Life Policy business objects respectively. However, through configuration,
the Requirements Manager can be invoked from any screen.

When invoked, the business service automatically prefills the target list or form with records as
defined in the Administration - Requirement Template screen.

To invoke Requirements Manager
1 Navigate to either:

m Applications screen > Application List view > Closing Requirements view

m Life & Annuities screen > Life Policy List view > Closing Requirements view

In the Templates list, create a new record.

Select the template name as defined in Creating Requirement Templates on page 251.
In the Templates list, click Execute.

Requirements Manager prefills Activities, Workflow, and Documents lists based on the records
specified in the Administration - Requirement Template screen.

5 Complete the fields in the Activities, Workflow, and Documents lists.

NOTE: If the workflow is not set to run automatically, you can set the workflow manually by clicking
Execute in the Workflow list.

Creating Record Group Templates

The Record Group Template is used to define a template that works in a specific business object/
component. The Record Group Template is used to aggregate other record group template and record
templates. A record group template is based on the business component relationship defined in the
business object layer. You can use the record group template to recursively execute interrelated
business components, and generate data in a particular business component.

A record group template can include other related record group templates and related record
templates. When the business service executes a record group template, it automatically, recursively
executes any other related record template or related record group template defined.

Creating a Record Group Template involves the following steps:
1 Creating Record Group Templates

2 Creating Related Record Group Templates

3 Creating Related Record Templates

For an example of setting up a record group template, see Example of Using Requirements Manager
for Record Group Templates on page 256.
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To create a record group template

1
2

Navigate to the Administration - Record Template screen > Record Group Template view.
In the Record Group Template list, create a new record and complete the fields.

Some fields are described in the following table.

Template Name Name for the record group template.

Display Name The display name of the template as seen in the Ul.
Business Object The business object for the template.

Business Component The business component on the selected business object.

In the Related Record Template list, create a new record and complete the fields.

You can use the Related Record Template list to specify a child of the record group template. Upon
execution, the business service inserts a record in the business component on which the record
template is defined, for the corresponding parent record.

Field Description

Template Name Name of the child template record.

Exclusion Rules A valid Siebel query language expression. If this conditional
expression evaluates to True, then the related record template is
excluded.

Repeat Expression A field indicating the number of times the record template should

be executed within the context of the parent record group
template. By default this is set to 1.

Business Component Read-only field. Identifies the business component on which the
exclusion rules are evaluated.

In the Related Record Group Template list, create a new record, and complete the fields.

You can use the Related Record Group Template list to specify the child record group template.
Upon execution, the business service executes the business component on which this record
group template is defined, within the context of the corresponding parent record group template.

Field Description

Template Name Name of the related record group template.

Exclusion Rules A valid Siebel query language expression. If this conditional
expression evaluates to True, then the related record template is
excluded.

Business Component Read-only field. Identifies the business component on which the

exclusion rules are evaluated.
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Example of Using Requirements Manager for Record
Group Templates

This section provides an example of configuring record group templates for automatically generating
vehicle coverages.

Record group templates can be used to automatically generate default coverage for vehicles in an
auto policy.

To setup auto coverage
1 Navigate to the Administration - Insurance screen > Auto Coverages view.

2 For each auto coverage in the Coverage Administration list, in the Coverage Values list, check
the default flag for one of the values.

To configure a record group template for generating vehicle coverages
1 Navigate to the Administration - Record Template screen > Record Template view.

2 Create a new record in the Record Template list, and enter the values as shown in the following

table.
Template Name INS Vehicle Default Coverage
Display Name Auto Default Coverages
Business Object INS Policy
Business Component INS Vehicle Default Coverage

3 Leave the Fields list empty.

The predefault values set for the fields in this business component in Siebel Tools will be
considered during execution.

4 Click the Record Group Template link bar, create a new record in the Record Group Template list,
and enter the values as shown in the following table.

Field Value

Template Name INS Vehicle Available Coverage Value Template
Display Name INS Vehicle Available Coverage Value Template
Business Object INS Policy

Business Component INS Vehicle Available Coverage Value
Condition [Default]="Y"
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5 In the Related Record Template list, create a new record and pick the record template defined in
Step 2.

6 Create another new record in the Record Group Template list, and enter the values as shown in
the following table.

Field Value

Template Name INS Vehicle Template

Display Name Default Vehicle Coverage Template
Business Object INS Policy

Business Component INS Vehicle

7 In the Related Record Group Template list, create a new record and pick the record group
template defined in Step 2.

To create an new auto policy
1 Navigate to Auto Policies screen and create a new policy.

Drill down on the Policy # record to navigate to the Quick Quote view and create the following
records:

a2 In the Vehicles list, create new vehicles

b In the Drivers list, create new driver records
3 Click the Rate Model view tab.

The vehicles list should display the vehicles created in the previous step.
4 Select a vehicle record and click Default Coverages.

The Select Templates to Run dialog box appears, and displays the template defined in Step 6 after
evaluating any conditional expressions defined.

5 In the dialog box, click Execute.

Default Vehicle Coverages are automatically created in the Vehicle Coverage list for the selected
vehicle record. These default coverages correspond to the default coverages selected in the
Administration - Insurance views in Step 2.

Customer Authentication Manager

Financial service institutions require customer authentication before a financial transaction can take

place. Furthermore, authentication becomes important as privacy and security regulations have
become common in the retail banking, and also make their way into insurance and healthcare
businesses.
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Typically, a bank may enforce tiered authentication policies that require a basic validation for
transactions up to certain limit, and require more rigorous transaction-based authentication for
transactions over the limit. In certain cases, for customers who perform regular high-value
transactions, the bank may use token validation, common ones being RSA tokens, or scratch lists.

Customer Authentication Manager is a utility that can be used to implement a secure and auditable
customer authentication during a sales or service process. You can use the Customer Authentication
Manager to prompt customer service representatives to authenticate a caller before providing any
service. It provides the following key features:

Ability to define multiple authentication templates using fields from the contact profile

B Rules-based, context sensitive invocation of authentication template
B Access from the global toolbar
B Audit trail of past authentication events; facilitates quick and accurate conflict resolutions

Ability to define success and failure workflows to take appropriate actions
Administering Customer Authentication Manager business service involves the following steps:
1 Creating Customer Authentication Templates

2 (Optional) Defining Customer Authentication Rules on page 260

Creating Customer Authentication Templates

Customer authentication templates define the credentials used for authentication and the actions
that follow a successful or a failed authentication attempt.

To create a customer authentication template

1 Navigate to the Administration - Application screen > Authentication Template view.
2 In the Templates list, create a new record, and complete the fields.

Some fields are described in the following table.

Field Comments

Name Name for the authentication template.
Description Description for the template.
Success Workflow Invoke this Siebel workflow if the authentication is successful.

The workflow called here should be deployed and active. The fields
used for authentication, and the confirm flag, are passed as process
properties to this workflow.

TIP: Use the success workflow to log the status of the
authentication for audit purposes.
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Field Comments

Failure Workflow Invoke this Siebel workflow if the authentication failed.

The workflow called here should be deployed and active. The fields
used for authentication, and the confirm flag, are passed as process
properties to this workflow.

Default If flagged as default, this template is used as the default template.
The default template is invoked if all rules defined in the
Authentication Rules fail.

Only one template can be flagged as default.

Alternate Template Defines an alternate template to use for authentication if the caller
fails to authenticate using the current template. The alternate
template is invoked by clicking the alternate button on the
authentication pop up window.

3 In the Credentials list, create a new record, and complete the fields.

Some fields are described in the following table.

Field Comments

Business Object Business Object for the credential field.

In the current Siebel release, the Contact business object is the only
business object that is available for use. Hence, this field is
predefaulted and read-only.

Business Component Business Component reference for the credentials field.

The business component used here should be a valid business
component on the Contact business object.

Field Name Name of the business component field.

Only single value fields are supported; multi-value fields are not
supported and may cause system instability if used.

Display Name The display name for the business component field. This specifies
the label for the field at run time.

Search Specification For any one-to-many contact business component, the search
specification provides the criteria to narrow selection to a single
record.

Required Flag Flag indicates that the field needs to be verified for the

authentication to be successful. If a required field is not confirmed
at run time, the authentication fails.

Defaults to No.
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Defining Customer Authentication Rules

Customer authentication rules define the logic to select an authentication template. When the
authentication manager is invoked, the business service steps through each rule for all applicable
rule-sets to find a rule that evaluates to true. The template defined against this rule is used for
authentication. If no rules are defined, or if none of the rules succeed, the default template, if
defined, is used for authentication.

To create a customer authentication rule
1 Navigate to the Administration - Application screen > Authentication Administration view.

2 In the Rule Sets list, create a new record, and complete the fields.

Some of the fields are described in the following table.

Field Comments

Name Name for the authentication rule set.

Description Description for the rule set.

Business Object Business Object context for evaluating the rules.

Business Component Business Component context for the conditional expression and

rules evaluation.

Conditional Expression A valid Siebel query language expression. If this conditional
expression evaluates to True, then the rules under the rule-set are
evaluated.

TIP: Use the expression builder to test the validity of conditional
expressions.

Active Flag Flag to activate or inactivate a rule-set.

The field predefaults to Inactive.

NOTE: If the conditional expression is not used, there should be only one rule-set per business
object/business component defined. If there are multiple rule-sets for the same BO/BC, and a
conditional expression is not defined, then the sequence of examination is random.

3 In the Rules applet, create a new record, and complete the fields.

Some of the fields are described in the following table.

Field Comments

Sequence Sequence number for rule evaluation.

Business Component Business component reference for the expression evaluation.

This field predefaults to the BC on the rule-set definition, and is a
read-only field.
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Field Comments

Inclusion Expression Siebel query language expression that specifies the rule.

If this conditional expression evaluates to True, then the template
associated with the rule is selected; further evaluation of the rules
is aborted.

TIP: Use the expression builder to test the validity of Inclusion
expressions.

Template Name The authentication template to use if the rule succeeds.

Invoking Customer Authentication Manager

Customer Authentication Manager is available preconfigured on the Contact, Members, and Providers
screens. However, using Siebel Workflow, you can invoke the Customer Authentication Manager from
any screen that contains a Contact, Member, or Provider business component.

Figure 6 shows the authentication icon on the toolbar. Click this icon to invoke the Customer
Authentication Manager.

File Edit “iew MNavigate Guery Tools

Eg=ES FAEREY =N

Contact:Paul Agee = Contact:

Figure 6. Authentication Icon on Toolbar

To authenticate a contact
1 Navigate to the Contacts List view.

2 Select the contact to authenticate and click the authentication icon on the toolbar.
The Siebel Authentication Manager dialog box appears.

3 Check the Confirmed checkbox for each field listed.
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4 Do one of the following:

To... Click...

Authenticate. Authenticate.

If all required fields are confirmed, the
authentication succeeds.

Use an alternate template. Alternate.

If an alternate template is defined, it appears.

Cancel authentication. Cancel.

NOTE: When Authentication Manager is invoked, if a matching template is not identified, an error
message appears.

Using the Calculation Manager

The Siebel Calculation Manager is designed to allow financial services institutions to declaratively
define and execute simple to moderately complex calculations within their Siebel application. It is
implemented as a business service that accepts input parameters for calculation, and the results are
available as output parameters. The Calculation Manager is tightly integrated into the Siebel
application architecture and can use Siebel Business component fields for input or output. The
business service facilitates specification of embedded calculation by business analysts.

Some examples of how Siebel Calculation Manager could be used:

B Loan Payment Schedule. The term, amount, and interest rate of a consumer installment loan
are captured in a Siebel Application. Calculation Manager is invoked to generate a schedule of
the amounts due—split by principle and interest—for each month of the term. The user evaluates
the schedule, runs several what-if scenarios with different loan amounts, and then exports the
schedule to an excel spreadsheet.

B Currency Conversion. A user wants to know the value of $100,000 in Japanese yen at the
current exchange rate. Calculation Manager is invoked, and an input dialog box is presented. The
current exchange rate has been prefilled into the dialog box. The user enters 100,000 as an
input, and clicks Calculate to see the result. The results are not saved.

B Early Withdrawal Penalty Calculation. A customer wants to remove money from a retirement
account he holds, but there is a penalty involved. The calculation of the penalty is complex, and
has been entered into the Siebel application as eScript. Upon invoking the Calculation Manager,
the Siebel application pulls in the variables necessary for the penalty calculation and runs the
eScript. The result is saved in the Siebel business component.
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Specifying Calculation Rules

Calculations are entered as calculation rules in a list, similar to how validation rules or Siebel
personalization rules are administered.

Calculation rules are specified in three stages:
1 Specify a calculation rule-set.
See To specify a calculation rule-set.
2 Specify variables used in the calculation.
See To specify variables on page 263.
3 Specify calculation details.

See To specify calculation details on page 264.

To specify a calculation rule-set
1 Navigate to the Administration - Application screen > Calculation Manager view.

2 In the Rule Sets list, create a new record, and complete the fields.

Some fields are described in the following table.

Field Comments

Name Calculation rule set name. Rule-set names are language
independent.

Comments Rule set description.

Business Object Business object context for evaluating the rules.

Array Output Business Business component context for writing the output of an array
Component calculation, such as Amortization table calculation.

Active Flag Flag to activate the calculation rule set. By default a calculation rule
set is inactive.

Script Flag Flag to indicate that the calculation rule is specified as a script,
rather than declarative rules.

Type List of values that provide the ability to categorize rules for easier
administration.

Applet Title Title for the pop-up applet that appears when the calculation
manager is invoked in the interactive mode.

To specify variables
1 Navigate to the Administration - Application screen > Calculation Manager view.

2 Select a Rule Set for which you want to specify variables.
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3 in the Variables list, create a new record and complete the fields.

Some fields are described in the following table.

Field Comments

Sequence Number Sequence number for the variable specification. The variables on the
pop-up applet appear in the sequence specified.

Name Internal name for the variable used when specifying the calculation
rule.

Variable names can contain a maximum of 35 characters and cannot
include spaces or arithmetic operators.

Display Format Display format for the variable. Example,
SH#H HHE
Display Name Label for the variable when presented to the user.
Type Type of variable. Values are Input, Output, or Output Array.
Business Component Business component context for the variable.
BC Field Name Business Component field name.

If the variable is an:

B Input variable, the run-time value of the business component
field name is assigned to this variable.

B Output variable, the value calculated for the variable is written
into the business component field name.

Optional Optional variables are variables not critical to the calculation, but
may be specified to alter the calculation.

This flag defaults to No.

Default Value Default value for the variable in the calculations. This value appears
in the dialog box for the variable.

Testing Value Value for the variable when the Calculation Manager is invoked in the
simulator.
Suppress Display Flag to indicate that the variable is hidden, and not displayed when

calculation manager is invoked in the interactive mode.

Variable Include Include the variable in the script generation.

To specify calculation details
1 Navigate to the Administration - Application screen > Calculation Manager view.

2 Select a Rule Set for which you want to specify calculation details.
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3 In the Rules list, create a new record, and complete the fields.

Some fields are described in the following table.

Field Comments

Sequence Number Sequence number for the rule execution.

Expression Calculation expression. The expression is guided by the following:

B Operator Support. All basic arithmetic operators, including
exponents, are supported (+,-,*,/,”). Nested quantities (that is
parentheses) are also supported.

B Simple Calculations. Simple calculations, such as a+b=c, are
defined in a single row.

B Compound Calculations. Multiple rows of calculations
specified in a single Template. This enables multiple variables to
be calculated independently, and then used in subsequent
calculations.

B For-Next Logic. Simple looping enables the generation of
arrays. Use a For statement and a Next statement to accomplish
looping. Example:

® row 1: For N=1 to Period,
®  row 2: [calculation]

®m row3: Next N

For-Next loops may be nested.

B If-Then-Else Logic. Simple If-Then-Else logic is supported
declaratively. As in the case of For-Next, If-Then-Else statements
appear on multiple rows of the calculation set. Nesting of If-
Than-Else statements is supported.

Example of Using Embedded eScript for Mortgage
Calculation

For compound calculations, embedded eScript is a more appropriate mechanism. The following is an
example of a mortgage calculation using eScript.

var Amount= O;

var NumPeriods= O;

var Rate= 0;

var InterestPaid = new Array;

var Payment = new Array;

var Period = new Array;

var PrincipleBalance = new Array;
var PrinciplePaid = new Array;
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var PeriodPayment = 0O
var Totallnterest = 0
var TotalPayment = O;

function Getlnput (Inputs)
{

with(Inputs)

var temp;
temp = GetProperty(“Amount™);
if (temp.length!=0)

Amount= ToNumber(temp);

temp = GetProperty("'NumPeriods™);
it (temp.length!=0)

NumPeriods= ToNumber (temp);

temp = GetProperty(‘'Rate™);
if (temp.length!=0)

Rate= ToNumber(temp);

}

function Main(Q)

{

Period[0] = O;

InterestPaid[0] = O;

PrinciplePaid[0] = O;

Payment[0] =0;

PrincipleBalance[0] = Amount;

Rate = Rate /1200;

PeriodPayment = Amount / (1.00/Rate - (1.00/Rate)/Math.pow((1.00+Rate),

NumPeriods));
for(var i=1; i<=NumPeriods-1; i++)
{
Period[i] = i;
InterestPaid[i] = PrincipleBalance[i-1]*Rate;
Payment[i] = PeriodPayment;
PrinciplePaid[i] = Payment[i]-InterestPaid[i];
PrincipleBalance[i] = PrincipleBalance[i-1] - PrinciplePaid[i];
3

TotalPayment = NumPeriods * PeriodPayment;
TotalInterest = TotalPayment - Amount;
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3

function Service_PrelnvokeMethod (MethodName, Inputs, Outputs)

{

Getlnput(Inputs);

MainQ);
SetOutput(Outputs);
return( CancelOperation );

}

function SetOutput (Outputs)
{

Outputs.SetType("Result™);

var psArray = TheApplication() .NewPropertySet();
psArray.SetType("'Array");

var len = InterestPaid.length;

for(var j=0; j<=len-1; j++)

{

var psArrayElement = TheApplication() -NewPropertySet();
psArrayElement.SetProperty("InterestPaid", InterestPaid[j]);
psArrayElement.SetProperty(*'Payment" ,Payment[j1);
psArrayElement.SetProperty("'Period",Period[j]):
psArrayElement.SetProperty(*'PrincipleBalance",PrincipleBalance[j]);
psArrayElement.SetProperty(*'PrinciplePaid”,PrinciplePaid[j1);
psArray.AddChild(psArrayElement);

}
Outputs.AddChild(psArray);

var psPeriodPayment= TheApplication() .-NewPropertySet();
psPeriodPayment.SetProperty(*'PeriodPayment",PeriodPayment);
Outputs.AddChi ld(psPeriodPayment);

var psTotallnterest= TheApplication().NewPropertySet();
psTotal Interest.SetProperty("Total Interest"”,Total Interest);
Outputs.AddChild(psTotal Interest);

var psTotalPayment= TheApplication() -NewPropertySet();

psTotalPayment.SetProperty("'TotalPayment' ,TotalPayment);
Outputs.AddChild(psTotalPayment);

Invoking Calculation Manager

Calculation Manager is invoked from within a Siebel workflow and can be triggered using a mini-
button on an applet. Use a business service step to invoke Siebel Calculation Manger in a workflow.
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Using the FINS Calculation Engine Business Service and the Calculate business service method, set
the input arguments as described in Table 26. There are no output arguments for this business
service.

Table 26. Input Arguments to Invoke Calculation Manager

Name Type Comments

Rule Expression Name Literal Calculation Rule name

Primary BC Name Literal Primary Business Component name

Primary BC Rowid Process Property Typically the Object Id of the
Workflow

Save To BC Literal Y or N

Child BC Namen (Optional) Literal Child Business Component name

Child BC Rowldn (Optional) Literal Child Business Component row id

When invoked interactively, the calculation manager displays a pop-up dialog box with the input and
output arguments. Perform the calculation by entering all input arguments and clicking the Calculate
button. A second pop-up dialog box appears with the calculated values. Finish the calculation by
clicking the Cancel button.

Using the Customer Expectations
Manager

Managing customer expectations around the length of time it takes to complete their requests is
crucial in maintaining customer satisfaction. Although many financial transactions complete in
seconds, a number of key relationship—enhancing tasks require lead time of one or more days to
complete. For example:

B Bank check deposits may not be available for immediate withdrawal and are subject to clearing.

B Credit and insurance applications typically undergo an underwriting process where the
application is evaluated for its creditworthiness, risk profile, and other factors that go into
approval and pricing. Fast turnaround is a competitive differentiator.

B Healthcare service complaints and grievances are handled through a structured review and
appeals process. In many jurisdictions, the processing of the complaints and grievances must
meet regulatory standards.

The Siebel Customer Expectations Manager (CEM) provides the ability to use historical estimates of
task completion times to aid the customer service representative in setting expectations for service
completion. It is most useful in situations where a standardized process is being executed, and there
is a need to estimate the expected completion date. Siebel CEM has the following two key features:

B Ability for an administrator to input the factors governing the time to complete task.
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B A run-time engine that sets Due Date and Expected Close Date for the enabled objects.

NOTE: For CEM versus Agreements/Entitlement Metrics, it is possible to establish an agreement for
an account that includes entitlements mandating the completion of Service Requests within specified
entitlement metrics. When these are setup, and the user navigates to the Service screen, they see
a Verify button. Clicking this button invokes the calculation of an Agent Committed Time. The
entitlement metrics will calculate a contracted due date. In contrast, CEM calculates an estimated
completion time or due date based on how long a process historically takes to complete. In cases
where a service agreement is in place, the contracted dates take precedence.

Defining Customer Expectation Manager Rules

The CEM administration screen holds the historical estimates for task completion times and the rules
for selecting an appropriate line. When CEM is invoked, the business service steps through each rule
for all applicable rule-sets to find a rule that evaluates to true. The estimates defined against this
rule are used for calculation of expected times.

To create a CEM rule
1 Navigate to the Administration - Application screen > Customer Expectations Manager view.

2 In the Rule Sets Applet, create a new record, and complete the fields.

Some fields are described in the following table.

Field Comments

Name CEM rule set name.

Business Object Business object context for evaluating the rules.

Business Component Business component context for the conditional expression and rules
evaluation.

Conditional Expression A valid Siebel query language expression. If this conditional
expression evaluates to True, then the rules under the rule-set
would be evaluated.

TIP: Use the expression builder to test the validity of conditional
expressions.

Active Flag Flag to activate or inactivate a rule-set.

The field predefaults to Inactive.

NOTE: If the conditional expression is not used, there should be only one rule-set per business
object/business component defined. If there are multiple rule-sets for the same BO/BC, and a
conditional expression is not defined, then the sequence of examination is random.
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Manager

3 In the Rules list, create a new record, and complete the fields.

Some fields are described in the following table.

Field Comments
Sequence Sequence number for rule evaluation.
Business Component Business component reference for the expression evaluation.

This field predefaults to the BC on the rule-set definition and is a
read-only field.

Conditional Expression Siebel query language expression that specifies the rule.

If this conditional expression evaluates to True, then the estimates
associated with the rule is selected; further evaluation of the rules
is aborted.

TIP: Use the expression builder to test the validity of Inclusion
expressions.

Name Unique name for the rule.

Used to improve performance of the rule-set search during
execution. Internally, a user key is constructed on the name field.

Schedule Schedule to use for calculating the expected completion times for
the task.

Schedules govern the working hours, holidays, and downtime. If
selected, the start time for the task is calculated using the
schedule.

Schedules are administered by navigating to the Administration -
Service screen > Schedules view. Refer to Siebel Field Service
Guide for details on schedule administration.

Use Employee Schedule If flagged, the employee schedule is used to calculate the start
time. Employee schedule override the default schedule.

Unit Unit of measure for the preparation, expected and slack times.
Valid units: Minutes, Hours, or Days.

Preparation Time Queue time for the task.

Expected Time Expected time to complete the task.

Slack Time Time buffer to allow for deviations from the expected completion
time.

Auxiliary Field (Optional) Specify Business Component field-value pairs. The

specified fields are updated with the values based upon the rule
selected. Example:

"Priority","0-ASAP"
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Invoking Customer Expectations Manager

In the current version of Siebel Financial Services, CEM is enabled for the Service Request object.

To invoke CEM
1 Click the Calculate Dates button on the Service Request form.

The CEM business service is invoked, and based on the administrative setup a pop-up dialog box
appears with the expected completion dates for the service request.

Closing the dialog box, the expected completion times are written into the current service
request.

2  Click the show more button on the Service Request form to view the expected completion times
in the Internal Tracking - Expected Times section.

Using Data Transfer Utilities (DTU)

This business service allows you to transfer data from a source business component to a destination
component. For example, a user can enter data in one view, then use a toolbar command to navigate
to another view. Data entered in the first view is automatically entered in the second view.

About Data Maps

Data maps are the logic defining the flow of data from one location to another. The DTU business
service uses data maps to transfer data from one location in the Siebel application to another.

This section contains the following topics:
B DataTransfer Method on page 279

B FAFireEventxxx Method on page 280

B GetActiveViewProp Method on page 280
B TryMockMethod Method on page 281

B QueueMethod Method on page 281
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Data Map Objects

Data map objects indicate the data that is being transferred from the source business object to the
destination business object. You can use the Administration - Application > Data Map Administration
screen to define data map objects. Only Siebel administrators should have access to this screen. Data
map objects are described in Table 27.

Table 27. Data Map Objects

Object Description

Name Data map object name. Enter a unique name.

Source Business Source business object name. You must define this name in the Siebel
Object Repository file.

Destination Business | Destination business object name. You can specify the same business
Object object as both source and destination business object.

Inactive Check this box to make the data map object inactive.

TIP: Data map objects are cached in memory. Whenever you make changes to an existing data map
object, click the Clear Cache button to refresh the cache so that your changes appear.

You can import or export data map objects as XML files through the Data Map Object applet menu
items: XML Import, XML Export.

Data Map Components

Data map components define the mapping at the child business component level. Each data map
object can contain multiple data map components. You can arrange data map components in a
parent-child hierarchy, but you must specify a parent for all except one data map component. The
parentless data map component is called the root data map component. Data map components are
described in Table 28.

Table 28. Data Map Components

Component Description

Name Data map component name. Enter a unique name for each data map
component in a data map object.

Source/Destination Source or destination business component name.

Business Component . . . .
If you specify a parent for this data map component, you must define this

business component in the Siebel repository file as a child of the source or
destination business object to which the parent data map component is
mapped.
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Table 28. Data Map Components

Component Description

Parent Parent data map component name.

If you:

B Specify a parent, the parent is mapped to particular source and
destination business components. Generally, you map the child data
map component to a child of those source and destination business
components.

B Do not want to specify a parent, leave it empty to indicate that this is
the root data map component. Each data map object can have only one
root data map component.

Inactive Check this box to make the data map component inactive.

Data Map Component Advanced Options

Fine-tune data transfer at the component level by using Advanced Options multi-value fields. Data
map components advanced options are described in Table 29.

Table 29. Data Map Components Advanced Options

Component Description

Source Search Defines the source Buscomp search spec and sort spec. The value can be a
Specification/Source | literal search spec/sort spec string. It can also contain a named parameter.
Sort Specification See Using Named Parameters in DTU on page 276. For example:

[1d] = [&Contactld]

where Contactld is a named parameter. At run time, only named
parameters are replaced by their string values.

Source Record Row One can selectively transfer only a subset of source Buscomp records. This

Number can be defined in three formats:
B Start-End
W Start-
B Number

For example, 0-5, 4-, 0.

NOTE: The row number starts at O.

Operation Override This option allows one to override the operation at the component level. For
example, if the current operation is Insert, you can use this option to set
some component to operate Update instead.
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Table 29. Data Map Components Advanced Options

Component Description

No Association

Y/N. Applicable to buscomps that have association list. By default, itis V.
Data Transfer Utilities first try to locate the desired destination record in the
associate list. If successful, the located record is associated. Otherwise, a
new record is created.

If N, association of existing records is not attempted. A new record is
created instead.

Cached Updates

The valid values include:

B  Source BusComp

B Destination BusComp

B Source/Destination BusComps

This is a performance enhancement option that defers sending SQL
statements to the database until they can be sent together. Since none of
the SQL statements is sent until the end, subsequent steps in the block
cannot be dependant on a previous step having been committed to the
database.

When you turn on this option, make sure to confirm all SQL statements are
generated correctly and there is no inter-dependency.

Field Validation

Y/N. By default it is Y.

By default, setting field values in a Siebel BusComp triggers field value
validation. If you have a bounded picklist, the new value is validated against
the picklist and the fields in the pick maps are set. Disabling field validation
also turns off picklists. It is a performance enhancement option.

All advanced option values can contain named parameters. At run time, the named parameter is
substituted by its run-time value.

If the source Buscomp has been well positioned, the source search spec, the source sort spec, and
source record row number must be evaluated to be empty at run time, otherwise a wrong advanced
option error is encountered. See Well-Positioned Buscomps on page 282 for more information.

Advanced Options does not apply to mvg subcomponents.
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Data Map Fields

Data map fields define the field-to-field mapping. Data map fields are described in Table 30.

Table 30. Data Map Fields

Field Description

Source Type/ Type of the source/destination field. Can be: Field, Expression, or
Destination Type Parameter:

B Field. A Siebel Buscomp field as defined in the srf.

B Parameter. A named parameter. The parameter should be pre-fixed
with an ampersand (&). See Using Named Parameters in DTU on
page 276. For example:

&Contactld

B Expression. A Siebel calculation expression. See Calculation
Expressions in DTU on page 277.

Source/Destination. | The contents of these fields depends on the source and destination type.
If the type is:

B Field, it should be a Buscomp field name.

B Expression, it should be a Siebel calculation expression.

B Parameter, it should be a named parameter.

If the destination field is a calculated expression, then the record is not
used to update the destination Buscomp. Instead, the result of the
expression, evaluated at run time, is written back into the source field at
the end of the data transfer operation of the component.

If the Source is:
B A Buscomp field, then source Buscomp is updated.

B A Parameter, the corresponding named parameter value is updated.

B An Expression, nothing happens.
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Table 30. Data Map Fields
Field Description
Key Matches the destination records with source records.

For example, the Update operation updates the record in the destination
business component whose key destination fields all match those of the
corresponding source fields.

Each data map component in general should contain at least one key field.
When there is no key defined, if the operation is:

B Insert, DTU would proceed without checking if a duplicate record with
the same key fields already exists.

B Update, it would update the current destination record.

If the destination business component is populated with an associated list
business component, at least one key field is required.

Source/Destination This link indicates that the source and destination fields are multi-value
Multi-Value Link fields.

Data is transferred from one multi-value field to another by dividing data
map fields into several subcomponents. All entries with the same source
and destination multi-value link constitute a subcomponent. Specify a key
for each subcomponent.

NOTE: Data transfer from a multi-value field to a single-value field is not
allowed.

Using Named Parameters in DTU

You can use named parameters to pass in a run-time dynamic value into DTU. For example, imagine
you want to pull a contact's latest information into your Buscomp. At design-time, you cannot foresee
what is the contact’s Id. Instead, you use a named parameter, &Contactld, and at run time, you pass
in the value &Contactld.

Named parameters are defined implicitly in two ways:

B Business Service Arguments. Pass in the named parameters when DTU is invoked. DTU knows
an argument is a named parameter if the argument name is prefixed with an ampersand (&).

For example,

var psinputs, psoutputs;

var myContactld = "0-45TU890";

psinputs = TheApplication() .-NewPropertySet();

psoutputs = TheApplication() .NewPropertySet();
psinputs.SetProperty (“'DataMapObj’™, "My Test DTU Object™);
psinputs.SetProperty (“'Operation’™, "Update™);
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psinputs.SetProperty (“&Contactld', myContactld);
var obs = TheApplication() .-GetService("FINS Data Transfer Utilities");
obs. InvokeMethod (“'DataTransfer,psinputs, psoutputs);

&Contactld serves as a named parameter.

The input value of a named parameter can be a calculation expression. In order to do so, set the
value to:

Expr: "YourExpression"

which is the syntax of Buscomp field predefault. At run time, the expression is evaluated against
the initiator Buscomp. For more information on initiator buscomp, see the argument description
in DataTransfer Method on page 279.

B Assignment by DTU. At run time, you can transfer into a named parameter if the field type is
Parameter. When this happens, if the named parameter is still not defined, it is instantiated.

A named parameter must be implicitly defined first before it can be used. In other words, un-
assigned named parameters cannot be used.

Named parameters can be used to define Data Map Component Advanced Options, and Data Map
Field Source or Destination that are of type Expression.

All named parameters are output into the DTU service output arguments.

TIP: Whenever a named parameter is used in DTU, it should be prefixed with &.

Calculation Expressions in DTU

When Data Map Field Source/Destination Type is Expression, the Source/Destination Fields are
calculation expressions that follow Siebel Query Language syntax. See Siebel Personalization
Administration Guide for more information on Siebel Query Language.

DTU contains two extensions to Siebel Query Language:
1 Curly bracket pair {field}

2 Named Parameter

Curly Bracket Pair {field}

Use this syntax to refer to a buscomp field at the other business component side. For example, if you
define the following expression as the source:

{Contactld}

[Contactld] would be evaluated at the destination bsucomp. When {} is involved, please note that
{} takes the highest precedence over other operator. Thus, if you have an expression like:

“{Last Name}" + “Test"

{Last Name} has precedence over quotes "". If the person's last name is Agee, {Last Name} is
evaluated to be "Agee". As a result, the final value is
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""Agee" Test
instead of

{Last Name} Test

Named Parameter

A calculation expression can contain named parameters, using the syntax of [&Parameter]. It is
important to pre-fix the ampersand to indicate a named parameter. For example,

"Sadmin®s opportunity #"' + [&Opptyld]

For more information on named parameters, see Using Named Parameters in DTU on page 276.

Data Transfer Utilities Methods

This section describes the following Data Transfer Utilities business service methods:
B DataTransfer Method on page 279

B FAFireEventxxx Method on page 280

B GetActiveViewProp Method on page 280
B TryMockMethod Method on page 281

|

QueueMethod Method on page 281
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DataTransfer Method

The DataTransfer method transfers data from the source business component to the destination
business component.

Argument Description
Data Map Object The name of the data map object that defines the mapping.
(Required)

Operation (Required) Valid entries include Insert, Update, Delete, and Upsert.

GotoView (Optional) The name of a view that appears to users after the data transfer
operation.
Option (Optional) A text field that allows you to specify additional options for the operation.

Supported options include:

B NewSrcBusObj. Force to instantiate a new Source business object.
Use instead of NewBusObj.

B NewDstBusObj. Force to instantiate a new destination business
object.

B  RootNotCommitted. Suggest DTU not to commit the root component,
if possible.

B SrcRootAdminMode. Set the source Buscomp of the root data map
component to Admin mode. This is valid only if the root source
Buscomp has not been executed.

B BatchMode. This is a performance enhancement option that
suppresses runtime events, disables undo, and defers field pre-
defaults until committing the record. Batch mode is only enabled for
source or destination business objects that are not the active
(initiator) business object.

The following syntax is recommended for defining Option:
/optionl /option2 ..
For example,

/NewSrcBusObj /NewDstBusObj

Initiator Business Used as a sanity check. If the BusObject that invokes DTU is different
Object (Optional) from what is specified by the InitBO argument, DTU exits as an external
error.

Initiator Business Object is part of the invocation context. DTU receives
a reference of the initiator business object only when invoked from
Runtime Evens, Buscomp Named Methods, or workflow processes with its
business object defined. See About Auto Application on page 141 as an
example. In Siebel Finance 7.7, DTU can be invoked without an initiator
business object.
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Argument Description

Initiator Business By default, the Buscomp that invokes DTU serves as the InitBC. Initiator

Component (Optional) Buscomp plays an important role in determining how records are
transferred. Use the InitBC argument to set other Buscomp in the
Initiator BusObject as the Initiator Buscomp.

Initiator Search Initiator Buscomp search spec and sort spec.
Specification / Initiator
Sort Specification

(Optional)

Initiator Buscomp Y/N. By default, Initiator Buscomp Enumerate Flag is N. When it is true,

Enumerate Flag DataTransfer is applied to each record in the initiator Buscomp. When

(Optional) InitSearchSpec or InitSortSpec is specified, InitEnumFlag is implicitly
true, even if InitEnumFlg is set to N.

MockMethodReplied Y/N.

NOTE: It is recommended that you specify both InitBO and InitBC specifically when invoking DTU.

DTU requeries the initiator buscomp when InitSearchSpec, InitSortSpec, InitEnumFlg are used.

FAFireEventxxx Method

FAFireEventxxx is a hidden method that you can use to create a toolbar command. It invokes the
method “EventMethodxxx” on the primary business component of the active view. “EventMethodxxx”
triggers the event manager, which invokes either a workflow or a business service.

GetActiveViewProp Method

This is an auxiliary function to retrieve the active view’s properties. It does not take any input
arguments.

Argument Description

Business Object Business object name.
View Active view name.
Screen Active screen name.
Thread Applet Thread applet name.
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Argument

Is Administration Mode Y or N.

View Mode Code An integer representing Siebel view mode:
B 0: SalesRep View
B 1: Manager View
B 2: Personal View

m 3: AllView

TryMockMethod Method

This is an advanced auxiliary function for administration of the tool bar button workflow. It does not
take any input arguments.

Argument Description

MockMethodReplied Y or N.

QueueMethod Method

Launch a queue method on an applet in another view. When invoked, the Ul navigates to the view
specified, and then the Queue method is invoked on the specified applet.

Other input arguments of this method will be cached into the application Shared Global, which can
be retried back.

DTU DataTransfer method has built-in integration with the QueueMethod. When the input argument
DataMapObject has the format:

SharedGlobal : NameofSharedGlobal

The data map object name can be retrieved from Shared Global with the name NameofSharedGlobal.

Argument Description

GotoView Name of the view to go to.

Applet Applet name.

Method Queued method to be invoked on the applet.

Considerations for Data Transfer Utilities
This section contains the following topics:
Il Use of Active Business Objects on page 282

B Invocation Context on page 282
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B Well-Positioned Buscomps on page 282
B Recursive Invocation on page 283

CAUTION: Spool SQL statements during the development stage to verify that all operations are
performed.

Use of Active Business Objects
Data Transfer Utilities execute inside a client's object manager.

The DTU reuses the current active business objects. It does not instantiate an independent source
business object unless directed. This leads to both a leaner memory use and better performance.
This is even more so if the destination business object is the same as the source business object. In
such a case, no new business objects are instantiated for the business service.

Because of the reuse of active objects, you must exercise caution to preserve the current business
object context. For example, the business components should not be in the query state when DTU is
launched.

Invocation Context

DTU in general needs the pass-in of a reference to the active Buscomp. To do so, the business service
should be invoked from Event Manager, Buscomp Named Method, or a workflow process that is
invoked by the event manager. However, in Siebel Finance 7.7, the requirement that one must have
an active Buscomp is relaxed.

Not all Buscomp events can be used to invoke the DataTransfer method. For example, Query event
in general should not be used to trigger DataTransfer, as the buscomps are not in an updateable
state.

In general, use PreDeleteRecord event; do not use DeleteRecord event. The Siebel event manager
does not pass in a reference to the active Buscomp in the DeleteRecord event.

Use special care when the service is used with other business services in a workflow. Other business
services should not interfere the passing of a reference to the active buscomp. Use a spooled sql
statement to confirm the operations carried out are correct.

Well-Positioned Buscomps

A well-positioned Buscomp is a Buscomp that has been positioned correctly, and whose position
should not be disturbed. DTU uses the following rule:

B The initiator Buscomp is a well-positioned Buscomp.
B The ascendants of a well-positioned Buscomp are well-positioned.

B For a given data map component, the buscomps involved in all its parent data map components
are well positioned.

If the source Buscomp is well-positioned:
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B Data transfer is only invoked on the current row of the source BusComp. Otherwise, the operation
is carried out on all rows in the source BusComp at the moment of invocation.

B Advanced options such as source search spec, source sort spec should be empty.

If the destination Buscomp is well-positioned:

B You do not need to specify key fields to retrieve the destination record. Even if you do in this
case, DTU would ignore them.

B And if the current operation is Insert, it would change to Update by default, unless overridden
by Operation Overrides.

Recursive Invocation

By default, you cannot use the DataTransfer operation to invoke another DataTransfer operation. In

other words, at anytime within a client's object manager, there is only one DataTransfer method in
the call stack.

Configuring Event-based Commands

The Data Transfer Utilities business service allows you to configure toolbar and menu commands

based on Siebel Event Manager. For an example of how to use DTU to define a toolbar button, see
About Auto Application on page 141.

To configure event-based commands
1 Define a command in Siebel Tools.

Business Service ="FINS Data Transfer Utilities”. Method = “FAFireEventxxx”. The method name
can be anything that begins with “FAFireEvent”. When the command is invoked, it, in turn,
invokes method EventMethodxxx on the primary buscomp of the active view, where xxx is of the
same value as in FAFireEventxxx.

2 Define a toolbar.
3 Define a toolbar item for the command you defined.

In the Siebel client, define a run-time event that will receive EventMethodxxx.
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5 Navigate to the Administration - Runtime Events screen > Events view, and create a Buscomp
run-time event as listed in the following table. See Siebel Personalization Administration Guide
for more information on run-time events.

Field Entry

Sequence -1
Object Type BusComp
Object Name The name of the business component in which the event is invoked. For a

toolbar command, this is the primary business component in the view in
which the command is invoked.

Event InvokeMethod

Sub Event EventMethodxxx. Choose the same value for xxx that you chose for
FAFireEvent.

Action Set Name The action set that invokes Siebel Workflow Manager or a business service.

Alternatively, you can define a workflow that has a Start step that contains run-time events.
When the workflow is activated, both the Action Sets and run-time events are created
automatically for you. See Siebel Business Process Designer Administration Guide.

6 Siebel run-time events are cached. After you make changes, click the Runtime Events applet
menu item Reload Runtime Events.

7 Configure dynamic enabling of the command. For more information, see Dynamic Enabling of
Commands on page 284.

8 Define command visibility.
a In Siebel Tools, navigate to Business Services > FINS Data Transfer Utilities.

b Define a user property in which Name = MethodName GotoView, and Value = The name of a
view. MethodName is the name of the command method.

When you define this user property, this method is enabled only for users who have visibility
to the view defined in the value. If the method does not contain a GotoView, visibility is not
imposed on the method.

Dynamic Enabling of Commands

When a command is invoked from a toolbar button or menu, the Data Transfer Utilities business
service invokes the method EventMethodxxx on the primary business component of the active view.
The primary business component should be derived from CSSBCBase to allow the invocation to be
captured by Siebel Event Manager.

When the view is changed, Siebel framework polls each command for the application-level toolbar
buttons and application menu to determine whether the button or menu items should be made read-
only.

There are two mechanisms for the dynamic enabling/disabling of commands in DTU:
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B Srf mode

B  Mock Event Sink

The System Preference FINS DTU Enable FireEvent Mode is used to determine the mode. The value
should be Srf or Runtime Event. The default value is Srf.

Srf Mode

In the Srf mode, a FAFireEventxxx invocation on a buscomp is enabled if there is a user property
underneath the FINS Data Transfer Utilities business service as such that the name of the user
property is:

Name: FAFireEventxxx Static Enabled BC [n]
Value: Buscomp Name
You can define multiple Buscomps for a FAFireEventxxx method.

Srf mode is introduced primarily for performance reasons. Compared with Runtime Event mode, it
allows fast enabling/disabling of a command button without actually invoking a run-time event. Srf
mode is the default mode.

Mock Event Sink

When System Preference FINS DTU Enable FireEvent Mode is Runtime Event, Data Transfer Utilities
determines at run time whether a FAFireEventxxx method should be disabled or not by initializing
Mock Event Mode. It sets up a global mock event flag within the client’s object manager. It then
invokes EventMethodxxx on the primary business component of the active view. If this
EventMethodxxx is finally captured by a Mock Event Sink, a global response flag is set. When the
Data Transfer Utilities finds out the response flag is set by a mock event sink, it enables the
FAFireEventxxx method for that particular view. Otherwise, the method is disabled.

Mock Event Sinks are specialized business service methods that capture mock events. They check
whether the client’'s OM is in the mock event mode. If not, they do nothing. If so, they reply to the
mock event by setting the response flag as well as the output argument.

MockMethodReplied =Y.

TryMockMethod in Data Transfer Utilities is a mock event sink. DataTransfer method has a built-in
mock event sink.

About Defining a Toolbar Button
For an example of how to use DTU to define a toolbar button, see About Auto Application on page 141.

For information about configuring a toolbar button, see Configuring Siebel Business Applications.
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Automating Approval Processing

In Siebel Finance, administrators can define a number of approval levels without the need for
programming, scripting, or configuring. You can define both basic or multiple step approval
processing levels based on the needs of your organization. You can invoke approval processing from
a workflow or a run-time event.

Automating an approval process involves the following steps:
B Administrator defines approval items and approval stages.
For more information, see Defining Approval Items and Approval Stages on page 286.
B  Administrator invokes approval processing.
For more information, see Invoking FINS Approval Item Service from a Workflow on page 287.
B End users approve or decline an approval stage.

For more information, see Approving or Declining Approval Stages (End User) on page 289.

Defining Approval Items and Approval Stages

An administrator defines the approval process by creating approval items and approval stages in the
Approval Administration view.

To define approval items and stages
1 Navigate to the Administration - Application screen > Approval Administration view.

2 In the Approval Item list, add a record and enter a name in the Approval Item field.
3 In the Approval Flow Type field, select one of the following:

B Sequential. Indicates this Approval Item is distributed to approvers one after another in the
sequence specified in the Approval Stage. The application routes the Approval Item to the
next approver only if the current approver approves the request. If any one approver in the
approval chain declines the request, the Approval Item is rejected and no further routing is
conducted.

m Parallel. Indicates this Approval Item is distributed to all approvers simultaneously for
approval. The Approval Item is rejected if at least one approver declines the approval
request.

Once you have defined an Approval Item, the next step is to define the appropriate approval
stages. The Approval Item and Approval Stage lists have a parent-child relationship.
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4 In the Approval Stage list, add a record for each approval stage and complete the necessary
fields.

Some fields are described in the following table.

Field Comments

Sequence # Identifies the numeric sequence of this Approval Stage in the current
Approval Item. The application executes Approval Stages in numerical order
based on this number.

Approval Type  Specifies whether the approver is a position or an employee.

Owner Login Indicates the login name tied to this Approval Stage. Relevant only if
Name Approval Type is Employee.

Owner Position Indicates the position tied to this Approval Stage. Relevant only if Approval
Type is Position.

End users use the My Approval Inbox view to approve an approval item. For more information, see
Approving or Declining Approval Stages (End User) on page 289.

Invoking FINS Approval Item Service from a Workflow

Invoke FINS Approval Item Service from a workflow by creating a workflow process in Siebel Tools
containing the following steps:

B Start. Initiates the process instance. When the conditions have been met, the application
initiates the process instance. See Configuring the Start Step on page 288 for details.

B Business Service. A step in a process in which an automated call is made to the FINS Approval
Item Service. A workflow process definition can have one or more business service steps. See
Configuring the Business Service Step on page 289 for details.

B End. A step in a process that specifies when a process instance is finished.

In order for your workflow to execute correctly, the Start and Business Service steps must meet the
minimum requirements described in the referenced sections. For more information on workflows, see
Siebel Business Process Designer Administration Guide.
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Configuring the Start Step

Table 31 details some of the start step parameters for the workflow process.

Table 31.
Field

Event

Parameters for Start Step

Comments

The specific event that happens to
the object. The set of available
events is different for different
object types.

Example

Use the WriteRecord business
component event if you want to
trigger the approval process after the
record is written to the database.

Use the WriteRecordNew business
component event if you want to
trigger the approval process after a
new record is written to the
database.

Event Object The name of the application, Contact
business component, or applet to
which the event occurs.

Event Object Type The type of object to which the BusComp

event occurs. This can be an
application, business component,
or applet.

Name

The name of the Next step branch.

The name of the branch must be
unique or you cannot import or
export the workflow process.

Next Step

The name of the step that follows
when conditions are met.

Picklist of existing process steps.

Type

The type of branch.

The value can be one of the
following:

B Condition. This value indicates
that a condition is defined for the
branch.

B Default. This value indicates that
if nothing else is satisfied, then
this branch is followed.
Additionally, if this value is used,
any conditions defined for the
branch are ignored.

288
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Configuring the Business Service Step

Table 32 and Table 33 detail some of the business service step parameters and input arguments for
the workflow process.

Table 32. Parameters for Business Service Step

Field Value

Business Service FINS Approval Item Service

Method Create Approval Stage

Table 33. Input Arguments for Business Service Step

Input Argument Property Name Comments

Approval Item ID Object Id Row Id of the object (for example, a Service
Request) that needs approval processing.

Approval Item Name Approval Item Name Name of the Approval Item defined in the
Approval Administration view.

Requesting Buscomp Requesting Buscomp Name of the buscomp object (for example, a
Service Request) that needs approval
processing.

Approving or Declining Approval Stages (End User)

End users approve approval items in the My Approval Inbox view. Users can view approval items by
login name or position. For more information on setting up approval processing, see Defining Approval
Items and Approval Stages on page 286.

To approve or decline an approval stage
1 Navigate to the My Approval Inbox screen.

2 Select one of the following views:
m My Approvals. Displays all approval items associated with the user’s login name.

®m My Position Approvals. Displays all approval items associated the current user’s position.

w

To view additional details about an approval item, drill down on the Approval Identifier link.
In that Status field, select Approve or Decline.

Once you select a status, the application populates the Approval By and Approval Date field and
sets the record to read-only.
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Automating the Display of Disclosure
Documents

Disclosure processing allows companies to comply with internal company policies and external
regulations. These policies and regulations require they display disclosure statements or external
documents to users, and then record whether or not they have read and understood them.
Implementing the automatic display of disclosure documents involves the following steps:

B Set up a disclosure by associating it with a product and literature.

For more information, see Setting Up Disclosures on page 290.
B Activate the appropriate workflows.

For more information, see Understanding and Activating Disclosure Workflows on page 291.
B Invoke the Disclosure Ul Service business service.

For more information, see Invoking the Disclosure Ul Service Business Service on page 292.
B View a disclosure history.

For more information, see Viewing Disclosures Associated with Contacts (End User) on page 293.

Setting Up Disclosures

To implement disclosure processing, you must associate each disclosure with a product and then, if
applicable, with the appropriate document.

To associate a disclosure with a product
1 Navigate to the Administration - Product screen > Disclosure view.

2 In the Product form, query for the product.
3 In the Disclosure list, add a new record, and complete the necessary fields.
4 To activate a disclosure, select it in the Disclosure list, and click Activate.

Clicking Activate, changes the Status from In Progress to Active and makes the record read-only.

To revise an existing disclosure
Navigate to the Administration - Product screen > Disclosure view.

In the Product form, query for the product.
In the Disclosure list, select the disclosure to be revised, and click Revise.

Clicking Revise creates a new version of the disclosure and sets its status to In Progress.
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4 Make the appropriate changes to the new disclosure, and click Activate.

Clicking Activate, changes the Status from In Progress to Active and makes the record read-only.
The prior version of the disclosure still appears, but displays a Status of Outdated.

5 To associate literature with a disclosure, add a new record in the Literatures list, and complete

the necessary fields.

For more information on loading literature into Siebel Finance, see the sharing literature discussion
in the Applications Administration Guide.

Understanding and Activating Disclosure Workflows

Siebel Finance includes three workflows that help manage the display of disclosure documents and
disclosure event logging. Table 34 describes each workflow.

Table 34. Disclosure Workflow Processes

Workflow Process Comments

FINS Disclosure

The FINS Disclosure Workflow process accomplishes the following
tasks:

1 Invokes the Setup method of the Disclosure Ul Service
business service. Invoking this method sets up the
appropriate disclosure documents based on the selected
product.

2 Calls the FINS Disclosure Goto File View subprocess. This
sub-process navigates users to the Disclosure Documents list,
where they can review all the disclosure documents pertaining
to the selected product. This subprocess also navigates users
back to the previous view after they accept or decline the
disclosure. This final navigation step is accomplished by
invoking the View Back method of the Disclosure Ul Service.

3 Calls the FINS Disclosure Create Activity Sub Workflow
subprocess. If the user accepts the disclosures, the workflow
calls the FINS Disclosure Create Activity Sub Workflow
subprocess to log the disclosure activity.

FINS Disclosure Goto File
View

This subprocess navigates users to the Disclosure Documents list,
where they can review all the disclosure documents pertaining to
the selected product. This subprocess also navigates users back to
the previous view after they accept or decline the disclosure. This
final navigation step is accomplished by invoking the View Back
method of the Disclosure Ul Service.

FINS Disclosure Create
Activity Sub

If the user accepts the disclosures, this sub process logs the
disclosure activity.
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Before you can display disclosure documents, you must:
B Deploy the workflow processes using Siebel Tools.
For more information, see Siebel Business Process Designer Administration Guide.
B Activate the workflow processes described in Table 34.
For more information, see To activate the workflows used to display disclosure documents.
B Invoke the Disclosure Ul Service business service.

For more information, see Invoking the Disclosure Ul Service Business Service.

To activate the workflows used to display disclosure documents
Navigate to the Administration - Business Process screen > Workflow Deployment view.

In the Repository Workflow Processes list, use a query to find all processes where the Name field
contains the word Disclosure.

NOTE: You can query on *Disclosure*.
3 Activate each workflow process shown in Table 34 on page 291, that has a status of Inactive.
a  Select the workflow process record.
b Click Activate.
4 To verify that the Status is Active for each process:
a In the lower Active Workflow Processes list, query again for Name = *Disclosure>.

b For each process, check that Deployment Status = Active.

Invoking the Disclosure Ul Service Business Service

You can invoke the Disclosure Ul Service from a workflow. This section describes some of the possible
steps you can include to enable this invocation. You may need to modify and expand on this
procedure to accommodate more complex business requirements. The workflow process you create
must contain the following steps:

B Start. Initiates the process instance. When the conditions have been met, the application
initiates the process instance.

B Sub Process. Calls the FINS Disclosure Workflow. When creating this step, you must populate
the following inputs:

m Contact Id. The Row Id of the contact who places the order of the product.
m Disclosure Name. The name of the Disclosure that relates to the product.
®  Product Id. The Row Id of the product that the customer has ordered.

B End. A step in a process that specifies when a process instance is finished.

For more information on workflows, see Siebel Business Process Designer Administration Guide.
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Viewing Disclosures Associated with Contacts (End
User)

All end users can view disclosures associated with a specific contact on the Contacts Disclosures
view. This view is read-only and displays the:

B Disclosure name

B Date the disclosure was presented to the user
B Date the user acknowledged the disclosure

B Date the user accepted the disclosure

For more information on setting up disclosure processing, see Automating the Display of Disclosure
Documents on page 290.

To view a disclosure history
1 Navigate to the Contacts screen > Contacts List view.

2 In the Contacts list, drill down on the contact.

3 Click the Disclosures view tab.

SmartScript Integration with Workflow

You can invoke a SmartScript from a workflow process and pass parameters from the SmartScript to
the workflow process. These business services support SmartScript integration with workflow:

B FINS Web Shopping Service.
For methods, see FINS Web Shopping Service Methods on page 295.
B  FINS SmartScript Output Service.
For methods, see FINS SmartScript Output Service Methods on page 296.

NOTE: In order to completely understand the concepts in this section, familiarity with SmartScript
is required. For more information, see Siebel SmartScript Administration Guide.

For a detailed explanation about how to integrate SmartScript with Workflow, see Example of
Integrating SmartScript with Workflow on page 293.

Example of Integrating SmartScript with Workflow

The scenario outlined in this section is an example of how to insert a SmartScript in a workflow
process. After the SmartScript ends, the workflow proceeds to the next step in the workflow process.
Your company may follow a different workflow that fits its business requirements.
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In this scenario, you are designing a SmartScript that allows customers to complete a loan
application online. After the loan application is complete, your workflow verifies the customer’s
address in an external system.

To configure SmartScript integration with Workflow

1 In the SmartScript, create Save User Parameters for the parameters you want to pass to the
workflow. For more information on SmartScript user parameters, see Siebel SmartScript
Administration Guide.

2 Create a Business Service step for your workflow, using the FINS Web Shopping Service business
service, and enter the input arguments described in Table 35 on page 295.

3 Create a subprocess to invoke the SmartScript using the workflow User Interact step. The
subprocess is based on the SmartScript Player business object and has three steps: a start step,
a user interact step, and an end step.

a In the user interact step, set the view name to FINS SmartScript Player View (App).

b In the Next Step’s applet, add two conditions, entering the information listed in the following
tables:

Entries for Record 1 (first condition):

Field Entry

Branch Name Cancel

Type Condition

Next Step End

Event Object Type Applet

Event Invoke Method

Event Object Smart Script Player Applet (FINS
eSales App)

Subevent CancelScript

Entries for Record 2 (second condition):

Field Entry

Branch Name Finish

Type Condition
Next Step End

Event Object Type Applet

Event Invoke Method
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Field Entry

Event Object Smart Script Player Applet (FINS
eSales App)
Subevent FinishScript

4 Add a Business Service step using the FINS SmartScript Output Service business service. Enter
the output arguments described in Table 36 on page 296.

Now you may either end your workflow process or include additional steps, depending on your
company’s business requirements. The SmartScript is integrated in your workflow process.

FINS Web Shopping Service Methods

The FINS Web Shopping Service business service methods are described in Table 35.

Table 35. FINS Web Shopping Service Methods

Method Description / Arguments

SetSmartScriptName | Input Arguments:

B Script Name (Required): The name of the SmartScript you want to
invoke.

B SSUserParameter# (Required): A SmartScript user parameter
between 1 and 20.

For example, SSUserParameterl. The value for the input argument
must be the exact name of the user parameter specified in the
SmartScript, whose value needs to be passed into the workflow
process at the conclusion of the SmartScript.
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FINS SmartScript Output Service Methods

The FINS SmartScript Output Service business service methods are described in Table 36.

Table 36. FINS SmartScript Output Service Methods

Method Description /7 Arguments

SetOutput Reads the SmartScript user parameters and outputs them as workflow
properties:

Output Arguments:

B The name of the user parameter. Specifies the SmartScript user
parameters as output arguments, and passes the value of the user
parameters back to the workflow process when the SmartScript ends.
These output arguments can be mapped to process properties.

B SmartScript Result Action: Returns the action users take to end the
SmartScript. Possible values are Finish or Cancel.

Dynamic Ul Business Service

This business service and associated administration views allow you to create and render views
containing a single read-only applet in the Siebel Financial Services application. These views and
applets, called dynamic applets, allow business analysts and developers to make frequent changes
to the user interface without the need to recompile and redeploy a Siebel Repository File (SRF).

The following topics are included in this section:
B Example of Creating a Dynamic Applet with the Dynamic Ul Business Service

B Displaying Dynamic Applets in a Workflow on page 297

Example of Creating a Dynamic Applet with the Dynamic
Ul Business Service

The scenario outlined in this section is an example of a Dynamic Ul Service in a workflow process.
Your company may follow a different workflow that fits its business requirements.

You would like to set up your company’s user interface to dynamically display read-only views at run
time, based on user input. For example, a customer requests a quote for an auto insurance policy.
The policy includes the option to cover additional drivers. After the customer enters additional driver
information, the workflow process uses a Dynamic Ul applet to display a read-only list of the
additional drivers for review. Customers can review the list, then select an option to continue the
process.

To set up a similar user interface for your business, follow the instructions that follow.
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To create a dynamic applet

1
2

Navigate to the Administration - Finance screen > Dynamic Applet Administration view.
In the Dynamic Applet list, click New, then enter the view alias and view name.

The view alias must be a unique name. The view name is a picklist of the views defined in the
Template Definition view.

Step off the record. The Applet Instance list automatically displays the name of the applet
template defined for this view.

In the Applet Instance list, enter the applet title, business object name, and business component
name.

The business object and business component determine the fields to display for this applet.
If you want to set up a default search specification, enter:

B Business component field. Specifies the field on which to base your search.

m Default. Specifies a default value for which you want to search.

In the Field Control list, add a new record for each field you want to display. Each field control is
displayed as a read-only text box with a text label. For each record, enter:

m Display Sequence number. Indicates the display order for the field. For list applets, the order
is left to right. For form applets, the order is left to right and top to bottom.

m Field name. The business component field whose value you want to display.
B Caption. The display label for the field.

In the Button Control list, add a new record for each button you want to display. Enter the
sequence number, caption, and method for each button.

m Display Sequence. Indicates the display order for the button, from left to right.
B Caption. The display label for the button.

m Method. The method invoked when the button is clicked. The method name must begin with
FrameEventMethod. For example, FrameEventMethodContinue.

Displaying Dynamic Applets in a Workflow

Workflows can invoke a dynamic applet as part of a process defined for a product application. This
feature enables an application administrator to establish applet instances without requiring
recompilation and redeployment of individual applets.

To integrate the dynamic applet in a workflow

1
2

Create a subprocess based on the FINS Dynamic Ul business object.

Add a Dynamic Ul Service business service step and invoke the Set View Name method described
in Table 37 on page 298.
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3 (Optional) Add a second Dynamic Ul Service business service step and invoke the AddRecord
method described in Table 37 on page 298.

4 Add a User Interact step to display the dynamic applet.

a For the view property of the User Interact step, enter the view template name defined in Step 2
of Example of Creating a Dynamic Applet with the Dynamic Ul Business Service.

b For each button that may be clicked in the dynamic applet, add entries into the Next Steps list
applet of the User Interact step. The following is an example of such an entry:

Field Entry

Branch Name

Continue Button

Type Condition
Next Step End

Event Object Type Applet

Event InvokeMethod

Event Object

FINS Dynamic Ul List Applet

Subevent

FrameEventMethodContinue

The Dynamic Ul Service business service methods are described in Table 37.

Table 37. Dynamic Ul

Service Methods

Method Description / Arguments

Set View Name

Input Arguments:

View Alias (Required): The view alias defined in Step 2 of Example of
Creating a Dynamic Applet with the Dynamic Ul Business Service.

AddRecord
(Optional)

Overrides the default search specification value.
Input Arguments:

B Business Component Name (Required): The name of the source
business component.

B Object ID (Required): The row ID of the business component.

Creating a View Template for Dynamic Applets

Creating a view template involves first creating views and applets based on specialized applet classes
within Siebel Tools. These views and applets contain placeholder fields. Placeholder fields are applet
controls that are not mapped to any particular business component. The views and applets will then
form the basis of view templates and applet templates. You can use a single view and applet template
to create any number of dynamic applets.
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Two templates are provided as part of seed data: a view template containing a list applet template,
and a view template containing a form applet template. The view templates are named as follows:

B  FINS Dynamic Ul Form view. A view template that contains a form applet template.
B  FINS Dynamic Ul view. A view template that contains a list applet template.
For more information about creating views and templates within Siebel Tools, see Using Siebel Tools.

When creating dynamic applets in Siebel Tools, note the considerations listed as follows. (Use of the
word applet in the following bulleted list refers to applets created in Siebel Tools.)

B When setting applet class, use:
B CSSFramelistFADynamicUl for list applets
m CSSFrameFADynamicUl for form applets

B If using a preconfigured business component, the applet business component should be FINS
Dynamic Ul.

B If you create your own Virtual Business Component (VBC) in Siebel Tools, the business class
should be CSSBCVDynamicUl.

Dynamic Applet supports 20 fields and five currency codes (that is, five types of currency value).
In your new VBC, all field names should start with the prefix Field and a number value, (for
example, FieldO..., Field19). All currency code fields should start with the prefix Currency Code
and a number value, (for example, Currency CodeO..., Currency Code4).

B It is recommended that applets based on the same VBC have their corresponding views use a
different business object.

Once the views and applets have been created in Siebel Tools, in order to define them as view
templates and applet templates, they must be added to the Template Definition view.

To add views and applets to the Template Definition view

1 Navigate to the Administration - Finance screen > Dynamic Applet Administration view >
Template Definition view.

In the Template Definition list, click New, and then enter the view name.

In the Applet Template Definition list, click New, and then enter the applet name.

FINS Application View Navigation

The FINS Application View Navigation Service guides users through a series of views based on
administration data. The view list is dynamically generated according to the products associated with
the current record. It replaces the Next/Previous button functionality, known as the FINS Application
Workflow, in previous releases.

For more information on how this business service is used, see Setting Up Application View
Navigation on page 139.

The following topics are presented in this section:
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Business Service Methods

Business Service Behaviors

Upgrade Note on page 302

Business Service Administration on page 301

Example of FINS Application View Navigation on page 301

Business Service Methods

The business service has two methods:

B GetNextViewName. Gets the next view name without view navigation.

B GotoNextView. Navigates to the next view.

Table 38 describes the arguments for these methods.

Table 38. FINS Application View Navigation Service Arguments

Name Type Description
BusComp Required The master buscomp through the view navigation.
Navigation Direction Optional Forward or Backward. Default is Forward.
Product Id Optional Product Id value.
Product Id Field Optional The field in the buscomp that is used to retrieved
Product Ids.
Status Output B O: success
B 1: EOF
B 2: BOF
W 3: Error
Next View Name Output Name of the Next View.
FINS View Navigation Optional Name of the admin buscomp.

Mgr Admin BC

Business Service Behaviors

The FINS Application View Navigation Service is constrained by the following behaviors:

B The business service can be invoked from any screen.
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B The navigation is limited to the views in the current screen that are accessible to the current
login.

For example, if there is a product that is associated with views in both the Contact and
Opportunity screens, and the invocation occurs inside the Contact screen, views in the
Opportunity screen are ignored. Furthermore, the views that the current login do not have access
to are also ignored.

A view in the view list that is left by clicking the Next button, is treated as a visited view.

At any point in the view navigation, if a next view request is triggered and there are views ahead
of the current views not marked as visited, the service navigates to the skipped views.

B During the navigation sequence, the master buscomp record row Id should not be changed.
Otherwise, all the views will be treated as unvisited after the record change.

Business Service Administration

The FINS Application View Navigation Service is administered through the Administration - Product
screen.

To administer the FINS Application View Navigation business service
Navigate to the Administration - Product screen > Products view.

In the Products list, query for the desired product, and drill down on the product name link.
Click the More Info view tab.

In the More Info form, click the Application Workflow view link.

a A 0w N PR

Create new records to associate views and their sequence to the product.
NOTE: You can associate views from any screen with a product.

If you specify views with a gap in the sequence on two different products and add both those
products to, for example, an Application, you navigate based on sequence number and not on
product.

For example, if you specify:

B View V1 with sequence 1 and view V2 with sequence 3 on product A

B And then also specify view V3 with sequence 2 and view V4 with sequence 4 on product B
B And then proceed to add both these products to an Application

The navigation sequence will be V1, V3, V2, V4.

Example of FINS Application View Navigation

The FINS Application View Navigation Service is used in Siebel Finance on the Application screen,
where the Application form contains Previous and Next buttons.
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The invocation on the Application screen uses Applet Named Method, a feature of frame classes
derived from CSSSWEFrameBase and CSSSWEFramelistBase. The applet User Property has the
following name/value pairs:

B Named Method 1: GotoPreView 'INVOKESVC', 'FINS Application View Navigation Service',
‘GotoNextView', ""BusComp', "'Opportunity™, "'Navigation
Direction™, "'Backward", "'Product Id Field"™, ""Opportunity
Product Id™

B Named Method 1: GotoNextView 'INVOKESVC', 'FINS Application View Navigation Service',
‘GotoNextView', "'‘BusComp', "'Opportunity', "‘Navigation
Direction'', "'Forward"', "'Product Id Field', "'Opportunity
Product Id™

The Next and Previous buttons are mapped to methods as follows:

B Previous GotoPreView
B  Next GotoNextView

Upgrade Note

In previous releases, the function provided by the FINS Application View Navigation business service
was available through NextView and PrevView methods in CSSSWEFrameFINApplication.

These methods are no longer supported since Siebel Finance 7.7. If you have upgraded to Siebel
Finance 7.8 from a release prior to Siebel 7.7, the Next and Previous buttons need to be reconfigured
following the example provided in Example of FINS Application View Navigation on page 301.
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This appendix lists the Actuate reports that are specific to the Siebel Finance (Table 39). For more
information about Actuate reports, including how to customize, enhance, and create Siebel reports,

see Siebel Reports Administration Guide.

Table 39. Siebel Finance Reports

Report Name and Description

Navigation Path

Report Selection

FINS Call Report Detail Call Reports > My Call Detalil
. . L Reports
Displays call report details, participating
contacts and employees, action items, and
notes of a single call report.
FINS Call Report Summary Call Reports > My Call Summary

Displays the company profile of commercial
banking clients including a corporate
summary, financial profile, subsidiaries,
contacts, and activities.

Reports

FINS Commercial Banking Client Profile

Displays the company profile of commercial
banking clients including a corporate
summary, financial profile, subsidiaries,
contacts, and activities.

Companies > My
Companies

Commercial Profile

FINS Commercial Deal Pipeline - Close
Date

Displays the opportunity pipeline of
commercial deals, grouped by closed date.

Opportunities > My
Opportunities

Commercial Pipeline
by Close Date

FINS Commercial Deal Pipeline - Primary
Rep

Displays the opportunity pipeline of
commercial deals, grouped by primary sales
representative.

Opportunities > My
Opportunities

Commercial Pipeline
by Primary Rep

FINS Commercial Deal Pipeline - Sales
Cycle

Displays the opportunity pipeline of
commercial deals, grouped by sales cycle.

Opportunities > My
Opportunities
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Table 39. Siebel Finance Reports

Report Name and Description

FINS Contact Profile

Displays contact profile information such as
name, address, date of birth, interests,
experience, and activities.

Navigation Path

Contacts > My Contacts

Report Selection

Profile

FINS Deal Source - Close Date

Displays lists of deals grouped by close date,
with information such as company, sales cycle
and primary sales representatives.

Opportunities > My
Opportunities

Source by Close
Date

FINS Deal Source - Primary Rep

Displays lists of deals grouped by primary
representatives, with information such as
company, sales cycle and close date.

Opportunities > My
Opportunities

Source by Primary
Rep

FINS Deal Source - Source

Displays lists of deals grouped by referral
source, with information such as company,
sales cycle and primary sales representatives.

Opportunities > My
Opportunities

Source by Source

FINS Deal Source - Source Type

Displays lists of deals grouped by referral
source type, with information such as
company, sales cycle and primary sales
representatives.

Opportunities > My
Opportunities

Source by Source
Type

FINS Investment Banking Client Profile

Displays the company profile of investment
banking clients including a corporate
summary, financial profile, stock market data,
subsidiaries, contacts, and activities.

Companies > My
Companies

Investment Profile

FINS Investment Deal Pipeline - Primary
Rep

Displays opportunity pipeline of investment
deals, grouped by primary representative.

Opportunities > My
Opportunities

Investment Pipeline
by Primary Rep

FINS Investor Profile

Displays profiles of investors including
specialties, industry, vehicles, holdings and
transactions.

Investors > My Investors

Profile

FINS Portfolio Roll-Up - Primary Rep

Displays lists of companies and their loans and
deposits, grouped by primary representatives.
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Report Name and Description

FINS Portfolio Roll-Up - Relationship

Displays lists of companies and their loans and
deposits, grouped by relationships.

Navigation Path

Companies > My
Companies

Report Selection

Roll-Up by
Relationship

FINS cBanking Credit Request Borrower
Summary

Displays a summary of the credit request,
profile of the borrower, and the facility.

Commercial Loan > My
Requests

Credit Request
Borrower Report

FINS cBanking Credit Request Facility
Summary

Displays the detail of the credit request facility
including collateral, guarantor, and fee.

Commercial Loan > My
Requests

Credit Request
Facility Report

FINS cBanking Credit Request Summary

Displays the detail of the credit request
including decisions, key credit issues, and
underwriting standard.

Commercial Loan > My
Requests

Credit Request
Report
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This appendix lists the sample ASPs for household financial accounts virtual business components. Siebel
Finance includes virtual business components to display financial account data sourced from a back
office or a third-party system. Use these virtual business components for specific financial accounts
views within the Households screen. For more information, see “Setting Up Household Financial
Accounts Virtual Business Components” on page 113.

You can use these sample Active Server Pages (ASPs) to retrieve data from a test database, and
return an XML file in Siebel format to the Siebel XML Gateway business service. For more information
on setting up a test ASP, see “To set up an ASP and local test database” on page 114.

This appendix includes the following topics:
B cashflow.asp on page 307
Performance.asp on page 313
ModelValueByClass.asp on page 319
ModelValueBySector.asp on page 325

holdings.asp on page 331

cashflow.asp

Use the following sample ASP to test retrieving data for the Cash Flow view.

<%@ EnableSessionState=False Language=VBScript %>
<% option explicit %>

<%

Dim Conn

Dim SQL

Dim R

Dim F

Dim RecsAffected

Dim aConnectionString

aConnectionString = "Provider=Microsoft.Jet.OLEDB.4.0;"

& "Data Source=c:\Inetpub\ibd\mdb.mdb"

Set Conn = Server.CreateObject(*"ADODB.Connection™)

Conn.Mode = 3
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cashflow.asp

Conn.ConnectionString = aConnectionString
Conn.CursorLocation = 3

Conn.Open

SQL="'SELECT * from cashflow"

Set R=Server.CreateObject(""ADODB.Recordset')

dim ts

dim sReq

Dim aPath
Dim aLogFile

dim item

aPath = Request.ServerVariables("'PATH_TRANSLATED'")

"Response.Write aPath

" strip the file name from the path
aPath = Left(aPath, instrRev(aPath, "\"))
® add the log file name

aLogFile = aPath & ""\log\cash.log"

set fs = Server.CreateObject(*'Scripting.FileSystemObject'™)

set ts = fs.OpenTextFile(aLogFile, 8, True, 0)

“for each item in Request.ServerVariables
“"ts.write item
"ts.writeline Request.ServerVariables(item)

“next

dim dombDoc

dim aFilename

set domDoc = Server.CreateObject(**MSXML.DOMDocument')
domDoc.async = false

“domDoc.setProperty(*'ServerHTTPRequest')=true
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cashflow.asp

domDoc . load(Request)

dim node

dim nodes

dim mainNode
dim mainNodes
dim matchNode
dim matchNodes
dim attribs
dim attrib
dim SQLwhere
Dim root

dim SQLinsert
dim SQLFields
dim SQLvalues
dim sWhere
dim x

dim y

dim sFields

dim sValues

set root = domDoc.documentElement

dim nName
dim inputText

dim data

"inputText = Request.Form(*"textlnput’)

nName = root.nodeName
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cashflow.asp

Select Case nName

Case "siebel-xmlext-fields-req"

R.Open SQL, Conn, 3, 1, &HOOO01l
domDoc.save (server._MapPath('initl.xml™))
Response.Write "<?xml version= ""1.0"" encoding="""UTF-8"""?>"
Response.Write '"<siebel-xmlext-fields-ret>"
For Each F in R_Fields
Response.Write "<support field=""& F_Name &""/>"
Next

Response.Write "</siebel-xmlext-fields-ret>"

R.Close

Case "'siebel-xmlext-query-req"

"This section of SelectCase is for the Query Request

dim attvall(25)

dim attNamel(25)

set mainNodes = root.childNodes

ts.writeline "Document have MainNodes: ' & mainNodes. length
Dim z
z=0

For each matchNode in MainNodes
"attvall(z) = matchNode.text
"set attribs = matchNode.attributes
"set attrib = attribs(0)
"attNamel(z) = attrib.nodeValue
“"ts.writeline
ts.writeline "MainNode " & z
"ts.write z
ts.writeline "Main Node Name: ' & matchNode.nodeName
ts.writeline "Main Node type: " & matchNode.nodeType
ts.writeline "Main Node value: "™ & matchNode.nodeValue

“ts.writeline "match Node data: ' & matchNode.data
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ts.writeline "Main line text: ' & matchNode.text

"ts.write attrib.nodeValue

z =2z +1

next

set matchNodes = root.SelectNodes(*'search-string')
ts.writeline "MatchNodes in document are : " & matchNodes.length

X =0

For each matchNode in matchNodes

ts.writeline "Match string is :" & matchNode.text
sWhere = matchNode.text
X = X +1

next

ts.writeline "This is sWhere ' & sWhere

"setting the WHERE clause in order to query the correct recordset

if sWhere=""" then

SQLwhere = SQL

else

SQLwhere = " WHERE " & sWhere
SQLwhere = SQL + SQLwhere

end if

“Response.Write SQLwhere

R.Open SQLwhere, Conn, 3, 1, &HO001

“for debugging

domDoc.save (server ._MapPath("init2.xml™))

unts Virtual Business Components B

cashflow.asp
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cashflow.asp

"build response stream by iterating through the recordset
Response._Write "<?xml version= ""1.0"" encoding="""UTF-8""?>"
Response.Write "<siebel-xmlext-query-ret>"

“"ts.write "<?xml version="1.0" encoding="UTF-8"?>"

"ts.write "<siebel-xmlext-query-ret>"

While Not R._EOF
Response.Write "<row>"
“"ts.write "<row>"

For Each F in R.Fields

Response.Write "<value field="""& F_Name &""""">"& F.Value &"</value>"
“"ts.write "<value field="""& F.Name &"""'>"& F.Value &"</value>"
Next

Response.Write "</row>"

“"ts.write "</row>"

R.MoveNext

Wend

Response.Write "'</siebel-xmlext-query-ret>"
“"ts.write "</siebel-xmlext-query-ret>"

R.Close

Case "'siebel-xmlext-preinsert-req"”

“Section for Prelnsert
Response.Write "<siebel-xmlext-preinsert-ret>"
Response._Write "<row></row>"

Response.Write "</siebel-xmlext-preinsert-ret>

Case "'siebel-xmlext-insert-req"

"Section for Insert

Case "'siebel-xmlext-delete-req"

"Section for Delete
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Performance.asp

End Select

“cleaning up the objects in memory
ts.close

set root = Nothing

set domDoc = Nothing

set ts = Nothing

set fs = Nothing

Set R = Nothing

Conn.Close

Set Conn = Nothing

%>

Performance.asp

Use the following sample ASP to test retrieving data for the Performance view.

<%@ EnableSessionState=False Language=VBScript %>
<% option explicit %>

<%

Dim Conn

Dim SQL

Dim R

Dim F

Dim RecsAffected

Dim aConnectionString

aConnectionString = "Provider=Microsoft.Jet.OLEDB.4.0;" _

& "Data Source=c:\Inetpub\ibd\mdb.mdb"

Set Conn = Server.CreateObject(""ADODB.Connection')
Conn_Mode = 3

Conn.ConnectionString = aConnectionString
Conn.CursorLocation = 3

Conn.Open

SQL="'SELECT * from perf"

Set R=Server.CreateObject(""ADODB.Recordset')
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Performance.asp

dim v

dim fs

dim ts

dim sReq

Dim aPath
Dim aLogFile

dim item

aPath = Request.ServerVariables(*"PATH_TRANSLATED'")
"Response.Write aPath

" strip the file name from the path

aPath = Left(aPath, instrRev(aPath, '"\"))
" add the log file name

aLogFile = aPath & "\log\perf.log"

set fs = Server.CreateObject("Scripting.FileSystemObject'™)

set ts = fs.OpenTextFile(aLogFile, 8, True, 0)

"for each item iIn Request.ServerVariables
“"ts.write item
"ts.writeline Request._ServerVariables(item)

"next

dim domDoc

dim aFilename

set domDoc = Server.CreateObject(**"MSXML.DOMDocument'")
domDoc.async = false
"domDoc.setProperty(*'ServerHTTPRequest')=true

domDoc . load(Request)

dim node
dim nodes
dim mainNode
dim mainNodes

dim matchNode
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Performance.asp

dim matchNodes

dim attribs
dim attrib
dim SQLwhere
Dim root

dim SQLinsert
dim SQLfields
dim SQLvalues
dim sWhere
dim x

dim y

dim sFields

dim sValues

set root = domDoc.documentElement

dim nName
dim inputText

dim data

"inputText = Request.Form(*textlnput')

nName = root.nodeName

Select Case nName

Case "'siebel-xmlext-fields-req"”
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Performance.asp

R.Open SQL, Conn, 3, 1, &HO001
domDoc.save (server _MapPath('initl_xml™))
Response.Write "<?xml version= ""1.0"" encoding="""UTF-8""?>"
Response.Write '"<siebel-xmlext-fields-ret>"
For Each F in R.Fields
Response.Write "<support field=""& F_Name &""/>"
Next

Response.Write "</siebel-xmlext-fields-ret>"

R.Close

Case "'siebel-xmlext-query-req"

"This section of SelectCase is for the Query Request

dim attval1(25)

dim attNamel(25)

set mainNodes = root.childNodes

ts.writeline "Document have MainNodes: ' & mainNodes. length
Dim z
z=0

For each matchNode in MainNodes
"attvall(z) = matchNode.text
"set attribs = matchNode.attributes
"set attrib = attribs(0)
"attNamel(z) = attrib.nodeValue
"ts.writeline
ts.writeline "MainNode " & z
"ts.write z
ts.writeline "Main Node Name: " & matchNode.nodeName

ts.writeline "Main Node type: ' & matchNode.nodeType

ts.writeline "Main Node value: " & matchNode.nodeValue
"ts.writeline "match Node data: " & matchNode.data
ts.writeline "Main line text: " & matchNode.text

"ts.write attrib._.nodeValue

z =z +1
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next

set matchNodes = root.SelectNodes(*'search-string')
ts.writeline "MatchNodes in document are : " & matchNodes.length

X =0

For each matchNode in matchNodes

ts.writeline "Match string is :" & matchNode.text

sWhere = matchNode.text

X = X +1

next

ts.writeline "This is sWhere " & sWhere

“setting the WHERE clause in order to query the correct recordset

if sWhere="" then

SQLwhere = SQL

else

SQLwhere = " WHERE " & sWhere
SQLwhere = SQL + SQLwhere

end if

"Response.Write SQLwhere

R.Open SQLwhere, Conn, 3, 1, &HO001

“for debugging

domDoc.save (server_MapPath("init2.xml"))

"build response stream by iterating through the recordset
Response.Write "<?xml version= ""1.0"" encoding=""'"UTF-8""?>"
Response.Write '"<siebel-xmlext-query-ret>"

“ts.write "<?xml version="1.0" encoding="UTF-8"?>"

counts Virtual Business Components B

Performance.asp
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Performance.asp

“"ts.write "<siebel-xmlext-query-ret>"

While Not R.EOF
Response._Write "<row>"
"ts.write "<row>"

For Each F in R.Fields

Response._Write "<value field="""& F.Name &"""'>"& F.Value &"</value>"
"ts.write "<value field=""""& F_Name &""""'>"& F_Value &"</value>"
Next

Response.Write "</row>"

"ts.write "</row>"

R.MoveNext

Wend

Response.Write "</siebel-xmlext-query-ret>"
“"ts.write ""</siebel-xmlext-query-ret>"

R.Close

Case "'siebel-xmlext-preinsert-req"

"Section for Prelnsert

Response.Write *"<siebel-xmlext-preinsert-ret>"

Response._Write "<row></row>"

Response.Write '"</siebel-xmlext-preinsert-ret>"

Case "'siebel-xmlext-insert-req"

“Section for Insert

Case "'siebel-xmlext-delete-req"

“Section for Delete

End Select

“cleaning up the objects in memory
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ts.close

set root = Nothing
set domDoc = Nothing
set ts = Nothing
set fs = Nothing
Set R = Nothing
Conn.Close

Set Conn = Nothing

%>

ModelValueByClass.asp

Use the following sample ASP to test retrieving data for the Class Allocation view.

<%@ EnableSessionState=False Language=VBScript %>
<% option explicit %>

<%

Dim RecsAffected

Dim aConnectionString

aConnectionString = "Provider=Microsoft.Jet.OLEDB.4.0;" _

& "Data Source=C:\Inetpub\ibd\mdb.mdb"

Set Conn = Server.CreateObject(""ADODB.Connection')
Conn_Mode = 3

Conn.ConnectionString = aConnectionString
Conn.CursorLocation = 3

Conn.Open

SQL=""SELECT * from ModelValueByClass"

Set R=Server.CreateObject(""ADODB.Recordset'")
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ModelValueByClass.asp

dim fs

dim ts

dim sReq

Dim aPath
Dim aLogFile

dim item

aPath = Request.ServerVariables(""PATH_TRANSLATED')

"Response.Write aPath

" strip the file name from the path
aPath = Left(aPath, instrRev(aPath, ""\'))
" add the log file name

alLogFile = aPath & "\log\ModelValueByClass.txt"

set fs = Server.CreateObject(*'Scripting.FileSystemObject)

set ts = fs._.OpenTextFile(aLogFile, 8, True, 0)

for each item in Request.ServerVariables
ts.write item
ts.write Request.ServerVariables(item)

next

dim domDoc

dim aFilename

set domDoc = Server.CreateObject(""MSXML.DOMDocument')
domDoc.async = false
“domDoc.setProperty(‘'ServerHTTPRequest')=true

domDoc . load(Request)

dim node
dim nodes
dim mainNode
dim mainNodes
dim matchNode

dim matchNodes
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dim attribs

dim attrib
dim SQLwhere
Dim root

dim SQLinsert
dim SQLFfields
dim SQLvalues
dim sWhere
dim x

dim y

dim sFields

dim sValues

set root = domDoc.documentElement

dim nName
dim inputText

dim data

"inputText = Request.Form(""textlnput')
nName = root.nodeName
ts.write nName

ts.close

Select Case nName

Case "'siebel-xmlext-fields-req"
R.Open SQL, Conn, 3, 1, &HO001
domDoc.save (server ._MapPath("initl.xml™))
Response.Write "<?xml version= ""1.0"" encoding="""UTF-8"""?>"
Response._Write "<siebel-xmlext-fields-ret>"
For Each F in R.Fields
Response.Write "<support field=""& F_Name &""/>"
Next
Response.Write "</siebel-xmlext-fields-ret>"

R.Close
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Case "siebel-xmlext-query-req"

"This section of SelectCase is for the Query Request
dim attvall(25)
dim attNamel(25)
“set mainNodes = root.childNodes
set matchNodes = domDoc.SelectNodes("'siebel-xmlext-query-req/match')
For each matchNode in matchNodes
attvall(x) = matchNode.text
set attribs = matchNode.attributes
set attrib = attribs(0)

attNamel(x) = attrib.nodeValue

X = x +1
next
X =x-1

for y=0 to x

if not ((x-y)>0) then

sWhere = sWhere & attNamel(y) & " = " & """ & attvall(y) & """
else

sWhere = sWhere & attNamel(y) & " = " & """ & attVall(y) & """ AND"
end if

next

"setting the WHERE clause in order to query the correct recordset

if sWhere=""" then

SQLwhere = SQL

else

SQLwhere = " WHERE " & sWhere
SQLwhere = SQL + SQLwhere

end if

"Response.Write SQLwhere

R.Open SQLwhere, Conn, 3, 1, &HO001
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“for debugging

domDoc.save (server_MapPath('init2_xml™))

"build response stream by iterating through the recordset
Response._Write "<?xml version= ""1.0"" encoding="""UTF-8""?>"
Response.Write "<siebel-xmlext-query-ret>"

“"ts.write "<?xml version="1.0" encoding="UTF-8"?>"

"ts.write "<siebel-xmlext-query-ret>"

While Not R_EOF
Response.Write "<row>"
"ts.write "<row>"

For Each F in R.Fields

Response.Write "<value field="""& F_Name &""""'>"& F.Value &"</value>"
“"ts.write "<value field="""& F.Name &"""'>"& F.Value &'"</value>"
Next

Response.Write "</row>"

“"ts.write "</row>"

R.MoveNext

Wend

Response.Write '"'</siebel-xmlext-query-ret>"
"ts.write "</siebel-xmlext-query-ret>"

R.Close

Case "'siebel-xmlext-preinsert-req"”

“Section for Prelnsert

Response.Write '"<siebel-xmlext-preinsert-ret>"

Response._Write "<row></row>"

Response.Write ''</siebel-xmlext-preinsert-ret>"

Case "'siebel-xmlext-insert-req"

"Section for Insert

ccounts Virtual Business Components &

ModelValueByClass.asp
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R.Open SQL, Conn, 3, 3, &HO001

dim attval
dim attNam
set mainNo

set matchN

(25)
e(25)
des = ri

odes =

oot.childNodes

domDoc.SelectNodes("'siebel-xmlext-insert-req/row/value')

For each matchNode in matchNodes

attVal(x) = matchNode.text

set attrib
set attrib

attName(x)

for y=0 to

s = mat

= attr

= attr

X

chNode.attributes
ibs(0)

ib_.nodeValue

if not ((x-y)>0) then

sFields =
sValues =
else

sFields =
sValues =

end if

next
"ts.write

“"ts.write

sFields

sValues

sFields

sValues

sFields

svValues

& " & attName(y) & tftt"
& "ttt & attval(y) & tttUYY
& " & attName(y) & "ttv, M
& "ttt & attval(y) & tttUY, 7

if (R.Supports(&H01000400)) then

R.AddNew Array(sFields), Array(sValues)

end if

R.Update

R.Close
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Case "siebel-xmlext-delete-req"

"Section for Delete

End Select

“cleaning up the objects in memory
"ts.close

set root = Nothing

set domDoc = Nothing

set ts = Nothing

set fs = Nothing

Set R = Nothing

Conn._Close

Set Conn = Nothing

%>

ModelValueBySector.asp

Use the following sample ASP to test retrieving data for the Sector Allocation view.

<%@ EnableSessionState=False Language=VBScript %>
<% option explicit %>

<%

Dim Conn

Dim SQL

Dim R

Dim F

Dim RecsAffected

Dim aConnectionString

aConnectionString = “Provider=Microsoft.Jet.OLEDB.4.0;" _

& "Data Source=C:\Inetpub\ibd\mdb.mdb"

Set Conn = Server.CreateObject(*"ADODB.Connection’)

Conn.Mode = 3
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ModelValueBySector.asp

Conn.ConnectionString = aConnectionString
Conn.CursorlLocation = 3

Conn.Open

SQL=""SELECT * from ModelValueBySector"

Set R=Server.CreateObject(""ADODB.Recordset')

dim ts

dim sReq

Dim aPath
Dim aLogFile

dim item

aPath = Request.ServerVariables("'PATH_TRANSLATED'")

"Response.Write aPath

" strip the file name from the path
aPath = Left(aPath, instrRev(aPath, "\"))
® add the log file name

aLogFile = aPath & "“\log\ModelValueBySector.txt"

set fs = Server.CreateObject(*'Scripting.FileSystemObject'™)

set ts = fs.OpenTextFile(aLogFile, 8, True, 0)

for each item in Request.ServerVariables
ts.write item
ts.write Request.ServerVariables(item)

next

dim dombDoc

dim aFilename

set domDoc = Server.CreateObject(**MSXML.DOMDocument')
domDoc.async = false

“domDoc.setProperty(*'ServerHTTPRequest')=true
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domDoc . load(Request)

dim node

dim nodes

dim mainNode
dim mainNodes
dim matchNode
dim matchNodes
dim attribs
dim attrib
dim SQLwhere
Dim root

dim SQLinsert
dim SQLfields
dim SQLvalues

dim sWhere

dim sFields

dim sValues

set root = domDoc.documentElement

dim nName
dim inputText

dim data

"inputText = Request.Form(*"textinput’)
nName = root.nodeName
ts.write nName

ts.close

Select Case nName

Case "'siebel-xmlext-fields-req"”

R.Open SQL, Conn, 3, 1, &HO0O01
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domDoc.save (server ._MapPath('initl.xml™))
Response._Write "<?xml version= ""1.0"" encoding="""UTF-8""?>"
Response.Write "<siebel-xmlext-fields-ret>"
For Each F in R.Fields
Response.Write "<support field=""& F_Name &""/>"
Next
Response.Write ""</siebel-xmlext-fields-ret>"

R.Close

Case "'siebel-xmlext-query-req"

"This section of SelectCase is for the Query Request
dim attvVall(25)
dim attNamel(25)
"set mainNodes = root.childNodes
set matchNodes = domDoc.SelectNodes(''siebel-xmlext-query-req/match'™)
For each matchNode in matchNodes
attvall(x) = matchNode.text
set attribs = matchNode.attributes
set attrib = attribs(0)

attNamel(x) = attrib.nodeValue

X = x +1
next
X =x-1

for y=0 to x

if not ((x-y)>0) then

sWhere = sWhere & attNamel(y) & " = " & """ & attvall(y) & """
else

sWhere = sWhere & attNamel(y) & " = " & """ & attvall(y) & """ AND"
end if

next

"setting the WHERE clause in order to query the correct recordset
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if sWhere="" then

SQLwhere = SQL

else

SQLwhere = " WHERE " & sWhere
SQLwhere = SQL + SQLwhere

end if

"Response.Write SQLwhere

R.Open SQLwhere, Conn, 3, 1, &H0001

“for debugging

domDoc.save (server _MapPath('init2_xml™))

"build response stream by iterating through the recordset
Response._Write "<?xml version= ""1.0"" encoding="""UTF-8""?>"
Response.Write '<siebel-xmlext-query-ret>"

“"ts.write "<?xml version="1.0" encoding="UTF-8"?>"

"ts.write "<siebel-xmlext-query-ret>"

While Not R.EOF
Response.Write "<row>"
“"ts.write "<row>"

For Each F in R.Fields

Response.Write "<value field="""& F_Name &""""">"& F.Value &"</value>"

“"ts.write "<value field=""""& F_Name &"""'>"& F._Value &"</value>"
Next
Response.Write "</row>"
“"ts.write "</row>"
R.MoveNext
Wend
Response.Write '"'</siebel-xmlext-query-ret>"
“"ts.write "</siebel-xmlext-query-ret>"

R.Close

Case "'siebel-xmlext-preinsert-req"”

“Section for Prelnsert

ccounts Virtual Business Components &

ModelValueBySector.asp
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ModelValueBySector.asp

Response.Write "<siebel-xmlext-preinsert-ret>"
Response.Write "<row></row>"

Response.Write "</siebel-xmlext-preinsert-ret>"

Case "'siebel-xmlext-insert-req"

"Section for Insert

R.Open SQL, Conn, 3, 3, &HO001

dim attval(25)

dim attName(25)

set mainNodes = root.childNodes

set matchNodes = domDoc.SelectNodes("siebel-xmlext-insert-req/row/value')
For each matchNode in matchNodes

attVal(x) = matchNode.text

set attribs = matchNode.attributes
set attrib = attribs(0)

attName(x) = attrib.nodevalue

X = x +1
next
X =x-1

for y=0 to x

if not ((x-y)>0) then

sFields = sFields & """ & attName(y) & ™"
svValues = sValues & """ & attval(y) & """
else

sFields = sFields & """ & attName(y) & "™, ™
sValues = svValues & """ & attval(y) & """, "
end if

next

“"ts.write sFields
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holdings.asp

“"ts.write sValues

if (R.Supports(&H01000400)) then
R.AddNew Array(sFields), Array(sValues)

end if

R.Update

R.Close

Case "siebel-xmlext-delete-req"

"Section for Delete

End Select

“cleaning up the objects in memory
"ts.close

set root = Nothing

set domDoc = Nothing

set ts = Nothing

set fs = Nothing

Set R = Nothing

Conn._Close

Set Conn = Nothing

%>

holdings.asp

Use the following sample ASP to test retrieving data for the Aggregated Holdings view.

<%@ EnableSessionState=False Language=VBScript %>
<% option explicit %>

<%

Dim Conn

Dim SQL

Dim R
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Dim RecsAffected

Dim aConnectionString

aConnectionString = "Provider=Microsoft.Jet_OLEDB.4.0;" _

& "Data Source=C:\Inetpub\ibd\mdb.mdb"

Set Conn = Server.CreateObject(**ADODB.Connection')
Conn.Mode = 3

Conn.ConnectionString = aConnectionString
Conn.CursorLocation = 3

Conn.Open

SQL=""SELECT * from Holdings"

Set R=Server.CreateObject(*'ADODB.Recordset")

dim ts

dim sReq

Dim aPath
Dim aLogFile

dim item

aPath = Request.ServerVariables(*"PATH_TRANSLATED')

"Response.Write aPath

® strip the file name from the path
aPath = Left(aPath, instrRev(aPath, '"\"))
" add the log file name

aLogFile = aPath & "\log\Holding.txt"

set fs = Server.CreateObject("Scripting.FileSystemObject'™)

set ts = fs.OpenTextFile(aLogFile, 8, True, 0)

"for each item iIn Request.ServerVariables

“"ts.write item
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"ts.write Request.ServerVariables(item)

"next

dim domDoc

dim aFilename

set domDoc = Server.CreateObject(**"MSXML.DOMDocument')
domDoc.async = false
"domDoc.setProperty(*'ServerHTTPRequest')=true

domDoc . load(Request)

dim node

dim nodes

dim mainNode
dim mainNodes
dim matchNode
dim matchNodes
dim attribs
dim attrib
dim SQLwhere
Dim root

dim SQLinsert
dim SQLfields
dim SQLvalues

dim sWhere

dim sFields

dim sValues

set root = domDoc.documentElement

dim nName

inputText

dim data

"inputText = Request.Form(*textlnput')

ts Virtual Business Components B
holdings.asp
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nName = root.nodeName
"ts.write nName

“"ts.close

Select Case nName

Case "'siebel-xmlext-fields-req"
R.Open SQL, Conn, 3, 1, &HOOO1l
domDoc.save (server._MapPath('initHoldl.xmlI'™))
Response.Write "<?xml version= ""1.0"" encoding="""UTF-8""?>"
Response.Write "<siebel-xmlext-fields-ret>"
For Each F in R_Fields
Response.Write "<support field=""& F_Name &""/>"
Next
Response.Write "</siebel-xmlext-fields-ret>"

R.Close

Case "'siebel-xmlext-query-req"

"This section of SelectCase is for the Query Request

dim attvall(25)

dim attNamel(25)

set mainNodes = root.childNodes

ts.writeline "Document have MainNodes: ' & mainNodes. length
Dim z
z=0

For each matchNode in MainNodes
"attvall(z) = matchNode.text
"set attribs = matchNode.attributes
"set attrib = attribs(0)
"attNamel(z) = attrib.nodeValue

“"ts.writeline

ts.writeline "MainNode " & z

"ts.write z

ts.writeline "Main Node Name: ' & matchNode.nodeName
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ts.writeline "Main Node type: ' & matchNode.nodeType

ts.writeline "Main Node value: "™ & matchNode.nodeValue
“"ts.writeline "match Node data: ' & matchNode.data
ts.writeline "Main line text: ' & matchNode.text

"ts.write attrib.nodeValue

z =2z +1

next

set matchNodes = root.SelectNodes(*'search-string')
ts.writeline "MatchNodes in document are : " & matchNodes.length

X =0

For each matchNode in matchNodes

ts.writeline "Match string is :" & matchNode.text

sWhere = matchNode.text

X = X +1

next

ts.writeline "This is sWhere " & sWhere

"setting the WHERE clause in order to query the correct recordset

if sWhere=""" then

SQLwhere = SQL

else

SQLwhere = " WHERE " & sWhere
SQLwhere = SQL + SQLwhere
end if

"Response.Write SQLwhere

R.Open SQLwhere, Conn, 3, 1, &HO001

counts Virtual Business Components B

holdings.asp
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“for debugging

domDoc.save (server _MapPath('initHold2.xml'))

"build response stream by iterating through the recordset
Response._Write "<?xml version= ""1.0"" encoding="""UTF-8""?>"
Response.Write "<siebel-xmlext-query-ret>"

“"ts.write "<?xml version="1.0" encoding="UTF-8"?>"

"ts.write "<siebel-xmlext-query-ret>"

While Not R_EOF
Response.Write "<row>"
"ts.write "<row>"

For Each F in R.Fields

Response.Write "<value field="""& F_Name &""""'>"& F.Value &"</value>"
“"ts.write "<value field="""& F.Name &"""'>"& F.Value &'"</value>"
Next

Response.Write "</row>"

“"ts.write "</row>"

R.MoveNext

Wend

Response.Write '"'</siebel-xmlext-query-ret>"
"ts.write "</siebel-xmlext-query-ret>"

R.Close

Case "'siebel-xmlext-preinsert-req"”

“Section for Prelnsert

Response.Write "<siebel-xmlext-preinsert-ret>"

Response._Write "<row></row>"

Response.Write "</siebel-xmlext-preinsert-ret>

Case "'siebel-xmlext-insert-req"

"Section for Insert
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Case "siebel-xmlext-delete-req"

"Section for Delete

End Select

“cleaning up the objects in memory
ts.close

set root = Nothing

set domDoc = Nothing

set ts = Nothing

set fs = Nothing

Set R = Nothing

Conn._Close

Set Conn = Nothing

%>
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Numerics
7.7 seed data, confirming 141

A

access exceptions
about 191
access exceptions by type, viewing 195
access exceptions, adding 194
access workflows, activating 193
business scenario 192
contact’s access level, setting 195
distribution exceptions, about activating
workflows 193
existing piece of literature, setting access
level 192
list, setting access level (administrator
procedure) 193
list, setting access level (end-user
procedure) 195
list, viewing access exceptions associated
with 196
literature and lists, about setting access
levels 192
literature, viewing access exceptions
associated with 195
access levels
contact access level, about using 82
contact’s access level, setting 195
contacts, setting access level 195
existing piece of literature, setting access
level 192
list, setting access level 195
literature and lists, about setting for 192
literature, setting list access level 193
account analysis, viewing 116
account holdings
comparing against portfolio model 72
account services
account services view items table 122

account services, requesting using a service

request 124
accounts

account holdings, comparing against portfolio

model 72

call list, creating based on account
criteria 116

expected future cash flows, viewing for

selected accounts 73

facilities, associating with financial
accounts 164

financial account, associated with a
household 72

financial account, viewing aggregated
holdings for 72

Financial Services, as used in 26

selected account holdings, viewing by
sector 72

selected accounts’ past performance,
viewing 73

action items

associating with call reports 97

Active Server Pages

cashflow.asp virtual business
component 307
holdings.asp virtual business
component 331
ModelValueByClass.asp virtual business
component 319
ModelValueBySector.asp virtual business
component 325
Performance.asp virtual business
component 313

activities

about and defined 101
activities plan for loan requests, about setting
up 162
business scenarios, institutional finance 102
business scenarios, retail finance 102
call lists, creating 104
closing activities, adding 155
company coverage team activities,
viewing 104
coworkers, assigning activities to 103
customers, making appointments with 102
group pension plan, creating activity
associated with 204
literature fulfillment, providing by email 104
My To Do List, managing 103
viewing aggregated activities for a
company 59

activity

activity plan, creating for a deal 45
new activity, creating and assigning a deal
team member 45
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Actuate reports, table of 303
address
company address, changing 121
company address, changing by service
request 124
customer address, changing 122
customer address, changing by service
request 125
Aggregated Holdings view
testing using holdings.asp 331
applets
Command Center applet, configuring
example 34
Command Center applet, defining actions 32
Command Line applet, creating global
commands for 36
read and write, or write-only, about
establishing 27
applicant information, adding 147
application information, managing
applicant and guarantor information,
adding 147
closing requirement, reviewing 150
collateral information, adding 149
consumer detail information, adding 148
disclosure information, capturing 149
documentation, managing using
subviews 150
product detail information, adding 146
reference information, adding 149
types of applicant information 146
updated statement, creating 147
application view navigation
See applications
applications
7.7 seed data, confirming 141
applicant and guarantor information,
adding 147
application information, types of 146
application process, about 137
application workflow, purpose of setting
up 139
application workflow, setting up 140
application, creating 144
Applications view, accessing from the
Companies screen 143
Applications view, accessing from the
Contacts screen 143
assessing applications, methods to 153
assigned applications, viewing 153
associating company applications with a
company 61
Auto Application workflow, deactivating 142
Auto Application workflow, routing actions
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to 142
Auto Application, about 141
Auto Application, screens available from 145
Auto Application, using to create an
application 145
Auto Application, verifying runtime event
data 141
business scenario, administrator creates a
new product 138
business scenario, branch agent assists a
customer opening a new
account 138
business services information, adding 152
closing activities, adding 155
closing requirements, reviewing 150
collateral information, adding 149
consumer detail information, adding 148
coworkers, assigning applications to 145
decisions, viewing 154
disclosure information, capturing 149
documentation, managing using
subviews 150
Next button, about using to complete
applications 144
notes, creating about applications 155
outstanding trailing documents, viewing 155
processing application tasks, list of 152
product detail information, adding 146
reference information, adding 149
regulation C compliance information,
entering 154
report information, entering 154
sales method creation and modification,
about 140
small business details, adding 151
small business loan applications, customer
information needed 150
small business loan features and terms,
recording 152
trailing documents, adding 155
updated statement, creating 147
Applications Administration Guide
about setup tasks information 25
Applications view
Companies screen, accessing from 143
Contacts screen, accessing from 143
appointments
making appointments with customers 102
approval levels
commercial loans, setting up for 162
loan request, associating with 166
approval stage
approving or declining 289
assessment templates



about setting up 161
assessments
company assessments, about creating 61
company assessments, performing 61
Assignment Manager
about using to resolve coverage team
problems 53
Assignment Statements, fine tuning
about 232
Cache flag, about 234
Light Parser flag, about 233
attachment
deal, creating for 45
attachments
associating with call reports 97
Audit Trail
using Show Audit Trail button 26
authorized user
adding to financial account 112
Auto Application
7.7 seed data, confirming 141
about 141
application, using to create 145
Auto Application workflow, routing actions
to 142

deactivating Auto Application workflow 142

runtime event data, verifying 141

screens available from 145
automating approval processing

about 286

approval items and stages, defining 286

FINS Approval Item Service, invoking from a

workflow 287

B

beneficiary information
recording for participant 203
billing
entering billing information group
pensions 202
bond records
about creating and modifying 177
borrower
borrower details, adding to a loan
request 166
policy exceptions, creating at borrower
level 170
BRP
See Business Rule Processor
business components
cashflow.asp virtual business
component 307
holdings.asp virtual business

Index m B

component 331
ModelValueByClass.asp virtual business
component 319
ModelValueBySector.asp virtual business
component 325
Performance.asp virtual business
component 313
Business Rule Process
procedure, defining 225
procedure, defining a step 225
procedures, about defining 224
Business Rule Processor
about 215
business rule process, creating 218
creating and managing, about 218
existing process, revising 219
process of defining 216
process, activating 219
process, exporting 219
process, importing 219
properties, defining 220
property types. about 220
property, defining 223
Business Rules Process
errors, recovering from within process 235
errors, throwing errors within 234
FINS CAP Buscomp Data Loader Business
Service 236
FINS CAP Buscomp Handler Business
Service 240
helper business services, about using 236
Business Rules Processor
debug messages, logging 248
invoking using eScript 247
invoking, about 246
business services
about 206
active business objects, use of 282
approval items and stages, defining 286
approval stage, approving or declining 289
Assignment Statements, fine tuning 232
automating approval processing 286
Business Rule Process procedure,
defining 225
Business Rule Process procedure, defining a
step 225
Business Rule Process procedures,
defining 224
Business Rule Processor debug messages,
logging 248
Business Rule Processor property types 220
Business Rule Processor property,
defining 223
Business Rule Processor, about 215
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Business Rule Processor, about creating and
managing 218

Business Rule Processor, activating a
process 219

Business Rule Processor, creating 218

Business Rule Processor, defining
properties 220

Business Rule Processor, exporting a
process 219

Business Rule Processor, importing a
process 219

Business Rule Processor, invoking using
eScript 247

Business Rule Processor, process of
defining 216

Business Rule Processor, revising an existing
process 219

Business Rules Process, about using helper
business services 236

Business Rules Process, recovering from
errors 235

Business Rules Process, throwing errors
within 234

Business Rules Processor, invoking 246

Cache flag, about 234

calculation details, specifying 264

calculation expressions in Data Transfer
Utilities 277

Calculation Manager, about and
examples 262

Calculation Manager, invoking 267

calculation rule set. specifying 263

Customer Authentication Manager 257

Customer Authentication Manager,
invoking 261

customer authentication rules, creating 260

customer authentication templates,
creating 258

Customer Expectation Manager rules,
defining 269

Customer Expectation Manager,
invoking 271

Customer Expectations Manager 268

data map component advanced options 273

data map components 272

data map fields 275

data map objects 272

data maps, about 271

Data Transfer method 279

Data Transfer Utilities, about 271

Data Validation Manager, about 214

disclosure documents, activating workflows
used to display 292

disclosure history, viewing associated with

342 Siebel Finance Guide Version 7.8

contacts 293

disclosure processing, automating
display 290

Disclosure Ul Service, about invoking from
workflow 292

disclosure workflow processes (table) 291

disclosures, associating with a product 290

dynamic applet, creating with Dynamic Ul
business service example 296

dynamic applet, displaying in a workflow 297

dynamic enabling of commands 284

Dynamic Ul business service, about 296

Dynamic Ul Service methods 299

embedded script for mortgage calculation
example 265

event-based commands, configuring 283

existing disclosure, revising 290

FINS Application View Navigation
Service 299

FINS Application View Navigation Service
example 301

FINS Application View Navigation Service,
administering 301

FINS Application View Navigation Service,
behaviors 300

FINS Application View Navigation Service,
methods 300

FINS Application View Navigation Service,
upgrade note 302

FINS Approval Item Service, invoking from a
workflow 287

FINS CAP Buscomp Data Loader Business
Service 236

FINS CAP Buscomp Handler Business
Service 240

FINS SmartScript Output Service
methods 296

FINS Web Shopping Service methods 295

Free Format Converter 213

invocation context 282

Light Parser flag, about 233

named parameters, using in Data Transfer
Utilities 276

Record Group templates, creating 254

record templates, creating 250

recursive invocation 283

requirement templates, creating 251

Requirements Manager 249

Requirements Manager key features 249

Requirements Manager, about invoking 249

Requirements Manager, administration
steps 250

Requirements Manager, example of using for
Record Group templates 256



Requirements Manager, invoking 254

SmartScript, about invoking from a
workflow 293

SmartScript, integrating with workflow
example 293

Template Definition view, adding views and
applets 299

variables, specifying 263

VBC cache and Instance Manager 208

view template, about creating for dynamic
applets 298

well-positioned buscomps 282

what is a business service 206

business services information, adding 152

C

C compliance information, entering 154
Cache flag, about 234
Calculation Expectations Manager
about 268
invoking 271
rules, defining 269
calculation expressions
about 277
curley bracket pair {field} 277
named parameters 278
Calculation Manager
about and examples 262
calculation details, specifying 264
calculation rule set, specifying 263
embedded script for mortgage calculation
example 265
invoking 267
variables, specifying 263
calculator
using the mortgage calculator 89
call lists
account criteria, creating based on 116
contacts in a targeted call list, modifying 182
contacts, searching for with particular
interests 181
creating 104
generation, configuring 183
holdings information, entering 180
interest based on a holding, recording 180
interest, recording 179
interest-based call lists, about creating 179
targeted call list, about creating and
using 181
targeted call list, using 183
call report email templates
viewing or changing 95
call reports

Index m C

action items, notes, and attachments,
associating with 97
business scenario 92
call report charts, viewing 94
call report distribution list, creating 97
call report email templates, viewing or
changing 95
call report privacy flag, setting 98
call report, adding 96
Data Transfer Utility, about using 95
defined and about 91
emailing and printing 98
New Call Report Workflow, activating 95
Cash flow view
testing using cashflow.asp 307
categories
creating contact information for 80
security categories, adding 177
charts
viewing access exceptions by type 195
Class Allocation view
testing using ModelValueByClass.asp 319
ClearCache method, about 240
client interests
holdings information, entering 180
interest based on a holding, recording 180
interest, recording 179
tracking, process of and creating interest-
based call lists 179
closing activities, adding 155
closing requirements, reviewing 150
Collapse button
Edit Layout view 28
summary view control, about 28
collateral
collateral information, adding 149
loan facilities, adding to 170
command center
about and interface types 29
configuration and administration, about 29
Command Center Action form
Command Center Action applet, configuring
example 34
Command Center action, selecting
responsibilities 34
Command Center applet, defining actions 32
Command Center business object,
defining 30
process of configuring appearance and
functions 30
Command Center applet
configuring example 34
defining actions 32
Command Center business object
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defining 30
Command Line applet
creating for global commands 36
commands
dynamic enabling, about 284
event-based commands, configuring 283
Mock Event Sink mode 285
Srf mode 285
toolbar buttons, defining 285
commercial loan
managing, about 157
commercial loans
activities plan, about setting up 162
approval level, associating with a loan
request 166
approval levels, setting up 162

assessment templates, about setting up 161

borrower details, adding to a loan
request 166

business scenario, administrator sets up
approval stages and underwriting
standards 159

business scenario, credit administrator set up

capital facility 159

business scenario, credit committee officer
reviews loan request 159

business scenario, loan officer creates new
load request 159

collateral, adding to loan facilities 170

commercial loan request, creating 165

commercial loan underwriting standard,
setting up 164

credit decisions, entering 172

credit issue for loan request, creating or
modifying 167

documentation templates, about setting
up 162

existing covenants, copying to another
facility 169

facilities, associating with financial
account 164

facility, adding covenants 169

facility, adding guarantors 168

facility, creating and associating a
borrower 167

facility, setting pricing and fees 168

facility, syndicating 167

group exposure, reviewing 171

loan request workflows, activating 161

loan request, assigning 172

policy exceptions, creating 170

portfolio types, setting up 163

scenarios 158

underwriting standard, reviewing 171
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companies

about 47, 48

aggregated activities viewing for a
company 59

aggregated coverage team, viewing 60

aggregated list of contacts, viewing 60

aggregated opportunities, viewing 60

business scenario, investment banker and
research analyst analyze research
literature 50

business scenario, sales representative tracks
company information 49

company applications, associating with a
company 61

company assessments, about creating 61

company assessments, performing 61

company coverage team, adding a
member 63

company coverage teams, about
managing 62

company hierarchies, about 48

company hierarchies, default 56

company hierarchies, viewing in roll-up
views 59

company information, making unavailable to
users 52

company or investor, adding 58

company summaries, viewing 63

competitor designation, changing 53

competitor, indicating a company is a
competitor 52

coverage team members, about verifying 53

coverage team members, adding or
deleting 53

coverage team members, search for a
company without 53

custom-defined relationship type, about
managing 54

custom-defined relationship type, adding 54

custom-defined relationship, creating 64

data aggregation, about generating company
hierarchies for 55

default company hierarchy, generating 56

dynamic company hierarchy, creating 57

industry, adding 51

parent-subsidiary relationship,
establishing 63

primary coverage team members,
changing 54

profiles, updating 58

service requests, adding associated with a
company 62

territory, adding 51

values, about setting up 51



Companies screen
accessing from Applications view 143
company
address or name, changing 121
address or name, changing by service
request 124
general needs analysis, performing 132
company coverage team
viewing activities 104
company hierarchies
aggregated activities, viewing for a
company 59
aggregated coverage team, viewing 60
aggregated list of contacts, viewing 60
aggregated opportunities, viewing 60
data aggregation, generating for 55
default company hierarchies 56
default company hierarchy, generating 56
dynamic company hierarchy, creating 57
roll-up view, viewing in 59
company relationship hierarchies
custom-defined relationship, creating 64
viewing 63
company summaries, viewing 63
competitor
company, indicating as a competitor 52
designation, changing competitor
designation 53
complaint, recording 126
compliance information
entering C compliance information 154
conditions
defining for a product 188
consumer detail information, adding 148
contacts
access level, setting 195
adding 79
business scenario, private banker prepares for
sales call 77
business scenario, sales representative adds a
new contact 76
categories, creating for contact
information 80
company, associating a contact with a
company 80
contact access level 82
contact profitability, reviewing 84
contact relationship hierarchies, viewing 86
contact summary, viewing 85
contact’s holding, updating or reviewing 78
contact’s investment profile, updating or
reviewing 78
customer assessments, about creating 84
customer assessments, creating 84

Index m C

customer value stars. adjusting 85
defined 75
disclosure history, viewing associated with
contacts 293
financial plans, creating 90
general needs analysis, performing 132
group pension plan contacts, recording 201
household, adding to a 69
households, associating with 69
investment needs analyses, performing
for 133
literature distribution, adding contact to 81
managing contact information, about 79
modifying in a targeted call list 182
mortgage calculator, using 89
mortgage needs analyses, performing for a
contact 87
mortgage prequalification, performing 89
mortgage product for which a customer
qualifies, recommending 88
mortgage product recommendations, about
making 88
mortgages, managing 87
notes, creating about contacts 81
particular interests, searching for 181
referral, creating to a contact 83
referral, entering a referral received from a
contact 82
relationship between contacts, defining 86
securities interest, entering for contacts 82
transaction history, viewing 82
Contacts screen
Applications view, accessing from 143
service requests, using to create 122
covenants
existing covenants, copying to another
facility 169
facilities, adding to 169
coverage teams
activities, viewing company coverage team
activities 104
company coverage team, adding a
member 63
company coverage teams, about
managing 62
coworkers
activities, assigning coworkers to 103
applications, assigning coworkers to 145
Create Statements button, using 147
credit committee officer
assigning loan request 172
credit decisions
entering for commercial loans 172
credit issue

Siebel Finance Guide Version 7.8 345



Index m D

creating or modifying for commercial loan
request 167
customer assessments
creating 84
creating, about 84
customer value stars, adjusting 85
Customer Authentication Manager
about 257
customer authentication rules, creating 260
customer authentication templates,
creating 258
invoking 261
customer value stars, adjusting 85
customers
address or name, changing 122
address or personal information, changing by
service request 125
making appointments with customers 102
new customer complaint, recording 126

D

data aggregation
company hierarchies, default 56
company hierarchies, generating for data
aggregation 55
default company hierarchy, generating 56
dynamic company hierarchy, creating 57
data field
determining which to display 27
Data Transfer method
arguments and descriptions 279
FAFireEventxx method 280
GetActiveViewProp method 280
QueueMethod 281
TryMockMethod 281
Data Transfer Utilities
about 271
about using 95
active business objects 282
calculation expressions in DTU, about 277
data map component advanced options 273
data map components 272
data map fields 275
data map objects 272
data maps, about 271
Data Transfer method 279
invocation context 282
named parameters, using in DTU 276
recursive invocation 283
well-positioned buscomps 282
Data Validation Manager
about 214
data, confirming 7.7 seed data 141
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database
setting up test ASP and local test
database 114
deal managing
about 44
deal management capabilities 37
deal, creating a new activity plan 45
deals, securing 44
new activity, creating and assigning a deal
team member 45
new attachment, creating for a deal 45
primary deal team member, changing 44
deleting
company information, making unavailable to
users 52
coverage team members 53
opportunities, if unsure whether opportunity
is active 40
disclosure documents
automating display, about 290
contacts, viewing disclosure history 293
Disclosure Ul Service, invoking from
workflow 292
disclosure workflow processes (table) 291
disclosures, associating with a product 290
existing disclosure, revising 290
workflows, activating used to display
disclosure documents 292
disclosure information, capturing 149
Disclosure Ul Service
invoking from a workflow 292
distribution exceptions
access workflows, activating 193
activating access workflows, about 193
distribution list
about creating 97
documentation
documentation template, about setting
up 162
documents, managing using subviews 150
literature document, associating with a
security 178
outstanding trailing documents, viewing 155
trailing documents, adding 155
dynamic applets
See Dynamic Ul business service
dynamic company hierarchy, creating 57
Dynamic Ul business service
about 296
dynamic applet, creating with Dynamic Ul
business service example 296
dynamic applet, displaying in a workflow 297
Dynamic Ul Service methods 299
Template Definition view, adding views and



applets 299
view template, about creating for dynamic
applets 298

E

Edit Layout view
about using and buttons 28
email templates
viewing or changing call report email
templates 95
emailing
call reports 98
literature fulfillment, providing by email 104
enrolling
new participants in group pension plan 203
Enterprise Integration Manager (EI1A)
about using to import market data 179
errors
Business Rules Process, throwing errors
within 234
recovering from errors within a Business Rules
Process 235
event-based commands
configuring 283
exceptions
creating policy exceptions 170
exchange
adding security exchange 177
Expand button
Edit Layout view 28
summary view control, about 28

E
facilities
collateral, adding to loan facilities 170
covenants, adding to facilities 169
existing covenants, copying to another
facility 169
financial accounts, associating with 164
guarantors, adding to loan facilities 168
new facility, creating and associating a
borrower 167
policy exceptions, creating a facility
level 170
pricing and fees, setting 168
syndicating a facility 167
FAFireEventxxx method 280
features, new 15
fees, defining for a product 188
fields
determining which data fields to display 27
financial accounts
account analysis, viewing 116

Index m E

account categories and account types, about
establishing 111
account holdings, comparing against a
portfolio model 72
administrator procedures, understanding
concepts 110
aggregated holdings, viewing for a financial
account 72
business scenario, call center agent 108
business scenario, relationship manager 109
business scenario, wealth management/
brokerage relationship manager 109
call list, creating based on account
criteria 116
expected future cash flows, viewing for
selected accounts 73
facilities, associating with 164
financial account, adding 111
financial accounts, reviewing 115
holdings information, associating with a
financial account 112
household financial accounts virtual business
components, about setting up 113
new authorized user, adding to a financial
account 112
selected account holdings, viewing by
sector 72
selected accounts’ past performance,
viewing 73
selecting associated with a household 72
service request, creating using the GO
button 116
test ASP and local test database, setting
up 114
trades, placing 117
virtual business component testing 115
virtual business component user properties,
configuring 113
financial needs analysis
See needs analysis
financial plans, creating 90
FINS Application View Navigation Service
about 299
administering 301
business service behaviors 300
business service methods 300
example 301
upgrade note 302
FINS Approval Item Service
business service step, configuring 289
start step, configuring 288
workflow, about invoking 287
FINS CAP Buscomp Data Loader Business
Service
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about 236
ClearCache method, about 240
LoadData method example using field
[n] 239
LoadData method example using Key and
Value fields 240
LoadData method, about 237
FINS CAP Buscomp Handler Business Service
about 240
GetFieldvalue method, about 243
InsertRecord method, about 244
NextRecord method, about 245
query method, about 241
SetFieldvalue method, about 244
FINS EAI Free Format Converter
about 213
methods 213
user properties 213
FINS SmartScript Output Service
methods 296
FINS Web Shopping Service methods 295
Free Format Converter
about 213
methods 213
user properties 213

funds
group pension plan, viewing available within
plan 203
G

GetActiveViewProp method 280
GetFieldValue method, about 243
global commands
creating for the Command Line applet 36
GO button
using to create service requests 116
grievances, recording 126
group exposure, reviewing 171
group pensions
activity, creating associating with a plan 204
administering group pension plans, list of
tasks 202
billing information, entering 202
business scenario 197
eligible plan members, adding 203
funding vehicles, defining for a group pension
product 199
funds and investments available within plan,
viewing 203
group pension plan contacts, recording 201
group pension plan, defining 200
group pension plans, process of defining 200
group pension product, defining 199
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managing, about 197

new participants, enrolling in plan 203

note, creating associated with a plan 204

participant beneficiary information,
recording 203

participant classes, defining for plan
participants 201

plan rules, specifying 201

service request, creating associated with
plan 203

tasks, samples performed when managing
group pensions (diagram) 198

guarantors
guarantor information, adding 147
loan facilities, adding to 168

H
Hide button
Edit Layout view 28
summary view control, about 28
holdings
about 173
business scenario 174
call list generation, configuring 183
clients’ interests, process of tracking 179
contacts in a targeted call list, modifying 182
contacts, searching for with particular
interests 181
holdings information, associating with a
financial account 112
holdings information, entering 180
industry values. defining 175
interest based on a holding, recording 180
interest, recording 179
list of holdings displayed by investor 66
literature document, associating with a
security 178
mutual fund information, editing 178
new securities record, adding 178
product class, adding for a security 176
product lines. defining 175
securities lists of values, setting up 175
securities, process of administering 174
security categories, adding 177
security exchange, adding 177
stock, bond. mutual fund records, about
creating and modifying 177
targeted call list, about creating and
using 181
targeted call list, using 183
holdings.asp 331
host applications
about integrating data with 26



households

account holding, comparing against a portfolio
model 72

business scenario 68

contact, adding to a household 69

contacts, associating with households 69

defined 67

expected future cash flows, viewing for
selected accounts 73

financial account, selecting associating with a
household 72

financial account, viewing aggregated holding
for 72

financial accounts virtual business
components, about setting up 113

household portfolios, about viewing and
evaluating 71

household summary, viewing 70

privacy option, setting 69

relationship hierarchy, about viewing 70

selected account holdings, viewing by
sector 72

selected accounts’ past performance,
viewing 73

test ASP and local test database, setting
up 114

virtual business component testing 115

virtual business component user properties,
configuring 113

Households financial accounts

cashflow.asp virtual business
component 307

holdings.asp virtual business
component 331

ModelValueByClass.asp virtual business
component 319

ModelValueBySector.asp virtual business
component 325

Performance.asp virtual business
component 313

industry values, defining 175
information
changing personal information by service
request 125
InsertRecord method, about 244
Instance Manager, and VBC Cache
about 208
caching VBC configuration 210
components 209
features and limitations 208
purging the VBC cache 211
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stages of caching process 209
interests
about 173
business scenario 174
call list generation, configuring 183
clients’ interests, process of tracking 179
contacts in a targeted call list, modifying 182
contacts, searching for with particular
interests 181
holdings information, entering 180
industry values, defining 175
interest based on a holding, recording 180
interest, recording 179
literature document, associating with a
security 178
mutual fund information, editing 178
product class, adding for a security 176
product lines, defining 175
securities lists of values, setting up 175
securities record, adding 178
securities, process of administering 174
security categories, adding 177
security exchange, adding 177
stock, bond. mutual fund records, about
creating and modifying 177
targeted call list, about creating and
using 181
targeted call list, using 183
investment objectives
creating 131
creating and the portfolio mix 130
portfolio mix administration, performing 131
investment profile
updating or reviewing a contact’s investment
profile 78
investments
viewing available within group pension
plan 203
investors
about 47, 48
investor, adding 58
list of holdings, displaying by investor 66
list of transactions, displayed by investor 65

L
Light Parser flag, about 233
List of Values
about configuring 27
lists
access exceptions associated with a list,
viewing 196
access level, setting (end-user
procedure) 195
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list, setting access level (administrator
procedure) 193

literature and lists, about setting access
levels 192

literature

access exceptions business scenario 192

access exceptions by type, viewing 195

access exceptions, about 191

access exceptions, adding 194

access exceptions, viewing associated
with 195

access workflows, activating 193

contact, distributing to 81

contact’s access level, setting 195

distribution exceptions, about activating
access workflows 193

existing piece of literature, setting access
level 192

literature and lists, about setting access
levels 192

literature fulfillment, providing by email 104

security, associating with a security 178

LoadData method

about and parameters 237

ClearCache method, about 240

example using field [n] 239

example using Key and Values fields 240

loans

activities plan, about setting up 162

approval level, associating with a loan
request 166

assessing applications, methods to 153

assessment templates, about setting up 161

assigned applications, viewing 153

borrower details, adding to a loan
request 166

business scenario, administrator sets up
approval stages and underwriting
standards 159

business scenario, credit administrator set up
capital facility 159

business scenario, credit committee officer
reviews loan request 159

business scenario, loan officer creates new
load request 159

business services information, adding 152

closing activities, adding 155

collateral, adding to loan facilities 170

commercial loan approval levels, setting
up 162

commercial loan request scenarios 158

commercial loan request, creating 165

commercial loan requests, assigning 172

commercial loan underwriting standard,
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setting up 164

covenants, adding to facilities 169

credit decisions, entering 172

credit issue for loan request, creating or
modifying 167

customer information needed for small
business loans 150

decisions, viewing on applications 154

documentation template, about setting
up 162

existing covenants, copying to another
facility 169

facilities, associating with financial
account 164

facility, creating and associating a
borrower 167

facility, setting pricing and fees 168

facility, syndicating 167

group exposure, reviewing 171

guarantors, adding to loan facilities 168

loan request workflows, activating 161

notes, creating about applications 155

outstanding trailing documents, viewing 155

policy exceptions, creating 170

portfolio types, setting up for commercial
loans 163

processing application tasks, list of 152

regulation C compliance information,
entering 154

report information entering 154

small business details, adding 151

small business loan features and terms,
recording 152

trailing documents, adding 155

underwriting standard, reviewing 171

M
Mobile Web Client
about performing administrative functions on
local db 25
Mock Event Sink mode 285
ModelValueByClass.asp 319
ModelValueBySector.asp 325
mortgages, managing
about 87
mortgage calculator, using 89
mortgage needs analyses, performing for a
contact 87
mortgage prequalification, performing 89
mortgage product for which a customer
qualifies, recommending 88
mortgage product recommendations, about
making 88



Move down button
Edit Layout view 28
Move up button
Edit Layout view 28
mutual fund records
creating and modifying, about 177
mutual fund information, editing 178
My To Do List
managing 103

N

name
company name, changing 121
company name, changing by service
request 124
customer name, changing 122
needs analysis
about 127
business scenario, administrator 128
business scenario, call center agent 128
company or contact, performing general
needs analysis 132
contacts, performing investment needs
for 133
investment objective and portfolio mix, about
creating 130
investment objective, creating 131
needs analysis by product type 132
needs analysis script creation, about 129
portfolio mix administration, performing 131
questions and score, associating with
products 129
recommendations, generating from needs
analysis 133
recommended product, selected using the
Apply field 134
script problems with a product score,
correcting 130
New Call Report Workflow
activating 95
Data Transfer Utility, about using to
modify 95
new features 15
Next button
applications, about using to complete 144
customer loan information, using to enter
information 150
processing applications, using to 152
NextRecord method, about 245
notes
applications, creating about applications 155
call reports, associating with 97
creating about contacts 81
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group pension plan, creating associated with
plan 204

@)

opportunities

applications, creating from 43

business scenario, investment banker creates
IPO deal 39

business scenario, sales representative
creates new opportunity 38

deal management capabilities 37

deal, creating a new activity plan 45

deals, securing 44

defined 37

deleting if unsure whether opportunity is
active 40

managing deals, about 44

new activity, creating and assigning a deal
team member 45

new attachment, creating for a deal 45

opportunity details, adding 43

opportunity, adding 42

primary deal team member, changing 44

primary sales team member, changing 41

sales team, adding or deleting members 41

securing an opportunity 41

outstanding trailing documents
viewing 155

P

parent-subsidiary relationship
establishing 63
pensions
See group pensions
Performance view
testing using Performance.asp 313
personal information
changing by service request 125
policies
creating policy exceptions 170
portfolio
account holding, comparing against 72
household portfolios, about viewing and
evaluating 71
investment objective, creating 131
investment objectives, creating and the
portfolio mix 130
portfolio mix administration, performing 131
portfolio types, setting up for commercial
loans 163
pricing
about 185
business scenario, administrator defines new
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products 186
business scenario, customer service
representative views product
information 186
fees and conditions, defining for a
product 188
new product line, creating 187
product information, using 190
product, creating 187
rate for a product, setting 189
scenarios, about 185
printing
call reports 98
privacy flags
setting the call report privacy flag 98
privacy option, setting 69
processing applications
accessing applications, methods to 153
assigned applications, viewing 153
closing activities, adding 155
decisions, viewing on applications 154
notes, creating about applications 155
outstanding trailing documents, viewing 155
regulation C compliance information,
entering 154
report information, entering 154
tasks, list of 152
trailing documents, adding 155
product type
applets, establishing as read and write, or
read-only 27
data fields, determining which to display 27
setting up, about 27
products
about 185
business scenario, administrator defines new
products 186
business scenario, customer service
representative views product
information 186
fees and conditions, defining for a
product 188
needs analysis by product type 132
new product line, creating 187
product class, adding for a security 176
product detail information, adding 146
product information, using 190
product lines, setting up 175
product, creating 187
questions and scores, associating with 129
rate, setting 189
recommended product, selecting using the
Apply field 134
scenarios, about 185
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script problem with a product score,
correcting 130
profiles
updating company profiles 58
profiles investment profile
updating or reviewing a contacts’s investment
profile 78

Q

questions
associating with products 129
QueueMethod 281

R

rates
setting for a product 189
recommendations
needs analysis, generating from 133
product, selecting using the Apply field 134
Record Group templates
creating 254
Requirements Manager, example of using for
Record Group templates 256
record templates, creating 250
reference information, adding 149
referral information
contact profitability, reviewing 84
referral, creating to a contact 83
referral, entering a referral received from a
contact 82
regulation
entering C compliance information 154
relationship hierarchy
contact, about viewing 86
contacts, defining a relationship between
contacts 86
household relationship hierarchy, about
viewing 70
relationship types, custom defined
managing, about 54
managing, adding 54
reports
information, entering 154
table of 303
requirement templates, creating 251
Requirements Manager
about and scenarios 249
administration steps 250
example of using for Record Group
templates 256
invoking Requirements Manager 254
invoking, about 249
key features 249



Record Group templates, creating 254

record templates, creating 250

requirement templates, creating 251
roll-up views

aggregated activities, viewing for a

company 59

aggregated coverage team, viewing 60

aggregated opportunities, viewing 60

company hierarchies, viewing in 59

S

sales methods
creation and modification 140
sales team members
new activity, creating and assigning a deal
team member 45
opportunity, adding or deleting members 41
primary deal team member, changing 44
primary sales team member, changing for an
opportunity 41
scores
associating with products 129
script problem with a product score 130
script
correcting script problem with a product
score, correcting 130
searching
contacts with particular interests 181
Sector Allocation view
testing using ModelValueBySector.asp 325
securities
clients’ interests, process of tracking and
creating interest-based call lists 179
holdings information, entering 180
interest based on a holding, recording 180
interest, recording 179
lists of values, setting up 175
literature document, associating with a
security 178
mutual fund information, editing 178
new securities record, adding 178
process of administering 174
product class, adding for a security 176
product lines, setting up 175
security categories, adding 177
security exchange, adding 177
stock, bond. mutual fund records, about
creating and modifying 177
securities interest
entering for contacts 82
seed data
confirming 7.7 seed data 141
service requests
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about and defined 119
account services view items table 122
account services, requesting using a service
request 124
adding associated with company 62
business scenario, application administrator
changes a company name 120
business scenario, call center agent creates a
service request 120
business scenario, relationship manager
creates a service request 120
company address or name, changing 121
company address or name, changing by
service request 124
creating service requests 122
creating, ways to create service
requests 122
customer address or name, changing 122
customer address or personal information,
changing by service request 125
GO button, using to create 116
group pension plan, creating associating
with 203
new customer complaint, recording 126
SetFieldvValue method
about 244
Show Audit Trail button
using 26
Show button
Edit Layout view 28
Siebel Calculation Expectations Manager
about 268
Siebel Calculation Manager
See Calculation Manager
small business loan applications
business services information, adding 152
customer information needed 150
features and terms, recording 152
small business details, adding 151
SmartScript
FINS SmartScript Output Service
methods 296
FINS Web Shopping Service methods 295
integrating with workflow example 293
workflow, about invoking from 293
Srf mode 285
statement
creating an updated statement 147
stock records
about creating and modifying 177
summary information
viewing a household summary 70
summary views
configuring, about 28
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layout, editing 28
syndicating a facility 167

T

targeted call lists
contacts in a targeted call list, modifying 182
contacts, searching for with particular
interests 181
creating and using, about 181
using 183
team members
coverage team members, about verifying 53
coverage team members, adding or
deleting 53
coverage team members, searching for a
company without 53
new activity, creating and assigning a deal
team member 45
opportunity, adding or deleting members 41
primary coverage team members,
changing 54
primary deal team member, changing 44
primary sales team member, changing for an
opportunity 41
Template Definition view
adding views and applets 299
templates
assessment templates, about setting up 161
call report email templates, viewing or
changing 95
customer authentication templates,
creating 258
documentation template, about setting
up 162
Dynamic Ul Service methods 299
Record Group templates, creating 254
Record Group templates, example of using
Requirements Manager for 256
record templates, creating 250
requirement templates, creating 251
Template Definition view, adding views and
applets 299
view template, about creating for dynamic
applets 298
test database
setting up test ASP and local test
database 114
testing
virtual business components 115
To Do items
viewing assigned to end user 103
toolbar buttons, defining 285
trades, placing 117
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trailing documents

adding and viewing 155
transaction history

viewing a contact’s transaction history 82
transactions

displaying list by investor 65
TryMockMethod 281

U

underwriting
commercial loan underwriting standard,
setting up 164
group exposure, reviewing 171
underwriting standard, reviewing 171
user
adding new authorized user 112

Vv

VBC Cache and Instance Manager
about 208
caching VBC configuration 210
components 209
features and limitations 208
purging the VBC cache 211
stages of caching process 209

view template
dynamic applets, about creating for 298
Dynamic Ul Service methods 299
Template Definition view, adding views and

applets 299

virtual business components
cashflow.asp 307
holdings.asp 331
ModelValueByClass.asp 319
ModelValueBySector.asp 325
Performance.asp 313
setting up, about 113
test ASP and local test database, setting

up 114

testing virtual business components 115
user properties, configuring 113

W

workflows
access exceptions, about activating 193
access workflows, activating 193
disclosure documents, activating (table) 292
Disclosure Ul Service, invoking from a
workflow 292
disclosure workflow processes (table) 291
dynamic applets, displaying in a
workflow 297
FINS Approval Item Service, invoking from a
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workflow 287 workflow 293
loan request workflows, activating 161 SmartScript, integrating with workflow
SmartScript, about invoking from a example 293
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